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Getting Started

® “Product Overview” on page 1-2

e “Expected Background” on page 1-4

e “Using Matrix Functions for Finance” on page 1-5

e “Matrix Algebra Refresher” on page 1-8

¢ “Function Input and Output Arguments” on page 1-19
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Product Overview
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The MATLAB® and Financial Toolbox™ products provide a complete
integrated computing environment for financial analysis and engineering.
The toolbox has everything you need to perform mathematical and statistical
analysis of financial data and display the results with presentation-quality
graphics. You can quickly ask, visualize, and answer complicated questions.

In traditional or spreadsheet programming, you must deal with all sorts of
housekeeping details: declaring, data typing, sizing, and so on. MATLAB
software does all that for you. You just write expressions the way you
think of problems. There is no need to switch tools, convert files, or rewrite
applications.

With the MATLAB and Financial Toolbox products, you can do the following:
¢ Compute and analyze prices, yields, and sensitivities for derivatives and

other securities, and for portfolios of securities.

¢ Perform Securities Industry Association (SIA) compatible fixed-income
pricing, yield, and sensitivity analysis.

® Analyze or manage portfolios.
® Design and evaluate hedging strategies.
¢ Identify, measure, and control risk.

® Analyze and compute cash flows, including rates of return and depreciation
streams.

¢ Analyze and predict economic activity.
¢ Visualize and analyze financial time series data.

¢ Create structured financial instruments, including foreign-exchange
instruments.

e Teach or conduct academic research.
This chapter uses MATLAB to review the fundamentals of matrix algebra you

need for financial analysis and engineering applications. It contains these
sections:
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¢ “Using Matrix Functions for Finance” on page 1-5

Reviews “Key Definitions” on page 1-5 and some matrix algebra
fundamentals, such as “Referencing Matrix Elements” on page 1-6 and
“Transposing Matrices” on page 1-7.

e “Matrix Algebra Refresher” on page 1-8

Provides a brief refresher on using matrix functions in financial analysis
and engineering

* “Function Input and Output Arguments” on page 1-19
Describes acceptable formats for providing data to MATLAB and the

resulting output from computations on the supplied data.

This material explains some MATLAB concepts and operations using financial
examples to help get you started.

1-3



1 Getting Started

1-4

Expected Background

In general, this guide assumes experience working with financial derivatives
and some familiarity with the underlying models.

In designing Financial Toolbox documentation, we assume that your title is
like one of these:

® Analyst, quantitative analyst

¢ Risk manager

¢ Portfolio manager

® Asset allocator

¢ Financial engineer

* Trader

® Student, professor, or other academic

We also assume your background, education, training, and responsibilities
match some aspects of this profile:

¢ Finance, economics, perhaps accounting

¢ Engineering, mathematics, physics, other quantitative sciences

® Focus on quantitative approaches to financial problems
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Using Matrix Functions for Finance

In this section...

“Introduction” on page 1-5
“Key Definitions” on page 1-5
“Referencing Matrix Elements” on page 1-6

“Transposing Matrices” on page 1-7

Introduction

Many financial analysis procedures involve sets of numbers; for example, a
portfolio of securities at various prices and yields. Matrices, matrix functions,
and matrix algebra are the most efficient ways to analyze sets of numbers
and their relationships. Spreadsheets focus on individual cells and the
relationships between cells. While you can think of a set of spreadsheet cells (a
range of rows and columns) as a matrix, a matrix-oriented tool like MATLAB
software manipulates sets of numbers more quickly, easily, and naturally.

Key Definitions

Matrix. A rectangular array of numeric or algebraic quantities subject to
mathematical operations; the regular formation of elements into rows and
columns. Described as a “m-by-n” matrix, with m the number of rows and

n the number of columns. The description is always “row-by-column.” For
example, here is a 2-by-3 matrix of two bonds (the rows) with different par
values, coupon rates, and coupon payment frequencies per year (the columns)
entered using MATLAB notation:

Bonds = [1000 0.06 2
500 0.055 4]

Vector. A matrix with only one row or column. Described as a “1-by-n” or
“m-by-1” matrix. The description is always “row-by-column.” For example,
here is a 1-by-4 vector of cash flows in MATLAB notation:

Cash = [1500 4470 5280 -1299]

1-5
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Scalar. A 1-by-1 matrix; that is, a single number.

Referencing Matrix Elements

To reference specific matrix elements, use (row, column) notation. For
example:

Bonds(1,2)
ans =
0.06
Cash(3)
ans =
5280.00

You can enlarge matrices using small matrices or vectors as elements. For
example,

AddBond = [1000 0.065 21;
Bonds = [Bonds; AddBond]

adds another row to the matrix and creates

Bonds =
1000 0.06 2
500 0.055 4
1000 0.065 2
Likewise,

Prices = [987.50
475.00
995.00]

Bonds = [Prices, Bonds]
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adds another column and creates

Bonds =

987.50 1000 0.06 2
475.00 500 0.055 4
995.00 1000 0.065 2

Finally, the colon (:) is important in generating and referencing matrix
elements. For example, to reference the par value, coupon rate, and coupon
frequency of the second bond:

BondItems Bonds (2, 2:4)

BondItems

500.00 0.055 4

Transposing Matrices

Sometimes matrices are in the wrong configuration for an operation. In
MATLAB, the apostrophe or prime character (') transposes a matrix: columns
become rows, rows become columns. For example,

Cash = [1500 4470 5280 -1299]"

produces
Cash =
1500
4470
5280
-1299

1-7
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In this section...

“Introduction” on page 1-8

“Adding and Subtracting Matrices” on page 1-8
“Multiplying Matrices” on page 1-9

“Dividing Matrices” on page 1-14

“Solving Simultaneous Linear Equations” on page 1-14

“Operating Element by Element” on page 1-18

Introduction

The explanations in the sections that follow should help refresh your skills for
using matrix algebra and using MATLAB functions.

In addition, William Sharpe’s Macro-Investment Analysis also provides an
excellent explanation of matrix algebra operations using MATLAB. It is
available on the Web at:

http://www.stanford.edu/~wfsharpe/mia/mia.htm

Tip When you are setting up a problem, it helps to “talk through” the units
and dimensions associated with each input and output matrix. In the
example under “Multiplying Matrices” on page 1-9, one input matrix has
“five days’ closing prices for three stocks,” the other input matrix has “shares
of three stocks in two portfolios,” and the output matrix therefore has “five
days’ closing values for two portfolios.” It also helps to name variables using
descriptive terms.

Adding and Subtracting Matrices

Matrix addition and subtraction operate element-by-element. The two input
matrices must have the same dimensions. The result is a new matrix of
the same dimensions where each element is the sum or difference of each
corresponding input element. For example, consider combining portfolios of


http://www.stanford.edu/%7Ewfsharpe/mia/mia.htm

Matrix Algebra Refresher

different quantities of the same stocks (“shares of stocks A, B, and C [the
rows] in portfolios P and Q [the columns] plus shares of A, B, and C in
portfolios R and S”).

Portfolios_PQ = [100 200
500 400
300 150] ;
Portfolios_RS = [175 125
200 200
100 500];
NewPortfolios = Portfolios_PQ + Portfolios_RS
NewPortfolios =
275.00 325.00
700.00 600.00
400.00 650.00

Adding or subtracting a scalar and a matrix is allowed and also operates
element-by-element.

SmallerPortf = NewPortfolios-10

SmallerPortf =
265.00 315.00
690.00 590.00
390.00 640.00

Multiplying Matrices

Matrix multiplication does not operate element-by-element. It operates
according to the rules of linear algebra. In multiplying matrices, it helps to
remember this key rule: the inner dimensions must be the same. That is, if
the first matrix is m-by-3, the second must be 3-by-n. The resulting matrix is
m-by-n. It also helps to “talk through” the units of each matrix, as mentioned
in “Using Matrix Functions for Finance” on page 1-5.

Matrix multiplication also is not commutative; that is, it is not independent of
order. A*B does not equal B¥A. The dimension rule illustrates this property.
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If A is 1-by-3 matrix and B is 3-by-1 matrix, A*B yields a scalar (1-by-1)
matrix but B*A yields a 3-by-3 matrix.

Multiplying Vectors

Vector multiplication follows the same rules and helps illustrate the
principles. For example, a stock portfolio has three different stocks and their
closing prices today are:

ClosePrices = [42.5 15 78.875]

The portfolio contains these numbers of shares of each stock.

NumShares = [100
500
300]

To find the value of the portfolio, multiply the vectors

PortfValue

ClosePrices * NumShares

which yields:

Portfvalue
35412.50
The vectors are 1-by-3 and 3-by-1; the resulting vector is 1-by-1, a scalar.
Multiplying these vectors thus means multiplying each closing price by its

respective number of shares and summing the result.

To illustrate order dependence, switch the order of the vectors

Values = NumShares * ClosePrices

Values =
4250.00 1500.00 7887.50
21250.00 7500.00 39437.50
12750.00 4500.00 23662.50

1-10
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which shows the closing values of 100, 500, and 300 shares of each stock, not
the portfolio value, and meaningless for this example.

Computing Dot Products of Vectors
In matrix algebra, if X and Y are vectors of the same length

Y = [y1.590-0,]
X = [x1x9,...x,]

then the dot product

XeoY =2y +x9¥g+ ... +2,V,

is the scalar product of the two vectors. It is an exception to the commutative
rule. To compute the dot product in MATLAB, use sum(X .* Y) or sum(Y .*
X). Just be sure the two vectors have the same dimensions. To illustrate, use
the previous vectors.

Value = sum(NumShares .* ClosePrices')
Value =

35412.50
Value = sum(ClosePrices .* NumShares')
Value =

35412.50

As expected, the value in these cases matches the PortfValue computed
previously.

Multiplying Vectors and Matrices

Multiplying vectors and matrices follows the matrix multiplication rules and
process. For example, a portfolio matrix contains closing prices for a week. A
second matrix (vector) contains the stock quantities in the portfolio.

1-11
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WeekClosePr = [42.5 15 78.875
42.125 15.5 78.75
42.125 15.125 79
42.625 15.25 78.875
43 15.25 78.625];
PortQuan = [100
500
30017 ;

To see the closing portfolio value for each day, simply multiply

WeekPortValue

WeekClosePr * PortQuan

WeekPortValue

35412.50
35587.50
35475.00
35550.00
35512.50

The prices matrix is 5-by-3, the quantity matrix (vector) is 3-by-1, so the
resulting matrix (vector) is 5-by-1.

Multiplying Two Matrices

Matrix multiplication also follows the rules of matrix algebra. In matrix
algebra notation, if A is an m-by-n matrix and B is an n-by-p matrix

aj.j. le Hln

bll e w blj e blp

A= ;1 Qg ... Q;

Ln

] B _ bzl nam sz naw bzp

' b b_. b
1
_aml L = Dn L " nE

then C = A*B is an m-by-p matrix; and the element ¢; in the ith row and
jth column of C is
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To illustrate, assume there are two portfolios of the same three stocks above
but with different quantities.

Portfolios = [100 200
500 400
300 150];

Multiplying the 5-by-3 week’s closing prices matrix by the 3-by-2 portfolios
matrix yields a 5-by-2 matrix showing each day’s closing value for both
portfolios.

PortfolioValues = WeekClosePr * Portfolios

PortfolioValues =
35412.50 26331.25
35587.50 26437.50
35475.00 26325.00
35550.00 26456.25
35512.50 26493.75

Monday’s values result from multiplying each Monday closing price by its
respective number of shares and summing the result for the first portfolio,
then doing the same for the second portfolio. Tuesday’s values result from
multiplying each Tuesday closing price by its respective number of shares and
summing the result for the first portfolio, then doing the same for the second
portfolio. And so on through the rest of the week. With one simple command,
MATLAB quickly performs many calculations.

Multiplying a Matrix by a Scalar

Multiplying a matrix by a scalar is an exception to the dimension and
commutative rules. It just operates element-by-element.

Portfolios = [100 200
500 400
300 150];

1-13
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DoublePort = Portfolios * 2

DoublePort =
200.00 400.00
1000.00 800.00
600.00 300.00

Dividing Matrices
Matrix division is useful primarily for solving equations, and especially for

solving simultaneous linear equations (see “Solving Simultaneous Linear
Equations” on page 1-14). For example, you want to solve for X in A*X = B.

In ordinary algebra, you would divide both sides of the equation by A, and X
would equal B/A. However, since matrix algebra is not commutative (A*X
# X*A), different processes apply. In formal matrix algebra, the solution
involves matrix inversion. MATLAB, however, simplifies the process by
providing two matrix division symbols, left and right (\ and /). In general,

X = A\B solves for X in A*X B and

X = B/A solves for X in X*A = B.

In general, matrix A must be a nonsingular square matrix; that is, it must
be invertible and it must have the same number of rows and columns.
(Generally, a matrix is invertible if the matrix times its inverse equals the
identity matrix. To understand the theory and proofs, consult a textbook on
linear algebra such as Elementary Linear Algebra by Hill listed in Appendix
A, “Bibliography”.) MATLAB gives a warning message if the matrix is

singular or nearly so.

Solving Simultaneous Linear Equations

Matrix division is especially useful in solving simultaneous linear equations.
Consider this problem: Given two portfolios of mortgage-based instruments,
each with certain yields depending on the prime rate, how do you weight the
portfolios to achieve certain annual cash flows? The answer involves solving
two linear equations.

A linear equation is any equation of the form
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aix+agy =b

where a,, a,, and b are constants (with a; and a, not both 0), and x and y are
variables. (It’s a linear equation because it describes a line in the xy-plane. For
example, the equation 2x + y = 8 describes a line such that if x =2, then y = 4.)

A system of linear equations is a set of linear equations that you usually
want to solve at the same time; that is, simultaneously. A basic principle for
exact answers in solving simultaneous linear equations requires that there
be as many equations as there are unknowns. To get exact answers for x
and y, there must be two equations. For example, to solve for x and y in the
system of linear equations

2x+yv = 13
x-3y = -18

there must be two equations, which there are. Matrix algebra represents this
system as an equation involving three matrices: A for the left-side constants,
X for the variables, and B for the right-side constants

A= 2 1 X = X E = 13
1 -3 y 18
where A*X = B.

Solving the system simultaneously means solving for X. Using MATLAB,

A=12 1
1 -3];

B =[13
-181;

X=A\B

solves for Xin A * X = B.

X =13 7]
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So x = 3 and y = 7 in this example. In general, you can use matrix algebra to
solve any system of linear equations such as

allxl+a1212+...+ﬂ1n:€” =b1
azlxl+azzxz+...+a2n1” :bz
Xy TpoXg o T8y Xy = bm

by representing them as matrices

@y Qqg --- Ay, xq bl
A - |®2 G - Ay, x - | %2 B - by
_aml Qg - amn_ _xn_ _'bm_

and solving for X in A*X = B.

To illustrate, consider this situation. There are two portfolios of
mortgage-based instruments, M1 and M2. They have current annual cash
payments of $100 and $70 per unit, respectively, based on today’s prime rate.
If the prime rate moves down one percentage point, their payments would
be $80 and $40. An investor holds 10 units of M1 and 20 units of M2. The
investor’s receipts equal cash payments times units, or R = C * U, for each
prime-rate scenario. As word equations:

M1 M2
Prime flat: $100 * 10 units +$70 * 20 units = $2400
receipts
Prime down: $80 * 10 units + $40 * 20 units = $1600
receipts
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As MATLAB matrices:

Cash = [100 70
80 40];

Units = [10
201;

Receipts Cash * Units

Receipts

2400.00
1600.00

Now the investor asks this question: Given these two portfolios and their
characteristics, how many units of each should I hold to receive $7000 if the
prime rate stays flat and $5000 if the prime drops one percentage point? Find
the answer by solving two linear equations.

M1 M2
Prime flat: $100 * x units + $70 * y units = $7000
receipts
Prime down: $80 * x units + $40 * y units = $5000
receipts

In other words, solve for U (units) in the equation R (receipts) = C (cash) * U
(units). Using MATLAB left division

Cash = [100 70
80 40];

Receipts = [7000
500017;

Units = Cash \ Receipts
Units

43.75

1-17
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37.50

The investor should hold 43.75 units of portfolio M1 and 37.5 units of portfolio
M2 to achieve the annual receipts desired.

Operating Element by Element

Finally, element-by-element arithmetic operations are called array operations.
To indicate a MATLAB array operation, precede the operator with a period
(.). Addition and subtraction, and matrix multiplication and division by a
scalar, are already array operations so no period is necessary. When using
array operations on two matrices, the dimensions of the matrices must be the
same. For example, given vectors of stock dividends and closing prices

Dividends = [1.90 0.40 1.56 4.50];
Prices = [25.625 17.75 26.125 60.50];

Yields

Dividends ./ Prices

Yields

0.0741 0.0225 0.0597 0.0744
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Function Input and Output Arguments

In this section...

“Input Arguments” on page 1-19
“Output Arguments” on page 1-21

“Interest Rate Arguments” on page 1-22

Input Arguments

Matrix Input

MATLAB software was designed to be a large-scale array (vector or

matrix) processor. In addition to its linear algebra applications, the

general array-based processing facility can perform repeated operations on
collections of data. When MATLAB code is written to operate simultaneously
on collections of data stored in arrays, the code is said to be vectorized.

Vectorized code is not only clean and concise, but is also efficiently processed
by the underlying MATLAB engine.

Because MATLAB can process vectors and matrices easily, most Financial
Toolbox functions allow vector or matrix input arguments, rather than just
single (scalar) values. For example, the irr function computes the internal
rate of return of a cash flow stream. It accepts a vector of cash flows and
returns a scalar-valued internal rate of return. However, it also accepts a
matrix of cash flow streams, a column in the matrix representing a different
cash flow stream. In this case, irr returns a vector of internal rates of return,
each entry in the vector corresponding to a column of the input matrix. Many
other toolbox functions work similarly.

As an example, suppose you make an initial investment of $100, from which

you then receive by a series of annual cash receipts of $10, $20, $30, $40, and
$50. This cash flow stream may be stored in a vector

CashFlows = [-100 10 20 30 40 50]'

which MATLAB displays as

CashFlows =

1-19
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-100
10
20
30
40
50

The irr function can compute the internal rate of return of this stream.

Rate = irr(CashFlows)

The internal rate of return of this investment is

Rate =
0.1201
or 12.01%.

In this case, a single cash flow stream (written as an input vector) produces a
scalar output — the internal rate of return of the investment.

Extending this example, if you process a matrix of identical cash flow streams

Rate = irr([CashFlows CashFlows CashFlows])

you should expect to see identical internal rates of return for each of the three
investments.

Rate =
0.1201 0.1201 0.1201

This simple example illustrates the power of vectorized programming. The
example shows how to collect data into a matrix and then use a toolbox
function to compute answers for the entire collection. This feature can be
useful in portfolio management, for example, where you might want to
organize multiple assets into a single collection. Place data for each asset in
a different column or row of a matrix, then pass the matrix to a Financial
Toolbox function. MATLAB performs the same computation on all of the
assets at once.
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Matrices of String Input
Enter MATLAB strings surrounded by single quotes ('string').

Strings are stored as character arrays, one ASCII character per element.
Thus, the date string

DateString = '9/16/2001"'

is actually a 1-by-9 vector. Strings making up the rows of a matrix or vector
all must have the same length. To enter several date strings, therefore, use
a column vector and be sure all strings are the same length. Fill in with
spaces or zeros. For example, to create a vector of dates corresponding to
irregular cash flows

DateFields = ['01/12/2001"
'02/14/2001"'
‘03/03/2001"
'06/14/2001"
'12/01/2001'];

DateFields actually becomes a 5-by-10 character array.

Don’t mix numbers and strings in a matrix. If you do, MATLAB treats all
entries as characters. For example,

Item = [83 90 99 '14-Sep-1999']

becomes a 1-by-14 character array, not a 1-by-4 vector, and it contains

Item

SZc14-Sep-1999

Output Arguments

Some functions return no arguments, some return just one, and some return
multiple arguments. Functions that return multiple arguments use the
syntax

[A, B, C] = function(variables...)
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to return arguments A, B, and C. If you omit all but one, the function returns
the first argument. Thus, for this example if you use the syntax

X = function(variables...)
function returns a value for A, but not for B or C.

Some functions that return vectors accept only scalars as arguments. Why
could such functions not accept vectors as arguments and return matrices,
where each column in the output matrix corresponds to an entry in the input
vector? The answer is that the output vectors can be variable length and
thus will not fit in a matrix without some convention to indicate that the
shorter columns are missing data.

Functions that require asset life as an input, and return values corresponding
to different periods over that life, cannot generally handle vectors or matrices
as input arguments. Those functions are:

amortize Amortization

depfixdb Fixed declining-balance depreciation
depgendb General declining-balance depreciation
depsoyd Sum of years’ digits depreciation

For example, suppose you have a collection of assets such as automobiles
and you want to compute the depreciation schedules for them. The function
depfixdb computes a stream of declining-balance depreciation values for an
asset. You might want to set up a vector where each entry is the initial value
of each asset. depfixdb also needs the lifetime of an asset. If you were to set
up such a collection of automobiles as an input vector, and the lifetimes of
those automobiles varied, the resulting depreciation streams would differ in
length according to the life of each automobile, and the output column lengths
would vary. A matrix must have the same number of rows in each column.

Interest Rate Arguments

One common argument, both as input and output, is interest rate. All
Financial Toolbox functions expect and return interest rates as decimal
fractions. Thus an interest rate of 9.5% is indicated as 0.095.
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Introduction

Financial Toolbox software contains functions that perform many common
financial tasks, including:

¢ “Handling and Converting Dates” on page 2-4

Calendar functions convert dates among different formats (including
Excel® formats), determine future or past dates, find dates of holidays and
business days, compute time differences between dates, find coupon dates
and coupon periods for coupon bonds, and compute time periods based on
360-, 365-, or 366-day years.

“Formatting Currency” on page 2-12

The toolbox includes functions for handling decimal values in bank
(currency) formats and as fractional prices.

“Charting Financial Data” on page 2-13

Charting functions produce a variety of financial charts including Bollinger
bands, high-low-close charts, candlestick plots, point and figure plots, and
moving-average plots.

“Analyzing and Computing Cash Flows” on page 2-17

Cash-flow evaluation and financial accounting functions compute interest
rates, rates of return, payments associated with loans and annuities,
future and present values, depreciation, and other standard accounting
calculations associated with cash-flow streams.

“Pricing and Computing Yields for Fixed-Income Securities” on page 2-22

Securities Industry Association (SIA) compliant fixed-income functions
compute prices, yields, accrued interest, and sensitivities for securities
such as bonds, zero-coupon bonds, and Treasury bills. They handle odd
first and last periods in price/yield calculations, compute accrued interest
and discount rates, and calculate convexity and duration. Another set of
functions analyzes term structure of interest rates, including pricing bonds
from yield curves and bootstrapping yield curves from market prices.

“Pricing and Analyzing Equity Derivatives” on page 2-40

Derivatives analysis functions compute prices, yields, and sensitivities for
derivative securities. They deal with both European and American options.
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Black-Scholes functions work with European options. They compute
delta, gamma, lambda, rho, theta, and vega, as well as values of call and
put options.

Binomial functions work with American options, computing put and call
prices.

“Analyzing Portfolios” on page 3-2

Portfolio analysis functions provide basic utilities to compute variances and
covariance of portfolios, find combinations to minimize variance, compute
Markowitz efficient frontiers, and calculate combined rates of return.

Modeling volatility in time series.

Generalized Autoregressive Conditional Heteroskedasticity
(GARCH) functions model the volatility of univariate economic time series.
(Econometrics Toolbox™ software provides a more comprehensive and
integrated computing environment. For information, see the Econometrics
Toolbox User’s Guide documentation or the financial products Web page at
http://www.mathworks.com/products/finprod.)
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Handling and Converting Dates

In this section...

“Date Formats” on page 2-4
“Date Conversions” on page 2-5

“Current Date and Time” on page 2-8

“Determining Dates” on page 2-9

Date Formats

Since virtually all financial data is dated or derives from a time series,
financial functions must have extensive date-handling capabilities. You most
often work with date strings (14-Sep-1999) when dealing with dates. Financial
Toolbox software works internally with serial date numbers (for example,
730377). A serial date number represents a calendar date as the number of
days that has passed since a fixed base date. In MATLAB software, serial date
number 1 is January 1, 0000 A.D. MATLAB also uses serial time to represent
fractions of days beginning at midnight; for example, 6 p.m. equals 0.75 serial
days. So 6:00 p.m. on 14-Sep-1999, in MATLAB, is date number 730377.75.

Note If you specify a two-digit year, MATLAB assumes that the year lies
within the 100-year period centered about the current year. See the function
datenum for specific information. MATLAB internal date handling and
calculations generate no ambiguous values. However, whenever possible,
programmers should use serial date numbers or date strings containing
four-digit years.

Many toolbox functions that require dates accept either date strings or
serial date numbers. If you are dealing with a few dates at the MATLAB
command-line level, date strings are more convenient. If you are using toolbox
functions on large numbers of dates, as in analyzing large portfolios or cash
flows, performance improves if you use date numbers.

The Financial Toolbox software provides functions that convert date strings
to serial date numbers, and vice versa.
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Date Conversions

Functions that convert between date formats are

datedisp Displays a numeric matrix with date entries formatted
as date strings

datenum Converts a date string to a serial date number

datestr Converts a serial date number to a date string

m2xdate Converts MATLAB serial date number to Excel serial
date number

x2mdate Converts Excel serial date number to MATLAB serial

date number

Another function, datevec, converts a date number or date string to a date
vector whose elements are [Year Month Day Hour Minute Second]. Date
vectors are mostly an internal format for some MATLAB functions; you would
not often use them in financial calculations.

Input Conversions

The datenum function is important for using Financial Toolbox software
efficiently. datenum takes an input string in any of several formats, with
‘dd-mmm-yyyy', 'mm/dd/yyyy"' or 'dd-mmm-yyyy, hh:mm:ss.ss' most
common. The input string can have up to six fields formed by letters and
numbers separated by any other characters:

¢ The day field is an integer from 1 through 31.

¢ The month field is either an integer from 1 through 12 or an alphabetical
string with at least three characters.

¢ The year field is a nonnegative integer: if only two numbers are specified,
then the year is assumed to lie within the 100-year period centered about
the current year; if the year is omitted, the current year is used as the
default.

¢ The hours, minutes, and seconds fields are optional. They are integers
separated by colons or followed by 'am' or 'pm'.

For example, if the current year is 1999, then these are all equivalent
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'17-May-1999"
"17-May-99'
"17-may'

'May 17, 1999'
'5/17/99'
'5/17'

and both of these represent the same time.

'17-May-1999, 18:30'
'5/17/99/6:30 pm'

Note that the default format for numbers-only input follows the American
convention. Thus 3/6 is March 6, not June 3.

With datenum you can convert dates into serial date format, store them in a
matrix variable, then later pass the variable to a function. Alternatively, you
can use datenum directly in a function input argument list.

For example, consider the function bndprice that computes the price of a bond
given the yield-to-maturity. First set up variables for the yield-to-maturity,
coupon rate, and the necessary dates.

Yield = 0.07;
CouponRate = 0.08;
Settle = datenum('17-May-2000"');

Maturity datenum('01-0ct-2000");

Then call the function with the variables

bndprice(Yield, CouponRate, Settle, Maturity)

Alternatively, convert date strings to serial date numbers directly in the
function input argument list.

bndprice(0.07, 0.08, datenum('17-May-2000"'),...
datenum('01-0ct-2000"))

bndprice is an example of a function designed to detect the presence of date
strings and make the conversion automatically. For these functions date
strings may be passed directly.
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bndprice(0.07, 0.08, '17-May-2000', '01-0ct-2000')

The decision to represent dates as either date strings or serial date numbers
is often a matter of convenience. For example, when formatting data for
visual display or for debugging date-handling code, it is often much easier

to view dates as date strings because serial date numbers are difficult to
interpret. Alternatively, serial date numbers are just another type of numeric
data, and can be placed in a matrix along with any other numeric data for
convenient manipulation.

Remember that if you create a vector of input date strings, use a column
vector and be sure all strings are the same length. Fill with spaces or zeros.
See “Matrices of String Input” on page 1-21.

Output Conversions

The function datestr converts a serial date number to one of 19 different
date string output formats showing date, time, or both. The default output for
dates is a day-month-year string, for example, 24-Aug-2000. This function is
quite useful for preparing output reports.

Format Description
01-Mar-2000 15:45:17 day-month-year hour:minute:second
01-Mar-2000 day-month-year
03/01/00 month/day/year

Mar month, three letters

M month, single letter

3 month

03/01 month/day

1 day of month

Wed day of week, three letters
W day of week, single letter
2000 year, four numbers

99 year, two numbers

2-7



2 Performing Common Financial Tasks

2-8

Format Description

Maro1 month year

15:45:17 hour:minute:second

03:45:17 PM hour:minute:second AM or PM
15:45 hour:minute

03:45 PM hour:minute AM or PM

Q1-99 calendar quarter-year

Q1 calendar quarter

Current Date and Time

The functions today and now return serial date numbers for the current date,
and the current date and time, respectively.

today
ans =
730693
now
ans =
730693.48

The MATLAB function date returns a string for today’s date.

date
ans =

26-Jul-2000



Handling and Converting Dates

Determining Dates

The Financial Toolbox software provides many functions for determining
specific dates, including functions which account for holidays and other
nontrading days. For example, you schedule an accounting procedure for the
last Friday of every month. The 1lweekdate function returns those dates for
2000; the 6 specifies Friday.

Fridates = lweekdate(6, 2000, 1:12);

Fridays datestr(Fridates)

Fridays =

28-Jan-2000
25-Feb-2000
31-Mar-2000
28-Apr-2000
26-May-2000
30-Jun-2000
28-Jul-2000
25-Aug-2000
29-Sep-2000
27-0ct-2000
24-Nov-2000
29-Dec-2000

Or your company closes on Martin Luther King Jr. Day, which is the third
Monday in January. The nweekdate function determines those dates for 2001
through 2004.

MLKDates = nweekdate(3, 2, 2001:2004, 1);

MLKDays = datestr(MLKDates)

MLKDays

15-Jan-2001
21-Jan-2002
20-Jan-2003
19-Jan-2004
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Accounting for holidays and other nontrading days is important when
examining financial dates. The Financial Toolbox software provides the
holidays function, which contains holidays and special nontrading days for
the New York Stock Exchange between 1950 and 2030, inclusive. You can edit
the holidays.m file to customize it with your own holidays and nontrading
days. In this example, use it to determine the standard holidays in the last
half of 2000.

LHHDates = holidays('1-Jul-2000', '31-Dec-2000');

LHHDays datestr(LHHDates)

LHHDays

04-Jul-2000
04-Sep-2000
23-Nov-2000
25-Dec-2000

Now use the toolbox busdate function to determine the next business day
after these holidays.

LHNextDates = busdate(LHHDates);

LHNextDays datestr(LHNextDates)

LHNextDays

05-Jul-2000
05-Sep-2000
24-Nov-2000
26-Dec-2000

The toolbox also provides the cfdates function to determine cash-flow dates
for securities with periodic payments. This function accounts for the coupons
per year, the day-count basis, and the end-of-month rule. For example, to
determine the cash-flow dates for a security that pays four coupons per year
on the last day of the month, on an actual/365 day-count basis, just enter the
settlement date, the maturity date, and the parameters.

PayDates = cfdates('14-Mar-2000', '30-Nov-2001', 4, 3, 1);
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PayDays datestr(PayDates)

PayDays =

31-May-2000
31-Aug-2000
30-Nov-2000
28-Feb-2001
31-May-2001
31-Aug-2001
30-Nov-2001
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Formatting Currency

Financial Toolbox software provides several functions to format currency and
chart financial data. The currency formatting functions are

cur2frac Converts decimal currency values to
fractional values

cur2str Converts a value to Financial Toolbox bank
format

frac2cur Converts fractional currency values to

decimal values

These examples show their use.

Dec = frac2cur('12.1', 8)

returns Dec = 12.125, which is the decimal equivalent of 12-1/8. The second
input variable is the denominator of the fraction.

Str = cur2str(-8264, 2)

returns the string ($8264.00). For this toolbox function, the output format
1s a numerical format with dollar sign prefix, two decimal places, and
negative numbers in parentheses; for example, ($123.45) and $6789.01. The
standard MATLAB bank format uses two decimal places, no dollar sign, and a
minus sign for negative numbers; for example, -123.45 and 6789.01.
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Charting Financial Data

In this section...

“Introduction” on page 2-13

“High-Low-Close Chart Example” on page 2-14

“Bollinger Chart Example” on page 2-15

Introduction

The following toolbox financial charting functions plot financial data and
produce presentation-quality figures quickly and easily.

bolling Bollinger band chart

bollinger Time series Bollinger band

candle Candlestick chart

candle Time series candle plot

pointfig Point and figure chart

highlow High, low, open, close chart

highlow Time series High-Low plot

movavg Leading and lagging moving averages chart

These functions work with standard MATLAB functions that draw axes,
control appearance, and add labels and titles. The toolbox also provides a
comprehensive set of charting functions that work with financial time series
objects. For lists of these, see “Financial Data Charts” on page 13-6 and
“Financial Time Series Indicator” on page 13-22.

Here are two plotting examples: a high-low-close chart of sample IBM® stock
price data, and a Bollinger band chart of the same data. These examples load
data from an external file (ibm.dat), then call the functions using subsets of
the data. The MATLAB variable ibm , which is created by loading ibm.dat,
1s a six-column matrix where each row is a trading day’s data and where
columns 2, 3, and 4 contain the high, low, and closing prices, respectively.
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Note The data in ibm.dat is fictional and for illustrative use only.

High-Low-Close Chart Example

First load the data and set up matrix dimensions. load and size are standard
MATLAB functions.

load ibm.dat;
[ro, co] = size(ibm);

Open a figure window for the chart. Use the Financial Toolbox highlow
function to plot high, low, and close prices for the last 50 trading days in
the data file.

figure;
highlow(ibm(ro-50:ro0,2),ibm(ro-50:ro0,3),ibm(ro-50:ro0,4),[1,'b"');

Add labels and title, and set axes with standard MATLAB functions. Use the
Financial Toolbox dateaxis function to provide dates for the x-axis ticks.

xlabel('");

ylabel('Price ($)');

title('International Business Machines, 941231 - 950219');
axis([0 50 -inf inf]);

dateaxis('x',6,'31-Dec-1994")

MATLAB produces a figure like this. The plotted data and axes you see may
differ. Viewed online, the high-low-close bars are blue.
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Bollinger Chart Example

The bolling function in Financial Toolbox software produces a Bollinger
band chart using all the closing prices in the same IBM stock price matrix.
A Bollinger band chart plots actual data along with three other bands of
data. The upper band is two standard deviations above a moving average;
the lower band i1s two standard deviations below that moving average; and
the middle band is the moving average itself. This example uses a 15-day
moving average.

Assuming the previous IBM data is still loaded, execute the function.
bolling(ibm(:,4), 15, 0);

Specify the axes, labels, and titles. Again, use dateaxis to add the x-axis
dates.

axis([0 ro min(ibm(:,4)) max(ibm(:,4))1);
ylabel('Price ($)');
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title(['International Business Machines']);
dateaxis('x', 6,'31-Dec-1994"')

International Business Machines

1Mo

100 -

80+

Price ()

70+

60

a0+

| 1 1 1 1 1 1 1 1
12431 02419 04410 0530 07419 0907 1027 1216 0204 03525

For help using MATLAB plotting functions, see Creating Plots in the
MATLAB documentation. See the MATLAB documentation for details on the
axis, title, xlabel, and ylabel functions.
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Analyzing and Computing Cash Flows

In this section...

“Introduction” on page 2-17
“Interest Rates/Rates of Return” on page 2-17
“Present or Future Values” on page 2-18

“Depreciation” on page 2-19

“Annuities” on page 2-19

Introduction

Financial Toolbox cash-flow functions compute interest rates and rates of
return, present or future values, depreciation streams, and annuities.

Some examples in this section use this income stream: an initial investment
of $20,000 followed by three annual return payments, a second investment of
$5,000, then four more returns. Investments are negative cash flows, return
payments are positive cash flows.

Stream = [-20000, 2000, 2500, 3500, -5000, 6500,...
9500, 9500, 9500];

Interest Rates/Rates of Return

Several functions calculate interest rates involved with cash flows. To
compute the internal rate of return of the cash stream, execute the toolbox
function irr

ROR = irr(Stream)
which gives a rate of return of 11.72%.

Note that the internal rate of return of a cash flow may not have a unique
value. Every time the sign changes in a cash flow, the equation defining irr
can give up to two additional answers. An irr computation requires solving a
polynomial equation, and the number of real roots of such an equation can
depend on the number of sign changes in the coefficients. The equation for
internal rate of return is
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cfl cfz cf”

+ 2+...+—+ Investment = 0
(1+7r) (1+7r) (1+r)"

where Investment is a (negative) initial cash outlay at time 0, cf, is the cash
flow in the nth period, and n is the number of periods. Basically, irr finds
the rate r such that the net present value of the cash flow equals the initial
investment. If all of the cf, s are positive there is only one solution. Every
time there i1s a change of sign between coefficients, up to two additional
real roots are possible. There is usually only one answer that makes sense,
but it is possible to get returns of both 5% and 11% (for example) from one
income stream.

Another toolbox rate function, effrr, calculates the effective rate of return
given an annual interest rate (also known as nominal rate or annual
percentage rate, APR) and number of compounding periods per year. To find
the effective rate of a 9% APR compounded monthly, enter

Rate = effrr(0.09, 12)
The answer 1s 9.38%.

A companion function nomrr computes the nominal rate of return given the
effective annual rate and the number of compounding periods.

Present or Future Values

The toolbox includes functions to compute the present or future value of cash
flows at regular or irregular time intervals with equal or unequal payments:
fvfix, fvvar, pvfix, and pvvar. The -fix functions assume equal cash flows
at regular intervals, while the -var functions allow irregular cash flows at
irregular periods.

Now compute the net present value of the sample income stream for which
you computed the internal rate of return. This exercise also serves as a
check on that calculation because the net present value of a cash stream at
its internal rate of return should be zero. Enter

NPV = pvvar(Stream, ROR)
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which returns an answer very close to zero. The answer usually is not exactly
zero due to rounding errors and the computational precision of the computer.

Note Other toolbox functions behave similarly. The functions that compute
a bond’s yield, for example, often must solve a nonlinear equation. If you
then use that yield to compute the net present value of the bond’s income
stream, it usually does not exactly equal the purchase price, but the difference
is negligible for practical applications.

Depreciation

The toolbox includes functions to compute standard depreciation schedules:
straight line, general declining-balance, fixed declining-balance, and sum of
years’ digits. Functions also compute a complete amortization schedule for
an asset, and return the remaining depreciable value after a depreciation
schedule has been applied.

This example depreciates an automobile worth $15,000 over five years with
a salvage value of $1,500. It computes the general declining balance using
two different depreciation rates: 50% (or 1.5), and 100% (or 2.0, also known
as double declining balance). Enter

Decline1 = depgendb (15000, 1500, 5, 1.5)
Decline2 depgendb (15000, 1500, 5, 2.0)

which returns

Declinel =

4500.00 3150.00 2205.00 1543.50 2101.50
Decline2 =

6000.00 3600.00 2160.00 1296.00 444,00

These functions return the actual depreciation amount for the first four years
and the remaining depreciable value as the entry for the fifth year.

Annuities

Several toolbox functions deal with annuities. This first example shows
how to compute the interest rate associated with a series of loan payments
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when only the payment amounts and principal are known. For a loan whose
original value was $5000.00 and which was paid back monthly over four years
at $130.00/month

Rate = annurate(4*12, 130, 5000, O, 0)
The function returns a rate of 0.0094 monthly, or about 11.28% annually.

The next example uses a present-value function to show how to compute the
initial principal when the payment and rate are known. For a loan paid at
$300.00/month over four years at 11% annual interest

Principal = pvfix(0.11/12, 4*12, 300, 0, 0)
The function returns the original principal value of $11,607.43.

The final example computes an amortization schedule for a loan or annuity.
The original value was $5000.00 and was paid back over 12 months at an
annual rate of 9%.

[Prpmt, Intpmt, Balance, Payment] = ...
amortize(0.09/12, 12, 5000, 0, 0);

This function returns vectors containing the amount of principal paid,

Prpmt = [399.76 402.76 405.78 408.82 411.89 414.97
418.09 421.22 424.38 427.56 430.77 434.00]

the amount of interest paid,

Intpmt = [37.50 34.50 31.48 28.44 25.37 22.28
19.17 16.03 12.88 9.69 6.49 3.26]

the remaining balance for each period of the loan,

Balance = [4600.24 4197.49 3791.71 3382.89 2971.01
2556.03 2137.94 1716.72 1292.34 864.77
434.00 0.00]
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and a scalar for the monthly payment.

Payment = 437.26
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Pricing and Computing Yields for Fixed-Income Securities

In this section...

“Introduction” on page 2-22
“Terminology” on page 2-22
“Framework” on page 2-27

“Default Parameter Values” on page 2-28
“Coupon Date Calculations” on page 2-31
“Yield Conventions” on page 2-31
“Pricing Functions” on page 2-32

“Yield Functions” on page 2-32

“Fixed-Income Sensitivities” on page 2-33

Introduction

The Financial Toolbox product provides functions for computing accrued
interest, price, yield, convexity, and duration of fixed-income securities.
Various conventions exist for determining the details of these computations.
The Financial Toolbox software supports conventions specified by the
Securities Industry and Financial Markets Association (SIFMA), used in
the US markets, the International Capital Market Association (ICMA),
used mainly in the European markets, and the International Swaps and
Derivatives Association (ISDA). Note that for historical reasons, SIFMA is
referred to in Financial Toolbox documentation as SIA and ICMA is referred
to as International Securities Market Association (ISMA).

Terminology

Since terminology varies among texts on this subject, here are some basic
definitions that apply to these Financial Toolbox functions. The “Glossary”
on page Glossary-1 contains additional definitions.

The settlement date of a bond is the date when money first changes hands;
that is, when a buyer pays for a bond. It need not coincide with the issue date,
which is the date a bond is first offered for sale.
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The first coupon date and last coupon date are the dates when the first and
last coupons are paid, respectively. Although bonds typically pay periodic
annual or semiannual coupons, the length of the first and last coupon periods
may differ from the standard coupon period. The toolbox includes price and
yield functions that handle these odd first and/or last periods.

Successive quasi-coupon dates determine the length of the standard coupon
period for the fixed income security of interest, and do not necessarily coincide
with actual coupon payment dates. The toolbox includes functions that
calculate both actual and quasi-coupon dates for bonds with odd first and/or
last periods.

Fixed-income securities can be purchased on dates that do not coincide with
coupon payment dates. In this case, the bond owner is not entitled to the full
value of the coupon for that period. When a bond is purchased between coupon
dates, the buyer must compensate the seller for the pro-rata share of the
coupon interest earned from the previous coupon payment date. This pro-rata
share of the coupon payment is called accrued interest. The purchase price, the
price actually paid for a bond, is the quoted market price plus accrued interest.

The maturity date of a bond is the date when the issuer returns the final
face value, also known as the redemption value or par value, to the buyer.
The yield-to-maturity of a bond i1s the nominal compound rate of return that
equates the present value of all future cash flows (coupons and principal) to
the current market price of the bond.

The period of a bond refers to the frequency with which the issuer of a bond
makes coupon payments to the holder.

Period of a Bond

Period Value Payment Schedule

0 No coupons (Zero coupon bond)
1 Annual

2 Semiannual

3 Tri-annual

4 Quarterly
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Period of a Bond (Continued)

Period Value Payment Schedule
6 Bi-monthly
12 Monthly

The basis of a bond refers to the basis or day-count convention for a bond.
Basis is normally expressed as a fraction in which the numerator determines
the number of days between two dates, and the denominator determines the
number of days in the year. For example, the numerator of actual/actual
means that when determining the number of days between two dates, count
the actual number of days; the denominator means that you use the actual
number of days in the given year in any calculations (either 365 or 366 days
depending on whether the given year is a leap year).

The day count convention determines how accrued interest is calculated and
determines how cash flows for the bond are discounted, thereby effecting
price and yield calculations. Furthermore, the SIA convention is to use the
actual/actual day count convention for discounting cash flows in all cases.

Basis of a Bond

Basis Value Meaning Description

0 (default) actual/actual Actual days held over
actual days in coupon
period. Denominator is
365 in most years and
366 in a leap year.

1 30/360 (SIA) Each month contains
30 days; a year contains
360 days. Payments
are adjusted for bonds
that pay coupons on the
last day of February.
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Basis of a Bond (Continued)

Basis Value

Meaning

Description

2

actual/360

Actual days held over
360.

actual/365

Actual days held over
365, even in leap years.

30/360 PSA (Public
Securities Association)

Each month contains
30 days; a year contains
360 days. If the last
date of the period is the
last day of February,
the month is extended
to 30 days.

30/360 ISDA
(International Swap
Dealers Association)

Variant of 30/360 with
slight differences for
calculating number of
days in a month.

30/360 European

Variant of 30/360 used
primarily in Europe.

actual/365 Japanese

All years contain 365
days. Leap days are
ignored.

actual/actual (ISMA)

Actual days held over
actual days in coupon
period. Denominator
1s 365 in most years
and 366 in a leap year.
This basis assumes an
annual compounding
period.

actual/360 (ISMA)

Actual days held

over 360. This basis
assumes an annual
compounding period.
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Basis of a Bond (Continued)

Basis Value

Meaning

Description

10

actual/365 (ISMA)

Actual days held over
365, even in leap years.
This basis assumes an
annual compounding
period.

11

30/360E (ISMA)

The number of days in
every month is set to 30.
If the start date or the
end date of the period
is the 31st of a month,
that date is set to the
30th. The number of
days in a year is 360.

12

actual/365 (ISDA)

This day count fraction
1s equal to the sum

of number of interest
accrual days falling
with a leap year divided
by 366 and the number
of interest accrual days
not falling within a leap
year divided by 365.

Note Although the concept of day count sounds deceptively simple, the
actual calculation of day counts can be quite complex. You can find a good
discussion of day counts and the formulas for calculating them in Chapter 5
of Stigum and Robinson, Money Market and Bond Calculations in Appendix

A, “Bibliography”.

The end-of-month rule affects a bond’s coupon payment structure. When
the rule is in effect, a security that pays a coupon on the last actual day of
a month will always pay coupons on the last day of the month. This means,
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for example, that a semiannual bond that pays a coupon on February 28 in
nonleap years will pay coupons on August 31 in all years and on February
29 in leap years.

End-of-Month Rule

End-of-Month Rule Value Meaning

1 (default) Rule in effect.

0 Rule not in effect.
Framework

Although not all Financial Toolbox functions require the same input
arguments, they all accept the following common set of input arguments.

Common Input Arguments

Input Meaning

Settle Settlement date

Maturity Maturity date

Period Coupon payment period
Basis Day-count basis
EndMonthRule End-of-month payment rule
IssueDate Bond issue date
FirstCouponDate First coupon payment date
LastCouponDate Last coupon payment date

Of the common input arguments, only Settle and Maturity are required.
All others are optional. They will be set to the default values if you do

not explicitly set them. Note that, by default, the FirstCouponDate and
LastCouponDate are nonapplicable. In other words, if you do not specify
FirstCouponDate and LastCouponDate, the bond is assumed to have no odd
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first or last coupon periods. In this case, the bond is a standard bond with a
coupon payment structure based solely on the maturity date.

Default Parameter Values

To illustrate the use of default values in Financial Toolbox functions, consider
the cfdates function, which computes actual cash flow payment dates for a
portfolio of fixed income securities regardless of whether the first and/or last
coupon periods are normal, long, or short.

The complete calling syntax with the full input argument list is

CFlowDates = cfdates(Settle, Maturity, Period, Basis,
EndMonthRule, IssueDate, FirstCouponDate, LastCouponDate)

while the minimal calling syntax requires only settlement and maturity dates

CFlowDates = cfdates(Settle, Maturity)

Single Bond Example

As an example, suppose you have a bond with these characteristics

Settle = '20-Sep-1999'
Maturity = '15-0ct-2007'
Period =2

Basis =0
EndMonthRule =1

IssueDate = NaN
FirstCouponDate = NaN
LastCouponDate = NaN

Note that Period, Basis, and EndMonthRule are set to their default values,
and IssueDate, FirstCouponDate, and LastCouponDate are set to NaN.

Formally, a NaN is an IEEE® arithmetic standard for Not-a-Number and

is used to indicate the result of an undefined operation (for example, zero
divided by zero). However, NaN is also a very convenient placeholder. In the
SIA functions of Financial Toolbox software, NaN indicates the presence of a
nonapplicable value. It tells the Financial Toolbox functions to ignore the
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input value and apply the default. Setting IssueDate, FirstCouponDate, and
LastCouponDate to NaN in this example tells cfdates to assume that the
bond has been issued before settlement and that no odd first or last coupon
periods exist.

Having set these values, all these calls to cfdates produce the same result.

cfdates
cfdates
cfdates

Settle, Maturity)
Settle, Maturity, Period)
Settle, Maturity, Period, [])

cfdates(Settle, Maturity, [], Basis)

cfdates(Settle, Maturity, [], [])

cfdates(Settle, Maturity, Period, [], EndMonthRule)
cfdates(Settle, Maturity, Period, [], NaN)

cfdates(Settle, Maturity, Period, [], [], IssueDate)
cfdates(Settle, Maturity, Period, [], [], IssueDate, [], [])

P

cfdates(Settle, Maturity, Period, []1, [], [], [],LastCouponDate)
cfdates(Settle, Maturity, Period, Basis, EndMonthRule,
IssueDate, FirstCouponDate, LastCouponDate)

Thus, leaving a particular input unspecified has the same effect as passing
an empty matrix ([ ]) or passing a NaN — all three tell cfdates (and other
Financial Toolbox functions) to use the default value for a particular input
parameter.

Bond Portfolio Example

Since the previous example included only a single bond, there was no
difference between passing an empty matrix or passing a NaN for an optional
input argument. For a portfolio of bonds, however, using NaN as a placeholder
is the only way to specify default acceptance for some bonds while explicitly
setting nondefault values for the remaining bonds in the portfolio.

Now suppose you have a portfolio of two bonds.

Settle
Maturity

'20-Sep-1999"
['15-0ct-2007'; '15-0ct-2010"']

These calls to cfdates all set the coupon period to its default value
(Period = 2) for both bonds.
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cfdates(Settle, Maturity, 2)
cfdates(Settle, Maturity, [2 2])
cfdates(Settle, Maturity, [])
cfdates(Settle, Maturity, NaN)
cfdates(Settle, Maturity, [NaN NaN])
cfdates(Settle, Maturity)

The first two calls explicitly set Period = 2. Since Maturity is a 2-by-1 vector
of maturity dates, cfdates knows you have a two-bond portfolio.

The first call specifies a single (that is, scalar) 2 for Period. Passing a scalar
tells cfdates to apply the scalar-valued input to all bonds in the portfolio.
This is an example of implicit scalar-expansion. Note that the settlement date
has been implicit scalar-expanded as well.

The second call also applies the default coupon period by explicitly passing
a two-element vector of 2’s. The third call passes an empty matrix, which
cfdates interprets as an invalid period, for which the default value will be
used. The fourth call is similar, except that a NaN has been passed. The fifth
call passes two NaN’s, and has the same effect as the third. The last call
passes the minimal input set.

Finally, consider the following calls to cfdates for the same two-bond
portfolio.

cfdates(Settle, Maturity, [4 NaN])
cfdates(Settle, Maturity, [4 2])

The first call explicitly sets Period = 4 for the first bond and implicitly sets
the default Period = 2 for the second bond. The second call has the same
effect as the first but explicitly sets the periodicity for both bonds.

The optional input Period has been used for illustrative purpose only. The
default-handling process illustrated in the examples applies to any of the
optional input arguments.
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Coupon Date Calculations

Calculating coupon dates, either actual or quasi dates, is notoriously
complicated. Financial Toolbox software follows the SIA conventions in
coupon date calculations.

The first step in finding the coupon dates associated with a bond is to
determine the reference, or synchronization date (the sync date). Within the
SIA framework, the order of precedence for determining the sync date is:

1 The first coupon date
2 The last coupon date

3 The maturity date

In other words, a Financial Toolbox function first examines the
FirstCouponDate input. If FirstCouponDate is specified, coupon
payment dates and quasi-coupon dates are computed with respect to
FirstCouponDate; if FirstCouponDate is unspecified, empty ([ ]), or NaN,
then the LastCouponDate is examined. If LastCouponDate is specified,
coupon payment dates and quasi-coupon dates are computed with respect
to LastCouponDate. If both FirstCouponDate and LastCouponDate are
unspecified, empty ([ 1), or NaN, the Maturity (a required input argument)
serves as the sync date.

Yield Conventions

There are two yield and time factor conventions that are used in the Financial
Toolbox software — these are determined by the input basis. Specifically,
bases 0 to 7 are assumed to have semiannual compounding, while bases 8

to 12 are assumed to have annual compounding regardless of the period of
the bond’s coupon payments (including zero-coupon bonds). In addition, any
yield-related sensitivity (that is, duration and convexity), when quoted on

a periodic basis, follows this same convention. (See bndconvp, bndconvy,
bnddurp, bnddury, and bndkrdur.)
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Pricing Functions

This example shows how easily you can compute the price of a bond with an
odd first period using the function bndprice. Assume you have a bond with
these characteristics:

Settle = '"11-Nov-1992"';
Maturity = '01-Mar-2005";
IssueDate = '15-0ct-1992';
FirstCouponDate = 'O1-Mar-1993';
CouponRate = 0.0785;
Yield = 0.0625;

Allow coupon payment period (Period = 2), day-count basis (Basis = 0), and
end-of-month rule (EndMonthRule = 1) to assume the default values. Also,
assume there is no odd last coupon date and that the face value of the bond is
$100. Calling the function

[Price, AccruedInt] = bndprice(Yield, CouponRate, Settle,
Maturity, []1, [], [], IssueDate, FirstCouponDate)

returns a price of $113.60 and accrued interest of $0.59.
Similar functions compute prices with regular payments, odd first and

last periods, and prices of Treasury bills and discounted securities such as
zero-coupon bonds.

Note bndprice and other functions use nonlinear formulas to compute the
price of a security. For this reason, Financial Toolbox software uses Newton’s
method when solving for an independent variable within a formula. See any
elementary numerical methods textbook for the mathematics underlying
Newton’s method.

Yield Functions

To illustrate toolbox yield functions, compute the yield of a bond that has odd
first and last periods and settlement in the first period. First set up variables
for settlement, maturity date, issue, first coupon, and a last coupon date.

Settle = '"12-dan-2000"';
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Maturity = '01-0ct-2001";
IssueDate = '01-dan-2000"';
FirstCouponDate = '15-Jan-2000"';
LastCouponDate = '15-Apr-2000';

Assume a face value of $100. Specify a purchase price of $95.70, a coupon
rate of 4%, quarterly coupon payments, and a 30/360 day-count convention
(Basis = 1).

Price = 95.7;
CouponRate = 0.04;
Period = 4;
Basis =1;
EndMonthRule = 1;

Calling the function

Yield = bndyield(Price, CouponRate, Settle, Maturity, Period,...
Basis, EndMonthRule, IssueDate, FirstCouponDate, LastCouponDate)

returns

Yield = 0.0659 (6.60%).

Fixed-Income Sensitivities

Financial Toolbox software supports the following options for managing
interest-rate risk for one or more bonds:

® bnddurp and bnddury support duration and convexity analysis based on
market quotes and assume parallel shifts in the bond yield curve.

® bndkrdur supports key rate duration based on a market yield curve and
can model nonparallel shifts in the bond yield curve.

Calculating Duration and Convexity for Bonds

The toolbox includes functions to perform sensitivity analysis such as
convexity and the Macaulay and modified durations for fixed-income
securities. The Macaulay duration of an income stream, such as a coupon
bond, measures how long, on average, the owner waits before receiving a
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payment. It is the weighted average of the times payments are made, with the
weights at time T equal to the present value of the money received at time T.
The modified duration is the Macaulay duration discounted by the per-period
interest rate; that is, divided by (1+rate/frequency).

To illustrate, the following example computes the annualized Macaulay and
modified durations, and the periodic Macaulay duration for a bond with
settlement (12-Jan-2000) and maturity (01-Oct-2001) dates as above, a 5%
coupon rate, and a 4.5% yield to maturity. For simplicity, any optional
input arguments assume default values (that is, semiannual coupons, and
day-count basis = 0 (actual/actual), coupon payment structure synchronized
to the maturity date, and end-of-month payment rule in effect).

CouponRate = 0.05;
Yield = 0.045;

[ModDuration, YearDuration, PerDuration] = bnddury(Yield,...
CouponRate, Settle, Maturity)

The durations are

ModDuration = 1.6107 (years)
YearDuration = 1.6470 (years)
PerDuration 3.2940 (semiannual periods)

Note that the semiannual periodic Macaulay duration (PerDuration) is twice
the annualized Macaulay duration (YearDuration).

Calculating Key Rate Durations for Bonds

Key rate duration enables you to evaluate the sensitivity and price of a
bond to nonparallel changes in the spot or zero curve by decomposing the
interest rate risk along the spot or zero curve. Key rate duration refers to
the process of choosing a set of key rates and computing a duration for each
rate. Specifically, for each key rate, while the other rates are held constant,
the key rate is shifted up and down (and intermediate cash flow dates are
interpolated), and then the present value of the security given the shifted
curves is computed.

The calculation of bndkrdur supports:



Pricing and Computing Yields for Fixed-lncome Securities

(PV_down - PV_up)
(PV x ShiftValue x 2)

Where PV is the current value of the instrument, PV_up and PV_down are
the new values after the discount curve has been shocked, and ShiftValue is
the change in interest rate. For example, if key rates of 3 months, 1, 2, 3,
5, 7, 10, 15, 20, 25, 30 years were chosen, then a 30-year bond might have
corresponding key rate durations of:

krdur_i =

3M 1Y 2Y 3Y 5Y 7Y 10Y 15Y 20Y 25Y 30Y
.01 .04 .09 21 4 .65 1.27 1.71 1.68 1.83 7.03

The key rate durations add up to approximately equal the duration of the
bond.

For example, compute the key rate duration of the U.S. Treasury Bond with
maturity date of August 15, 2028 and coupon rate of 5.5%. (For further
information on this bond, refer to .)

Settle = datenum('18-Nov-2008');
CouponRate = 5.500/100;

Maturity = datenum('15-Aug-2028');
Price = 114.83;

For the ZeroData information on the current spot curve for this bond, refer to :

ZeroDates = daysadd(Settle ,[30 90 180 360 360*2 360*3 360*5 ...
360*7 360*10 360*20 360*30]) ;
ZeroRates = ([0.06 0.12 0.81 1.08 1.22 1.53 2.32 2.92 3.68 4.42 4.20]/100)';

Compute the key rate duration for a specific set of rates (choose this based on
the maturities of the available hedging instruments):

krd = bndkrdur([ZeroDates ZeroRates],CouponRate,Settle,Maturity, 'keyrates',[2 5 10 20])

krd

0.2865 0.8729 2.6451 8.5778

Note, the sum of the key rate durations approximately equals the duration
of the bond:
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[sum(krd) bnddurp(Price,CouponRate,Settle,Maturity)]
ans =

12.3823 12.3919
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Term Structure of Interest Rates

In this section...

“Introduction” on page 2-37

“Deriving an Implied Zero Curve” on page 2-38

Introduction

The Financial Toolbox product contains several functions to derive and
analyze interest rate curves, including data conversion and extrapolation,
bootstrapping, and interest-rate curve conversion functions.

One of the first problems in analyzing the term structure of interest rates is
dealing with market data reported in different formats. Treasury bills, for
example, are quoted with bid and asked bank-discount rates. Treasury notes
and bonds, on the other hand, are quoted with bid and asked prices based

on $100 face value. To examine the full spectrum of Treasury securities,
analysts must convert data to a single format. Financial Toolbox functions
ease this conversion. This brief example uses only one security each; analysts
often use 30, 100, or more of each.

First, capture Treasury bill quotes in their reported format

% Maturity Days Bid Ask AskYield
TBill = [datenum('12/26/2000') 53 0.0503 0.0499 0.0510];

then capture Treasury bond quotes in their reported format

% Coupon Maturity Bid Ask AskYield
TBond = [0.08875 datenum(2001,11,5) 103+4/32 103+6/32 0.0564];

and note that these quotes are based on a November 3, 2000 settlement date.

Settle = datenum('3-Nov-2000"');

Next use the toolbox tb12bond function to convert the Treasury bill data to
Treasury bond format.

TBTBond = tbl2bond(TBill)
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TBTBond =
0 730846 99.26 99.27 0.05

(The second element of TBTBond is the serial date number for December 26,
2000.)

Now combine short-term (Treasury bill) with long-term (Treasury bond) data
to set up the overall term structure.

TBondsAll = [TBTBond; TBond]

TBondsAll

0 730846 99.26 99.27 0.05
0.09 731160 103.13 103.19 0.06

The Financial Toolbox software provides a second data-preparation
function,tr2bonds, to convert the bond data into a form ready for the
bootstrapping functions. tr2bonds generates a matrix of bond information
sorted by maturity date, plus vectors of prices and yields.

[Bonds, Prices, Yields] = tr2bonds(TBondsAll);

Deriving an Implied Zero Curve

Using this market data, you can use one of the Financial Toolbox
bootstrapping functions to derive an implied zero curve. Bootstrapping is a
process whereby you begin with known data points and solve for unknown
data points using an underlying arbitrage theory. Every coupon bond can
be valued as a package of zero-coupon bonds which mimic its cash flow and
risk characteristics. By mapping yields-to-maturity for each theoretical
zero-coupon bond, to the dates spanning the investment horizon, you can
create a theoretical zero-rate curve. The Financial Toolbox software provides
two bootstrapping functions: zbtprice derives a zero curve from bond data
and prices, and zbtyield derives a zero curve from bond data and yields.
Using zbtprice

[ZeroRates, CurveDates] = zbtprice(Bonds, Prices, Settle)

ZeroRates =
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CurveDates =

730846
731160

CurveDates gives the investment horizon.
datestr(CurveDates)
ans =

26-Dec-2000
05-Nov-2001

Additional Financial Toolbox functions construct discount, forward, and par
yield curves from the zero curve, and vice versa.

[DiscRates, CurveDates] = zero2disc(ZeroRates, CurveDates,...
Settle);

[FwdRates, CurveDates] = zero2fwd(ZeroRates, CurveDates, Settle);
[PYldRates, CurveDates] = zero2pyld(ZeroRates, CurveDates,...
Settle);
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Pricing and Analyzing Equity Derivatives

In this section...

“Introduction” on page 2-40
“Sensitivity Measures” on page 2-40

“Analysis Models” on page 2-41

Introduction

These toolbox functions compute prices, sensitivities, and profits for portfolios
of options or other equity derivatives. They use the Black-Scholes model

for European options and the binomial model for American options. Such
measures are useful for managing portfolios and for executing collars, hedges,
and straddles.

Sensitivity Measures

There are six basic sensitivity measures associated with option pricing: delta,
gamma, lambda, rho, theta, and vega — the “greeks.” The toolbox provides
functions for calculating each sensitivity and for implied volatility.

Delta

Delta of a derivative security is the rate of change of its price relative to the
price of the underlying asset. It is the first derivative of the curve that relates
the price of the derivative to the price of the underlying security. When delta
is large, the price of the derivative is sensitive to small changes in the price
of the underlying security.

Gamma

Gamma of a derivative security is the rate of change of delta relative to the
price of the underlying asset; that is, the second derivative of the option price
relative to the security price. When gamma is small, the change in delta is
small. This sensitivity measure is important for deciding how much to adjust
a hedge position.
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Lambda

Lambda, also known as the elasticity of an option, represents the percentage
change in the price of an option relative to a 1% change in the price of the
underlying security.

Rho

Rho is the rate of change in option price relative to the risk-free interest rate.

Theta

Theta is the rate of change in the price of a derivative security relative to
time. Theta is usually very small or negative since the value of an option
tends to drop as it approaches maturity.

Vega

Vega is the rate of change in the price of a derivative security relative to

the volatility of the underlying security. When vega is large the security is
sensitive to small changes in volatility. For example, options traders often
must decide whether to buy an option to hedge against vega or gamma. The
hedge selected usually depends upon how frequently one rebalances a hedge
position and also upon the standard deviation of the price of the underlying
asset (the volatility). If the standard deviation is changing rapidly, balancing
against vega is usually preferable.

Implied Volatility

The implied volatility of an option is the standard deviation that makes an
option price equal to the market price. It helps determine a market estimate
for the future volatility of a stock and provides the input volatility (when
needed) to the other Black-Scholes functions.

Analysis Models

Toolbox functions for analyzing equity derivatives use the Black-Scholes
model for European options and the binomial model for American options.
The Black-Scholes model makes several assumptions about the underlying
securities and their behavior. The binomial model, on the other hand, makes
far fewer assumptions about the processes underlying an option. For further
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explanation, see Options, Futures, and Other Derivatives by John Hull in
Appendix A, “Bibliography”.

Black-Scholes Model

Using the Black-Scholes model entails several assumptions:

® The prices of the underlying asset follow an Ito process. (See Hull, page
222.)

® The option can be exercised only on its expiration date (European option).

¢ Short selling is permitted.

® There are no transaction costs.

o All securities are divisible.

® There is no riskless arbitrage.

® Trading is a continuous process.

¢ The risk-free interest rate is constant and remains the same for all

maturities.

If any of these assumptions is untrue, Black-Scholes may not be an
appropriate model.

To illustrate toolbox Black-Scholes functions, this example computes the

call and put prices of a European option and its delta, gamma, lambda, and
implied volatility. The asset price is $100.00, the exercise price is $95.00, the
risk-free interest rate is 10%, the time to maturity is 0.25 years, the volatility
is 0.50, and the dividend rate is 0. Simply executing the toolbox functions

[OptCall, OptPut] blsprice(100, 95, 0.10, 0.25, 0.50, 0);
[CallVal, PutVal] blsdelta(100, 95, 0.10, 0.25, 0.50, 0);
GammaVal = blsgamma(100, 95, 0.10, 0.25, 0.50, 0);

VegavVal = blsvega(100, 95, 0.10, 0.25, 0.50, 0);

[LamCall, LamPut] = blslambda(100, 95, 0.10, 0.25, 0.50, 0);

yields:

® The option call price OptCall = $13.70
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The option put price OptPut = $6.35
delta for a call CallvVal = 0.6665 and delta for a put PutVal = -0.3335

® gamma GammaVal = 0.0145
® vega VegaVal = 18.1843
lambda for a call LamCall = 4.8664 and lambda for a put LamPut = -5.2528

Now as a computation check, find the implied volatility of the option using
the call option price from blsprice.

Volatility = blsimpv(100, 95, 0.10, 0.25, OptCall);

The function returns an implied volatility of 0.500, the original blsprice
input.

Binomial Model

The binomial model for pricing options or other equity derivatives assumes
that the probability over time of each possible price follows a binomial
distribution. The basic assumption is that prices can move to only two values,
one up and one down, over any short time period. Plotting the two values,
and then the subsequent two values each, and then the subsequent two
values each, and so on over time, is known as “building a binomial tree.” This
model applies to American options, which can be exercised any time up to
and including their expiration date.

This example prices an American call option using a binomial model. Again,
the asset price is $100.00, the exercise price is $95.00, the risk-free interest
rate is 10%, and the time to maturity is 0.25 years. It computes the tree in
increments of 0.05 years, so there are 0.25/0.05 = 5 periods in the example.
The volatility is 0.50, this is a call (flag = 1), the dividend rate is 0, and it
pays a dividend of $5.00 after three periods (an ex-dividend date). Executing
the toolbox function

[StockPrice, OptionPrice] = binprice(100, 95, 0.10, 0.25,...
0.05, 0.50, 1, 0, 5.0, 3);

returns the tree of prices of the underlying asset

StockPrice =
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100.00 111.27 123.87 137.96 148.69 166.28
0 89.97 100.05 111.32 118.90 132.96
0 0 81.00 90.02 95.07 106.32
0 0 0 72.98 76.02 85.02
0 0 0 0 60.79 67.98
0 0 0 0 0 54.36

and the tree of option values.

OptionPrice =

12.10 19.17 29.35 42.96 54.17 71.28
0 5.31 9.41 16.32 24.37 37.96
0 0 1.35 2.74 5.57 11.32
0 0 0 0 0 0
0 0 0 0 0 0
0 0 0 0 0 0

The output from the binomial function is a binary tree. Read the StockPrice
matrix this way: column 1 shows the price for period 0, column 2 shows the
up and down prices for period 1, column 3 shows the up-up, up-down, and
down-down prices for period 2, and so on. Ignore the zeros. The OptionPrice
matrix gives the associated option value for each node in the price tree. Ignore
the zeros that correspond to a zero in the price tree.
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¢ “Analyzing Portfolios” on page 3-2

® “Portfolio Optimization Functions” on page 3-3

¢ “Portfolio Construction Examples” on page 3-5

e “Portfolio Selection and Risk Aversion” on page 3-8
¢ “Constraint Specification” on page 3-12

e “Active Returns and Tracking Error Efficient Frontier” on page 3-20
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Analyzing Porifolios

3-2

Portfolio managers concentrate their efforts on achieving the best possible
trade-off between risk and return. For portfolios constructed from a fixed
set of assets, the risk/return profile varies with the portfolio composition.
Portfolios that maximize the return, given the risk, or, conversely, minimize
the risk for the given return, are called optimal. Optimal portfolios define a
line in the risk/return plane called the efficient frontier.

A portfolio may also have to meet additional requirements to be considered.
Different investors have different levels of risk tolerance. Selecting the
adequate portfolio for a particular investor is a difficult process. The portfolio
manager can hedge the risk related to a particular portfolio along the efficient
frontier with partial investment in risk-free assets. The definition of the
capital allocation line, and finding where the final portfolio falls on this line, if
at all, is a function of:

® The risk/return profile of each asset

¢ The risk-free rate

® The borrowing rate

® The degree of risk aversion characterizing an investor

Financial Toolbox software includes a set of portfolio optimization functions
designed to find the portfolio that best meets investor requirements.
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Porifolio Optimization Functions

The portfolio optimization functions assist portfolio managers in constructing
portfolios that optimize risk and return.

Capital

Allocation Description

portalloc Computes the optimal risky portfolio on the efficient
frontier, based on the risk-free rate, the borrowing rate,
and the investor’s degree of risk aversion. Also generates
the capital allocation line, which provides the optimal
allocation of funds between the risky portfolio and the
risk-free asset.

Efficient

Frontier

Computation | Description

frontcon Computes portfolios along the efficient frontier for a
given group of assets. The computation is based on sets
of constraints representing the maximum and minimum
weights for each asset, and the maximum and minimum
total weight for specified groups of assets.

frontier Computes portfolios along the efficient frontier for a
given group of assets. Generates a surface of efficient
frontiers showing how asset allocation influences risk
and return over time.

portopt Computes portfolios along the efficient frontier for a
given group of assets. The computation is based on

a set of user-specified linear constraints. Typically,

these constraints are generated using the constraint
specification functions described below.
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Constraint
Specification

Description

portcons

Generates the portfolio constraints matrix for a portfolio
of asset investments using linear inequalities. The
inequalities are of the type A*Wts' <= b, where Wts is a
row vector of weights.

portvrisk

Portfolio value at risk (VaR) returns the maximum
potential loss in the value of a portfolio over one period of
time, given the loss probability level RiskThreshold.

pcalims

Asset minimum and maximum allocation. Generates a
constraint set to fix the minimum and maximum weight
for each individual asset.

pcgcomp

Group-to-group ratio constraint. Generates a constraint
set specifying the maximum and minimum ratios
between pairs of groups.

pcglims

Asset group minimum and maximum allocation.
Generates a constraint set to fix the minimum and
maximum total weight for each defined group of assets.

pcpval

Total portfolio value. Generates a constraint set to fix the
total value of the portfolio.

Constraint
Conversion

Description

abs2active

Transforms a constraint matrix expressed in absolute
weight format to an equivalent matrix expressed in active
weight format.

active2abs

Transforms a constraint matrix expressed in active
weight format to an equivalent matrix expressed in
absolute weight format.
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Porifolio Construction Examples

In this section...

“Introduction” on page 3-5

“Efficient Frontier Example” on page 3-5

Introduction

The efficient frontier computation functions require information about each
asset in the portfolio. This data is entered into the function via two matrices:
an expected return vector and a covariance matrix. The expected return
vector contains the average expected return for each asset in the portfolio.
The covariance matrix is a square matrix representing the interrelationships
between pairs of assets. This information can be directly specified or can be
estimated from an asset return time series with the function ewstats.

Efficient Frontier Example

This example computes the efficient frontier of portfolios consisting of three
different assets using the function frontcon. To visualize the efficient frontier
curve clearly, consider 10 different evenly spaced portfolios.

Assume that the expected return of the first asset is 10%, the second is 20%,
and the third is 15%. The covariance is defined in the matrix ExpCovariance.

ExpReturn = [0.1 0.2 0.15];

ExpCovariance = [ 0.005 -0.010 0.004;
-0.010 0.040 -0.002;
0.004 -0.002 0.023];

NumPorts = 10;

Since there are no constraints, you can call frontcon directly with the
data you already have. If you call frontcon without specifying any output
arguments, you get a graph representing the efficient frontier curve.

frontcon (ExpReturn, ExpCovariance, NumPorts);
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Calling frontcon while specifying the output arguments returns the
corresponding vectors and arrays representing the risk, return, and weights
for each of the 10 points computed along the efficient frontier.

[PortRisk, PortReturn, PortWts] = frontcon(ExpReturn,...
ExpCovariance, NumPorts)

PortRisk =

0.0392
.0445
.0559
.0701
.0858
.1023
.1192
.1383
.1661
.2000

O O0OO0OO0OO0OO0OO0OO0oOOo

PortReturn =
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0.1231
0.1316
0.1402
0.1487
0.1573
0.1658
0.1744
0.1829
0.1915
0.2000
PortWts =
0.7692 0.2308 0.0000
0.6667 0.2991 0.0342
0.5443 0.3478 0.1079
0.4220 0.3964 0.1816
0.2997 0.4450 0.2553
0.1774 0.4936 0.3290
0.0550 0.5422 0.4027
0 0.6581 0.3419
0 0.8291 0.1709
0 1.0000 0.0000

The output data is represented row-wise. Each portfolio’s risk, rate of return,
and associated weights are identified as corresponding rows in the vectors
and matrix.

For example, you can see from these results that the second portfolio has a

risk of 0.0445, an expected return of 13.16%, and allocations of about 67% in
the first asset, 30% in the second, and 3% in the third.

3-7



3 Portfolio Analysis

Portfolio Selection and Risk Aversion

In this section...

“Introduction” on page 3-8

“Optimal Risky Portfolio Example” on page 3-9

Introduction

One of the factors to consider when selecting the optimal portfolio for a
particular investor is degree of risk aversion. This level of aversion to risk
can be characterized by defining the investor’s indifference curve. This curve
consists of the family of risk/return pairs defining the trade-off between

the expected return and the risk. It establishes the increment in return

that a particular investor will require in order to make an increment in risk
worthwhile. Typical risk aversion coefficients range between 2.0 and 4.0, with
the higher number representing lesser tolerance to risk. The equation used to
represent risk aversion in Financial Toolbox software is

U= E(r) - 0.005*A*sig"2
where:
U is the utility value.
E(r) 1is the expected return.
A is the index of investor’s aversion.

sig is the standard deviation.
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Optimal Risky Porifolio Example

This example computes the optimal risky portfolio on the efficient frontier
based upon the risk-free rate, the borrowing rate, and the investor’s degree of
risk aversion. You do this with the function portalloc.

First generate the efficient frontier data using either portopt or frontcon.
This example uses portopt and the same asset data from the previous
example.

ExpReturn = [0.1 0.2 0.15];

ExpCovariance = [ 0.005 -0.010 0.004;
-0.010 0.040 -0.002;
0.004 -0.002 0.023];

This time consider 20 different points along the efficient frontier.

NumPorts = 20;
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[PortRisk, PortReturn, PortWts] = portopt(ExpReturn,...
ExpCovariance, NumPorts);

As with frontcon, calling portopt while specifying output arguments returns
the corresponding vectors and arrays representing the risk, return, and
weights for each of the portfolios along the efficient frontier. Use them as the
first three input arguments to the function portalloc.

Now find the optimal risky portfolio and the optimal allocation of funds
between the risky portfolio and the risk-free asset, using these values for the
risk-free rate, borrowing rate and investor’s degree of risk aversion.

RisklessRate = 0.08
BorrowRate = 0.12
RiskAversion = 3

Calling portalloc without specifying any output arguments gives a graph
displaying the critical points.

portalloc (PortRisk, PortReturn, PortWts, RisklessRate,...
BorrowRate, RiskAversion);
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Calling portalloc while specifying the output arguments returns the
variance (RiskyRisk), the expected return (RiskyReturn), and the weights
(RiskyWts) allocated to the optimal risky portfolio. It also returns the fraction
(RiskyFraction) of the complete portfolio allocated to the risky portfolio,
and the variance (OverallRisk) and expected return (OverallReturn) of the
optimal overall portfolio. The overall portfolio combines investments in the
risk-free asset and in the risky portfolio. The actual proportion assigned to
each of these two investments is determined by the degree of risk aversion
characterizing the investor.

[RiskyRisk, RiskyReturn, RiskyWts,RiskyFraction, OverallRisk,...
OverallReturn] = portalloc (PortRisk, PortReturn, PortWts,...
RisklessRate, BorrowRate, RiskAversion)

RiskyRisk = 0.1288
RiskyReturn = 0.1791
RiskyWts = 0.0057 0.5879 0.4064
RiskyFraction = 1.1869
OverallRisk = 0.1529

= 0.1902

OverallReturn

The value of RiskyFraction exceeds 1 (100%), implying that the risk
tolerance specified allows borrowing money to invest in the risky portfolio, and
that no money will be invested in the risk-free asset. This borrowed capital is
added to the original capital available for investment. In this example the
customer will tolerate borrowing 18.69% of the original capital amount.
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Constraint Specification
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In this section...

“Example” on page 3-12
“Linear Constraint Equations” on page 3-14

“Specifying Additional Constraints” on page 3-17

Example

This example computes the efficient frontier of portfolios consisting of three
different assets, INTC, XON, and RD, given a list of constraints. The expected
returns for INTC, XON, and RD are respectively as follows:

ExpReturn = [0.1 0.2 0.15];

The covariance matrix is

ExpCovariance = [ 0.005 -0.010 0.004;
-0.010 0.040 -0.002;
0.004 -0.002 0.023];

e Constraint 1

= Allow short selling up to 10% of the portfolio value in any asset, but limit
the investment in any one asset to 110% of the portfolio value.

® Constraint 2

= Consider two different sectors, technology and energy, with the following
table indicating the sector each asset belongs to.

Asset INTC XON RD
Sector Technology Energy Energy

Constrain the investment in the Energy sector to 80% of the portfolio
value, and the investment in the Technology sector to 70%.

To solve this problem, use frontcon, passing in a list of asset constraints.
Consider eight different portfolios along the efficient frontier:



Constraint Specification

NumPorts = 8;

To introduce the asset bounds constraints specified in Constraint 1,
create the matrix AssetBounds, where each column represents an
asset. The upper row represents the lower bounds, and the lower row
represents the upper bounds.

AssetBounds = [-0.10, -0.10, -0.10;
1.10, 1.10, 1.10];

Constraint 2 needs to be entered in two parts, the first part defining the
groups, and the second part defining the constraints for each group.
Given the information above, you can build a matrix of 1s and Os
indicating whether a specific asset belongs to a group. Each column
represents an asset, and each row represents a group. This example has
two groups: the technology group, and the energy group. Create the
matrix Groups as follows.

Groups = [0 1 1;
1 0 01;

The GroupBounds matrix allows you to specify an upper and lower
bound for each group. Each row in this matrix represents a group.
The first column represents the minimum allocation, and the second
column represents the maximum allocation to each group. Since the
investment in the Energy sector is capped at 80% of the portfolio value,
and the investment in the Technology sector is capped at 70%, create
the GroupBounds matrix using this information.

GroupBounds = [0 0.80;
0 0.70];

Now use frontcon to obtain the vectors and arrays representing the
risk, return, and weights for each of the eight portfolios computed along
the efficient frontier.

[PortRisk, PortReturn, PortWts] = frontcon(ExpReturn,...
ExpCovariance, NumPorts, [], AssetBounds, Groups, GroupBounds)

PortRisk =
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.0416
.0499
.0624
.0767
.0920
.1100
.1378
.1716

O O O0OO0OO0OO0oOOoOOo

PortReturn =

.1279
. 1361
.1442
.1524
.1605
.1687
.1768
.1850

O O O0OO0OO0OO0oOOoOOo

PortWts =

.7000
.6031
.4864
.3696
.2529
.2000
.2000
.2000

.2582
. 3244
.3708 .1428
L4172 .2132

0.0418
0
0
0
.4636 0.2835
0
0
-0

.0725

.5738 .2262
.7369 .0631
.9000 .1000

[N elNeNelNolNolNolNol
OO OO0 oOoOo

The output data is represented row-wise, where each portfolio’s risk,
rate of return, and associated weight is identified as corresponding rows
in the vectors and matrix.

Linear Constraint Equations

While frontcon allows you to enter a fixed set of constraints related to
minimum and maximum values for groups and individual assets, you often
need to specify a larger and more general set of constraints when finding
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the optimal risky portfolio. The function portopt addresses this need, by
accepting an arbitrary set of constraints as an input matrix.

The auxiliary function portcons can be used to create the matrix of
constraints, with each row representing an inequality. These inequalities are
of the type A*Wts' <= b, where A is a matrix, b is a vector, and Wts is a row
vector of asset allocations. The number of columns of the matrix A, and the
length of the vector Wts correspond to the number of assets. The number of
rows of the matrix A, and the length of vector b correspond to the number

of constraints. This method allows you to specify any number of linear
inequalities to the function portopt.

In actuality, portcons is an entry point to a set of functions that generate
matrices for specific types of constraints. portcons allows you to specify all
the constraints data at once, while the specific portfolio constraint functions
allow you to build the constraints incrementally. These constraint functions
are pcpval, pcalims, pcglims, and pcgcomp.

Consider an example to help understand how to specify constraints to portopt
while bypassing the use of portcons. This example requires specifying the

minimum and maximum investment in various groups.

Maximum and Minimum Group Exposure

Group Minimum Exposure = Maximum Exposure
North America 0.30 0.75
Europe 0.10 0.55
Latin America 0.20 0.50
Asia 0.50 0.50

Note that the minimum and maximum exposure in Asia is the same. This
means that you require a fixed exposure for this group.

Also assume that the portfolio consists of three different funds. The
correspondence between funds and groups is shown in the table below.
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Group Membership

Group Fund 1 Fund 2 Fund 3
North America X X

Europe X
Latin America X

Asia X X

Using the information in these two tables, build a mathematical
representation of the constraints represented. Assume that the vector of
weights representing the exposure of each asset in a portfolio is called
Wts = [W1 W2 W3].

Specifically
1. W1+ W2 > 0.30
2. W1+ W2 < 0.75
3. w3 > 0.10
4. w3 < 0.55
5. w1 > 0.20
6. w1 < 0.50
7. W2 + W3 = 0.50

Since you need to represent the information in the form A*Wts <= b,
multiply equations 1, 3 and 5 by —1. Also turn equation 7 into a set of two
inequalities: W2 + W3 > 0.50 and W2 + W3 < 0.50. (The intersection of these
two inequalities is the equality itself.) Thus

1. -W1 - W2 < -0.30
W1 + W2 < 0.75
3. -W3 < -0.10
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4. W3 < 0.55
5. -W1 < -0.20
6. w1 < 0.50
7. -W2 - W3 < -0.50
8. W2 + W3 < 0.50

Bringing these equations into matrix notation gives

H

>
I

J
H

H

OO0 4 a4 00 = =

J

—_ a4 OO0 00O 4 4

0
0
-1
13
0
0
_1;
1]

.30;
.75;
.10;
.55;
.20;
.50;
.50;
.50]

O O0OO0OO0OO0OOoOOoOOo

Build the constraint matrix ConSet by concatenating the matrix A to the
vector b.

ConSet = [A, b]

Specifying Additional Constraints

The example above defined a constraints matrix that specified a set of typical
scenarios. It defined groups of assets, specified upper and lower bounds for
total allocation in each of these groups, and it set the total allocation of one of
the groups to a fixed value. Constraints like these are common occurrences.
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The function portcons was created to simplify the creation of the constraint
matrix for these and other common portfolio requirements. portcons takes
as input arguments a list of constraint-specifier strings, followed by the data
necessary to build the constraint specified by the strings.

Assume that you need to add more constraints to the previous example.
Specifically, add a constraint indicating that the sum of weights in any
portfolio should be equal to 1, and another set of constraints (one per

asset) indicating that the weight for each asset must greater than 0. This
translates into five more constraint rows: two for the new equality, and three
indicating that each weight must be greater or equal to 0. The total number
of inequalities in the example is now 13. Clearly, creating the constraint
matrix can turn into a tedious task.

To create the new constraint matrix using portcons, use two separate
constraint-specifier strings:

e 'Default', which indicates that each weight is greater than 0 and that the
total sum of the weights adds to 1

® 'GroupLims', which defines the minimum and maximum allocation on
each group

The only data requirement for the constraint-specifier string 'Default’

is NumAssets (the total number of assets). The constraint-specifier string
'GroupLims' requires three different arguments: a Groups matrix indicating
the assets that belong to each group, the GroupMin vector indicating the
minimum bounds for each group, and the GroupMax vector indicating the
maximum bounds for each group. Based on the table Group Membership on
page 3-16, build the Group matrix, with each row representing a group, and
each column representing an asset.

H

Group = [1 1 0
0 0 1;

1 0 0;

0 1 1]

The table Maximum and Minimum Group Exposure on page 3-15 has the
information to build GroupMin and GroupMax.

GroupMin = [0.30 0.10 0.20 0.50];



Constraint Specification

GroupMax = [0.75 0.55 0.50 0.50];

Given that the number of assets is three, build the constraint matrix by
calling portcons.

ConSet = portcons('Default', 3, 'GroupLims', Group, GroupMin,...
GroupMax) ;

In most cases, portcons('Default') returns the minimal set of constraints
required for calling portopt. If ConSet is not specified in the call to portopt,
the function calls portcons passing 'Default' as its only specifier.

Now use portopt to obtain the vectors and arrays representing the risk,
return, and weights for the portfolios computed along the efficient frontier.

[PortRisk, PortReturn, PortWts] = portopt(ExpReturn,...
ExpCovariance, [], [], ConSet)

PortRisk = 0.0586
Port Return = 0.1375
PortWts = 0.5 0.25 0.25

In this case, the constraints allow only one optimum portfolio.
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Active Returns and Tracking Error Efficient Frontier

Suppose you want to identify an efficient set of portfolios that minimize
the variance of the difference in returns with respect to a given target
portfolio, subject to a given expected excess return. The mean and standard
deviation of this excess return are often called the active return and active
risk, respectively. Active risk is sometimes referred to as the tracking error.
Since the objective is to track a given target portfolio as closely as possible,
the resulting set of portfolios is sometimes referred to as the tracking error
efficient frontier.

Specifically, assume that the target portfolio is expressed as an index weight
vector, such that the index return series may be expressed as a linear
combination of the available assets. This example illustrates how to construct
a frontier that minimizes the active risk (tracking error) subject to attaining a
given level of return. That is, it computes the tracking error efficient frontier.

One way to construct the tracking error efficient frontier is to explicitly form
the target return series and subtract it from the return series of the individual
assets. In this manner, you specify the expected mean and covariance of

the active returns, and compute the efficient frontier subject to the usual
portfolio constraints.

This example works directly with the mean and covariance of the absolute
(unadjusted) returns but converts the constraints from the usual absolute
weight format to active weight format.

Consider a portfolio of five assets with the following expected returns,
standard deviations, and correlation matrix based on absolute weekly asset

returns.
NumAssets = 5;
ExpReturn = [0.2074 0.1971 0.2669 0.1323 0.2535]/100;
Sigmas = [2.6570 3.6297 3.9916 2.7145 2.6133]/100;
Correlations = [1.0000 0.6092 0.6321 0.5833 0.7304

0.6092 1.0000 0.8504 0.8038 0.7176
0.6321 0.8504 1.0000 0.7723 0.7236
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0.5833 0.8038 0.7723 1.0000 0.7225
0.7304 0.7176 0.7236 0.7225 1.0000];

Convert the correlations and standard deviations to a covariance matrix
using corr2cov.

ExpCovariance = corr2cov(Sigmas, Correlations);

Next, assume that the target index portfolio is an equally-weighted portfolio
formed from the five assets. Note that the sum of index weights equals 1,
satisfying the standard full investment budget equality constraint.

Index = ones(NumAssets, 1)/NumAssets;

Generate an asset constraint matrix using portcons. The constraint matrix
AbsConSet is expressed in absolute format (unadjusted for the index), and is
formatted as [A b], corresponding to constraints of the form A*w <= b. Each
row of AbsConSet corresponds to a constraint, and each column corresponds to
an asset. Allow no short-selling and full investment in each asset (lower and
upper bounds of each asset are 0 and 1, respectively). In particular, note that
the first two rows correspond to the budget equality constraint; the remaining
rows correspond to the upper/lower investment bounds.

AbsConSet = portcons('PortvValue', 1, NumAssets,
"AssetLims', zeros(NumAssets,1), ones(NumAssets,1));

Now transform the absolute constraints to active constraints with
abs2active.

ActiveConSet = abs2active(AbsConSet, Index);
An examination of the absolute and active constraint matrices reveals that
they are differ only in the last column (the columns corresponding to the
b in A*w <= b).

[AbsConSet(:,end) ActiveConSet(:,end)]

ans =

1.0000 0
-1.0000 0
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1.0000 0.8000
1.0000 0.8000
1.0000 0.8000
1.0000 0.8000
1.0000 0.8000
0 0.2000
0 0.2000
0 0.2000
0 0.2000
0 0.2000

In particular, note that the sum-to-one absolute budget constraint becomes
a sum-to-zero active budget constraint. The general transformation is as
follows:

b =bh - A Index

active absolite

Now construct and plot the tracking error efficient frontier with 21 portfolios.

[ActiveRisk, ActiveReturn, ActiveWeights] =

portopt (ExpReturn,ExpCovariance, 21, [], ActiveConSet);
ActiveRisk = real(ActiveRisk);

plot (ActiveRisk*100, ActiveReturn*100, 'blue')
grid('on')

xlabel('Active Risk (Standard Deviation in Percent)')
ylabel('Active Return (Percent)')

title('Tracking Error Efficient Frontier')
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Of particular interest is the lower-left portfolio along the frontier. This
zero-risk/zero-return portfolio has a practical economic significance. It
represents a full investment in the index portfolio itself. Note that each
tracking error efficient portfolio (each row in the array ActiveWeights)
satisfies the active budget constraint, and thus represents portfolio investment
allocations with respect to the index portfolio. To convert these allocations to
absolute investment allocations, add the index to each efficient portfolio.

AbsoluteWeights = ActiveWeights + repmat(Index', 21, 1);
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Investment Performance
Metrics

® “Overview of Performance Metrics” on page 4-2

¢ “Using the Sharpe Ratio” on page 4-6

e “Using the Information Ratio” on page 4-8

® “Tracking Error” on page 4-10

e “Risk-Adjusted Return” on page 4-11

* “Sample and Expected Lower Partial Moments” on page 4-13

e “Maximum and Expected Maximum Drawdown” on page 4-16
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Overview of Performance Metrics

In this section...

“Performance Metrics Classes” on page 4-2

“Performance Metrics Example” on page 4-3

Performance Metrics Classes

Sharpe first proposed a ratio of excess return to total risk as an investment
performance metric. Subsequent work by Sharpe, Lintner, and Mossin
extended these ideas to entire asset markets in what is called the Capital
Asset Pricing Model (CAPM). Since the development of the CAPM, a variety
of investment performance metrics has evolved.

This chapter presents four classes of investment performance metrics:

® The first class of metrics are absolute investment performance metrics that
can be called “classic” metrics since they are based on the CAPM. They
include the Sharpe ratio, the information ratio, and tracking error. To
compute the Sharpe ratio from data, use the function sharpe to calculate
the ratio for one or more asset return series. To compute the information
ratio and associated tracking error, use the function inforatio to calculate
these quantities for one or more asset return series.

® The second class of metrics are relative investment performance metrics
to compute risk-adjusted returns. These metrics are also based on the
CAPM and include Beta, Jensen’s Alpha, the Security Market Line (SML),
Modigliani and Modigliani Risk-Adjusted Return, and the Graham-Harvey
measures. To calculate risk-adjusted alpha and return, use portalpha.

® The third class of metrics are alternative investment performance metrics
based on lower partial moments. To calculate lower partial moments, use
the functions 1pm for sample lower partial moments and elpm for expected
lower partial moments.

® The fourth class of metrics are performance metrics based on maximum
drawdown and expected maximum drawdown. To calculate maximum
or expected maximum drawdowns, use the functions maxdrawdown and
emaxdrawdown.
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Performance Metrics Example
To illustrate the functions for investment performance metrics, you will work

with three financial time series objects using performance data for:
® An actively managed, large-cap value mutual fund
® A large-cap market index

® 90-day Treasury bills
The data is monthly total return prices that cover a span of 5 years.

The following plot illustrates the performance of each series in terms of total
returns to an initial $1 invested at the start of this 5-year period:

load FundMarketCash

plot(TestData)

hold all

title('\bfFive-Year Total Return Performance');
legend('Fund', 'Market', 'Cash', 'Location', 'SouthEast');
hold off
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The mean (Mean) and standard deviation (Sigma) of returns for each series are

Returns = tick2ret(TestData);
Assets

Mean = mean(Returns)

Sigma = std(Returns, 1)

which gives the following result:

Assets =

'"Fund' '"Market' 'Cash’
Mean =

0.0038 0.0030 0.0017
Sigma =

0.0229 0.0389 0.0009
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In this chapter, you will work with this data to demonstrate that the example
fund has done well in absolute, relative, and risk-adjusted terms with respect
to the investment performance metrics.

Note Functions for investment performance metrics use total return price
and total returns. To convert between total return price and total returns,
use ret2tick and tick2ret.
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Using the Sharpe Ratio

In this section...

“Introduction” on page 4-6

“Sharpe Ratio Example” on page 4-6

Introduction

The Sharpe ratio is the ratio of the excess return of an asset divided by the
asset’s standard deviation of returns. The Sharpe ratio has the form:

(Mean - Riskless) / Sigma

Here Mean is the mean of asset returns, Riskless is the return of a riskless
asset, and Sigma is the standard deviation of asset returns. A higher Sharpe
ratio is better than a lower Sharpe ratio. A negative Sharpe ratio indicates
“anti-skill” since the performance of the riskless asset is superior.

Sharpe Ratio Example

To compute the Sharpe ratio, the mean return of the cash asset will be used
as the return for the riskless asset. Thus, given asset return data and the
riskless asset return, the Sharpe ratio is calculated with

Riskless = mean(Returns(:,3))
Sharpe = sharpe(Returns, Riskless)

which gives the following result:

Riskless =
0.0017
Sharpe =
0.0886 0.0315 0

The Sharpe ratio of the example fund is significantly higher than the Sharpe
ratio of the market. As will be demonstrated with portalpha, this translates
into a strong risk-adjusted return. Since the Cash asset is the same as
Riskless, it makes sense that its Sharpe ratio is 0. The Sharpe ratio was
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calculated with the mean of cash returns. It can also be calculated with the
cash return series as input for the riskless asset

Sharpe = sharpe(Returns, Returns(:,3))

which gives the following result:

Sharpe =
0.0886 0.0315 0
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Using the Information Ratio

In this section...

“Introduction” on page 4-8

“Information Ratio Example” on page 4-8

Introduction

Although originally called the “appraisal ratio” by Treynor and Black, the
information ratio is the ratio of relative return to relative risk (known as
“tracking error”). Whereas the Sharpe ratio looks at returns relative to a
riskless asset, the information ratio is based on returns relative to a risky
benchmark which is known colloquially as a “bogey.” Given an asset or
portfolio of assets with random returns designated by Asset and a benchmark
with random returns designated by Benchmark, the information ratio has

the form:

Mean(Asset - Benchmark) / Sigma (Asset - Benchmark)

Here Mean(Asset - Benchmark) is the mean of Asset minus Benchmark
returns, and Sigma(Asset - Benchmark) is the standard deviation of Asset
minus Benchmark returns. A higher information ratio is considered better
than a lower information ratio.

Information Ratio Example

To calculate the information ratio using the example data, the mean return of
the market series will be used as the return of the benchmark. Thus, given
asset return data and the riskless asset return, compute the information
ratio with

Benchmark Returns(:,2);
InfoRatio = inforatio(Returns, Benchmark)

which gives the following result:

InfoRatio =
0.0432 NaN -0.0315
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Since the market series has no risk relative to itself, the information ratio
for the second series is undefined (which is represented as NaN in MATLAB
software). Its standard deviation of relative returns in the denominator is 0.
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Tracking Error

In this section...

“Introduction” on page 4-10

“Tracking Error Example” on page 4-10

Introduction

Given an asset or portfolio of assets and a benchmark, the relative standard
deviation of returns between the asset or portfolio of assets and the
benchmark is called tracking error.

Tracking Error Example

The function inforatio computes tracking error and returns it as a second
argument

Benchmark = Returns(:,2);
[InfoRatio, TrackingError] = inforatio(Returns, Benchmark)

which gives the following results:

InfoRatio =

0.0432 NaN -0.0315
TrackingError =

0.0187 0 0.0390

Tracking error is a useful measure of performance relative to a benchmark
since it 1s in units of asset returns. For example, the tracking error of 1.87%
for the fund relative to the market in this example is reasonable for an
actively managed, large-cap value fund.
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Risk-Adjusted Return

In this section...

“Introduction” on page 4-11

“Risk-Adjusted Return Example” on page 4-11

Introduction

Risk-adjusted return either shifts the risk (which is the standard deviation
of returns) of a portfolio to match the risk of a market portfolio or shifts the
risk of a market portfolio to match the risk of a fund. According to the Capital
Asset Pricing Model (CAPM), the market portfolio and a riskless asset are
points on a Security Market Line (SML). The return of the resultant shifted
portfolio, levered or unlevered, to match the risk of the market portfolio, is
the risk-adjusted return. The SML provides another measure of risk-adjusted
return, since the difference in return between the fund and the SML, return

at the same level of risk.

Risk-Adjusted Return Example

Given our example data with a fund, a market, and a cash series, you can
calculate the risk-adjusted return and compare it with the fund and market’s

mean returns

Fund = Returns(:,1);
Market = Returns(:,2);
Cash = Returns(:,3);
MeanFund = mean(Fund)
MeanMarket = mean(Market)

[MM, aMM] = portalpha(Fund, Market, Cash)

[GH1, aGH1] = portalpha(Fund, Market, Cash,
[GH2, aGH2] = portalpha(Fund, Market, Cash,
[SML, aSML] = portalpha(Fund, Market, Cash,

which gives the following results:

MeanFund =
0.0038

'ght")
‘gh2')
‘sml')
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MeanMarket =
0.0030

MM =

.0052

aMM

.0022

GH1

o Il ol o

.0025
aGH1 =
0.0013
GH2 =
0.0052
aGH2 =
0.0022
SML =
0.0025
aSML =
0.0013

Since the fund’s risk is much less than the market’s risk, the risk-adjusted
return of the fund is much higher than both the nominal fund and market
returns.
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Sample and Expected Lower Partial Moments

In this section...

“Introduction” on page 4-13
“Sample Lower Partial Moments Example” on page 4-13

“Expected Lower Partial Moments Example” on page 4-14

Introduction

Use lower partial moments to examine what is colloquially known as
“downside risk.” The main idea of the lower partial moment framework is to
model moments of asset returns that fall below a minimum acceptable level of
return. To compute lower partial moments from data, use 1pm to calculate
lower partial moments for multiple asset return series and for multiple
moment orders. To compute expected values for lower partial moments under
several assumptions about the distribution of asset returns, use elpm to
calculate lower partial moments for multiple assets and for multiple orders.

Sample Lower Partial Moments Example

The following example demonstrates 1pm to compute the zero-order,
first-order, and second-order lower partial moments for the three time series,
where the mean of the third time series is used to compute MAR (with the
so-called risk-free rate).

Assets
MAR = mean(Returns(:,3))
LPM = 1lpm(Returns, MAR, [0 1 2])

which gives the following results:

"Fund' 'Market' "Cash'

0
0.4333 0.4167 0.6167
0.0075 0.0140 0.0004
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0.0003 0.0008 0.0000

The first row of LPM contains zero-order lower partial moments of the three
series. The fund and market index fall below MAR about 40% of the time and
cash returns fall below its own mean about 60% of the time.

The second row contains first-order lower partial moments of the three series.
The fund and market have large expected shortfall returns relative to MAR by
75 and 140 basis points per month. On the other hand, cash underperforms
MAR by about only 4 basis points per month on the downside.

The third row contains second-order lower partial moments of the three
series. The square root of these quantities provides an idea of the dispersion
of returns that fall below the MAR. The market index has a much larger
variation on the downside when compared to the fund.

Expected Lower Partial Moments Example

To compare realized values with expected values, use elpm to compute
expected lower partial moments based on the mean and standard deviations
of normally distributed asset returns. The elpm function works with the mean
and standard deviations for multiple assets and multiple orders

Assets
ELPM = elpm(Mean, Sigma, MAR, [0 1 2])

which gives the following results:

Assets =
"Fund' "Market' "Cash’
ELPM =
0.4647 0.4874 0.5000
0.0082 0.0149 0.0004
0.0002 0.0007 0.0000

Based on the moments of each asset, the expected values for lower partial
moments imply better than expected performance for the fund and market
and worse than expected performance for cash. Note that this function works
with either degenerate or nondegenerate normal random variables. For
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example, if cash were truly riskless, its standard deviation would be 0. You
can examine the difference in expected shortfall.

RisklessCash = elpm(Mean(3), 0, MAR, 1)

which gives the following result:

RisklessCash =
0
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Maximum and Expected Maximum Drawdown

In this section...

“Introduction” on page 4-16
“Maximum Drawdown Example” on page 4-16

“Expected Maximum Drawdown Example” on page 4-18

Introduction

Although additional metrics exist that are used in the hedge fund and
commodity trading communities (see Pederson and Rudholm-Alfvin in
Appendix A, “Bibliography”), the original definition and subsequent
implementation of these metrics is not yet standardized. The “traditional”
return form for maximum drawdown is the drop from maximum to minimum
return over a period of time. Given returns that have been transformed into
a linear Brownian motion with drift, it is possible to compute the expected
maximum drawdown (see Magdon-Ismail, Atiya, Pratap, and Abu-Mostafa
in Appendix A, “Bibliography”). Use maxdrawdown and emaxdrawdown to
calculate the maximum and expected maximum drawdowns.

Maximum Drawdown Example

This example demonstrates computing MaxDD for three types of returns: fund,
market, and cash

load FundMarketCash
MaxDD = maxdrawdown(TestData)

which gives the following results:

MaxDD =
0.1658 0.3381 0

Most academic research on maximum drawdown focuses on the underlying
stochastic processes that generate asset returns. Convert price data to
geometric Brownian motion and compute maximum drawdown

Returns = TestData(2:end,:) ./ TestData(l:end - 1,:);
MaxDD = maxdrawdown(Returns, 'geometric')
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which gives the following results:

MaxDD =
0.1007 0.1890 0.0023

Convert price data to arithmetic Brownian motion and compute maximum
drawdown (the answer should match the previous result).

Returns = log(Returns);
MaxDD = maxdrawdown(Returns, 'arithmetic')

which gives the following results:

MaxDD =
0.1007 0.1890 0.0023

The maximum drawdown function has been enhanced to return the indices of
the maximum drawdown periods for each series

[MaxDD, MaxDDIndex] = maxdrawdown(TestData)
Start = MaxDDIndex(1,:)
End = MaxDDIndex(2,:)

which gives the following results:

MaxDD =

0.1658 0.3381 0
MaxDDIndex =

2 2  NaN

18 18 NaN

2 2 NaN
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18 18 NaN

The first two series have the same periods for maximum drawdown from the
2nd to the 18th month in the data. Note that the third series never has a
drawdown, so that the indices are NaNs.

Expected Maximum Drawdown Example

This example demonstrates using the return moments of the fund to compute
the expected MaxDD and then compare it with the realized MaxDD

load FundMarketCash

Returns = TestData(2:end,:) ./ TestData(1l:end - 1,:);
Returns = log(Returns);

MaxDD = maxdrawdown(Returns(:,1),'arithmetic')

Mu = mean(Returns(:,1));

Sigma = std(Returns(:,1),1);

EMaxDD = emaxdrawdown(Mu, Sigma, 100)

which gives the following results:

MaxDD =
0.1007

EMaxDD =
0.1852



Regression with Missing
Data

e “Multivariate Normal Regression” on page 5-2
¢ “Maximum Likelihood Estimation with Missing Data” on page 5-9
e “Multivariate Normal Regression Types” on page 5-17

® “Valuation with Missing Data” on page 5-34
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Multivariate Normal Regression

In this section...

“Introduction” on page 5-2

“Multivariate Normal Linear Regression” on page 5-3
“Maximum Likelihood Estimation” on page 5-4

“Special Case of a Multiple Linear Regression Model” on page 5-5
“Least-Squares Regression” on page 5-5

“Mean and Covariance Estimation” on page 5-5

“Convergence” on page 5-6

“Fisher Information” on page 5-6

“Statistical Tests” on page 5-7

Introduction

This section focuses on using likelihood-based methods for multivariate
normal regression. The parameters of the regression model are estimated via
maximum likelihood estimation. For multiple series, this requires iteration
until convergence. The complication due to the possibility of missing data is
incorporated into the analysis with a variant of the EM algorithm known as
the ECM algorithm.

The underlying theory of maximum likelihood estimation and the definition
and significance of the Fisher information matrix can be found in Caines [1]
and Cramér [2]. The underlying theory of the ECM algorithm can be found in
Meng and Rubin [8] and Sexton and Swensen [9].

In addition, these two examples of maximum likelihood estimation are
presented:

e “Example of Portfolios with Missing Data” on page 5-26
e “KEstimation of Some Technology Stock Betas” on page 5-36
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Multivariate Normal Linear Regression
Suppose you have a multivariate normal linear regression model in the form

A H.b

Z H b

n M

where the model has m observations of n-dimensional random variables Z, ...,
Z, with a linear regression model that has a p-dimensional model parameter

0

0

-C

vector b. In addition, the model has a sequence of m design matrices H,, ...,

H,, where each design matrix is a known n-by-p matrix.

Given a parameter vector b and a collection of design matrices, the collection

of m independent variables Z, is assumed to have independent identically

distributed multivariate normal residual errors Z, — H, b with n-vector mean
0 and n-by-n covariance matrix C for each k =1, ..., m.

A concise way to write this model is

Z, ~ N(H,b,C)

fork=1, ..., m.

The goal of multivariate normal regression is to obtain maximum likelihood

estimates for b and C given a collection of m observations z,, ..., z,, of the
random variables Z,, ..., Z . The estimated parameters are the p distinct

elements of b and the n (n + 1)/2 distinct elements of C (the lower-triangular

elements of C).

Note Quasi-maximum likelihood estimation works with the same models but
with a relaxation of the assumption of normally distributed residuals. In this

case, however, the parameter estimates are asymptotically optimal.
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Maximum Likelihood Estimation

To estimate the parameters of the multivariate normal linear regression
model using maximum likelihood estimation, it is necessary to maximize the
log-likelihood function over the estimation parameters given observations z,,

C 2,
Given the multivariate normal model to characterize residual errors in the
regression model, the log-likelihood function is

L(zq, ....2,,:b,C) = %mn]og{?n}+%m log (det (C))

+

e=T

nt T 1
Y (z,-H,b) C (z, - H,b)
k=1

Although the cross-sectional residuals must be independent, you can use this
log-likelihood function for quasi-maximum likelihood estimation. In this case,
the estimates for the parameters b and C provide estimates to characterize
the first and second moments of the residuals. See Caines [1] for details.

Except for a special case (see “Special Case of a Multiple Linear Regression
Model” on page 5-5), if both the model parameters in b and the covariance
parameters in C are to be estimated, the estimation problem is intractably
nonlinear and a solution must use iterative methods. Denote estimates for
the parameters b and C for iteration ¢ = 0, 1, ... with the superscript notation
b® and C®.,

Given initial estimates b©® and C© for the parameters, the maximum
likelihood estimates for b and C are obtained using a two-stage iterative
process with

-1
(£+1) - T, (£ -1 - T -1
b = | Y H,(CY) H, Y H,(CY) g
k=1 . k=1 .

and
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m T

k=1

fort=0,1, ... .

Special Case of a Multiple Linear Regression Model

The special case mentioned in “Maximum Likelihood Estimation” on page 5-4
occurs if n = 1 so that the sequence of observations is a sequence of scalar
observations. This model is known as a multiple linear regression model. In
this case, the covariance matrix C is a 1-by-1 matrix that drops out of the
maximum likelihood iterates so that a single-step estimate for b and C can
be obtained with converged estimates b® and C®,

Least-Squares Regression

Another simplification of the general model is called least-squares regression.
If b® =0 and C© =1, then b® and C® from the two-stage iterative process
are least-squares estimates for b and C, where

LS m T -1 m T
E=1 . E=1 )
and
LS | LS Ls. T
c-° = ’E;Elizk_Hkb ) (z, - H,b™)

Mean and Covariance Estimation

A final simplification of the general model is to estimate the mean and
covariance of a sequence of n-dimensional observations z,, ..., z,,. In this case,
the number of series is equal to the number of model parameters with n =p
and the design matrices are identity matrices with H, =Ifor:=1, ..., m so
that b is an estimate for the mean and C is an estimate of the covariance of

the collection of observations z,, ..., z,,.
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Convergence

If the iterative process continues until the log-likelihood function increases
by no more than a specified amount, the resultant estimates are said to be
maximum likelihood estimates b and C¥L,

Note that if n = 1 (which implies a single data series), convergence occurs
after only one iterative step, which, in turn, implies that the least-squares
and maximum likelihood estimates are identical. If, however, n > 1, the
least-squares and maximum likelihood estimates are usually distinct.

In Financial Toolbox software, both the changes in the log-likelihood function
and the norm of the change in parameter estimates are monitored. Whenever
both changes fall below specified tolerances (which should be something
between machine precision and its square root), the toolbox functions
terminate under an assumption that convergence has been achieved.

Fisher Information

Since maximum likelihood estimates are formed from samples of random
variables, their estimators are random variables; an estimate derived from
such samples has an uncertainty associated with it. To characterize these
uncertainties, which are called standard errors, two quantities are derived
from the total log-likelihood function.

The Hessian of the total log-likelihood function is
viL .0
- (24.....2,,:0)

and the Fisher information matrix is

1(0) = ~E[V'L(2q.....2,,:0)]

where the partial derivatives of the V operator are taken with respect to the
combined parameter vector ® that contains the distinct components of b and
C with a total of ¢ = p + n (n + 1)/2 parameters.

Since maximum likelihood estimation is concerned with large-sample
estimates, the central limit theorem applies to the estimates and the Fisher
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information matrix plays a key role in the sampling distribution of the
parameter estimates. Specifically, maximum likelihood parameter estimates
are asymptotically normally distributed such that

(0% _ 0y~ N0, T 0%)) as t —

where O is the combined parameter vector and @@ is the estimate for the
combined parameter vector at iteration t =0, 1, ... .

The Fisher information matrix provides a lower bound, called a Cramér-Rao
lower bound, for the standard errors of estimates of the model parameters.

Statistical Tests

Given an estimate for the combined parameter vector O, the squared standard
errors are the diagonal elements of the inverse of the Fisher information
matrix

2 . -1
s (8;) = (I ()i
fori=1, .., q.
Since the standard errors are estimates for the standard deviations of the

parameter estimates, you can construct confidence intervals so that, for
example, a 95% interval for each parameter estimate is approximately

B; + 1.96 5(6;)
fori=1, .., q.

Error ellipses at a level-of-significance a ¢ [ 0, 1 ] for the parameter estimates
satisfy the inequality

Y .
(8-8) L0) (0-8)< 114,

2

and follow a X distribution with ¢ degrees-of-freedom. Note that similar
inequalities can be formed for any subcollection of the parameters.
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In general, given parameter estimates, the computed Fisher information
matrix, and the log-likelihood function, you can perform numerous statistical
tests on the parameters, the model, and the regression.

5-8
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Maximum Likelihood Estimation with Missing Data

In this section...

“Introduction” on page 5-9

“ECM Algorithm” on page 5-10

“Standard Errors” on page 5-11

“Data Augmentation” on page 5-11

“Multivariate Normal Regression Functions” on page 5-12
“Multivariate Normal Regression Without Missing Data” on page 5-14
“Multivariate Normal Regression With Missing Data” on page 5-14
“Least-Squares Regression with Missing Data” on page 5-15

“Multivariate Normal Parameter Estimation with Missing Data” on page
5-15

“Support Functions” on page 5-16

Introduction

Suppose that a portion of the sample data is missing, where missing values
are represented as NaNs. If the missing values are missing-at-random and
ignorable, where Little and Rubin [7] have precise definitions for these
terms, it is possible to use a version of the Expectation Maximization, or EM,
algorithm of Dempster, Laird, and Rubin [3] to estimate the parameters of
the multivariate normal regression model. The algorithm used in Financial
Toolbox software is the ECM (Expectation Conditional Maximization)
algorithm of Meng and Rubin [8] with enhancements by Sexton and Swensen

[9].

Each sample z, for £ =1, ..., m, is either complete with no missing values,
empty with no observed values, or incomplete with both observed and missing
values. Empty samples are ignored since they contribute no information.

To understand the missing-at-random and ignorabable conditions, consider
an example of stock price data before an IPO. For a counterexample, censored
data, in which all values greater than some cutoff are replaced with NaNs, does
not satisfy these conditions.
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In sample &, let x, represent the missing values in z,, and y, represent the
observed values. Define a permutation matrix P, so that

Xk
Zk = Pk
¥

fork=1, ..., m.

ECM Algorithm

The ECM algorithm has two steps — an E, or expectation step, and a CM, or
conditional maximization, step. As with maximum likelihood estimation, the
parameter estimates evolve according to an iterative process, where estimates
for the parameters after ¢ iterations are denoted as b® and C®.

The E step forms conditional expectations for the elements of missing data

with
E[X, |Yfz _ n:bm,cir)]
cov[ X, | Y, = y,:b7C" ]

for each sample ® € {1, ..., M} that has missing data.

The CM step proceeds in the same manner as the maximum likelihood
procedure without missing data. The main difference is that missing data
moments are imputed from the conditional expectations obtained in the E
step.

The E and CM steps are repeated until the log-likelihood function ceases to
increase. One of the important properties of the ECM algorithm is that it is
always guaranteed to find a maximum of the log-likelihood function and,
under suitable conditions, this maximum can be a global maximum.

5-10
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Standard Errors

The negative of the expected Hessian of the log-likelihood function and the
Fisher information matrix are identical if no data is missing. However, if
data is missing, the Hessian, which is computed over available samples,
accounts for the loss of information due to missing data. Consequently, the
Fisher information matrix provides standard errors that are a Cramér-Rao
lower bound whereas the Hessian matrix provides standard errors that may
be greater if there is missing data.

Data Augmentation

The ECM functions do not “fill in” missing values as they estimate model
parameters. In some cases, you may want to fill in the missing values.
Although you can fill in the missing values in your data with conditional
expectations, you would get optimistic and unrealistic estimates because
conditional estimates are not random realizations.

Several approaches are possible, including resampling methods and multiple
imputation (see Little and Rubin [7] and Shafer [10] for details). A somewhat
informal sampling method for data augmentation is to form random samples
for missing values based on the conditional distribution for the missing values.

Given parameter estimates for b and C, each observation has moments

E[Z,] =H,b
and
cov(Z,) = Hka]Hf

for k=1, ..., m, where you have dropped the parameter dependence on the
left sides for notational convenience.

For observations with missing values partitioned into missing values X,
and observed values Y, = y,, you can form conditional estimates for any
subcollection of random variables within a given observation. Thus, given
estimates E[ Z, ] and cov(Z,) based on the parameter estimates, you can
create conditional estimates

5-11



5 Regression with Missing Data

5-12

E[ X;z | vy
and
cou(Xk| ¥.)

using standard multivariate normal distribution theory. Given these
conditional estimates, you can simulate random samples for the missing
values from the conditional distribution

X, ~ N(E[X, |y, ] cov(X;|y,))

The samples from this distribution reflect the pattern of missing and
nonmissing values for observations & = 1, ..., m. You must sample from
conditional distributions for each observation to preserve the correlation
structure with the nonmissing values at each observation.

If you follow this procedure, the resultant filled-in values are random and
generate mean and covariance estimates that are asymptotically equivalent
to the ECM-derived mean and covariance estimates. Note, however, that the
filled-in values are random and reflect likely samples from the distribution
estimated over all the data and may not reflect “true” values for a particular
observation.

Multivariate Normal Regression Functions

Financial Toolbox software has a number of functions for multivariate
normal regression with or without missing data. The toolbox functions solve
four classes of regression problems with functions to estimate parameters,
standard errors, log-likelihood functions, and Fisher information matrices.
The four classes of regression problems are:

e “Multivariate Normal Regression Without Missing Data” on page 5-14
e “Multivariate Normal Regression With Missing Data” on page 5-14

® “Least-Squares Regression with Missing Data” on page 5-15

e “Multivariate Normal Parameter Estimation with Missing Data” on page
5-15
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Additional support functions are also provided, see “Support Functions” on
page 5-16.

In all functions, the MATLAB representation for the number of observations
(or samples) is NumSamples = m, the number of data series is NumSeries =
n, and the number of model parameters is NumParams = p. Note that the
moment estimation functions have NumSeries = NumParams.

The collection of observations (or samples) is stored in a MATLAB matrix
Data such that

T
Dartaik, ) = Z,
fork = 1, ..., NumSamples, where Data is a NumSamples-by-NumSeries
matrix.

For the multivariate normal regression or least-squares functions, an
additional required input is the collection of design matrices that is stored as
either a MATLAB matrix or a vector of cell arrays denoted as Design.

If Numseries = 1 Design can be a NumSamples-by-NumParams matrix. This
is the “standard” form for regression on a single data series.

If Numseries = 1 Design can be either a cell array with a single cell or
a cell array with NumSamples cells. Each cell in the cell array contains a
NumSeries-by-NumParams matrix such that

Design{k} = H,

for k = 1, ..., NumSamples. If Design has a single cell, it is assumed to be
the same Design matrix for each sample such that
Design{l} = H; = ... = H

m

Otherwise, Design must contain individual design matrices for each and
every sample.

The main distinction among the four classes of regression problems depends
upon how missing values are handled and where missing values are
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represented as the MATLAB value NaN. If a sample is to be ignored given any
missing values in the sample, the problem is said to be a problem “without
missing data.” If a sample is to be ignored if and only if every element of the
sample is missing, the problem is said to be a problem “with missing data”
since the estimation must account for possible NaN values in the data.

In general, Data may or may not have missing values and Design should have
no missing values. In some cases, however, if an observation in Data is to be
ignored, the corresponding elements in Design are also ignored. Consult the
function reference pages for details.

Multivariate Normal Regression Without Missing
Data

You can use the following functions for multivariate normal regression
without missing data.

mvnrmle Estimate model parameters, residuals, and the
residual covariance.

mvnrstd Estimate standard errors of model and
covariance parameters.

mvnrfish Estimate the Fisher information matrix.

mvnrobj Calculate the log-likelihood function.

The first two functions are the main estimation functions. The second two are
supporting functions that can be used for more detailed analyses.

Multivariate Normal Regression With Missing Data

You can use the following functions for multivariate normal regression with
missing data.

ecmmvnrmle Estimate model parameters, residuals, and the
residual covariance.

ecmmvnrstd Estimate standard errors of model and
covariance parameters.



Maximum Likelihood Estimation with Missing Data

ecmmvnrfish Estimate the Fisher information matrix.

ecmmvnrobj Calculate the log-likelihood function.

The first two functions are the main estimation functions. The second two are
supporting functions used for more detailed analyses.

Least-Squares Regression with Missing Data

You can use the following functions for least-squares regression with missing
data or for covariance-weighted least-squares regression with a fixed
covariance matrix.

ecmlsrmle Estimate model parameters, residuals, and the
residual covariance.

ecmlsrobj Calculate the least-squares objective function
(pseudo log-likelihood).

To compute standard errors and estimates for the Fisher information matrix,
the multivariate normal regression functions with missing data are used.

ecmmvnrstd Estimate standard errors of model and
covariance parameters.

ecmmvnrfish Estimate the Fisher information matrix.

Multivariate Normal Parameter Estimation with
Missing Data

You can use the following functions to estimate the mean and covariance
of multivariate normal data.

ecmnmle Estimate the mean and covariance of the data.

ecmnstd Estimate standard errors of the mean and
covariance of the data.
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ecmnfish Estimate the Fisher information matrix.

ecmnhess Estimate the Fisher information matrix using
the Hessian.

ecmnobj Calculate the log-likelihood function.

These functions behave slightly differently from the more general regression
functions since they solve a specialized problem. Consult the function
reference pages for details.

Support Functions
Two support functions are included.

convert2sur Convert a multivariate normal regression model
into an SUR model.

ecmninit Obtain initial estimates for the mean and
covariance of a Data matrix.

The convert2sur function converts a multivariate normal regression model
into a seemingly unrelated regression, or SUR, model. The second function
ecmninit is a specialized function to obtain initial ad hoc estimates for the
mean and covariance of a Data matrix with missing data. (If there are no
missing values, the estimates are the maximum likelihood estimates for the
mean and covariance.)
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Multivariate Normal Regression Types

In this section...

“Regressions” on page 5-17

“Multivariate Normal Regression” on page 5-17

“Least-Squares Regression” on page 5-18

“Covariance-Weighted Least Squares” on page 5-19

“Feasible Generalized Least Squares” on page 5-20

“Seemingly Unrelated Regression” on page 5-21

“Mean and Covariance Parameter Estimation” on page 5-23
“Troubleshooting Multivariate Normal Regression” on page 5-23
“Slow Convergence” on page 5-24

“Nonrandom Residuals” on page 5-24

“Nonconvergence” on page 5-25

“Example of Portfolios with Missing Data” on page 5-26

Regressions

Each regression function has a specific operation. This section shows how to
use these functions to perform specific types of regressions. To illustrate use
of the functions for various regressions, “typical” usage is shown with optional
arguments kept to a minimum. For a typical regression, you estimate model
parameters and residual covariance matrices with the mle functions and
estimate the standard errors of model parameters with the std functions.
The regressions “without missing data” essentially ignore samples with any
missing values, and the regressions “with missing data” ignore samples with
every value missing.

Multivariate Normal Regression

Multivariate normal regression, or MVNR, is the “standard” implementation
of the regression functions in Financial Toolbox software.
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Multivariate Normal Regression Without Missing Data
Estimate Parameters

[Parameters, Covariance] = mvnrmle(Data, Design);

Estimate Standard Errors

StdParameters = mvnrstd(Data, Design, Covariance);

Multivariate Normal Regression with Missing Data
Estimate Parameters

[Parameters, Covariance] = ecmmvnrmle(Data, Design);

Estimate Standard Errors

StdParameters = ecmmvnrstd(Data, Design, Covariance);

Least-Squares Regression

Least-squares regression, or LSR, sometimes called ordinary least-squares
or multiple linear regression, is the simplest linear regression model. It also
enjoys the property that, independent of the underlying distribution, it is a
best linear unbiased estimator (BLUE).

Given m = NumSamples observations, the typical least-squares regression
model seeks to minimize the objective function

m T
z (Z,-H,b) (Z,-H,b)
k=1

which, within the maximum likelihood framework of the multivariate normal
regression routine mvnrmle, is equivalent to a single-iteration estimation

of just the parameters to obtain Parameters with the initial covariance
matrix Covariance held fixed as the identity matrix. In the case of missing
data, however, the internal algorithm to handle missing data requires a
separate routine ecmlsrmle to do least-squares instead of multivariate
normal regression.
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Least-Squares Regression Without Missing Data
Estimate Parameters

[Parameters, Covariance] = mvnrmle(Data, Design, 1);

Estimate Standard Errors

StdParameters = mvnrstd(Data, Design, Covariance);

Least-Squares Regression with Missing Data
Estimate Parameters

[Parameters, Covariance] = ecmlsrmle(Data, Design);

Estimate Standard Errors

StdParameters = ecmmvnrstd(Data, Design, Covariance);

Covariance-Weighted Least Squares

Given m = NUMSAMPLES observations, the typical covariance-weighted least
squares, or CWLS, regression model seeks to minimize the objective function

m T

> (Z,-H,b) Cy(Z,-H,b)
k=1
Co.

with fixed covariance

-1
In most cases, CD is a diagonal matrix. The inverse matrix W= CD has
diagonal elements that can be considered relative “weights” for each series.
Thus, CWLS is a form of weighted least squares with the weights applied
across series.

Covariance-Weighted Least Squares Without Missing Data
Estimate Parameters

[Parameters, Covariance] = mvnrmle(Data, Design, 1, [], [1, [1,
Covar0);
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Estimate Standard Errors

StdParameters = mvnrstd(Data, Design, Covariance);

Covariance-Weighted Least Squares with Missing Data
Estimate Parameters

[Parameters, Covariance] = ecmlsrmle(Data, Design, [], [1, [, [],
Covaro0);

Estimate Standard Errors
StdParameters = ecmmvnrstd(Data, Design, Covariance);

Feasible Generalized Least Squares

An ad hoc form of least squares that has surprisingly good properties for
misspecified or nonnormal models is known as feasible generalized least
squares, or FGLS. The basic procedure is to do least-squares regression and
then to do covariance-weighted least-squares regression with the resultant
residual covariance from the first regression.

Feasible Generalized Least Squares Without Missing Data
Estimate Parameters

[Parameters, Covariance] = mvnrmle(Data, Design, 2, 0, 0);

or (to illustrate the FGLS process explicitly)

[Parameters, CovarO] = mvnrmle(Data, Design, 1);
[Parameters, Covariance] = mvnrmle(Data, Design, 1, [], []1, [1,
Covar0);

Estimate Standard Errors

StdParameters = mvnrstd(Data, Design, Covariance);

Feasible Generalized Least Squares with Missing Data
Estimate Parameters
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[Parameters, Covar0] = ecmlsrmle(Data, Design);
[Parameters, Covariance] = ecmlsrmle(Data, Design, [1, [1, [1, [],
Covaro0);

Estimate Standard Errors

StdParameters = ecmmvnrstd(Data, Design, Covariance);

Seemingly Unrelated Regression

Given a multivariate normal regression model in standard form with a

Data matrix and a Design array, it is possible to convert the problem into a
seemingly unrelated regression (SUR) problem by a simple transformation

of the Design array. The main idea of SUR is that instead of having a
common parameter vector over all data series, you have a separate parameter
vector associated with each separate series or with distinct groups of series
that, nevertheless, share a common residual covariance. It is this ability to
aggregate and disaggregate series and to perform comparative tests on each
design that is the power of SUR.

To make the transformation, use the function convert2sur, which converts a
standard-form design array into an equivalent design array to do SUR with
a specified mapping of the series into NUMGROUPS groups. The regression
functions are used in the usual manner, but with the SUR design array
instead of the original design array. Instead of having NUMPARAMS elements,
the SUR output parameter vector has NUMGROUPS of stacked parameter
estimates, where the first NUMPARAMS elements of Parameters contain
parameter estimates associated with the first group of series, the next
NUMPARAMS elements of Parameters contain parameter estimates associated
with the second group of series, and so on. If the model has only one series,
for example, NUMSERIES = 1, then the SUR design array is the same as the
original design array since SUR requires two or more series to generate
distinct parameter estimates.

Given NUMPARAMS parameters and NUMGROUPS groups with a parameter
vector Parameters with NUMGROUPS * NUMPARAMS elements from any of the
regression routines, the following MATLAB code fragment shows how to
print a table of SUR parameter estimates with rows that correspond to each
parameter and columns that correspond to each group or series:

fprintf (1, 'Seemingly Unrelated Regression Parameter
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Estimates\n');
fprintf(1,"’ %s7s 'y, ')
fprintf(1,' Group(%3d) ',1:NumGroups);
fprintf(1,'\n');
for i = 1:NumParams
fprintf (1, %7d ',1i);
ii = 1i;
for j = 1:NumGroups
fprintf(1, '%12g ',Param(ii));
ii = ii + NumParams;
end
fprintf(1,'\n');
end
fprintf(1,'\n');

Seemingly Unrelated Regression Without Missing Data
Form an SUR Design

DesignSUR = convert2sur(Design, Group);
Estimate Parameters

[Parameters, Covariance] = mvnrmle(Data, DesignSUR);
Estimate Standard Errors

StdParameters = mvnrstd(Data, DesignSUR, Covariance);
Seemingly Unrelated Regression with Missing Data
Form an SUR Design

DesignSUR = convert2sur(Design, Group);
Estimate Parameters

[Parameters, Covariance] = ecmmvnrmle(Data, DesignSUR);
Estimate Standard Errors

StdParameters = ecmmvnrstd(Data, DesignSUR, Covariance);
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Mean and Covariance Parameter Estimation

Without missing data, you can estimate the mean of your Data with the
function mean and the covariance with the function cov. Nevertheless, the
function ecmnmle does this for you if it detects an absence of missing values.
Otherwise, it uses the ECM algorithm to handle missing values.

Estimate Parameters

[Mean, Covariance] = ecmnmle(Data);

Estimate Standard Errors

StdMean = ecmnstd(Data, Mean, Covariance);

Troubleshooting Multivariate Normal Regression

This section provides a few pointers to handle various technical and
operational difficulties that might occur.

Biased Estimates

If samples are ignored, the number of samples used in the estimation is

less than NumSamples. Clearly the actual number of samples used must be
sufficient to obtain estimates. In addition, although the model parameters
Parameters (or mean estimates Mean) are unbiased maximum likelihood
estimates, the residual covariance estimate Covariance is biased. To convert
to an unbiased covariance estimate, multiply Covariance by

Count/ (Count — 1)

where Count is the actual number of samples used in the estimation with
Count = NumSamples Note that none of the regression functions perform
this adjustment.

Requirements

The regression functions, particularly the estimation functions, have several
requirements. First, they must have consistent values for NumSamples,
NumSeries, and NumParams. As a general rule, the multivariate normal
regression functions require
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Count#NumSeries < max{NumParams, NumSeries#(NumSeries + 1)/2}

and the least-squares regression functions require

CounrMNumSeries =< NumParams

where Count is the actual number of samples used in the estimation with

Count = NumSamples

Second, they must have enough nonmissing values to converge. Third, they
must have a nondegenerate covariance matrix.

Although some necessary and sufficient conditions can be found in the
references, general conditions for existence and uniqueness of solutions in
the missing-data case do not exist. Nonconvergence is usually due to an
ill-conditioned covariance matrix estimate, which is discussed in greater
detail in “Nonconvergence” on page 5-25.

Slow Convergence

Since worst-case convergence of the ECM algorithm is linear, it is possible
to execute hundreds and even thousands of iterations before termination of
the algorithm. If you are estimating with the ECM algorithm on a regular
basis with regular updates, you can use prior estimates as initial guesses for
the next period’s estimation. This approach often speeds things up since the
default initialization in the regression functions sets the initial parameters b
to zero and the initial covariance C to be the identity matrix.

Other ad hoc approaches are possible although most approaches are
problem-dependent. In particular, for mean and covariance estimation, the
estimation function ecmnmle uses a function ecmninit to obtain an initial
estimate.

Nonrandom Residuals

Simultaneous estimates for parameters b and covariances C require C to be
positive-definite. Consequently, the general multivariate normal regression
routines require nondegenerate residual errors. If you are faced with a
model that has exact results, the least-squares routine ecmlsrmle still
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works, although it provides a least-squares estimate with a singular residual
covariance matrix. The other regression functions will fail.

Nonconvergence

Although the regression functions are robust and work for most “typical”
cases, they can fail to converge. The main failure mode is an ill-conditioned
covariance matrix, where failures are either soft or hard. A soft failure
wanders endlessly toward a nearly singular covariance matrix and can

be spotted if the algorithm fails to converge after about 100 iterations. If
MaxIterations is increased to 500 and display mode is initiated (with no
output arguments), a typical soft failure looks like this.

Progress of ECM Algorithm in ecmnmle
45 T T T T T T

Log-Likelihood

5 1

1] A0 100 160 200 2E0 300 350 400
lteration

This case, which is based on 20 observations of 5 assets with 30% of data
missing, shows that the log-likelihood goes linearly to infinity as the likelihood
function goes to 0. In this case, the function converges but the covariance
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matrix is effectively singular with a smallest eigenvalue on the order of
machine precision (eps).

For the function ecmnmle, a hard error looks like this:

> In ecmninit at 60
In ecmnmle at 140
??? Error using ==> ecmnmle
Full covariance not positive-definite in iteration 218.

From a practical standpoint, if in doubt, test your residual covariance matrix
from the regression routines to ensure that it is positive-definite. This is
important because a soft error has a matrix that appears to be positive-definite
but actually has a near-zero-valued eigenvalue to within machine precision.
To do this with a covariance estimate Covariance, use cond(Covariance),
where any value greater than 1/eps should be considered suspect.

If either type of failure occurs, however, note that the regression routine is
indicating that something is probably wrong with the data. (Even with no
missing data, two time series that are proportional to one another produce a
singular covariance matrix.)

Example of Porifolios with Missing Data

This example illustrates how to use the missing data algorithms for portfolio
optimization and for valuation. This example works with 5 years of daily
total return data for 12 computer technology stocks, with 6 hardware and 6
software companies. The example estimates the mean and covariance matrix
for these stocks, forms efficient frontiers with both a naive approach and the
ECM approach, and compares results.

You can run the example directly with the M-file ecmtechdemo.m.
1 Load the following data file:

load ecmtechdemo
This file contains these three quantities:

® Assets is a cell array of the tickers for the twelve stocks in the example.
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® Datais a 1254-by-12 matrix of 1254 daily total returns for each of the 12
stocks.

® Dates is a 1254-by-1 column vector of the dates associated with the data.
The time period for the data extends from April 19, 2000 to April 18, 2005.

The sixth stock in Assets is Google (GOOG), which started trading on
August 19, 2004. Consequently, all returns before August 20, 2004 are
missing and represented as NaNs. Also, Amazon (AMZN) had a few days
with missing values scattered throughout the past 5 years.

A naive approach to the estimation of the mean and covariance for these 12
assets is to eliminate all days that have missing values for any of the 12
assets. Use the function ecmninit with the nanskip option to do this.

[NaNMean, NaNCovar] = ecmninit(Data, 'nanskip');

Contrast the result of this approach with using all available data and the
function ecmnmle to compute the mean and covariance. First, call ecmnmle
with no output arguments to establish that enough data is available to
obtain meaningful estimates.

ecmnmle(Data);

The following figure shows that, even with almost 87% of the Google data
being NaN values, the algorithm converges after only four iterations.
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w 10 Progress of ECM Algorithm in ecmnmle

32 T T T T T

Log-Likelihood

1
1 1.5 2 25 3 35
lteration

4 Estimate the mean and covariance as computed by ecmnmle.

>> [ECMMean, ECMCovar] = ecmnmle(Data)
ECMMean =

0.0008
0.0008
0.0005
0.0002
0.0011
0.0038
-0.0003
-0.0000
-0.0003
-0.0000
-0.0003
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0.0004

ECMCovar =

.0012
.0005
.0006
.0005
.0005
.0003
.0005
.0003
.0006
.0003
.0005
.0006

OO O0OO0OO0OO0ODO0ODO0OO0OO0OO0oOOo

OO0 00000000 O0OOo

.0005
.0024
.0007
.0006
.0010
.0004
.0005
.0003
.0006
.0004
.0006
.0012

ECMCovar (continued)

.0005
.0005
.0006
.0005
.0005
.0001
.0009
.0003
.0005
.0004
.0005
.0006

OO O0OO0OO0OO0ODO0DO0OO0OO0OO0oOOo

(el elNeNelNelNelNolNeolNolNolNolNo]

.0003
.0003
.0004
.0003
.0003
.0002
.0003
.0005
.0004
.0003
.0004
.0004

.0006
.0007
.0013
.0007
.0007
.0003
.0006
.0004
.0008
.0005
.0008
.0008

[elNelNeolNelNeololNolNolNolNolNolNo

.0006
.0006
.0008
.0007
.0006
.0002
.0005
.0004
.0011
.0005
.0007
.0007

OO O0OO0OO0OO0OO0ODO0O0OO0OO0OOo

.0005
.0006
.0007
.0009
.0006
.0002
.0005
.0003
.0007
.0004
.0005
.0007

OO O0OO0OO0OO0ODO0ODO0OO0OO0OO0oOOo

.0003
.0004
.0005
.0004
.0004
.0001
.0004
.0003
.0005
.0006
.0004
.0005

OO O0OO0OO0OO0ODO0DO0OO0OO0OO0oOOo

OO0 O0OO0OO0OO0ODO0ODO0OO0OO0OO0OOo

[N elNeNelNelNelNeolNeolNoNolNo o]

.0005
.0010
.0007
.0006
.0016
.0006
.0005
.0003
.0006
.0004
.0007
.0011

.0005
.0006
.0008
.0005
.0007
.0003
.0005
.0004
.0007
.0004
.0013
.0007

[elNeNeolNellolNolNolNolNolNolNolNo

[elNeNeolNellololNolNolNolNolNolNo)

.0003
.0004
.0003
.0002
.0006
.0022
.0001
.0002
.0002
.0001
.0003
.0016

.0006
.0012
.0008
.0007
.0011
.0016
.0006
.0004
.0007
.0005
.0007
.0020

5 Given estimates for the mean and covariance of asset returns derived
from the naive and ECM approaches, estimate portfolios, and associated
expected returns and risks on the efficient frontier for both approaches.

[ECMRisk, ECMReturn,

[NaNRisk, NaNReturn, NaNWts]

6 Plot the results on the same graph to illustrate the differences.

ECMWts] =

portopt (ECMMean',ECMCovar,10);
portopt(NaNMean',NaNCovar,10);
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figure(gcf)

plot(ECMRisk,ECMReturn,'-bo', 'MarkerFaceColor','b', 'MarkerSize', 3);
hold all

plot(NaNRisk,NaNReturn,'-ro', 'MarkerFaceColor','r', 'MarkerSize', 3);
title('\bfMean-Variance Efficient Frontiers under Various Assumptions');
legend('ECM', 'NaN', 'Location', 'SouthEast');

xlabel('\bfStd. Dev. of Returns');

ylabel('\bfMean of Returns');

hold off

" 1dﬂean-\.'ariance Efficient Frontiers under Yarious Assumptions

Mean of Returns
I
T
1

—=— ECM

—=— hlaly

I:I 1 1 1 1 1 1 1
ooos 001 0015 002 002 003 0035 004 0045 005
Std. Dev. of Returns

7 Clearly, the naive approach is optimistic about the risk-return trade-offs
for this universe of 12 technology stocks. The proof, however, lies in the
portfolio weights. To view the weights, enter

Assets
ECMWts
NaNWts
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which generates

>> Assets
ans =
"AAPL' "AMZN'
>> ECMWts
ans =
0.0358 0.0011
0.0654 0.0110
0.0923 0.0194
0.1165 0.0264
0.1407 0.0334
0.1648 0.04083
0.1755 0.0457
0.1845 0.0509
0.1093 0.0174
0 0
>> NaNWts
ans =
-0.0000 0.0000
0.0576 -0.0000
0.1248 -0.0000
0.1969 -0.0000
0.2690 -0.0000
0.3414 0.0000
0.4235 0.0000
0.5245 0.0000
0.6269 -0.0000
1.0000 -0.0000
Assets (continued)

'CSCO'

[N elNelelelNolNolNolNolNo]

.0000
.0000
.0000
.0000
.0000
.0000
.0000
.0000
.0000
.0000

.0000
-0.
-0.
.0000
-0.
-0.
.0000
-0.
-0.
.0000

0000
0000

0000
0000

0000
0000

'"DELL'

o O oo

o O oo

.0000
.0000
.0000
.0000

.0000
.0000
.0000
.0000

.1185
.1219
.0952
.0529
.0105
.0000
.0000
.0000
.0000
.0000

"EBAY'

0.0000
0.0000
0.0000
0.0000
0.0000
0.0000
0.0000
-0.0000

0.0000

0.0000
-0.0000
-0.0000

0.0000
-0.0000
-0.0000
-0.0000
-0.0000
-0.0000

'GO0G'

.0989
.1877
.2784
.3712
.4639
.5566
.6532
.7502
.8733
.0000

- OO0 000000 O0o

.0522
.0854
.1195
.1551
.1906
.2265
.2639
.3034
.3425

[eNelNelNelelNolNolNolNo]
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"HPQ' "IBM' "INTC' '"MSFT' "ORCL' "YHOO'

ECMWts (continued)

0.0535 0.4676 0.0000 0.3431 -0.0000 0.0000
0.0179 0.3899 -0.0000 0.3282 0.0000 -0.0000

0 0.3025 -0.0000 0.3074 0.0000 -0.0000
0.0000 0.2054 -0.0000 0.2806 0.0000 0.0000
0.0000 0.1083 -0.0000 0.2538 -0.0000 0.0000
0.0000 0.0111 -0.0000 0.2271 -0.0000 0.0000
0.0000 0.0000 -0.0000 0.1255 -0.0000 0.0000
0.0000 0 -0.0000 0.0143 -0.0000 -0.0000
0.0000 -0.0000 -0.0000 -0.0000 -0.0000 0.0000
0.0000 -0.0000 -0.0000 -0.0000 -0.0000 0.0000

NaNWts (continued)

0.0824 0.1779 0.0000 0.5691 -0.0000 0.0000
0.1274 0.0460 0.0000 0.5617 -0.0000 -0.0000
0.1674 -0.0000 0.0000 0.4802 0.0129 -0.0000
0.2056 -0.0000 0.0000 0.3621 0.0274 -0.0000
0.2438 -0.0000 0.0000 0.2441 0.0419 -0.0000
0.2782 -0.0000 0.0000 0.0988 0.0551 -0.0000
0.2788 -0.0000 0.0000 -0.0000 0.0337 -0.0000
0.1721 -0.0000 0.0000 -0.0000 -0.0000 -0.0000
0.0306 -0.0000 0.0000 0.0000 0 -0.0000

0 0.0000 0.0000 -0.0000 -0.0000 -0.0000

The naive portfolios in NaNWts tend to favor Apple® Computer (AAPL),
which happened to do well over the period from the Google IPO to the
end of the estimation period, while the ECM portfolios in ECMWts tend
to underweight Apple Computer and to recommend increased weights in
Google relative to the naive weights.

To evaluate the impact of estimation error and, in particular, the effect of
missing data, use ecmnstd to calculate standard errors. Although it is
possible to estimate the standard errors for both the mean and covariance,
the standard errors for the mean estimates alone are usually the main
quantities of interest.
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StdMeanF = ecmnstd(Data,ECMMean,ECMCovar, 'fisher');

9 Calculate standard errors that use the data-generated Hessian matrix
(which accounts for the possible loss of information due to missing data)
with the option HESSIAN.

StdMeanH = ecmnstd(Data,ECMMean,ECMCovar, 'hessian');

The difference in the standard errors shows the increase in uncertainty
of estimation of asset expected returns due to missing data. This can be
viewed by entering

Assets

StdMeanH'

StdMeanF'

StdMeanH' - StdMeanF'

The two assets with missing data, AMZN and GOOG, are the only assets
to have differences due to missing information.
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Valuation with Missing Data

In this section...

“Introduction” on page 5-34

“Capital Asset Pricing Model” on page 5-34

“Estimation of the CAPM” on page 5-35

“Estimation with Missing Data” on page 5-36

“Estimation of Some Technology Stock Betas” on page 5-36
“Grouped Estimation of Some Technology Stock Betas” on page 5-39

“References” on page 5-42

Introduction

The Capital Asset Pricing Model (CAPM) is a venerable but often maligned
tool to characterize comovements between asset and market prices. Although
many issues arise in CAPM implementation and interpretation, one problem
that practitioners face is to estimate the coefficients of the CAPM with
incomplete stock price data.

This example shows how to use the missing data regression functions to
estimate the coefficients of the CAPM. You can run the example directly with
the M-file CAPMdemo . m.

Capital Asset Pricing Model

Given a host of assumptions that can be found in the references (see

Sharpe [11], Lintner [6], Jarrow [5], and Sharpe, et. al. [12]), the CAPM
concludes that asset returns have a linear relationship with market returns.
Specifically, given the return of all stocks that constitute a market denoted as
M and the return of a riskless asset denoted as C, the CAPM states that the
return of each asset R, in the market has the expectational form

E[RL] =0y +C+BZ(E[M]_C)
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for assets i = 1, ..., n, where B, is a parameter that specifies the degree of
comovement between a given asset and the underlying market. In other
words, the expected return of each asset is equal to the return on a riskless
asset plus a risk-adjusted expected market return net of riskless asset

returns. The collection of parameters F1: =*-» I'j’n is called asset betas.

Note that the beta of an asset has the form
cov(R,, M)
i var(M)

which is the ratio of the covariance between asset and market returns divided
by the variance of market returns. If an asset has a beta = 1, the asset is
said to move with the market; if an asset has a beta > 1, the asset is said to
be more volatile than the market. Conversely, if an asset has a beta < 1, the
asset is said to be less volatile than the market.

Estimation of the CAPM

The standard CAPM model is a linear model with additional parameters
for each asset to characterize residual errors. For each of n assets with m

samples of observed asset returns =" k. i, market returns M E, and riskless
asset returns —k, the estimation model has the form

Ry ;=0; +Cp, +B;(Mp, - Cp)+ Vy;

]

for samples k=1, ..., m and assets i = 1, ..., n, where ~'i is a parameter that

specifies the nonsystematic return of an asset, |3:L is the asset beta, and = k.1
is the residual error for each asset with associated random variable " i.

The collection of parameters 015 -+ Oy are called asset alphas. The strict

form of the CAPM specifies that alphas must be zero and that deviations from
zero are the result of temporary disequilibria. In practice, however, assets
may have nonzero alphas, where much of active investment management is
devoted to the search for assets with exploitable nonzero alphas.
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To allow for the possibility of nonzero alphas, the estimation model generally
seeks to estimate alphas and to perform tests to determine if the alphas are
statistically equal to zero.

The residual errors V; are assumed to have moments

E[V,]=10

and

oS

for assets I, J = 1, ..., 1 where the parameters S:I.:L1 - nn are called

residual or nonsystematic variances/covariances.

The square root of the residual variance of each asset, for example, SQI‘t[Su}
fort =1, ..., M is said to be the residual or nonsystematic risk of the
asset since it characterizes the residual variation in asset prices that are not
explained by variations in market prices.

Estimation with Missing Data

Although betas can be estimated for companies with sufficiently long histories
of asset returns, it is difficult to estimate betas for recent IPOs. However, if
a collection of sufficiently observable companies exists that can be expected
to have some degree of correlation with the new company’s stock price
movements, that is, companies within the same industry as the new company,
it 1s possible to obtain imputed estimates for new company betas with the
missing-data regression routines.

Estimation of Some Technology Stock Betas

To illustrate how to use the missing-data regression routines, estimate betas
for 12 technology stocks, where a single stock (GOOG) 1s an IPO.

1 Load dates, total returns, and ticker symbols for the 12 stocks from the
MAT-file CAPMuniverse.

load CAPMuniverse
whos Assets Data Dates
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Name Size
Assets 1x14
Data 1471x14
Dates 1471x1

Bytes

164752
11768

Class

952 cell array
double array
double array

Grand total is 22135 elements using 177472 bytes

The assets in the model have the following symbols, where the last two
series are proxies for the market and the riskless asset:

Assets(1:7)
Assets(8:14)

ans =

"AAPL' "AMZN' 'CSco’ 'DELL' "EBAY'

ans =

"IBM' "INTC' '"MSFT' 'ORCL"' "YHOO'

'GO0G" "HPQ'

'MARKET' 'CASH'

The data covers the period from January 1, 2000 to November 7, 2005 with
daily total returns. Two stocks in this universe have missing values that
are represented by NaNs. One of the two stocks had an IPO during this
period and, consequently, has significantly less data than the other stocks.

2 Compute separate regressions for each stock, where the stocks with missing
data will have estimates that reflect their reduced observability.

[NumSamples, NumSeries] = size(Data);
NumAssets = NumSeries - 2;

StartDate = Dates(1);
EndDate = Dates(end);

fprintf (1, 'Separate regressions with ');

fprintf (1, 'daily total return data from %s to %s ..

datestr(StartDate,1),datestr(EndDate,1));

Anty,oL
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fprintf(1,' %4s %-20s %-20s %-20s\n','','Alpha','Beta','Sigma');
fprintf(1,' ---- --ccieiiiiii o Y
FPrintf (1, ---mmm e e \n');

for i = 1:NumAssets

% Set up separate asset data and design matrices
TestData = zeros(NumSamples,1);
TestDesign = zeros(NumSamples,2);

TestData(:) = Data(:,i) - Data(:,14);
TestDesign(:,1) = 1.0;
TestDesign(:,2) = Data(:,13) - Data(:,14);

% Estimate CAPM for each asset separately
[Param, Covar] = ecmmvnrmle(TestData, TestDesign);

% Estimate ideal standard errors for covariance parameters
[StdParam, StdCovar] = ecmmvnrstd(TestData, TestDesign,
Covar, 'fisher');

% Estimate sample standard errors for model parameters
StdParam = ecmmvnrstd(TestData, TestDesign, Covar, 'hessian');

% Set up results for output
Alpha = Param(1);
Beta = Param(2);
Sigma = sqrt(Covar);

StdAlpha = StdParam(1);
StdBeta = StdParam(2);
StdSigma = sqrt(StdCovar);

% Display estimates
fprintf(' %4s %9.4f (%8.4F) %9.4f (%8.4f) %9.4f (%8.4f)\n',
Assets{i},Alpha(1),abs(Alpha(1)/StdAlpha(1)),
Beta(1),abs(Beta(1)/StdBeta(1)),Sigma(1),StdSigma(1));
end

This code fragment generates the following table.
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Separate regressions with daily total return data from 03-Jan-2000
to 07-Nov-2005 ...

Alpha Beta Sigma
AAPL 0.0012 ( 1.3882) 1.2294 ( 17.1839) 0.0322 ( 0.0062)
AMZN 0.0006 ( 0.5326) 1.3661 ( 13.6579) 0.0449 ( 0.0086)
CSCO  -0.0002 ( 0.2878) 1.5653 ( 23.6085) 0.0298 ( 0.0057)
DELL  -0.0000 ( 0.0368) 1.2594 ( 22.2164) 0.0255 ( 0.0049)
EBAY 0.0014 ( 1.4326) 1.3441 ( 16.0732) 0.0376 ( 0.0072)
GOOG 0.0046 ( 3.2107) 0.3742 ( 1.7328) 0.0252 ( 0.0071)
HPQ 0.0001 ( 0.1747) 1.3745 ( 24.2390) 0.0255 ( 0.0049)
IBM -0.0000 ( 0.0312) 1.0807 ( 28.7576) 0.0169 ( 0.0032)
INTC 0.0001 ( 0.1608) 1.6002 ( 27.3684) 0.0263 ( 0.0050)
MSFT  -0.0002 ( 0.4871) 1.1765 ( 27.4554) 0.0193 ( 0.0037)
ORCL 0.0000 ( 0.0389) 1.5010 ( 21.1855) 0.0319 ( 0.0061)
YHOO 0.0001 ( 0.1282) 1.6543 ( 19.3838) 0.0384 ( 0.0074)

The Alpha column contains alpha estimates for each stock that are near
zero as expected. In addition, the t-statistics (which are enclosed in
parentheses) generally reject the hypothesis that the alphas are nonzero
at the 99.5% level of significance.

The Beta column contains beta estimates for each stock that also have
t-statistics enclosed in parentheses. For all stocks but GOOG, the
hypothesis that the betas are nonzero is accepted at the 99.5% level of
significance. It seems, however, that GOOG does not have enough data
to obtain a meaningful estimate for beta since its t-statistic would imply
rejection of the hypothesis of a nonzero beta.

The Sigma column contains residual standard deviations, that is, estimates

for nonsystematic risks. Instead of t-statistics, the associated standard
errors for the residual standard deviations are enclosed in parentheses.

Grouped Estimation of Some Technology Stock Betas

To estimate stock betas for all 12 stocks, set up a joint regression model that
groups all 12 stocks within a single design. (Since each stock has the same
design matrix, this model is actually an example of seemingly unrelated
regression.) The routine to estimate model parameters is ecmmvnrmle, and
the routine to estimate standard errors is ecmmvnrstd.
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Because GOOG has a significant number of missing values, a direct use of
the missing data routine ecmmvnrmle takes 482 iterations to converge. This
can take a long time to compute. For the sake of brevity, the parameter and
covariance estimates after the first 480 iterations are contained in a MAT-file
and are used as initial estimates to compute stock betas.

load CAPMgroupparam
whos ParamO CovaroO

Name Size Bytes Class
CovaroO 12x12 1152 double array
ParamO 24x1 192 double array

Grand total is 168 elements using 1344 bytes

Now estimate the parameters for the collection of 12 stocks.

fprintf(1,'\n");
fprintf (1, 'Grouped regression with ');

fprintf (1, 'daily total return data from %s to %s ...\n',
datestr(StartDate,1),datestr(EndDate,1));

fprintf(1,' %4s %-20s %-20s %-20s\n','','Alpha', 'Beta','Sigma');

fprintf(1,' ---- ---ccmmiiia i ")

fprintf(1, ' ---ccmmmmii i \n');

NumParams = 2 * NumAssets;

% Set up grouped asset data and design matrices
TestData = zeros(NumSamples, NumAssets);
TestDesign = cell(NumSamples, 1);

Design = zeros(NumAssets, NumParams);

for k = 1:NumSamples
for i = 1:NumAssets
TestData(k,i) = Data(k,i) - Data(k,14);
Design(i,2*i - 1) = 1.0;
Design(i,2*i) = Data(k,13) - Data(k,14);
end
TestDesign{k} = Design;
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end

% Estimate CAPM for all assets together with initial parameter

% estimates

[Param, Covar] = ecmmvnrmle(TestData, TestDesign, [1, [], [],---
Param0, Covar0);

% Estimate ideal standard errors for covariance parameters
[StdParam, StdCovar] = ecmmvnrstd(TestData, TestDesign, Covar,...
'fisher');

% Estimate sample standard errors for model parameters
StdParam = ecmmvnrstd(TestData, TestDesign, Covar, 'hessian');

% Set up results for output
Alpha = Param(1:2:end-1);
Beta = Param(2:2:end);
Sigma = sqrt(diag(Covar));

StdAlpha = StdParam(1:2:end-1);
StdBeta = StdParam(2:2:end);
StdSigma = sqrt(diag(StdCovar));

% Display estimates

for i = 1:NumAssets
fprintf(' %4s %9.4f (%8.4F) %9.4f (%8.4f) %9.4f (%8.4f)\n',
Assets{i},Alpha(i),abs(Alpha(i)/StdAlpha(i)),
Beta(i),abs(Beta(i)/StdBeta(i)),Sigma(i),StdSigma(i));

end

This code fragment generates the following table.

Grouped regression with daily total return data from 03-Jan-2000
to 07-Nov-2005 ...

Alpha Beta Sigma
1.3882) 1.2294 ( 17.1839) 0.0322 ( 0.0062)
0.6086) 1.3673 ( 13.6427) 0.0450 ( 0.0086)
0.2878) 1.5653 ( 23.6085) 0.0298 ( 0.0057)
0.0368) 1.2594 ( 22.2164) 0.0255 ( 0.0049)
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EBAY  0.0014 ( 1.4326) 1.3441 ( 16.0732) 0.0376 ( 0.0072)
GOOG  0.0041 ( 2.8907) 0.6173 ( 3.1100) 0.0337 ( 0.0065)
HPQ 0.0001 ( 0.1747) 1.3745 ( 24.2390) 0.0255 ( 0.0049)
IBM -0.0000 ( 0.0312) 1.0807 ( 28.7576) 0.0169 ( 0.0032)
INTC  0.0001 ( 0.1608) 1.6002 ( 27.3684) 0.0263 ( 0.0050)
MSFT  -0.0002 ( 0.4871) 1.1765 ( 27.4554) 0.0193 ( 0.0037)
ORCL  0.0000 ( 0.0389) 1.5010 ( 21.1855) 0.0319 ( 0.0061)
YHOO  0.0001 ( 0.1282) 1.6543 ( 19.3838) 0.0384 ( 0.0074)

Although the results for complete-data stocks are the same, note that the beta
estimates for AMZN and GOOG (the two stocks with missing values) are
different from the estimates derived for each stock separately. Since AMZN
has few missing values, the differences in the estimates are small. With
GOOG, however, the differences are more pronounced.

The t-statistic for the beta estimate of GOOG is now significant at the 99.5%
level of significance. Note, however, that the t-statistics for beta estimates
are based on standard errors from the sample Hessian which, in contrast to
the Fisher information matrix, accounts for the increased uncertainty in an
estimate due to missing values. If the t-statistic is obtained from the more
optimistic Fisher information matrix, the t-statistic for GOOG is 8.25. Thus,
despite the increase in uncertainty due to missing data, GOOG nonetheless
has a statistically significant estimate for beta.

Finally, note that the beta estimate for GOOG is 0.62 —a value that may
require some explanation. Although the market has been volatile over this
period with sideways price movements, GOOG has steadily appreciated in
value. Consequently, it is less tightly correlated with the market, implying
that it is less volatile than the market (beta < 1).

References
[1] Caines, Peter E. Linear Stochastic Systems. John Wiley & Sons, Inc., 1988.

[2] Cramér, Harald. Mathematical Methods of Statistics. Princeton
University Press, 1946.



Valuation with Missing Data

[3] Dempster, A.P, N.M. Laird, and D.B Rubin. “Maximum Likelihood from
Incomplete Data via the EM Algorithm,”Journal of the Royal Statistical
Society, Series B, Vol. 39, No. 1, 1977, pp. 1-37.

[4] Greene, William H. Econometric Analysis, 5th ed., Pearson Education,
Inc., 2003.

[6] Jarrow, R.A. Finance Theory, Prentice-Hall, Inc., 1988.
[6] Lintner, J. “The Valuation of Risk Assets and the Selection of Risky
Investments in Stocks,” Review of Economics and Statistics, Vol. 14, 1965,

pp. 13-37.

[7] Little, Roderick J. A and Donald B. Rubin. Statistical Analysis with
Missing Data, 2nd ed., John Wiley & Sons, Inc., 2002.

[8] Meng, Xiao-Li and Donald B. Rubin. “Maximum Likelihood Estimation
via the ECM Algorithm,” Biometrika, Vol. 80, No. 2, 1993, pp. 267-278.

[9] Sexton, Joe and Anders Rygh Swensen. “ECM Algorithms that Converge
at the Rate of EM,” Biometrika, Vol. 87, No. 3, 2000, pp. 651-662.

[10] Shafer, J. L. Analysis of Incomplete Multivariate Data, Chapman &
Hall/CRC, 1997.

[11] Sharpe, W. F. “Capital Asset Prices: A Theory of Market Equilibrium
Under Conditions of Risk,” Journal of Finance, Vol. 19, 1964, pp. 425-442.

[12] Sharpe, W. F., G. J. Alexander, and J. V. Bailey. Investments, 6th ed.,
Prentice-Hall, Inc., 1999.

5-43



5 Regression with Missing Data

5-44



Solving Sample Problems

¢ “Introduction” on page 6-2
¢ “Common Problems in Finance” on page 6-3

¢ “Producing Graphics with the Toolbox” on page 6-21



6 Solving Sample Problems

Introduction

This section shows how Financial Toolbox functions solve real-world problems.
The examples ship with the toolbox as M-files. Try them by entering the
commands directly or by executing the M-files.

This chapter contains two major topics:

¢ “Common Problems in Finance” on page 6-3

Shows how the toolbox solves real-world financial problems, specifically:

“Sensitivity of Bond Prices to Changes in Interest Rates” on page 6-3

“Constructing a Bond Portfolio to Hedge Against Duration and
Convexity” on page 6-6

“Sensitivity of Bond Prices to Parallel Shifts in the Yield Curve” on
page 6-9

“Constructing Greek-Neutral Portfolios of European Stock Options” on
page 6-14

“Term Structure Analysis and Interest Rate Swap Pricing” on page 6-18

¢ “Producing Graphics with the Toolbox” on page 6-21

Shows how the toolbox produces presentation-quality graphics by solving
these problems:

“Plotting an Efficient Frontier” on page 6-21
“Plotting Sensitivities of an Option” on page 6-24
“Plotting Sensitivities of a Portfolio of Options” on page 6-26
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Common Problems in Finance

In this section...

“Sensitivity of Bond Prices to Changes in Interest Rates” on page 6-3

“Constructing a Bond Portfolio to Hedge Against Duration and Convexity”
on page 6-6

“Sensitivity of Bond Prices to Parallel Shifts in the Yield Curve” on page 6-9

“Sensitivity of Bond Prices to Nonparallel Shifts in the Yield Curve” on
page 6-12

“Constructing Greek-Neutral Portfolios of European Stock Options” on
page 6-14

“Term Structure Analysis and Interest Rate Swap Pricing” on page 6-18

Sensitivity of Bond Prices to Changes in Interest Rates

Macaulay and modified duration measure the sensitivity of a bond’s price

to changes in the level of interest rates. Convexity measures the change

in duration for small shifts in the yield curve, and thus measures the
second-order price sensitivity of a bond. Both measures can gauge the
vulnerability of a bond portfolio’s value to changes in the level of interest rates.

Alternatively, analysts can use duration and convexity to construct a bond
portfolio that is partly hedged against small shifts in the term structure. If you
combine bonds in a portfolio whose duration is zero, the portfolio is insulated,
to some extent, against interest rate changes. If the portfolio convexity is also
zero, this insulation is even better. However, since hedging costs money or
reduces expected return, you need to know how much protection results from
hedging duration alone compared to hedging both duration and convexity.

This example demonstrates a way to analyze the relative importance of
duration and convexity for a bond portfolio using some of the SIA-compliant
bond functions in Financial Toolbox software. Using duration, it constructs
a first-order approximation of the change in portfolio price to a level shift
in interest rates. Then, using convexity, it calculates a second-order
approximation. Finally, it compares the two approximations with the true
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price change resulting from a change in the yield curve. The example M-file is
ftspexi.m.

Step 1. Define three bonds using values for the settlement date, maturity
date, face value, and coupon rate. For simplicity, accept default values for the
coupon payment periodicity (semiannual), end-of-month payment rule (rule
in effect), and day-count basis (actual/actual). Also, synchronize the coupon
payment structure to the maturity date (no odd first or last coupon dates).
Any inputs for which defaults are accepted are set to empty matrices ([ ])

as placeholders where appropriate.

Settle = '19-Aug-1999';

Maturity = ['17-Jun-2010"'; '09-Jun-2015'; '14-May-2025'];
Face = [100; 100; 1000];

CouponRate = [0.07; 0.06; 0.045];

Also, specify the yield curve information.

Yields = [0.05; 0.06; 0.065];

Step 2. Use Financial Toolbox functions to calculate the price, modified
duration in years, and convexity in years of each bond.

The true price is quoted (clean) price plus accrued interest.

[CleanPrice, AccruedInterest] = bndprice(Yields, CouponRate,...
Settle, Maturity, 2, 0, [], [], [I1, [], [], Face);

Durations = bnddury(Yields, CouponRate, Settle, Maturity, 2, 0,...
(1, 11, 11, 11, [1, Face);

Convexities = bndconvy(Yields, CouponRate, Settle, Maturity, 2, 0,...
(1, 11, 11, [1, [1, Face);

Prices = CleanPrice + AccruedInterest;

Step 3. Choose a hypothetical amount by which to shift the yield curve (here,
0.2 percentage point or 20 basis points).

dY = 0.002;
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Weight the three bonds equally, and calculate the actual quantity of each
bond in the portfolio, which has a total value of $100,000.

PortfolioPrice 100000;
PortfolioWeights ones(3,1)/3;
PortfolioAmounts = PortfolioPrice * PortfolioWeights ./ Prices;

Step 4. Calculate the modified duration and convexity of the portfolio. Note
that the portfolio duration or convextity is a weighted average of the durations
or convexities of the individual bonds. Calculate the first- and second-order
approximations of the percent price change as a function of the change in the
level of interest rates.

PortfolioDuration = PortfolioWeights' * Durations;
PortfolioConvexity = PortfolioWeights' * Convexities;
PercentApprox1 = -PortfolioDuration * dY * 100;
PercentApprox2 = PercentApprox1l + ...

PortfolioConvexity*dY~2*100/2.0;

Step 5. Estimate the new portfolio price using the two estimates for the
percent price change.

PriceApprox1 = PortfolioPrice +
PercentApprox1 * PortfolioPrice/100;

PriceApprox2 = PortfolioPrice +
PercentApprox2 * PortfolioPrice/100;

Step 6. Calculate the true new portfolio price by shifting the yield curve.
[CleanPrice, AccruedInterest] = bndprice(Yields + dY,...
CouponRate, Settle, Maturity, 2, 0, [1, [1, []1, [1, [1,..-
Face);

NewPrice = PortfolioAmounts' * (CleanPrice + AccruedInterest);

Step 7. Compare the results. The analysis results are as follows (verify these
results by running the example M-file ftspex1.m):

¢ The original portfolio price was $100,000.
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e The yield curve shifted up by 0.2 percentage point or 20 basis points.

® The portfolio duration and convexity are 10.3181 and 157.6346,
respectively. These will be needed for “Constructing a Bond Portfolio to
Hedge Against Duration and Convexity” on page 6-6.

® The first-order approximation, based on modified duration, predicts the
new portfolio price (PriceApprox1) will be $97,936.37.

® The second-order approximation, based on duration and convexity, predicts
the new portfolio price (PriceApprox2) will be $97,967.90.

® The true new portfolio price (NewPrice) for this yield curve shift is
$97,967.51.

® The estimate using duration and convexity is quite good (at least for this
fairly small shift in the yield curve), but only slightly better than the
estimate using duration alone. The importance of convexity increases as
the magnitude of the yield curve shift increases. Try a larger shift (dY)
to see this effect.

The approximation formulas in this example consider only parallel shifts in
the term structure, because both formulas are functions of dY, the change
in yield. The formulas are not well-defined unless each yield changes by
the same amount. In actual financial markets, changes in yield curve level
typically explain a substantial portion of bond price movements. However,
other changes in the yield curve, such as slope, may also be important and
are not captured here. Also, both formulas give local approximations whose
accuracy deteriorates as dY increases in size. You can demonstrate this by
running the program with larger values of dY.

Constructing a Bond Portfolio to Hedge Against
Duration and Convexity

This example constructs a bond portfolio to hedge the portfolio of “Sensitivity
of Bond Prices to Changes in Interest Rates” on page 6-3 It assumes a long
position in (holding) the portfolio, and that three other bonds are available
for hedging. It chooses weights for these three other bonds in a new portfolio
so that the duration and convexity of the new portfolio match those of the
original portfolio. Taking a short position in the new portfolio, in an amount
equal to the value of the first portfolio, partially hedges against parallel shifts
in the yield curve.
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Recall that portfolio duration or convexity is a weighted average of the
durations or convexities of the individual bonds in a portfolio. As in the
previous example, this example uses modified duration in years and convexity
in years. The hedging problem therefore becomes one of solving a system of
linear equations, which is an easy to do in MATLAB software. The M-file for
this example is ftspex2.m.

Step 1. Define three bonds available for hedging the original portfolio.
Specify values for the settlement date, maturity date, face value, and coupon
rate. For simplicity, accept default values for the coupon payment periodicity
(semiannual), end-of-month payment rule (rule in effect), and day-count
basis (actual/actual). Also, synchronize the coupon payment structure to the
maturity date (that is, no odd first or last coupon dates). Set any inputs for
which defaults are accepted to empty matrices ([ ]) as placeholders where
appropriate. The intent is to hedge against duration and convexity and
constrain total portfolio price.

Settle = '"19-Aug-1999"';

Maturity = ['15-Jun-2005"'; '02-0ct-2010'; 'O1-Mar-2025'];
Face = [500; 1000; 250];

CouponRate = [0.07; 0.066; 0.08];

Also, specify the yield curve for each bond.

Yields = [0.06; 0.07; 0.075];

Step 2. Use Financial Toolbox functions to calculate the price, modified
duration in years, and convexity in years of each bond.

The true price is quoted (clean price plus accrued interest.

[CleanPrice, AccruedInterest] = bndprice(Yields,CouponRate,...
Settle, Maturity, 2, 0, [], [1, [1, [1, [1, Face);

Durations = bnddury(Yields, CouponRate, Settle, Maturity,...
2, 0, [1, [1, [1, [1, [1, Face);

Convexities = bndconvy(Yields, CouponRate, Settle,...
Maturity, 2, 0, [1, [1, [I, [1, []1, Face);

Prices = CleanPrice + AccruedInterest;
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Step 3. Set up and solve the system of linear equations whose solution is
the weights of the new bonds in a new portfolio with the same duration

and convexity as the original portfolio. In addition, scale the weights to

sum to 1; that is, force them to be portfolio weights. You can then scale this
unit portfolio to have the same price as the original portfolio. Recall that

the original portfolio duration and convexity are 10.3181 and 157.6346,
respectively. Also, note that the last row of the linear system ensures that the
sum of the weights is unity.

A = [Durations'
Convexities'
11 1];

b =1 10.3181
157.6346

11;
Weights = A\b;

Step 4. Compute the duration and convexity of the hedge portfolio, which
should now match the original portfolio.

PortfolioDuration Weights' * Durations;
PortfolioConvexity = Weights' * Convexities;

Step 5. Finally, scale the unit portfolio to match the value of the original
portfolio and find the number of bonds required to insulate against small
parallel shifts in the yield curve.

PortfolioValue = 100000;
HedgeAmounts Weights ./ Prices * PortfolioValue;

Step 6. Compare the results. (Verify the analysis results by running the
example M-file ftspex2.m.)

® Asrequired, the duration and convexity of the new portfolio are 10.3181
and 157.6346, respectively.

¢ The hedge amounts for bonds 1, 2, and 3 are -57.37, 71.70, and 216.27,
respectively.
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Notice that the hedge matches the duration, convexity, and value ($100,000)
of the original portfolio. If you are holding that first portfolio, you can hedge
by taking a short position in the new portfolio.

Just as the approximations of the first example are appropriate only for small
parallel shifts in the yield curve, the hedge portfolio is appropriate only for
reducing the impact of small level changes in the term structure.

Sensitivity of Bond Prices to Parallel Shifts in the
Yield Curve

Often bond portfolio managers want to consider more than just the sensitivity
of a portfolio’s price to a small shift in the yield curve, particularly if the
investment horizon is long. This example shows how MATLAB software can
help you to visualize the price behavior of a portfolio of bonds over a wide
range of yield curve scenarios, and as time progresses toward maturity.

This example uses Financial Toolbox bond pricing functions to evaluate the
impact of time-to-maturity and yield variation on the price of a bond portfolio.
It plots the portfolio value and shows the behavior of bond prices as yield and
time vary. This example M-file is ftspex3.m.

Step 1. Specify values for the settlement date, maturity date, face value,
coupon rate, and coupon payment periodicity of a four-bond portfolio. For
simplicity, accept default values for the end-of-month payment rule (rule
in effect) and day-count basis (actual/actual). Also, synchronize the coupon
payment structure to the maturity date (no odd first or last coupon dates).
Any inputs for which defaults are accepted are set to empty matrices ([ ])
as placeholders where appropriate.

Settle = '15-dan-1995"';

Maturity = datenum(['03-Apr-2020'; '14-May-2025"';
'09-Jun-2019'; '25-Feb-2019']);

Face = [1000; 1000; 1000; 1000];

CouponRate = [0; 0.05; 0; 0.055];

Periods = [0; 2; 0; 2];

Also, specify the points on the yield curve for each bond.

Yields = [0.078; 0.09; 0.075; 0.085];
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Step 2. Use Financial Toolbox functions to calculate the true bond prices as
the sum of the quoted price plus accrued interest.

[CleanPrice, AccruedInterest] = bndprice(Yields,...
CouponRate,Settle, Maturity, Periods,...
(1, £1, 11, (1, [1, [1, Face);

Prices = CleanPrice + AccruedInterest;

Step 3. Assume the value of each bond is $25,000, and determine the
quantity of each bond such that the portfolio value is $100,000.

BondAmounts = 25000 ./ Prices;

Step 4. Compute the portfolio price for a rolling series of settlement dates
over a range of yields. The evaluation dates occur annually on January 15,
beginning on 15-Jan-1995 (settlement) and extending out to 15-Jan-2018.
Thus, this step evaluates portfolio price on a grid of time of progression (dT)
and interest rates (dY).

dy = -0.05:0.005:0.05; % Yield changes
D = datevec(Settle); % Get date components
dt = datenum(D(1):2018, D(2), D(3)); % Get evaluation dates

[dT, dY] = meshgrid(dt, dy); % Create grid
NumTimes = length(dt); % Number of time steps
NumYields = 1length(dy); % Number of yield changes

NumBonds length(Maturity); % Number of bonds

% Preallocate vector
Prices = zeros(NumTimes*NumYields, NumBonds);

Now that the grid and price vectors have been created, compute the price of
each bond in the portfolio on the grid one bond at a time.

for i = 1:NumBonds

[CleanPrice, AccruedInterest] = bndprice(Yields(i)+...
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dY(:), CouponRate(i), dT(:), Maturity(i), Periods(i),...
(1, 1, 1, 1, [1, [1, Face(i));

Prices(:,1) = CleanPrice + AccruedInterest;
end

Scale the bond prices by the quantity of bonds.

Prices = Prices * BondAmounts;

Reshape the bond values to conform to the underlying evaluation grid.

Prices = reshape(Prices, NumYields, NumTimes);

Step 5. Plot the price of the portfolio as a function of settlement date and
a range of yields, and as a function of the change in yield (dY). This plot
illustrates the interest rate sensitivity of the portfolio as time progresses
(dT), under a range of interest rate scenarios. With the following graphics
commands, you can visualize the three-dimensional surface relative to the
current portfolio value (that is, $100,000).

figure % Open a new figure window
surf(dt, dy, Prices) % Draw the surface

Add the base portfolio value to the existing surface plot.

hold on % Add the current value for reference
basemesh = mesh(dt, dy, 100000*ones(NumYields, NumTimes));

Make it transparent, plot it so the price surface shows through, and draw a
box around the plot.

set(basemesh, 'facecolor', 'none');
set(basemesh, 'edgecolor'; 'm');
set(gca, 'box', 'on');

Plot the x-axis using two-digit year (YY format) labels for ticks.

dateaxis('x', 11);
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Add axis labels and set the three-dimensional viewpoint. MATLAB produces
the figure.

xlabel('Evaluation Date (YY Format)');
ylabel('Change in Yield');
zlabel('Portfolio Price');

hold off

view(-25,25);

4
@ : : 5 -‘!,-fr'léf’lfi’}?;
Ez :
%
5
&y

Ol‘:-
0.05

005 g

Change in Yield .
Ewvaluation Date (Y Format)

MATLAB three-dimensional graphics allow you to visualize the interest

rate risk experienced by a bond portfolio over time. This example assumed
parallel shifts in the term structure, but it might similarly have allowed other
components to vary, such as the level and slope.

Sensitivity of Bond Prices to Nonparallel Shifts in the
Yield Curve

Key rate duration enables you to determine the sensitivity of the price of a
bond to nonparallel shifts in the yield curve. This example uses bndkrdur to
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construct a portfolio to hedge the interest rate risk of a U.S. Treasury bond
maturing in 20 years. For more information on this bond, see .

Settle = datenum('2-Dec-2008"');
CouponRate = 5.500/100;

Maturity = datenum('15-Aug-2028');
Price = 128.68;

The interest rate risk of this bond is hedged with the following four on-the-run

Treasury bonds:

The 30-year bond. For more information, see .

Maturity_30 = datenum('15-May-2038"');
Coupon_30 = .045;
Price_30 = 124.69;

The ten-year note. For more information, see .
Maturity_10 = datenum('15-Nov-2018"');

Coupon_10 = .0375;
Price_10 = 109.35;

The five-year note. For more information, see .
Maturity 05 = datenum('30-Nov-2013");

Coupon_05 = .02;
Price 05 = 101.67;

The two-year note. For more information, see .

Maturity_02 = datenum('30-Nov-2010");
Coupon_02 = .01250;
Price_02 = 100.72;

You can get the Treasury spot or zero curve from: .

ZeroDates = daysadd(Settle,[30 90 180 360 360*2 360*3 360*5 ...

360*7 360*10 360*20 360*30]) ;

ZeroRates = ([0.09 0.07 0.44 0.81 0.90 1.16 1.71 2.13 2.72 3.51 3.22]/100)';
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Step 1. Compute the key rate durations for both the bond and the hedging
portfolio:

BondKRD = bndkrdur([ZeroDates ZeroRates], CouponRate, Settle,...
Maturity, 'keyrates',[2 5 10 20]);

HedgeMaturity = [Maturity_O2;Maturity_O5;Maturity_10;Maturity_30];
HedgeCoupon = [Coupon_02;Coupon_05;Coupon_10;Coupon_30];

HedgeKRD = bndkrdur([ZeroDates ZeroRates], HedgeCoupon,...

Settle, HedgeMaturity, 'keyrates',[2 5 10 20]);

Step 2. Compute the dollar durations for each of the instruments and each of
the key rates (assuming holding 100 bonds):

PortfolioDD = 100*Price* BondKRD;
HedgeDD = bsxfun(@times, HedgeKRD,[Price_30;Price_10;Price_05;Price_02]);

Step 3. Compute the number of bonds to sell short to obtain a key rate
duration that is O for the entire portfolio:

NumBonds = PortfolioDD/HedgeDD;

NumBonds

3.8973 6.1596  23.0282 80.0522

These results indicate selling 4, 6, 23 and 80 bonds respectively of the 2-, 5-,
10-, and 30-year bonds achieves a portfolio that is neutral with respect to
the 2-, 5-, 10-, and 30-year spot rates.

Constructing Greek-Neutral Portfolios of European
Stock Options

The option sensitivity measures familiar to most option traders are often
referred to as the greeks: delta, gamma, vega, lambda, rho, and theta. Delta
is the price sensitivity of an option with respect to changes in the price

of the underlying asset. It represents a first-order sensitivity measure
analogous to duration in fixed income markets. Gamma is the sensitivity

of an option’s delta to changes in the price of the underlying asset, and
represents a second-order price sensitivity analogous to convexity in fixed
income markets. Vega is the price sensitivity of an option with respect to
changes in the volatility of the underlying asset. See “Pricing and Analyzing
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Equity Derivatives” on page 2-40 or the “Glossary” on page Glossary-1 for
other definitions.

The greeks of a particular option are a function of the model used to price the
option. However, given enough different options to work with, a trader can
construct a portfolio with any desired values for its greeks. For example, to
insulate the value of an option portfolio from small changes in the price of the
underlying asset, one trader might construct an option portfolio whose delta
is zero. Such a portfolio is then said to be “delta neutral.” Another trader may
want to protect an option portfolio from larger changes in the price of the
underlying asset, and so might construct a portfolio whose delta and gamma
are both zero. Such a portfolio is both delta and gamma neutral. A third
trader may want to construct a portfolio insulated from small changes in the
volatility of the underlying asset in addition to delta and gamma neutrality.
Such a portfolio is then delta, gamma, and vega neutral.

Using the Black-Scholes model for European options, this example creates
an equity option portfolio that is simultaneously delta, gamma, and vega
neutral. The value of a particular greek of an option portfolio is a weighted
average of the corresponding greek of each individual option. The weights are
the quantity of each option in the portfolio. Hedging an option portfolio thus
involves solving a system of linear equations, an easy process in MATLAB.
This example M-file is ftspex4.m.

Step 1. Create an input data matrix to summarize the relevant information.
Each row of the matrix contains the standard inputs to Financial Toolbox
Black-Scholes suite of functions: column 1 contains the current price of the
underlying stock; column 2 the strike price of each option; column 3 the

time to-expiry of each option in years; column 4 the annualized stock price
volatility; and column 5 the annualized dividend rate of the underlying asset.
Note that rows 1 and 3 are data related to call options, while rows 2 and 4 are
data related to put options.

DataMatrix = [100.000 100 0.2 0.3 O % Call
119.100 125 0.2 0.2 0.025 % Put
87.200 85 0.1 0.23 O % Call
301.125 315 0.5 0.25 0.0333] % Put

Also, assume the annualized risk-free rate is 10% and is constant for all
maturities of interest.
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RiskFreeRate = 0.10;

For clarity, assign each column of DataMatrix to a column vector whose name
reflects the type of financial data in the column.

StockPrice = DataMatrix(:,1);
StrikePrice = DataMatrix(:,2);
ExpiryTime = DataMatrix(:,3);
Volatility = DataMatrix(:,4);
DividendRate = DataMatrix(:,5);

Step 2. Based on the Black-Scholes model, compute the prices, and the delta,
gamma, and vega sensitivity greeks of each of the four options. Note that
the functions blsprice and blsdelta have two outputs, while blsgamma

and blsvega have only one. The price and delta of a call option differ from
the price and delta of an otherwise equivalent put option, in contrast to the
gamma and vega sensitivities, which are valid for both calls and puts.

[CallPrices, PutPrices] = blsprice(StockPrice, StrikePrice,...
RiskFreeRate, ExpiryTime, Volatility, DividendRate);

[CallDeltas, PutDeltas] = blsdelta(StockPrice,...
StrikePrice, RiskFreeRate, ExpiryTime, Volatility,...
DividendRate);

Gammas = blsgamma(StockPrice, StrikePrice, RiskFreeRate,...
ExpiryTime, Volatility , DividendRate)';

Vegas = blsvega(StockPrice, StrikePrice, RiskFreeRate,...
ExpiryTime, Volatility , DividendRate)';

Extract the prices and deltas of interest to account for the distinction between
call and puts.

Prices = [CallPrices(1) PutPrices(2) CallPrices(3)...
PutPrices(4)1;

Deltas = [CallDeltas(1) PutDeltas(2) CallDeltas(3)...
PutDeltas(4)1];
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Step 3. Now, assuming an arbitrary portfolio value of $17,000, set up and
solve the linear system of equations such that the overall option portfolio is
simultaneously delta, gamma, and vega-neutral. The solution computes the
value of a particular greek of a portfolio of options as a weighted average of
the corresponding greek of each individual option in the portfolio. The system
of equations is solved using the back slash (\) operator discussed in “Solving
Simultaneous Linear Equations” on page 1-14.

A [Deltas; Gammas; Vegas; Prices];
b = [0; 0; 0; 17000];
OptionQuantities = A\b; % Quantity (number) of each option.

Step 4. Finally, compute the market value, delta, gamma, and vega of the
overall portfolio as a weighted average of the corresponding parameters of the
component options. The weighted average is computed as an inner product of
two vectors.

PortfolioValue = Prices * OptionQuantities;
PortfolioDelta = Deltas * OptionQuantities;
PortfolioGamma = Gammas * OptionQuantities;
PortfolioVega = Vegas * OptionQuantities;

The example ftspex4.m performs these computations and displays the output
on the screen.

Option Price Delta Gamma Vega Quantity
1 6.3441 0.5856 0.0290 17.4293 22332.6131
2 6.6035 -0.6255 0.0353 20.0347 6864.0731
3 4.2993 0.7003 0.0548 9.5837 -15654.8657
4 22.7694 -0.4830 0.0074 83.5225 -4510.5153

Portfolio Value: $17000.00

Portfolio Delta: 0.00
Portfolio Gamma: -0.00
Portfolio Vega : 0.00

You can verify that the portfolio value 1s $17,000 and that the option portfolio
is indeed delta, gamma, and vega neutral, as desired. Hedges based on these
measures are effective only for small changes in the underlying variables.
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Term Structure Analysis and Interest Rate Swap
Pricing

This example illustrates some of the term-structure analysis functions found
in Financial Toolbox software. Specifically, it illustrates how to derive
implied zero (spot) and forward curves from the observed market prices of
coupon-bearing bonds. The zero and forward curves implied from the market
data are then used to price an interest rate swap agreement.

In an interest rate swap, two parties agree to a periodic exchange of cash
flows. One of the cash flows is based on a fixed interest rate held constant
throughout the life of the swap. The other cash flow stream is tied to some
variable index rate. Pricing a swap at inception amounts to finding the fixed
rate of the swap agreement. This fixed rate, appropriately scaled by the
notional principal of the swap agreement, determines the periodic sequence of
fixed cash flows.

In general, interest rate swaps are priced from the forward curve such that
the variable cash flows implied from the series of forward rates and the
periodic sequence of fixed-rate cash flows have the same current value. Thus,
interest rate swap pricing and term structure analysis are intimately related.

Step 1. Specify values for the settlement date, maturity dates, coupon rates,
and market prices for 10 U.S. Treasury Bonds. This data allows you to price a
five-year swap with net cash flow payments exchanged every six months. For
simplicity, accept default values for the end-of-month payment rule (rule in
effect) and day-count basis (actual/actual). To avoid issues of accrued interest,
assume that all Treasury Bonds pay semiannual coupons and that settlement
occurs on a coupon payment date.

Settle = datenum('15-Jdan-1999"');

BondData = {'15-Jul-1999' 0.06000 99.93
'15-Jan-2000' 0.06125 99.72
'15-Jul-2000' 0.06375 99.70
'15-Jan-2001' 0.06500 99.40
'15-Jul-2001' 0.06875 99.73
'15-Jan-2002' 0.07000 99.42
'15-Jul-2002' 0.07250 99.32
'15-Jan-2003' 0.07375 98.45
'15-Jul-2003' 0.07500 97.71
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‘15-dan-2004' 0.08000 98.15};

BondData is an instance of a MATLAB cell array, indicated by the curly
braces ({}).

Next assign the date stored in the cell array to Maturity, CouponRate, and
Prices vectors for further processing.

Maturity datenum(strvcat(BondData{:,1}));
CouponRate = [BondData{:,2}]1"';

Prices [BondData{:,3}]"';

Period 2; % semiannual coupons

Step 2. Now that the data has been specified, use the term structure
function zbtprice to bootstrap the zero curve implied from the prices of
the coupon-bearing bonds. This implied zero curve represents the series of
zero-coupon Treasury rates consistent with the prices of the coupon-bearing
bonds such that arbitrage opportunities will not exist.

ZeroRates = zbtprice([Maturity CouponRate], Prices, Settle);

The zero curve, stored in ZeroRates, is quoted on a semiannual bond basis
(the periodic, six-month, interest rate is doubled to annualize). The first
element of ZeroRates is the annualized rate over the next six months, the
second element is the annualized rate over the next 12 months, and so on.

Step 3. From the implied zero curve, find the corresponding series of implied
forward rates using the term structure function zero2fwd.

ForwardRates = zero2fwd(ZeroRates, Maturity, Settle);

The forward curve, stored in ForwardRates, is also quoted on a semiannual
bond basis. The first element of ForwardRates is the annualized rate applied
to the interval between settlement and six months after settlement, the
second element is the annualized rate applied to the interval from six months
to 12 months after settlement, and so on. This implied forward curve is also
consistent with the observed market prices such that arbitrage activities
will be unprofitable. Since the first forward rate is also a zero rate, the first
element of ZeroRates and ForwardRates are the same.
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Step 4. Now that you have derived the zero curve, convert it to a sequence of
discount factors with the term structure function zero2disc.

DiscountFactors = zero2disc(ZeroRates, Maturity, Settle);

Step 5. From the discount factors, compute the present value of the variable
cash flows derived from the implied forward rates. For plain interest rate
swaps, the notional principle remains constant for each payment date and
cancels out of each side of the present value equation. The next line assumes
unit notional principle.

PresentValue = sum((ForwardRates/Period) .* DiscountFactors);

Step 6. Compute the swap’s price (the fixed rate) by equating the present
value of the fixed cash flows with the present value of the cash flows derived
from the implied forward rates. Again, since the notional principle cancels out
of each side of the equation, it is simply assumed to be 1.

SwapFixedRate = Period * PresentValue / sum(DiscountFactors);

The example ftspex5.m performs these computations and displays the output
on the screen.

Zero Rates Forward Rates

0.0614 0.0614
0.0642 0.0670
0.0660 0.0695
0.0684 0.0758
0.0702 0.0774
0.0726 0.0846
0.0754 0.0925
0.0795 0.1077
0.0827 0.1089
0.0868 0.1239

Swap Price (Fixed Rate) = 0.0845

All rates are in decimal format. The swap price, 8.45%, would likely be the
mid-point between a market-maker’s bid/ask quotes.
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Producing Graphics with the Toolbox

In this section...

“Introduction” on page 6-21
“Plotting an Efficient Frontier” on page 6-21
“Plotting Sensitivities of an Option” on page 6-24

“Plotting Sensitivities of a Portfolio of Options” on page 6-26

Introduction

Financial Toolbox and MATLAB graphics functions work together to produce
presentation quality graphics, as these examples show. The examples ship
with the toolbox as M-files. Try them by entering the commands directly or
by executing the M-files. For help using MATLAB plotting functions, see
“Creating Line Plots” in the MATLAB documentation.

Plotting an Efficient Frontier

This example plots the efficient frontier of a hypothetical portfolio of three
assets. It illustrates how to specify the expected returns, standard deviations,
and correlations of a portfolio of assets, how to convert standard deviations
and correlations into a covariance matrix, and how to compute and plot the
efficient frontier from the returns and covariance matrix. The example also
illustrates how to randomly generate a set of portfolio weights, and how to
add the random portfolios to an existing plot for comparison with the efficient
frontier. The example M-file is ftgex1.m.

First, specify the expected returns, standard deviations, and correlation
matrix for a hypothetical portfolio of three assets.

Returns = [0.1 0.15 0.12];

STDs = [0.2 0.25 0.18];

Correlations = [ 1 0.3 0.4
0.3 1 0.3
0.4 0.3 11;
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Convert the standard deviations and correlation matrix into a
variance-covariance matrix with the Financial Toolbox function corr2cov.

Covariances = corr2cov(STDs, Correlations);

Evaluate and plot the efficient frontier at 20 points along the frontier, using
the function portopt and the expected returns and corresponding covariance
matrix. Although rather elaborate constraints can be placed on the assets in a
portfolio, for simplicity accept the default constraints and scale the total value
of the portfolio to 1 and constrain the weights to be positive (no short-selling).

portopt(Returns, Covariances, 20)

hean-Yariance-Efficient Frontier
0152 : : : : :

0.15

0.145

0.14

0135

Expected Return

0.13

0125

0.12

0115
016 018 02 0.2 0.24 0.26

Risk (Standard Desviation)

Now that the efficient frontier is displayed, randomly generate the asset
weights for 1000 portfolios starting from the MATLAB initial state.

rand('state', 0)
Weights = rand(1000, 3);
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The previous line of code generates three columns of uniformly distributed
random weights, but does not guarantee they sum to 1. The following code
segment normalizes the weights of each portfolio so that the total of the three
weights represent a valid portfolio.

Total = sum(Weights, 2); % Add the weights
Total = Total(:,ones(3,1)); % Make size-compatible matrix
Weights = Weights./Total; % Normalize so sum = 1

Given the 1000 random portfolios just created, compute the expected return
and risk of each portfolio associated with the weights.

[PortRisk, PortReturn] = portstats(Returns, Covariances,
Weights);

Finally, hold the current graph, and plot the returns and risks of each
portfolio on top of the existing efficient frontier for comparison. After plotting,
annotate the graph with a title and return the graph to default holding status
(any subsequent plots will erase the existing data). The efficient frontier
appears in blue, while the 1000 random portfolios appear as a set of red dots
on or below the frontier.

hold on

plot (PortRisk, PortReturn, '.r')

title('Mean-Variance Efficient Frontier and Random Portfolios')
hold off
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Mean-*¥ariance Efficient Frontier and Random Portfolios
0.16 T T T T T

0.15

Expected Retumn
= =
0 =

]
—
]

0.1

» | | i |
0.16 0.18 0.2 022 0.24 0.26
Risk (Standard Deviation)

Plotting Sensitivities of an Option

This example creates a three-dimensional plot showing how gamma changes
relative to price for a Black-Scholes option. Recall that gamma is the second
derivative of the option price relative to the underlying security price. The
plot shows a three-dimensional surface whose z-value is the gamma of an
option as price (x-axis) and time (y-axis) vary. It adds yet a fourth dimension
by showing option delta (the first derivative of option price to security price)
as the color of the surface. This example M-file is ftgex2.m.

First set the price range of the options, and set the time range to one year
divided into half-months and expressed as fractions of a year.

Range = 10:70;

Span = length(Range);

j = 1:0.5:12;

Newj = j(ones(Span,1),:)'/12;



Producing Graphics with the Toolbox

For each time period create a vector of prices from 10 to 70 and create a
matrix of all ones.

JSpan = ones(length(j),1);
NewRange = Range(JSpan,:);
Pad = ones(size(Newj));

Calculate the toolbox gamma and delta sensitivity functions (greeks). (Recall
that gamma is the second derivative of the option price with respect to the
stock price, and delta is the first derivative of the option price with respect to
the stock price.) The exercise price is $40, the risk-free interest rate is 10%,
and volatility is 0.35 for all prices and periods.

ZVal = blsgamma(NewRange, 40*Pad, 0.1*Pad, Newj, 0.35*Pad);
Color = blsdelta(NewRange, 40*Pad, 0.1*Pad, Newj, 0.35*Pad);

Display the greeks as a function of price and time. Gamma is the z-axis;
delta is the color.

mesh(Range, j, Zval, Color);
xlabel('Stock Price ($)');

ylabel('Time (months)');
zlabel('Gamma');

title('Call Option Price Sensitivity');
axis([10 70 1 12 -inf inf]);
view(-40, 50);

colorbar('horiz');
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Stock Price (§

Call Optian Price Sensitivity

Time {months)

ns 04 05 0B 07 08 089

0z

0.1

ions

ies of a Portfolio of Opt

This example plots gamma as a function of price and time for a portfolio of

ITivi

Plotting Sens

10 Black-Scholes options. The plot shows a three-dimensional surface. For

each point on the surface, the height (z-value) represents the sum of the

gammas for each option in the portfolio weighted by the amount of each

and the y-axis represents time.

The plot adds a fourth dimension by showing delta as surface color. This

option. The x-axis represents changing price,
has applications in hedging.

-file is ftgex3.m.

This example M

First set up the portfolio with arbitrary data. Current prices range from $20
to $90 for each option. Set corresponding exercise prices for each option.

Range = 20:90;

length(Range);

PLen

[75 70 50 55 75 50 40 75 60 35];

ExPrice
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Set all risk-free interest rates to 10%, and set times to maturity in days. Set
all volatilities to 0.35. Set the number of options of each instrument, and
allocate space for matrices.

Rate 0.1*ones(10,1);

Time [36 36 36 27 18 18 18 9 9 9];

Sigma = 0.35*0ones(10,1);

NumOpt = 1000*[4 8 3 5 5.5 2 4.8 3 4.8 2.5];
ZVal = zeros(36, PLen);

Color = zeros(36, PLen);

For each instrument, create a matrix (of size Time by PLen) of prices for
each period.

for i = 1:10
Pad = ones(Time(i),PLen);
NewR = Range(ones(Time(i),1),:);

Create a vector of time periods 1 to Time; and a matrix of times, one column
for each price.

T= (1:Time(1))"';
NewT = T(:,ones(PLen,1));

Call the toolbox gamma and delta sensitivity functions to compute gamma
and delta.

ZVal(36-Time(i)+1:36,:) = ZVal(36-Time(i)+1:36,:)
+ NumOpt(i) * blsgamma(NewR, ExPrice(i)*Pad,
Rate(i)*Pad, NewT/36, Sigma(i)*Pad);

Color(36-Time(i)+1:36,:) = Color(36-Time(i)+1:36,:)
+ NumOpt (i) * blsdelta(NewR, ExPrice(i)*Pad,
Rate(i)*Pad, NewT/36, Sigma(i)*Pad);
end

Draw the surface as a mesh, set the viewpoint, and reverse the x-axis because
of the viewpoint. The axes range from 20 to 90, 0 to 36, and - to oo.

mesh(Range, 1:36, ZVal, Color);
view(60,60);
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RE

‘mesh_axes_3

Itagl,

-inf inf]);

‘xdir', 'reverse’,

set(gca,

axis([20 90 O 36

Add a title and axis labels and draw a box around the plot. Annotate the

colors with a bar and label the colorbar.

title('Call Option Portfolio Sensitivity');

xlabel('Stock Price ($)');

ylabel('Time (months)');
zlabel('Gamma');

set(gca,

‘on');

) .

"box"',

bl

colorbar('horiz
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® “Analyzing Financial Time Series” on page 7-2
e “Creating Financial Time Series Objects” on page 7-3

e “Visualizing Financial Time Series Objects” on page 7-18
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7-2

Analyzing Financial Time Series

Financial Toolbox software provides a collection of tools for the analysis of
time series data in the financial markets. The toolbox contains a financial
time series object constructor and several methods that operate on and
analyze the object. Financial engineers working with time series data, such
as equity prices or daily interest fluctuations, can use these tools for more
intuitive data management than by using regular vectors or matrices.

This chapter discusses how to create a financial time series object in one

of two ways:

e “Using the Constructor” on page 7-3

* “Transforming a Text File” on page 7-14

The chapter also discusses chartfts, a graphical tool for visualizing financial

time series objects. You can find this discussion in “Visualizing Financial
Time Series Objects” on page 7-18.
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Creating Financial Time Series Objects

In this section...

“Introduction” on page 7-3
“Using the Constructor” on page 7-3

“Transforming a Text File” on page 7-14

Introduction

Financial Toolbox software provides two ways to create a financial time
series object:

e At the command line using the object constructor fints

®* From a text data file through the function ascii2fts

The structure of the object minimally consists of a description field, a
frequency indicator field, the date vector field, and at least one data series
vector. The names for the fields are fixed for the first three fields: desc, freq,
and dates. You can specify names of your choice for any data series vectors.

If you do not specify names, the object uses the default names seriesft,
series2, series3, and so on.

If time-of-day information is incorporated in the date vector, the object
contains an additional field named times.

Using the Constructor
The object constructor function fints has five different syntaxes. These forms

exist to simplify object construction. The syntaxes vary according to the types
of input arguments presented to the constructor. The syntaxes are
® Single Matrix Input

= See “Time-of-Day Information Excluded” on page 7-4.

= See “Time-of-Day Information Included” on page 7-7.

® Separate Vector Input
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= See “Time-of-Day Information Excluded” on page 7-8.
= See “Time-of-Day Information Included” on page 7-9.
® See “Data Name Input” on page 7-10.
® See “Frequency Indicator Input” on page 7-12.
® See “Description Field Input” on page 7-14.

Single Matrix Input

The date information provided with this syntax must be in serial date number
format. The date number may or may not include time-of-day information.

Note If you are unfamiliar with the concepts of date strings and serial date
numbers, consult “Handling and Converting Dates” on page 2-4.

Time-of-Day Information Excluded.

fts = fints(dates_and_data)

In this simplest form of syntax, the input must be at least a two-column
matrix. The first column contains the dates in serial date format; the
second column is the data series. The input matrix can have more than two
columns, each additional column representing a different data series or set
of observations.

If the input is a two-column matrix, the output object contains four fields:
desc, freq, dates, and seriesi. The description field, desc, defaults to
blanks '', and the frequency indicator field, freq, defaults to 0. The dates
field, dates, contains the serial dates from the first column of the input
matrix, while the data series field, seriesi, has the data from the second
column of the input matrix.

The first example makes two financial time series objects. The first one has
only one data series, while the other has more than one. A random vector
provides the values for the data series. The range of dates is arbitrarily
chosen using the today function:

date_series = (today:today+100)"';
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data_series = exp(randn(1,

dates_and_data =

ftsi

101))"';

[date_series data_series];
= fints(dates_and_data);

Examine the contents of the object fts1 create. The actual date series you
observe will vary according to the day when you run the example (the value of
today). Also, your values in series1 will differ from those shown, depending
upon the sequence of random numbers generated:

fts1

desc: (none)

freq: Unknown (0)

‘dates: (101
'12-Jul-1999'
'13-Jul-1999'
'14-Jul-1999'
'15-Jul-1999'
'16-Jul-1999'
'17-Jul-1999'
'18-Jul-1999'
'19-Jul-1999'
'20-Jul-1999'
'21-Jul-1999'
'22-Jul-1999'
'23-Jul-1999'
'24-Jul-1999'
'25-Jul-1999'
'26-Jul-1999'
'27-Jul-1999'
'28-Jul-1999'

) ‘seriesi:

[
[
[
[
[
[
[
[
[
[
[
[
[
[
[
[
[

- 0Oo0ooopPpPOOOH—~ 00 —+0WO

(101) "
.3124]
.2665]
.9847]
.7095]
.4885]
.5192]
.3694]
.1127]
.3485]
.7595]
.1390]
.5201]
.1430]
.1863]
.5635]
.8304]
.0090]. ..

The output is truncated for brevity. There are actually 101 data points in
the object.

Note that the desc field displays as (none) instead of ' ', and that the contents
of the object display as cell array elements. Although the object displays as
such, it should be thought of as a MATLAB structure containing the default
field names for a single data series object: desc, freq, dates, and seriesi.
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date_series =
data_series1

data_series2 =
dates_and_data

(today:today+100) ';

= exp(randn(1,

exp(randn(1,

101)) 5
101)) 5

Now create an object with more than one data series in it:

= [date_series data_series1 data_series2];

fts2

Now look at the object created (again in abbreviated form):

fts2

The second data series name defaults to series?2, as expected.

= fints(dates_and_data);

desc: (none)
freq:

'dates: (101
'12-Jul-1999"
'13-Jul-1999"
'14-Jul-1999"
'15-Jul-1999"
'16-Jul-1999"
'17-Jul-1999"
'18-Jul-1999"
'19-Jul-1999"
'20-Jul-1999"
'21-Jul-1999"
'22-Jul-1999"
'23-Jul-1999"
'24-Jul-1999"
'25-Jul-1999"
'26-Jul-1999"
'27-Jul-1999"
'28-Jul-1999"

Unknown (0)

) ‘seriest:

[
[
[
[
[
[
[
[
[
[
[
[
[
[
[
[
[

WL W_LO0-+2 PO == DNO—=-—=DNO0CGO

(101) "
.5816]
.1253]
.2824]
.2596]
.9574]
.6017]
.3546]
.3080]
.8682]
.3509]
.6444]
.5441]
.1470]
.5999]
.5764]
.8937]
.9780]

'series2:

[
[
[
[
[
[
[
[
[
[
[
[
[
[
[
[
[

N =20 -=-DN0OO0OO0OO0CO0OO0O =+ =000 =

(101)"
.2816]
.9262]
.6869]
.0631]
.8709]
.0962]
.4459]
.6304]
.2451]
.6876]
.6244]
.7621]
.1238]
.0671]
.7462]
.0863]
.1516]. ..

Before you can perform any operations on the object, you must set the
frequency indicator field freq to the valid frequency of the data series
contained in the object. You can leave the description field desc blank.
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To set the frequency indicator field to a daily frequency, enter

fts2.freq

1, or

fts2.freq

'daily’

See the fints function description in Chapter 13, “Function Reference” or
Chapter 14, “Functions — Alphabetical List”.

Time-of-Day Information Included. The serial date number used with this
form of the fints function can incorporate time-of-day information. When
time-of-day information is present, the output of the function contains a field
times that indicates the time of day.

If you recode the previous example to include time-of-day information, you
can see the additional column present in the output object:

time_series = (now:now+100)';

data_series = exp(randn(i, 101))"';
times_and_data = [time_series data_series];
fts1 fints(times_and_data);

fts1

desc: (none)
freq: Unknown (0)

‘dates: (101)' ‘times: (101)' ‘seriesi: (101)'
'29-Nov-2001" '14:57' [ 0.5816]
'30-Nov-2001" '14:57' [ 5.1253]
'01-Dec-2001" '14:57' [ 2.2824]
'02-Dec-2001" '14:57' [ 1.2596]...

Separate Vector Input

The date information provided with this syntax can be in serial date number
or date string format. The date information may or may not include
time-of-day information.
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Time-of-Day Information Excluded.

fts = fints(dates, data)

In this second syntax the dates and data series are entered as separate
vectors to fints, the financial time series object constructor function. The
dates vector must be a column vector, while the data series data can be a
column vector (if there is only one data series) or a column-oriented matrix
(for multiple data series). A column-oriented matrix, in this context, indicates
that each column is a set of observations. Different columns are different
sets of data series.

Here is an example:

dates = (today:today+100)';
data_series1 = exp(randn(1, 101))";
data_series2 = exp(randn(1, 101))";
data = [data_series1 data_series2];
fts = fints(dates, data)

fts

desc: (none)
freq: Unknown (0)

'dates: (101)' 'seriesi: (101)' 'series2: (101)'
'12-Jul-1999' [ 0.5816] [ 1.2816]
'13-Jul-1999' [ 5.1253] [ 0.9262]
'14-Jul-1999' [ 2.2824] [ 5.6869]
'15-Jul-1999' [ 1.2596] [ 5.0631]
'16-Jul-1999' [ 1.9574] [ 1.8709]
'17-Jul-1999' [ 0.6017] [ 1.0962]
'18-Jul-1999' [ 2.3546] [ 0.4459]
'19-Jul-1999' [ 1.3080] [ 0.6304]
'20-Jul-1999' [ 1.8682] [ 0.2451]
'21-Jul-1999' [ 0.3509] [ 0.6876]
'22-Jul-1999' [ 4.6444] [ 0.6244]
'23-Jul-1999' [ 1.5441] [ 5.7621]
'24-Jul-1999' [ 0.1470] [ 2.1238]
'25-Jul-1999' [ 1.5999] [ 1.0671]
'26-Jul-1999' [ 3.5764] [ 0.7462]
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'27-Jul-1999" [ 1.8937] [ 1.0863]
'28-Jul-1999" [ 3.9780] [ 2.1516]...

The result is exactly the same as the first syntax. The only difference between
the first and second syntax is the way the inputs are entered into the
constructor function.

Time-of-Day Information Included. With this form of the function you can
enter the time-of-day information either as a serial date number or as a date
string. If more than one serial date and time are present, the entry must be in
the form of a column-oriented matrix. If more than one string date and time
are present, the entry must be a column-oriented cell array of dates and times.

With date string input the dates and times can initially be separate
column-oriented date and time series, but you must concatenate them into
a single column-oriented cell array before entering them as the first input
to fints.

For date string input the allowable formats are

e 'ddmmmyy hh:mm' or 'ddmmmyyyy hh:mm'

® 'mm/dd/yy hh:mm' or 'mm/dd/yyyy hh:mm'
® 'dd-mmm-yy hh:mm' or 'dd-mmm-yyyy hh:mm'
® 'mmm.dd,yy hh:mm' or 'mmm.dd,yyyy hh:mm'

The next example shows time-of-day information input as serial date numbers
in a column-oriented matrix:

f fints([now;now+1],(1:2)")

desc: (none)
freq: Unknown (0)

'dates: (2)' "times: (2)' ‘seriesi: (2)'
'29-Nov-2001" '15:22" [ 1]
'30-Nov-2001" '15:22" [
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If the time-of-day information is in date string format, you must provide it to
fints as a column-oriented cell array:

f fints({'01-Jan-2001 12:00';'02-Jan-2001 12:00'},(1:2)")

desc: (none)
freq: Unknown (0)

‘dates: (2)' "times: (2)' ‘series1: (2)'
'01-Jan-2001" '12:00' [ 1]
'02-Jan-2001" '12:00' [ 2]

If the dates and times are in date string format and contained in separate
matrices, you must concatenate them before using the date and time
information as input to fints:

dates = ['01-Jan-2001"'; '02-Jan-2001'; '03-Jan-2001'];

times = ['12:00';'12:00';'12:00'];

dates_time = cellstr([dates,repmat(' ',size(dates,1),1),times]);
f = fints(dates_time,(1:3)")

f:

desc: (none)
freq: Unknown (0)

'dates: (3)' ‘times: (3)' ‘seriesi: (3)'
'01-Jan-2001" '12:00' [ 1]
'02-Jan-2001" '12:00' [ 2]
'03-Jan-2001" ‘12:00' [ 3]

Data Name Input

fts = fints(dates, data, datanames)

The third syntax lets you specify the names for the data series with the
argument datanames. The datanames argument can be a MATLAB string
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for a single data series. For multiple data series names, it must be a cell
array of strings.

Look at two examples, one with a single data series and a second with two.
The first example sets the data series name to the specified name First:

date
data
ftsi

fts1

S:

desc:
freq:

(none)

'dates:
'12-Jul-1999'
'13-Jul-1999'
'14-Jul-1999'
'15-Jul-1999'
'16-Jul-1999'
'17-Jul-1999'
'18-Jul-1999'
'19-Jul-1999'
'20-Jul-1999'
'21-Jul-1999'
'22-Jul-1999'
'23-Jul-1999'
'24-Jul-1999'
'25-Jul-1999'
'26-Jul-1999'
'27-Jul-1999'

(101) "'

(today:today+100) ';
= exp(randn(1,

101))

fints(dates, data,

Unknown (0)

'"First:

[
[
[
[
[
[
[
[
[
[
[
[
[
[
[
[

‘First')

(101) "'
.4615]
.1640]
.7140]
.6400]
.8983]
.7552]
.6217]
.0714]
.4897]
.0536]
.8598]
.7500]
.2537]
.5037]
.3933]

O~ o000~ W=~~~ —=0MOMNMNO—=O

.3687]...

The second example provides two data series named First and Second:

date

data_seriesi =
data_series2 =

data
fts2

S =

(today:today+100) ';
exp(randn(1, 101))"';
exp(randn(1, 101))"';

= [data_series1 data_series2];

fints(dates, data,

{'First',

'Second'})
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fts2 =
desc: (none)
freq: Unknown (0)

'dates: (101)' "First: (101)' ‘Second: (101)'
'12-Jul-1999' [ 1.2305] [ 0.7396]
'13-Jul-1999" [ 1.2473] [ 2.6038]
'14-Jul-1999" [ 0.3657] [ 0.5866]
'15-Jul-1999" [ 0.6357] [ 0.4061]
'16-Jul-1999" [ 4.0530] [ 0.4096]
'17-Jul-1999' [ 0.6300] [ 1.3214]
'18-Jul-1999' [ 1.0333] [ 0.4744]
'19-Jul-1999' [ 2.2228] [ 4.9702]
'20-Jul-1999' [ 2.4518] [ 1.7758]
'21-Jul-1999' [ 1.1479] [ 1.3780]
'22-Jul-1999' [ 0.1981] [ 0.8595]
'23-Jul-1999"' [ 0.1927] [ 1.3713]
'24-Jul-1999" [ 1.5353] [ 3.8332]
'25-Jul-1999" [ 0.4784] [ 0.1067]
'26-Jul-1999" [ 1.7593] [ 3.6434]
'27-Jul-1999" [ 0.2505] [ 0.6849]
'28-Jul-1999' [ 1.5845] [ 1.0025]...

Note Data series names must be valid MATLAB variable names. The only
allowed nonalphanumeric character is the underscore () character.

Because freq for fts2 has not been explicitly indicated, the frequency
indicator for fts2 is set to Unknown. Set the frequency indicator field freq
before you attempt any operations on the object. You will not be able to use
the object until the frequency indicator field is set to a valid indicator.

Frequency Indicator Input

fts = fints(dates, data, datanames, freq)
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With the fourth syntax you can set the frequency indicator field when you
create the financial time series object. The frequency indicator field freq is
set as the fourth input argument. You will not be able to use the financial
time series object until freq is set to a valid indicator. Valid frequency
indicators are

UNKNOWN, Unknown, unknown, U, u,0

DAILY, Daily, daily, D, d,1

WEEKLY, Weekly, weekly, W, w,2

MONTHLY, Monthly, monthly, M, m,3
QUARTERLY, Quarterly, quarterly, Q, q,4
SEMIANNUAL, Semiannual, semiannual, S, s,5
ANNUAL, Annual, annual, A, a,6

The previous example contained sets of daily data. The freq field displayed
as Unknown (0) because the frequency indicator was not explicitly set. The
command

fts = fints(dates, data, {'First', 'Second'}, 1);

sets the freq indicator to Daily (1) when creating the financial time series
object:

fts =

desc: (none)
freq: Daily (1)

'dates: (101)' "First: (101)' 'Second: (101)'
'12-Jul-1999" [ 1.2305] [ 0.7396]
'13-Jul-1999" [ 1.2473] [ 2.6038]
'14-Jul-1999' [ 0.3657] [ 0.5866]
'15-Jul-1999" [ 0.6357] [ 0.4061]
'16-Jul-1999" [ 4.0530] [ 0.4096]
'17-Jul-1999" [ 0.6300] [ 1.3214]
'18-Jul-1999" [ 1.0333] [ 0.4744]...

When you create the object using this syntax, you can use the other valid
frequency indicators for a particular frequency. For a daily data set you can
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use DAILY, Daily, daily, D, or d. Similarly, with the other frequencies, you
can use the valid string indicators or their numeric counterparts.

Description Field Input

fts = fints(dates, data, datanames, freq, desc)

With the fifth syntax, you can explicitly set the description field as the fifth
input argument. The description can be anything you want. It is not used in
any operations performed on the object.

This example sets the desc field to 'Test TS'.

dates = (today:today+100)';

data_series1 = exp(randn(1, 101))";

data_series2 = exp(randn(1, 101))";

data = [data_series1 data_series2];

fts = fints(dates, data, {'First', 'Second'}, 1, 'Test TS')

fts =
desc: Test TS
freq: Daily (1)

'dates: (101)' "First: (101)' 'Second: (101)'
'12-Jul-1999' [ 0.5428] [ 1.2491]
'13-Jul-1999' [ 0.6649] [ 6.4969]
'14-Jul-1999' [ 0.2428] [ 1.1163]
'15-Jul-1999' [ 1.2550] [ 0.6628]
'16-Jul-1999' [ 1.2312] [ 1.6674]
'17-Jul-1999' [ 0.4869] [ 0.3015]
'18-Jul-1999' [ 2.1335] [ 0.9081]...

Now the description field is filled with the specified string 'Test TS' when
the constructor is called.

Transforming a Text File

The function ascii2fts creates a financial time series object from a text
(ASCII) data file provided that the data file conforms to a general format. The
general format of the text data file is as follows:
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e (Can contain header text lines.

¢ (Can contain column header information. The column header information
must immediately precede the data series columns unless the skiprows
argument (see below) is specified.

¢ Leftmost column must be the date column.
® Dates must be in a valid date string format.
= 'ddmmmyy' or 'ddmmmyyyy'
= 'mm/dd/yy"' or 'mm/dd/yyyy'
= 'dd-mmm-yy' or 'dd-mmm-yyyy'
= 'mmm.dd,yy"' or 'mmm.dd,yyyy'
e Each column must be separated either by spaces or a tab.

Several example text data files are included with the toolbox. These files are in
the ftsdata subdirectory within the directory matlabroot/toolbox/finance.

The syntax of the function

fts = ascii2fts(filename, descrow, colheadrow, skiprows);

takes in the data file name (filename), the row number where the text for
the description field is (descrow), the row number of the column header
information (colheadrow), and the row numbers of rows to be skipped
(skiprows). For example, rows need to be skipped when there are intervening
rows between the column head row and the start of the time series data.

Look at the beginning of the ASCII file disney.dat in the ftsdata
subdirectory:

Walt Disney Company (DIS)

Daily prices (3/29/96 to 3/29/99)

DATE OPEN HIGH Low CLOSE VOLUME
3/29/99 33.0625 33.188 32.75 33.063 6320500
3/26/99 33.3125 33.375 32.75 32.938 5552800
3/25/99 33.5 33.625 32.875 33.375 7936000
3/24/99 33.0625 33.25 32.625 33.188 6025400. ..
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The command line
disfts = ascii2fts('disney.dat', 1, 3, 2)

uses disney.dat to create time series object disfts. This example

Reads the text data file disney.dat

Uses the first line in the file as the content of the description field

Skips the second line

Parses the third line in the file for column header (or data series names)

Parses the rest of the file for the date vector and the data series values

The resulting financial time series object looks like this.

disfts =

desc: Walt Disney Company (DIS)
freq: Unknown (0)

'dates: (782)' "OPEN: (782)" 'HIGH: (782)" 'Low:  (782)
'29-Mar-1996' [ 21.1938] [ 21.6250] [ 21.2920]
'01-Apr-1996' [ 21.1120] [ 21.6250] [ 21.4170]
'02-Apr-1996' [ 21.3165] [ 21.8750] [ 21.6670]
'03-Apr-1996' [ 21.4802] [ 21.8750] [ 21.7500]
'04-Apr-1996' [ 21.4393] [ 21.8750] [ 21.5000]
'05-Apr-1996' [ NaN] [ NaN] [ NaN]
'09-Apr-1996' [ 21.1529] [ 21.5420] [ 21.2080]
'10-Apr-1996' [ 20.7387] [ 21.1670] [  20.2500]
"11-Apr-1996' [ 20.0829] [ 20.5000] [ 20.0420]
"12-Apr-1996' [ 19.9189] [ 20.5830] [ 20.0830]
"15-Apr-1996' [ 20.2878] [ 20.7920] [ 20.3750]
"16-Apr-1996' [ 20.3698] [ 20.9170] [ 20.1670]
"17-Apr-1996' [ 20.4927] [ 20.9170] [ 20.7080]
'18-Apr-1996' [ 20.4927] [ 21.0420] [ 20.7920]

There are 782 data points in this object. Only the first few lines are shown
here. Also, this object has two other data series, the CLOSE and VOLUME data
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series, that are not shown here. Note that in creating the financial time series
object, ascii2fts sorts the data into ascending chronological order.

The frequency indicator field, freq, is set to 0 for Unknown frequency. You
can manually reset it to the appropriate frequency using structure syntax
disfts.freq = 1 for Daily frequency.

With a slightly different syntax, the function ascii2fts can create a financial
time series object when time-of-day data is present in the ASCII file. The new
syntax has the form

fts = ascii2fts(filename, timedata, descrow, colheadrow,
skiprows);

Set timedata to 'T' when time-of-day data is present and to 'NT' when there
is no time data. For an example using this function with time-of-day data,
see the reference page for ascii2fts.
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Visualizing Financial Time Series Objects

In this section...

“Introduction” on page 7-18
“Using chartfts” on page 7-18
“Zoom Tool” on page 7-21
“Combine Axes Tool” on page 7-24

Introduction

Financial Toolbox software contains the function chartfts, which provides
a visual representation of a financial time series object. chartfts is an
interactive charting and graphing utility for financial time series objects.
With this function, you can observe time series values on the entire range
of dates covered by the time series.

Note Interactive charting is also available from the Graphs menu of the
graphical user interface. See “Interactive Chart” on page 10-17 for additional
information.

Using charifts

chartfts requires a single input argument, tsobj, where tsobj is the name
of the financial time series object you want to explore. Most equity financial
time series objects contain four price series, such as opening, closing, highest,
and lowest prices, plus an additional series containing the volume traded.
However, chartfts is not limited to a time series of equity prices and volume
traded. It can be used to display any time series data you may have.

To illustrate the use of chartfts, use the equity price and volume traded data
for the Walt Disney Corporation (NYSE: DIS) provided in the file disney.mat:

load disney.mat

whos
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Name Size Bytes Class

dis 782x5 39290 fints object
dis_CLOSE 782x1 6256 double array
dis_HIGH 782x1 6256 double array
dis_LOW 782x1 6256 double array
dis_OPEN 782x1 6256 double array
dis_VOLUME 782x1 6256 double array
dis_nv 782x4 32930 fints object
g_dis 13x4 2196 fints object

For charting purposes look only at the objects dis (daily equity data including
volume traded) and dis_nv (daily data without volume traded). Both objects
contain the series OPEN, HIGH, LOW, and CLOSE, but only dis contains the
additional VOLUME series.

Use chartfts(dis) to observe the values.

<} Interactive Chart: Walt Disney Company (DIS) - |EI|1|

File Edit Yiew Insert Tools ‘Window Help Chart Tools
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The chart contains five plots, each representing one of the series in the time
series object. Boxes indicate the value of each individual plot. The date box
1s always on the left. The number of data boxes on the right depends upon
the number of data series in the time series object, five in this case. The
order in which these boxes are arranged (left to right) matches the plots from
top to bottom. With more than eight data series in the object, the scroll bar
on the right is activated so that additional data from the other series can

be brought into view.

Slide the mouse cursor over the chart. A vertical bar appears across all
plots. This bar selects the set of data shown in the boxes below. Move this
bar horizontally and the data changes accordingly.

<} Interactive Chart: Walt Disney Company (DIS) - |EI|1|
File Edit Yiew Insert Tools ‘Window Help Chart Tools
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Click the plot. A small information box displays the data at the point where
you click the mouse button.
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<} Interactive Chart: Walt Disney Company (DIS) - |EI|1|

File Edit Yiew Insert Tools ‘Window Help Chart Tools
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Zoom Tool

The zoom feature of chartfts enables a more detailed look at the data during
a selected time frame. The Zoom tool is found under the Chart Tools menu.

<} Interactive Chart: Walt Disney Company (DIS) - |EI|1|
File Edit View Insert Tools ‘Window Help | Chart Taols

3 on

- Wal Combine Axes  k w OfF

Chatt Tool Help Help H"“““‘%\.Mgmm
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e
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a0

Note Due to the specialized nature of this feature, do not use the MATLAB
zoom command or Zoom In and Zoom Out from the Tools menu.
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When the feature is turned on, you will see two inactive buttons (ZOOM In
and Reset ZOOM) above the boxes. The buttons become active later after
certain actions have been performed.

a0 T T
- P,
: . M—-\__« e ]
e e e T i : vathmfpﬂﬁh

o 1 |

CLOSE

29-hviar- 1997 30-hefar- 1902
ZOOM In | Fieset ZOOH |

OPEN: HIGH: LOw: CLOSE: -
Disites: 21,1939 21.625 21.292 21242
29-hiar-1996
YOLUME: ‘
3373800

The window title bar displays the status of the chart tool that you are using.
With the Zoom tool turned on, you see Zoom ON in the title bar in addition
to the name of the time series you are working with. When the tool is off,
no status is displayed.

<} Interactive Chart: Walt Disney Company (DIS}, Zoom ON ii 1Ol x|

File Edit Wiew Insert Tools Window Help  Chart Tools

o Walt Dishey Company (DIS)
EnE———CSSSSes

To zoom into the chart, you need to define the starting and ending dates.
Define the starting date by moving the cursor over the chart until the desired
date appears at the bottom-left box and click the mouse button. A blue
vertical line indicates the starting date you have selected. Next, again move
the cursor over the chart until the desired ending date appears in the box
and click the mouse once again. This time, a red vertical line appears and
the ZOOM In button is activated.

OPEN
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The chart is zoomed in. Note that the Reset ZOOM button now becomes
active while the ZOOM In button becomes inactive again. To return the chart
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to its original state (not zoomed), click the Reset ZOOM button. To zoom into
the chart even further, repeat the steps above for zooming into the chart.

Turn the Zoom tool off by going back to the Chart Tools menu and choosing
Zoom Off,

<} Interactive Chart: Walt Disney Company (DIS) =1Ol=l
File Edit Miew Insert Tools ‘window Help m
- -
a0 Wal Combine Axes l
Ezsﬂww ChartToolbelp  Help [~ e
a0 i |

With the tool turned off, the chart stays at the last state that it was in. If you
turn it off when the chart is zoomed in, the chart stays zoomed in. If you reset
the zoom before turning it off, the chart becomes the original (not zoomed).

Combine Axes Tool

The Combine Axes tool allows you to combine all axes or specific axes into one.
With axes combined, you can visually spot any trends that can occur among
the data series in a financial time series object.

To illustrate this tool, use dis_nv, the financial time series object that does
not contain volume traded data:

chartfts(dis_nv)
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<} Interactive Chart: Walt Disney Company (DIS) - No ¥OLUME | = |EI|1|
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To combine axes, choose the Chart Tools menu, followed by Combine Axes
and On.

J Interactive Chart: Walt Disney Company (DIS) - No YOLUME
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When the Combine Axes tool is on, check boxes appear beside each individual
plot. An additional check box enables the combination of all plots.
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<} Interactive Chart: Walt Disney Company (DIS) - No ¥OLUME 10l =|
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Combining All Axes
To combine all plots, select the Select all plots check box.
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<} Interactive Chart: Walt Disney Company (DIS) - No ¥OLUME - |EI|1|
File Edit Yiew Insert Tools ‘Window Help Chart Tools
Walt Disney Company (DIS) - No VOLUME
a0 T T
= H o e b,
& - Mwmww—mw{w - %W"J‘ i, 5
(=] H H
0 |
a0 T T
H st pRa—
P R Ve M
T H H
0 |
a0 T T
1 R L VP
H i P
0 I I
a0 T ey
w H \
! et e s
% 'WPWM'MWWHWM H MW v
3 | |
28-Mar-1996 29-Mar-1997 30-Mar-1998 31-Mar-1999
Combine Selected Graphs Select all plats v
OPEM: HIGH: LObw: CLOSE:
Dates: 21.1938 21.625 21.292 21.292
29-Mar-1996

]

Now click the Combine Selected Graphs button to combine the chosen

plots. In this case, all plots are combined.
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-} Interactive Chart: Walt Disney Company (DIS) - No ¥OLUME = |EI|1|

File Edit Yiew Insert Tools ‘Window Help Chart Tools

____________________________________________________________________

__________________________________________________________________________________

The combined plots have a single plot axis with all data series traced. The
background of each data box has changed to the color corresponding to the
color of the trace that represents the data series. After the axes are combined,
the tool is turned off.

Combining Selected Axes

You can choose any combination of the available axes to combine. For
example, combine the HIGH and LOW price series of the Disney time series.
Click the check boxes next to the corresponding plots. The Combine
Selected Graphs button appears and is active.
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<} Interactive Chart: Walt Disney Company (DIS) - No ¥OLUME - |EI|1|
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Click the Combine Selected Graphs button. The chart with the combined
plots looks like the next figure.
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<} Interactive Chart: Walt Disney Company (DIS) - No ¥OLUME - |EI|1|
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The plot with the combined axes is located at the top of the chart while the
remaining plots follow it. The data boxes have also been changed. The boxes
that correspond to the combined axes are relocated to the beginning, and the
background colors are set to the color of the respective traces. The data boxes
for the remaining axes retain their original formats.

Resetting Axes

If you have altered the chart by combining axes, you must reset the axes
before you can visualize additional combinations. Reset the axes with the
Reset Axes menu item under Chart Tools > Combine Axes. Note that now
the On and Off features are turned off.
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<} Interactive Chart: Walt Disney Company (DIS) - No ¥YOLUME
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With axes reset, the interactive chart appears in its original format, and you
can proceed with additional axes combinations.
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¢ “Introduction” on page 8-2
* “Working with Financial Time Series Objects” on page 8-3

¢ “Demonstration Program” on page 8-25



8 Using Financial Time Series

Introduction

This chapter discusses how to manipulate and analyze financial time series
data. The major topics discussed include

¢ “Financial Time Series Object Structure” on page 8-3

e “Data Extraction” on page 8-4

® “Object-to-Matrix Conversion” on page 8-6

¢ “Indexing a Financial Time Series Object” on page 8-8

® “Operations” on page 8-15

e “Data Transformation and Frequency Conversion” on page 8-19

Much of this information is summarized in the “Demonstration Program”
on page 8-25.

8-2



Working with Financial Time Series Objects

Working with Financial Time Series Objects

In this section...

“Introduction” on page 8-3

“Financial Time Series Object Structure” on page 8-3
“Data Extraction” on page 8-4

“Object-to-Matrix Conversion” on page 8-6

“Indexing a Financial Time Series Object” on page 8-8

“Operations” on page 8-15

“Data Transformation and Frequency Conversion” on page 8-19

Introduction

A financial time series object is designed to be used as if it were a MATLAB
structure. (See the MATLAB documentation for a description of MATLAB
structures or how to use MATLAB in general.)

This part of the tutorial assumes that you know how to use MATLAB and
are familiar with MATLAB structures. The terminology is similar to that of
a MATLAB structure. The financial time series object term component is
interchangeable with the MATLAB structure term field.

Financial Time Series Object Structure

A financial time series object always contains three component names: desc
(description field), freq (frequency indicator field), and dates (date vector).

If you build the object using the constructor fints, the default value for the
description field is a blank string (' '). If you build the object from a text data
file using ascii2fts, the default is the name of the text data file. The default
for the frequency indicator field is 0 (Unknown frequency). Objects created
from operations can default the setting to 0. For example, if you decide to pick
out values selectively from an object, the frequency of the new object might
not be the same as that of the object from which it came.
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The date vector dates does not have a default set of values. When you create
an object, you have to supply the date vector. You can change the date vector
afterward but, at object creation time, you must provide a set of dates.

The final component of a financial time series object is one or more data series
vectors. If you do not supply a name for the data series, the default name is
seriesi. If you have multiple data series in an object and do not supply the
names, the default is the name series followed by a number, for example,
seriest, series2, and series3.

Data Extraction

Here is an exercise on how to extract data from a financial time series object.
As mentioned before, you can think of the object as a MATLAB structure.
Highlight each line in the exercise in the MATLAB Help browser, press the
right mouse button, and select Evaluate Selection to execute it.

To begin, create a financial time series object called myfts:

dates = (datenum('05/11/99'):datenum('05/11/99')+100)"';
data_series1 = exp(randn(1, 101))';

data_series2 = exp(randn(1, 101))"';

data = [data_series1 data_series2];

myfts = fints(dates, data);

The myfts object looks like this:
myfts =

desc: (none)
freq: Unknown (0)

'dates: (101)' 'seriesi: (101)' 'series2: (101)'
'11-May-1999' [ 2.8108] [ 0.9323]
'12-May-1999' [ 0.2454] [ 0.5608]
'13-May-1999' [ 0.3568] [ 1.5989]
'14-May-1999' [ 0.5255] [ 3.6682]
'15-May-1999' [ 1.1862] [ 5.1284]
'16-May-1999' [ 3.8376] [ 0.4952]
'17-May-1999' [ 6.9329] [ 2.2417]
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'18-May-1999'
'19-May-1999"
'20-May-1999"
'21-May-1999"
'22-May-1999'
'23-May-1999"
'24-May-1999'
'25-May-1999"

—————— ——

2.0987]
2.2524]
0.8669]
0.
0
1
3
3

9050]

.4493]
.6376]
.4472]
.6545]

[
[
[
[
[
[
[
[

O =00 = =2 WO

.3579]
.6492]
.0150]
.2445]
.5466]
.1251]
.1195]
.3374]...

There are more dates in the object; only the first few lines are shown here.

Note The actual data in your seriesi and series2 will differ from the above
because of the use of random numbers.

Now create another object with only the values for series2:

srs2

srs2

desc:
freq:

(none)

'dates:
"11-May-1999'
'12-May-1999'
'13-May-1999'
'14-May-1999'
'15-May-1999'
'16-May-1999'
'17-May-1999'
'18-May-1999'
'19-May-1999'
'20-May-1999'
'21-May-1999'
'22-May-1999'
'23-May-1999'
'24-May-1999'

= myfts.series2

Unknown (0)

(101) "

'series2:

[
[
[
[
[
[
[
[
[
[
[
[
[
[

- OO0 - =+ WONMNOULIW-—=O0OOo

(101) "
.9323]
.5608]
.5989]
.6682]
.1284]
.4952]
.2417]
.3579]
.6492]
.0150]
.2445]
.5466]
.1251]
.1195]
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'25-May-1999" [ 0.3374]...

The new object srs2 contains all the dates in myfts, but the only data series
is series2. The name of the data series retains its name from the original
object, myfts.

Note The output from referencing a data series field or indexing a financial
time series object is always another financial time series object. The
exceptions are referencing the description, frequency indicator, and dates
fields, and indexing into the dates field.

Object-to-Matrix Conversion

The function fts2mat extracts the dates and/or the data series values from an
object and places them into a vector or a matrix. The default behavior extracts
just the values into a vector or a matrix. Look at the next example:

srs2_vec fts2mat(myfts.series2)

srs2_vec

.9323
.5608
.5989
.6682
.1284
.4952
.2417
.3579
.6492
.0150
.2445
.5466
. 1251
.1195
.3374...

O - 00 = 2 WOMNOUILW—=0O0
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If you want to include the dates in the output matrix, provide a second input
argument and set it to 1. This results in a matrix whose first column is a
vector of serial date numbers:

format long ¢

srs2_mtx = fts2mat(myfts.series2, 1)

srs2_mtx =
730251 0.932251754559576
730252 0.560845677519876
730253 1.59888712183914
730254 3.6681500883527
730255 5.12842215360269
730256 0.49519254119977
730257 2.24174134286213
730258 0.357918065917634
730259 3.64915665824198
730260 1.01504236943148
730261 1.24446420606078
730262 5.54661849025711
730263 0.12507959735904
730264 1.11953883096805
730265 0.337398214166607

The vector srs2_vec contains just series2 values. The matrix srs2_mtx
contains dates in the first column and the values of the series2 data series
in the second. Dates in the first column are in serial date format. Serial
date format is a representation of the date string format (for example, serial
date = 1 is equivalent to 01-Jan-0000). (The serial date vector can include
time-of-day information.)

The long g display format displays the numbers without exponentiation. (To
revert to the default display format, use format short. (See the format
command in the MATLAB documentation for a description of MATLAB
display formats.) Remember that both the vector and the matrix have 101
rows of data as in the original object myfts but are shown truncated here.
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Indexing a Financial Time Series Object

You can also index into the object as with any other MATLAB variable or
structure. A financial time series object lets you use a date string, a cell
array of date strings, a date string range, or normal integer indexing. You
cannot, however, index into the object using serial dates. If you have serial
dates, you must first use the MATLAB datestr command to convert them
into date strings.

When indexing by date string, note that

¢ Each date string must contain the day, month, and year. Valid formats are
= 'ddmmmyy hh:mm' or 'ddmmmyyyy hh:mm'
= 'mm/dd/yy hh:mm' or 'mm/dd/yyyy hh:mm'
= 'dd-mmm-yy hh:mm' or 'dd-mmm-yyyy hh:mm'
= 'mmm.dd,yy hh:mm' or ‘mmm.dd,yyyy hh:mm'

e All data falls at the end of the indicated time period, that is, weekly data
falls on Fridays, monthly data falls on the end of each month, and so on,
whenever the data has gone through a frequency conversion.

Indexing with Date Strings
With date string indexing you get the values in a financial time series object
for a specific date using a date string as the index into the object. Similarly,
if you want values for multiple dates in the object, you can put those date

strings into a cell array and use the cell array as the index to the object. Here

are some examples.

This example extracts all values for May 11, 1999 from myfts:

format short
myfts('05/11/99")

ans =

desc: (none)
freq: Unknown (0)

'dates: (1) ‘seriesi: (1) ‘series2: (1)'
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"11-May-1999" [ 2.8108] [ 0.9323]

The next example extracts only series2 values for May 11, 1999 from myfts:

myfts.series2('05/11/99")
ans =

desc: (none)
freq: Unknown (0)

‘dates: (1) ‘series2: (1)
"11-May-1999' [ 0.9323]

The third example extracts all values for three different dates:
myfts({'05/11/99', '05/21/99', '05/31/99'})

ans =

desc: (none)
freq: Unknown (0)

'dates: (3)' 'seriesi: (3)' 'series2: (3)'
'11-May-1999' [ 2.8108] [ 0.9323]
'21-May-1999' [ 0.9050] [ 1.2445]
'31-May-1999' [ 1.4266] [ 0.6470]

The next example extracts only series2 values for the same three dates:
myfts.series2({'05/11/99', '05/21/99', '05/31/99'})

ans =

desc: (none)
freq: Unknown (0)

'dates: (3)' 'series2: (3)'
'11-May-1999' [ 0.9323]
'21-May-1999" [ 1.2445]
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'31-May-1999" [ 0.6470]

Indexing with Date String Range

A financial time series is unique because it allows you to index into the
object using a date string range. A date string range consists of two date
strings separated by two colons (::). In MATLAB this separator is called
the double-colon operator. An example of a MATLAB date string range is
'05/11/99::05/31/99'. The operator gives you all data points available
between those dates, including the start and end dates.

Here are some date string range examples:
myfts ('05/11/99::05/15/99")
ans =

desc: (none)
freq: Unknown (0)

'dates: (5)' 'seriesi: (5)' 'series2: (5)'
'11-May-1999" [ 2.8108] [ 0.9323]
'12-May-1999" [ 0.2454] [ 0.5608]
'13-May-1999' [ 0.3568] [ 1.5989]
'14-May-1999' [ 0.5255] [ 3.6682]
'15-May-1999" [ 1.1862] [ 5.1284]

myfts.series2('05/11/99::05/15/99")
ans =

desc: (none)
freq: Unknown (0)

'dates: (5)' 'series2: (5)'
'11-May-1999' [ 0.9323]
'12-May-1999' [ 0.5608]
'13-May-1999' [ 1.5989]
'14-May-1999' [ 3.6682]
'15-May-1999' [ 5.1284]
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As with any other MATLAB variable or structure, you can assign the output
to another object variable:

nfts = myfts.series2('05/11/99::05/20/99");
nfts is the same as ans in the second example.
If one of the dates does not exist in the object, an error message indicates that
one or both date indexes are out of the range of the available dates in the

object. You can either display the contents of the object or use the command
ftsbound to determine the first and last dates in the object.

Indexing with Integers
Integer indexing is the normal form of indexing in MATLAB. Indexing starts

at 1 (not 0); index = 1 corresponds to the first element, index = 2 to the second
element, index = 3 to the third element, and so on. Here are some examples
with and without data series reference.
Get the first item in series2:

myfts.series2(1)

ans =

desc: (none)
freq: Unknown (0)

'dates: (1) ‘series2: (1)
'11-May-1999" [ 0.9323]

Get the first, third, and fifth items in series2:
myfts.series2([1, 3, 5])
ans =

desc: (none)
freq: Unknown (0)

‘dates: (3)' ‘series2: (3)'
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"11-May-1999"
'13-May-1999'
'15-May-1999"

Get items 16 through 20 in series2:

myfts.series2(16:20)
ans =

desc: (none)

[
[
[

freq: Unknown (0)

‘dates: (5)'
'26-May-1999"
'27-May-1999'
'28-May-1999'
'29-May-1999'
'30-May-1999"

0.9323]
1.5989]
5.1284]

‘series2: (5)'

—_r————

0.2105]
1.8916]
0.6673]
0.6681]
1.0877]

Get 1items 16 through 20 in the financial time series object myfts:

myfts(16:20)
ans =

desc: (none)

freq: Unknown (0)

'dates: (5)'
'26-May-1999'
'27-May-1999"
'28-May-1999'
'29-May-1999'
'30-May-1999'

Get the last item in myfts:

myfts(end)

'seriesi: (5)'

[
[
[
[
[

0.7571]
1.2425]
1.8790]
0.5778]
1.2581]

'series2: (5)'

—_—————

0.2105]
1.8916]
0.6673]
0.6681]
1.0877]
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ans =

desc: (none)
freq: Unknown (0)

'dates: (1) ‘seriest: (1) ‘series2: (1)
'19-Aug-1999' [ 1.4692] [ 3.4238]

This example uses the MATLAB special variable end, which points to the last
element of the object when used as an index. The example returns an object
whose contents are the values in the object myfts on the last date entry.

Indexing When Time-of-Day Data Is Present

Both integer and date string indexing are permitted when time-of-day
information is present in the financial time series object. You can index into
the object with both date and time specifications, but not with time of day
alone. To show how indexing works with time-of-day data present, create a
financial time series object called timeday containing a time specification:

dates ['01-dan-2001"';'01-Jan-2001"'; '02-Jan-2001";
'02-dan-2001'; '083-Jan-2001';'03-Jan-2001'];
times = ['11:00';'12:00';'11:00';'12:00';'11:00';'12:00'];
dates_times = cellstr([dates, repmat(' ',size(dates,1),1),...
times]);

fints(dates_times, (1:6)',{'Data1'},1,'My first FINTS')

timeday

timeday

desc: My first FINTS
freq: Daily (1)

'dates: (6)' "times: (6)' ‘Datal: (6)'
'01-Jan-2001" '11:00' [ 1]
' " ' '12:00' [ 2]
'02-Jan-2001" '11:00' [ 3]
' " ' '12:00' [ 4]
'03-Jan-2001" '11:00' [ 5]
' " ' '12:00' [ 6]
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Use integer indexing to extract the second and third data items from timeday:

timeday(2:3)
ans =

desc: My first FINTS
freq: Daily (1)

‘dates: (2)' "times: (2)' ‘Datal: (2)'
'01-Jan-2001" '12:00' [ 2]
'02-Jan-2001" ‘11:00" [ 3]

For date string indexing, enclose the date and time string in one pair of
quotation marks. If there is one date with multiple times, indexing with only
the date returns the data for all the times for that specific date. For example,

the command timeday('01-Jan-2001") returns the data for all times on
January 1, 2001:

ans =

desc: My first FINTS
freq: Daily (1)

'dates: (2)' "times: (2)' ‘Datatl: (2)'
'01-Jdan-2001" ‘11:00' [ 1]
' " ' ‘12:00' [ 2]

You can also indicate a specific date and time:
timeday('01-Jan-2001 12:00"')

ans =

desc: My first FINTS
freq: Daily (1)

'dates: (1) "times: (1)' ‘Datatl: (1)
'01-Jan-2001" '12:00' [ 2]
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Use the double-colon operator : : to specify a range of dates and times:
timeday('01-Jan-2001 12:00::03-Jan-2001 11:00")
ans =

desc: My first FINTS
freq: Daily (1)

‘dates: (4)' "times: (4)' ‘Datal: (4)'
'01-Jan-2001" '12:00' [ 2]
'02-Jan-2001" ‘11:00" [ 3]
' " ' '12:00' [ 4]
'03-Jan-2001" ‘11:00' [ 5]

Treat timeday as a MATLAB structure if you want to obtain the contents of
a specific field. For example, to find the times of day included in this object,
enter

datestr(timeday.times)
ans =

11:00 AM
12:00 PM
11:00 AM
12:00 PM
11:00 AM
12:00 PM

Operations

Several MATLAB functions have been overloaded to work with financial time
series objects. The overloaded functions include basic arithmetic functions
such as addition, subtraction, multiplication, and division and other functions
such as arithmetic average, filter, and difference. Also, specific methods have
been designed to work with the financial time series object. For a list of
functions grouped by type, refer to Chapter 13, “Function Reference” or enter

help ftseries
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at the MATLAB command prompt.

Basic Arithmetic

Financial time series objects permit you to do addition, subtraction,
multiplication, and division, either on the entire object or on specific object
fields. This is a feature that MATLAB structures do not allow. You cannot
do arithmetic operations on entire MATLAB structures, only on specific
fields of a structure.

You can perform arithmetic operations on two financial time series objects
as long as they are compatible. (All contents are the same except for the
description and the values associated with the data series.)

Note Compatible time series are not the same as equal time series. Two time
series objects are equal when everything but the description fields is the same.

Here are some examples of arithmetic operations on financial time series
objects.

Load a MAT-file that contains some sample financial time series objects:
load dji30short

One of the objects in dji30short is called myfts1i:
myftstl =

desc: DJI3OMAR94.dat
freq: Daily (1)

'dates: (20)' 'Open: (20)' 'High: (20)' 'Low: (20)' 'Close: (20)'
'04-Mar-1994' [ 3830.90] [ 3868.04] [ 3800.50] [ 3832.30]
'07-Mar-1994' [ 3851.72] [ 3882.40] [ 3824.71] [ 3856.22]
'08-Mar-1994' [ 3858.48] [ 3881.55] [ 3822.45] [ 3851.72]
'09-Mar-1994' [ 3853.97] [ 3874.52] [ 3817.95] [ 3853.41]
'10-Mar-1994' [ 3852.57] [ 3865.51] [ 3801.63] [ 3830.62]...

Create another financial time series object that is identical to myfts1:
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newfts = fints(myftsi.dates, fts2mat(myfts1)/100,...
{'Open', 'High', 'Low',

newfts =

desc: New FTS

freq: Daily (1)
'dates: (20)' 'Open:
'04-Mar-1994' [ 38
'07-Mar-1994' [ 38
'08-Mar-1994' [ 38
'09-Mar-1994' [ 38
'10-Mar-1994' [ 38

1, 'New FTS')
(20)' 'Low:
.68] [ 38.
.82] [ 38.
.82] [ 38.
.75] [ 38.
.66] [ 38.

‘Close'},
(20) ' 'High:
.31] [ 38
.52] [ 38
.58] [ 38
.54] [ 38
.53] [ 38

Perform an addition operation on both time series objects:

addup = myfts1 + newfts

addup

desc: DJI3OMAR94.dat

freq: Daily (1)

'dates: (20)' 'Open:

'04-Mar-1994"' [
'07-Mar-1994"' [
'08-Mar-1994' [
'09-Mar-1994' [
'10-Mar-1994"' [

Now, perform a subtraction operation on both time series objects:

subout = myfts1

subout

3869
3890
3897
3892
3891

desc: DJI3OMAR94.dat

freq: Daily (1)

(20)"

.21]
.24]
.06]
.51]
.10]

- newfts

[
[
[
[
[

'High:

3906.72]
3921.22]
3920.37]
3913.27]
3904.17]

(20)"

'L

[
[
[
[
[

ow: (20)'

3838.51]
3862.96]
3860.67]
3856.13]
3839.65]

'C

[
[
[
[
[

lose:

3870
3894
3890
3891
3868

(20)"
01]
25]
22]
18]
02]

(20)"
.62]
.78]
.24]
.94]
.93]...

[

—_————

‘Close: (20)"

38.32]
38.56]
38.52]
38.53]

38.31]...
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‘dates: (20)' ‘'Open: (20)' 'High: (20)' 'Low: (20)' 'Close:
'04-Mar-1994' [ 3792.59] [ 3829.36] [ 3762.49] [ 3793.
'07-Mar-1994' [ 3813.20] [ 3843.58] [ 3786.46] [ 3817.
'08-Mar-1994' [ 3819.90] [ 3842.73] [ 3784.23] [ 3813.
'09-Mar-1994' [ 3815.43] [ 3835.77] [ 3779.77] [ 3814.
'10-Mar-1994' [ 3814.04] [ 3826.85] [ 3763.61] [ 3792.

Operations with Objects and Matrices

You can also perform operations involving a financial time
matrix or scalar:

addscalar = myfts1 + 10000

addscalar

desc: DJI3OMAR94.dat
freq: Daily (1)

(20)"
98]
66]
20]
88]
31]...

series object and a

‘dates: (20)' ‘'Open: (20)' 'High: (20)' 'Low: (20)' 'Close: (20)'
'04-Mar-1994' [ 13830.90] [ 13868.04] [ 13800.50] [ 13832.30]
'07-Mar-1994' [ 13851.72] [ 13882.40] [ 13824.71] [ 13856.22]
'08-Mar-1994' [ 13858.48] [ 13881.55] [ 13822.45] [ 13851.72]
'09-Mar-1994' [ 13853.97] [ 13874.52] [ 13817.95] [ 13853.41]
'10-Mar-1994' [ 13852.57] [ 13865.51] [ 13801.63] [ 13862.70]...

For operations with both an object and a matrix, the size of the matrix must
match the size of the object. For example, a matrix to be subtracted from
myfts1 must be 20-by-4, since myfts1 has 20 dates and four data series:

submtx = myfts1 - randn(20, 4)

submtx

desc: DJI3OMAR94.dat
freq: Daily (1)

'dates: (20)' 'Open: (20)' 'High: (20)' 'Low: (20)' 'Close: (20)'
'04-Mar-1994' [ 3831.33] [ 3867.75] [ 3802.10] [ 3832.63]
'07-Mar-1994' [ 3853.39] [ 3883.74] [ 3824.45] [ 3857.06]
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'08-Mar-1994' [ 3858.35] [ 3880.84] [ 3823.51] [ 3851.22]
'09-Mar-1994' [ 3853.68] [ 3872.90] [ 3816.53] [ 3851.92]
'10-Mar-1994' [ 3853.72] [ 3866.20] [ 3802.44] [ 3831.17]...

Arithmetic Operations with Differing Data Series Names

Arithmetic operations on two objects that have the same size but contain
different data series names require the function fts2mat. This function
extracts the values in an object and puts them into a matrix or vector,
whichever is appropriate.

To see an example, create another financial time series object the same size as
myfts1 but with different values and data series names:

newfts2 = fints(myftsi.dates, fts2mat(myfts1/10000),...
{'Rat1','Rat2', 'Rat3','Rat4'}, 1, 'New FTS')

If you attempt to add (or subtract, and so on) this new object to myfts1, an

error indicates that the objects are not identical. Although they contain the
same dates, number of dates, number of data series, and frequency, the two
time series objects do not have the same data series names. Use fts2mat to
bypass this problem:

addother = myfts1 + fts2mat(newfts2);

This operation adds the matrix that contains the contents of the data series in
the object newfts2 to myftsi1. You should carefully consider the effects on your
data before deciding to combine financial time series objects in this manner.

Other Arithmetic Operations

In addition to the basic arithmetic operations, several other mathematical
functions operate directly on financial time series objects. These functions
include exponential (exp), natural logarithm (1og), common logarithm (1og10),
and many more. See Chapter 13, “Function Reference” for more details.

Data Transformation and Frequency Conversion

The data transformation and the frequency conversion functions convert a
data series into a different format.
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Data Transformation Functions

Function Purpose

boxcox Box-Cox transformation
diff Differencing

fillts Fill missing values
filter Filter

lagts Lag time series object
leadts Lead time series object
peravg Periodic average
smoothts Smooth data

tsmovavg Moving average

Frequency Conversion Functions

Function New Frequency
convertto As specified
resamplets As specified
toannual Annual

todaily Daily

tomonthly Monthly
toquarterly Quarterly
tosemi Semiannually
toweekly Weekly

As an example look at boxcox, the Box-Cox transformation function. This
function transforms the data series contained in a financial time series object
into another set of data series with relatively normal distributions.
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First create a financial time series object from the supplied whirlpool.dat
data file.

whrl = ascii2fts('whirlpool.dat', 1, 2, []);

Fill any missing values denoted with NaNs in whrl with values calculated
using the linear method:

f_whrl = fillts(whrl);

Transform the nonnormally distributed filled data series f_whrl into a
normally distributed one using Box-Cox transformation:

bc_whrl = boxcox(f_whrl);

Compare the result of the Close data series with a normal (Gaussian)
probability distribution function and the nonnormally distributed f_whrl:

subplot(2, 1, 1);

hist(f_whrl.Close);

grid; title('Nonnormally Distributed Data');
subplot(2, 1, 2);

hist(bc_whrl.Close);

grid; title('Box-Cox Transformed Data');
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Box-Cox Transformation

The bar chart on the top represents the probability distribution function of
the filled data series, f_whrl, which is the original data series whrl with
the missing values interpolated using the linear method. The distribution
is skewed toward the left (not normally distributed). The bar chart on

the bottom is less skewed to the left. If you plot a Gaussian probability
distribution function (PDF) with similar mean and standard deviation, the
distribution of the transformed data is very close to normal (Gaussian).

When you examine the contents of the resulting object bc_whrl, you find

an identical object to the original object whrl but the contents are the
transformed data series. If you have the Statistics Toolbox™ software, you can
generate a Gaussian PDF with mean and standard deviation equal to those of
the transformed data series and plot it as an overlay to the second bar chart.
In the next figure, you can see that it is an approximately normal distribution.
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Box-Cox Transformed Data & Gaussian PDF
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The next example uses the smoothts function to smooth a time series.

To begin, transform ibm9599.dat, a supplied data file, into a financial time
series object:

ibm = ascii2fts('ibm9599.dat', 1, 3, 2);

Fill the missing data for holidays with data interpolated using the fillts
function and the Spline fill method:

f_ibm = fillts(ibm, 'Spline');

Smooth the filled data series using the default Box (rectangular window)
method:

sm_ibm = smoothts(f_ibm);

Now, plot the original and smoothed closing price series for IBM stock:

plot(f_ibm.CLOSE('11/01/97::02/28/98'), 'r")
datetick('x', 'mmmyy')

hold on
plot(sm_ibm.CLOSE('11/01/97::02/28/98'), 'b")
hold off

datetick('x', 'mmmyy')

legend('Filled', 'Smoothed')
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title('Filled IBM Close Price vs. Smoothed Series')

<) Figure No. 1 i 10l =|

File Edit Yiew Insert Tools Window Help
Deda "A 2/ | @20

Filled IBM Close Price vs. Smoothed Series
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Smoothed Data Series

These examples give you an idea of what you can do with a financial time
series object. This toolbox provides some MATLAB functions that have been
overloaded to work directly with the these objects. The overloaded functions
are those most commonly needed to work with time series data.
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Demonstration Program

In this section...

“Overview” on page 8-25

“Loading the Data” on page 8-26

“Create Financial Time Series Objects” on page 8-26

“Create Closing Prices Adjustment Series” on page 8-27

“Adjust Closing Prices and Make Them Spot Prices” on page 8-28
“Create Return Series” on page 8-28

“Regress Return Series Against Metric Data” on page 8-28

“Plot the Results” on page 8-29

“Calculate the Dividend Rate” on page 8-30

Overview

This example demonstrates a practical use of financial time series objects,
predicting the return of a stock from a given set of data. The data is a series
of closing stock prices, a series of dividend payments from the stock, and an
explanatory series (in this case a market index). Additionally, the example
calculates the dividend rate from the stock data provided.

Note You can find a script M-file for this demonstration program in the
directory matlabroot/toolbox/finance/ftsdemos on your MATLAB path.
The script is named predict_ret.m.

To perform these computations:

1 Load the data.

2 Create financial time series objects from the loaded data.

3 Create the series from dividend payment for adjusting the closing prices.

4 Adjust the closing prices and make them the spot prices.
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5 Create the return series.

6 Regress the return series against the metric data (for example, a market
index) using the MATLAB \ operator.

7 Plot the results.

8 Calculate the dividend rate.

Loading the Data

The data for this demonstration is found in the MAT-file
predict_ret_data.mat:

load predict_ret_data.mat

The MAT-file contains six vectors:

Dates corresponding to the closing stock prices, sdates

Closing stock prices, sdata

Dividend dates, divdates

Dividend paid, divdata

Dates corresponding to the metric data, expdates

Metric data, expdata

Use the whos command to see the variables in your MATLAB workspace.

Create Financial Time Series Objects

It is useful to work with financial time series objects rather than with the
vectors now in the workspace. By using objects, you can easily keep track of
the dates. Also, you can easily manipulate the data series based on dates
because the object keeps track of the administration of time series for you.

Use the object constructor fints to construct three financial time series
objects.

t0 = fints(sdates, sdata, {'Close'}, 'd', 'Inc');
do fints(divdates, divdata, {'Dividends'}, 'u', 'Inc');
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x0 = fints(expdates, expdata, {'Metric'}, 'w', 'Index');

The variables t0, d0, and x0 are financial time series objects containing
the stock closing prices, dividend payments, and the explanatory data,
respectively. To see the contents of an object, type its name at the MATLAB
command prompt and press Enter. For example:

do

do =
'desc:’ "Inc'
'freq:' "“Unknown (0)'
'dates: (4)' ‘Dividends: (4)'
'04/15/99" '0.2000'
'06/30/99" '0.3500'
'10/02/99" '0.2000'
'12/30/99" '0.1500'

Create Closing Prices Adjustment Series

The price of a stock 1s affected by the dividend payment. On the day before
the dividend payment date, the stock price reflects the amount of dividend
to be paid the next day. On the dividend payment date, the stock price is
decreased by the amount of dividend paid. Create a time series that reflects
this adjustment factor:

dadj1 = dO0;
dadj1.dates = dadj1.dates-1;

Now create the series that adjust the prices at the day of dividend payment;
this is an adjustment of 0. You also need to add the previous dividend
payment date since the stock price data reflect the period subsequent to that
day; the previous dividend date was December 31, 1998:

dadj2 = d0;
dadj2.Dividends = 0;
dadj2 = fillts(dadj2,'linear','12/31/98");

dadj2('12/31/98")

0;

Combining the two objects above gives the data needed to adjust the prices.
However, since the stock price data is daily data and the effect of the dividend
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is linearly divided during the period, use the fillts function to make a daily
time series from the adjustment data. Use the dates from the stock price data
to make the dates of the adjustment the same:

dadj3 = [dadj1; dadj2];
dadj3 fillts(dadj3, 'linear', t0.dates);

Adjust Closing Prices and Make Them Spot Prices

The stock price recorded already reflects the dividend effect. To obtain the
“correct” price, subtract the dividend amount from the closing prices. Put the
result inside the same object t0 with the data series name Spot.

To make sure that adjustments correspond, index into the adjustment series
using the dates from the stock price series t0. Use the datestr command
because t0.dates returns the dates in serial date format. Also, since the
data series name in the adjustment series dadj3 does not match the one in
t0, use the function fts2mat:

t0.Spot = t0.Close - fts2mat(dadj3(datestr(tO.dates)));

Create Return Series

Now calculate the return series from the stock price data. A stock return is
calculated by dividing the difference between the current closing price and the
previous closing price by the previous closing price.

tret = (t0.Spot - lagts(t0.Spot, 1)) ./ lagts(t0.Spot, 1);
tret = chfield(tret, 'Spot', 'Return');

Ignore any warnings you receive during this sequence. Since the operation on
the first line above preserves the data series name Spot, it has to be changed
with the chfield command to reflect the contents correctly.

Regress Return Series Against Metric Data

The explanatory (metric) data set is a weekly data set while the stock price
data is a daily data set. The frequency needs to be the same. Use todaily
to convert the weekly series into a daily series. The constant needs to be
included here to get the constant factor from the regression:

x1 = todaily(x0);
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x1.Const = 1;

Get all the dates common to the return series calculated above and the
explanatory (metric) data. Then combine the contents of the two series that
have dates in common into a new time series:

dcommon = intersect(tret.dates, x1.dates);
regtso [tret(datestr(dcommon)), x1(datestr(dcommon))];

Remove the contents of the new time series that are not finite:

finite_regtsO
regtsi

find(all(isfinite( fts2mat(regts0)), 2));
regts0( finite_regts0 );

Now, place the data to be regressed into a matrix using the function fts2mat.
The first column of the matrix corresponds to the values of the first data series
in the object, the second column to the second data series, and so on. In this
case, the first column is regressed against the second and third column:

DataMatrix
XCoeff

fts2mat(regtsi);
DataMatrix(:, 2:3) \ DataMatrix(:, 1);

Using the regression coefficients, calculate the predicted return from the
stock price data. Put the result into the return time series tret as the data
series PredReturn:

RetPred = DataMatrix(:,2:3) * XCoeff;
tret.PredReturn(datestr(regtsi.dates)) = RetPred;

Plot the Results

Plot the results in a single figure window. The top plot in the window has the
actual closing stock prices and the dividend-adjusted stock prices (spot prices).
The bottom plot shows the actual return of the stock and the predicted stock
return through regression:

subplot(2, 1, 1);

plot(t0);

title('Spot and Closing Prices of Stock');
subplot(2, 1, 2);

plot(tret);
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title('Actual and Predicted Return of Stock');

Spot and Closing Prices of Stock

9 H H H
Q1-99 Q2-99 Q3-99 Q4-99 Q1-00
Actual and Predicted Return of Stock

Closing Prices and Returns

Calculate the Dividend Rate

The last part of the task is to calculate the dividend rate from the stock price
data. Calculate the dividend rate by dividing the dividend payments by the
corresponding closing stock prices.

First check to see if you have the stock price data on all the dividend dates:

datestr(d0.dates, 2)
ans =

04/15/99

06/30/99

10/02/99

12/30/99
t0(datestr(d0.dates))
ans =

'desc:' "Inc' t
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'freq:' ‘Daily (1)
‘dates: (3)' ‘Close: (3)'
'04/15/99" ‘10.3369'
'06/30/99" '11.4707"'
'12/30/99" '11.2244"

(3)'

Note that stock price data for October 2, 1999 does not exist. The fillts

function can overcome this situation; fillts allows you to insert a date and
interpolate a value for the date from the existing values in the series. There
are a number of interpolation methods. See fillts in Chapter 13, “Function

Reference” for details.

Use fillts to create a new time series containing the missing date from the

original data series. Then set the frequency indicator to daily:

t1 = fillts(t0, 'nearest’',d0.dates);
t1.freq = 'd';

Calculate the dividend rate:

tdr = dO0./fts2mat(t1.Close(datestr(d0.dates)))
tdr =

'desc:’ "Inc'

'freq:' ‘Unknown (0)'

'dates: (4)' '‘Dividends: (4)'

'04/15/99' '0.0193'

'06/30/99' '0.0305'

'10/02/99" '0.0166'

'12/30/99' '0.0134'
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e “What Is the Financial Time Series Tool?” on page 9-2

® “Getting Started with FTSTool” on page 9-4

e “Loading Data with FTSTool” on page 9-5

e “Using FTSTool for Supported Tasks” on page 9-10

e “Using FTSTool with Other Time Series GUIs” on page 9-18
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What Is the Financial Time Series Tool?

The Financial Time Series Tool (ftstool) provides a graphical user interface
to create and manage financial time series (fints) objects. ftstool
interoperates with the Financial Time Series Graphical User Interface
(ftsgui) and Interactive Chart (chartfts). In addition, you can use Datafeed
Toolbox™ or Database Toolbox™ software to connect to external data sources.

A financial time series object minimally consists of:

® Desc, which is the description field.
® Freq, which is a frequency indicator field.

® Dates, which is a date vector field. If the date vector incorporates
time-of-day information, the object contains an additional field named
times.

¢ In addition, you can have at least one data series vector. You can specify
names for any data series vectors. If you do not specify names, the object
uses the default names seriesi, series2, series3, and so on.

In general, the workflow for using FTSTool is:

1 Acquire data.
2 Create a variable.
3 Convert the variable to fints.

4 Convert fints to a MATLAB double object.

To obtain the data for ftstool, you need to use a MATLAB double object or a
financial time series (fints) object. You can use previously stored internal
data on your computer or you can connect to external data sources using
Datafeed Toolbox or Database Toolbox software.

Note You must obtain a license for these products from The MathWorks™
before you can use either of these toolboxes.




What Is the Financial Time Series Tool2

After creating a financial time series object, you can use ftstool to change the
characteristics of the time series object, including merging with other financial
time series objects, removing rows or columns, and changing the frequency.
You can also use ftstool to generate various forms of plotted output and you
can reconvert a fints object to a MATLAB double-precision matrix.
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Getting Started with FTSTool

To start the Financial Time Series Tool:

1 At the MATLAB command prompt, enter

ftstool

The Financial Time Series Tool opens.

2 If you plan to load data from Database Toolbox or Datafeed Toolbox
software, ensure you have a license. For more information on using these
toolboxes, see the Database Toolbox User’s Guide and Datafeed Toolbox
User’s Guide documentation.
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Loading Data with FTSTool

In this section...

“Overview” on page 9-5

“Obtaining External Data” on page 9-5
“Obtaining Internal Data” on page 9-7
“Viewing the MATLAB Workspace” on page 9-8

Overview

The Data source pane in the Financial Time Series Tool window lets you
do the following:

¢ Obtain live data from various external data servers using either Datafeed
Toolbox or Database Toolbox software.
¢ Load data you previously obtained and stored in a file.

¢ View data contained within the MATLAB workspace.

Obtaining External Data

You can obtain external data using Datafeed Toolbox or Database Toolbox
software. Datafeed Toolbox software lets you obtain data from several
financial data servers, including:

¢ Bloomberg®

¢ FactSet®

® Federal Reserve Economic Data

e Haver Analytics financial data

¢ Interactive Data Pricing and Reference Data

e Kx Systems®, Inc. kdb+ database

¢ Reuters®

¢ Thomson® Datastream®

® Yahoo!®
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Except for Federal Reserve Economic Data and Yahoo!, these data servers
require that you obtain a license from the vendor before you can access their
data.

Tip If you open Datafeed Toolbox or Database Toolbox software before
starting FTSTool, FTSTool is unable to recognize the toolboxes. When
working with FTSTool, select File > Load to open these toolboxes.

Obtaining External Data with Datafeed Toolbox Software

1 From the Financial Time Series Tool window, select File > Load >
Datafeed Toolbox to open the toolbox.

2 Click the Connection tab in Datafeed Toolbox software to select the data
source you want to load into FTSTool.

3 Click the Data tab in Datafeed Toolbox software to select the security and
the associated data that you want to load into FTSTool.

4 After using Datafeed Toolbox software to define the connection, security,
data, and MATLAB variable name, click Get Data and then, using
FTSTool, click Refresh variable list. The Data source field in FT'STool
displays the name of the security you selected from the Data tab in
Datafeed Toolbox software. The FTSTool Active variable field indicates
the name of the MATLAB workspace variable you chose for this security.

5 Click Close to exit Datafeed Toolbox software. FTSTool clears the Data
source and Active variable fields.

Obtaining External Data with Database Toolbox Software

1 From the Financial Time Series Tool window, select File > Load >
Database Toolbox to open the toolbox.
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2 From the Visual Query Builder window, select the data you want to load
into FTSTool.

3 After using Database Toolbox software to select data and name the
MATLAB workspace variable, click Execute and then, using FT'STool,
click Refresh variable list. The Data source field in FTSTool displays
the name of the highlighted data source that you selected from the Data
list box in the Visual Query Builder window. The FTSTool Active variable
field indicates the name of the MATLAB workspace variable you chose for
the security in the Visual Query Builder window.

4 From the Database Toolbox software, select Query > Close Visual Query
Builder, FTSTool clears the Data source and Active variable fields.

Obtaining Internal Data
You can use FTSTool to load data from files previously stored on your

computer. The types of data files you can load are as follows:
e MATLAB .mat files
e ASCII text files (.dat or .txt suffixes)

e Excel .x1s files
To obtain internal data:

1 From the Financial Time Series Tool window, select File > Load > File to
open the Load a MAT, ASCII, .XLS File dialog box.

2 Select the data you want to load into FTSTool.

e If you load a MATLAB MAT-file, the variables in the file are placed
into the MATLAB workspace. The MATLAB Workspace Variables
list box shows the variables that have been added to the workspace.
For example, if you load the file disney.mat, which is distributed with
the toolbox, the MATLAB Workspace Variables list box displays the
variables in that MAT-file.
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Note FTSTool automatically generates a line plot for each workspace
variables unless you disable this feature by resetting the default action
under File > Preferences > Generate line plot on load.

¢ Ifyou load a .dat or an ASCII .txt file, the ASCII File Parameters
dialog box opens. Use this dialog box to transform a text data file into
a MATLAB financial time series fints object. (See the reference page
for ascii2fts for further explanation of the fields in the ASCII File
Parameters dialog box.

e If you load an Excel .x1s file, the Excel File Parameters dialog box
opens. Use this dialog box to transform Excel worksheet data into a
MATLAB financial time series (fints) object.

3 From the Financial Time Series Tool window, select File > Save to save
the data you gave loaded from an internal file.

Viewing the MATLAB Workspace

The MATLAB Workspace Variables list box displays all existing MATLAB
workspace variables. Double-click any variable to display the data in the
Data Table. You can only display financial time series (fints) objects,
MATLAB doubles, and cell arrays of double data in the Data Table.



Loading Data with FTSTool

} Finandal Time Series Tool

File Edit Tools Help

=1o| x|

Create ohject via:

& Active varia... { Components

Titrie vectar sourcelcurr 'l

[Iata source(s):
=

=l

Remove data |

Add data |

MATLAE workspace variahle:

|myFts Create FINTS |

Additional options | Update workspac. |

— Data Sourc — Data Management
e Active myFts
.IDatafeed To l Load | et Tabl V!
D 6] Sty Dates/Times Close
Active BiF 1 ||13-Apr-1998 104.19 i’
— MATLAB Warkspace Yariables 2 |14-Apr-1935 106,25
[Mame | Size | Class] 3 |15-Apr-1398 108.75
curr 2z01zxz double a| 4 | 16-Apr-1398 107.81
wyFrs 2012x1 fints 5 |17-Apr-1995 107.75
5 | 20-Apr-1998 111.19
7 |21-Apr-1998 118.0
8 |22-Apr-1998 114.75
9 |23-Apr-1998 117.5
- 10 |24-Apr-1998 117.37
4 | LI—I 11 |27-Apr-1998 115.31
12 |28-Apr-1998 115.69
Refresh variable..| Remove variabl... | 13 |23-Apr-1933 115.56
14 |30-Apr-1998 115.587
— FINTS Objects and Outputs 15 |01-May-1398 11687
o i | || 5105251159 e
Active myFts 18 |06-May-1995 117.25.7 |

Start
End date

— FINTS Object Properti

Descriptio IBM Equity

Fraquenc IDain vl Advanced'

13-Apr-1958
10-Apr-2006

Series Mames

1{Close

Update properties |

Ready

In addition, you can click Refresh variable list to refresh the MATLAB
Workspace Variables list box. You need to refresh this list periodically
because it is refreshed automatically only for operations performed with
FTSTool, not for operations performed within MATLAB itself.

Click Remove variable(s) to remove variable from the MATLAB
Workspace Variables list and from the MATLAB workspace.
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Using FTSTool for Supported Tasks

In this section...

“Creating a Financial Time Series Object” on page 9-10
“Merging Financial Time Series Objects” on page 9-11

“Converting a Financial Time Series Object to a MATLAB Double-Precision
Matrix” on page 9-12

“Plotting the Output in Several Formats” on page 9-12

“Viewing Data for a Financial Time Series Object in the Data Table” on
page 9-13

“Modifying Data for a Financial Time Series Object in the Data Table”
on page 9-14

“Viewing and Modifying the Properties for a FINTS Object” on page 9-16

Creating a Financial Time Series Object

Using the Create tab in the FINTS Objects and Outputs pane for FTSTool,
you can create a financial time series (fints) object from one or more selected
variables.

Note When you first start FTSTool, the Create tab appears on top, unless
you reset the default using File > Preferences > Show Create tab when
ftstool starts.

To create a financial time series (fints) object from one or more selected
variables:

1 Load data into FTSTool from either an external data source using Datafeed
Toolbox or Database Toolbox software or an internal data source using
File > Load > File.

2 Select one or more variables from the MATLAB Workspace Variables
list.
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3 Click the Create tab and then click Active variable.

When combining multiple variables, you can type a new variable name
for the combined variables in the MATLAB workspace variable box.
The new variable name is added to the MATLAB Workspace Variables
list. (If you do not choose a name for the MATLAB workspace variable,
FTSTool uses the default name myFts.)

4 Click Create FINTS object to display the result in the Data Table.

Merging Financial Time Series Objects

Using the Create tab in the FINTS Objects and Outputs pane for FTSTool,
you can create a new financial time series object by merging (joining) multiple
existing financial time series objects.

Note When you first start FTSTool, the Create tab appears on top, unless
you reset the default using File > Preferences.

To create a financial time series (fints) object by merging multiple existing
financial time series objects:

1 Load data into FTSTool from either an external data source using Datafeed
Toolbox or Database Toolbox software or an internal data source using
File > Load > File.

2 To merge multiple existing financial time series objects, click the Create
tab, click Components, and then select a value for the Time vector
source and one or more items from the Data sources list.

Note You can merge at once multiple financial time series objects. For
more information on merging fints objects, see merge.

3 Click Create FINTS object to display the result in the Data Table.
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Converting a Financial Time Series Object to a
MATLAB Double-Precision Matrix

Using the Convert tab in the FINTS Objects and Outputs pane for
FTSTool, you can convert a financial time series (fints) object to a MATLAB
double-precision matrix.

To create a financial time series object from one or more selected variables:

1 Load data into FTSTool from either an external data source using Datafeed
Toolbox or Database Toolbox software or an internal data source using
File > Load > File.

2 Select a variable from the MATLAB Workspace Variables list box.

3 Click the Convert tab and then determine whether to include or exclude
dates in the conversion by clicking Include dates or Exclude dates.

4 Type a variable name in the Output variable name box. (If you do not
choose a variable name, FTSTool uses the default name myDb1.)

5 Click Convert FINTS to double matrix. (This operation is equivalent to
performing fts2mat on a financial time series object.)

Plotting the Output in Several Formats

Using the Plot tab in the FINTS Objects and Outputs pane for FTSTool,
you can create several forms of plotted output by using a selection list. You
can create four types of bar charts, candle plots, high-low plots, line plots, and
interactive charts (the latter is created by using the interoperation of FT'STool
with the function chartfts).

The set of plots supported by FTSTool are identical to the set provided by the
Graphs menu of the Financial Time Series GUI. (See “Graphs Menu” on page
10-15.) You can find more detailed information for the supported plots by
consulting the reference page for each individual type of plot.

To create a plotted output:
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1 Load data into FTSTool from either an external data source using Datafeed
Toolbox or Database Toolbox software or an internal data source using
File > Load > File.

2 Select a variable from the MATLAB Workspace Variables list box or
select data from the Data Table.

3 Click the Plot tab and indicate whether you are plotting based on a
workspace variable or data from the Data Table.

4 From the Type drop-down list, select the type of plot.

5 Click Plot. The plot is displayed.

Note If the selected workspace variable that you are plotting is not a
fints object, a fints object is created when you click Plot. The new fints
object uses the name designated by the MATLAB workspace variable
box on the Create tab.

Viewing Data for a Financial Time Series Object in
the Data Table

Once a financial time series (fints) object is created, the FTSTool Data
Table displays user-designated data, including financial time series objects,
MATLAB double-precision variables, and cell arrays of doubles. (Cell arrays of
doubles is often the resulting format when using Database Toolbox software.)

When displaying double variables (or a cell array of doubles) in the Data
Table, the column headings for a double variable or cell array of doubles
displayed in the Data Table are labeled A, B, C, and so on.

Overwriting Data in the Data Table Display

If you use the command line to overwrite data previously retrieved using
Datafeed Toolbox or Database Toolbox software, two events could occur:

e If the new data contains the same number of columns as before, the headers

remain unchanged when you attempt to create a financial time series
(fints) object using the modified data.
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e If the data contains a different number of columns, a warning dialog box
appears.

For example, assume that you use Datafeed Toolbox software to obtain Close,
High, Low, and Volume data for the equity GlaxoSmithkline. You store the
data in the MATLAB workspace with the variable name glaxo. From the
command line, if you redefine the variable glaxo, eliminating the second
column (Close)

glaxo(:,2) = [ ]

and then return to FTSTool and attempt to create a financial time series
object, a warning dialog box appears.

Fimancial Time Senes T ool Warning

Ihcatnpatible series namels] exist in memory for the
variakle 'glaxo’.

There are:
Too mary DATARNAMES for the number of dats series.

Incompstible series namel=) Close, High, Lovw, Open,
Yolume

A FINTS abject will be constructed with default setiss
SIME(S).

Mismatched seties names wil be remowed from memory.

Inform me of future FINTS object creation errors?

£ Mo, do not ask e agsin. & Yes, ask me each time.

QK |

Modifying Data for a Financial Time Series Object in
the Data Table

FTSTool lets you update your data displayed in the Data Table by adding or
removing rows or columns.
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Note Modifying data in the Data Table will not update the MATLAB
workspace variable. To update the workspace variable after modifying the
Data Table, click Update workspace variable.

Adding and Removing Rows
To add a row of data displayed in the Data Table:

1 Select a row from the Data Table display where you want to add a row.
Click Additional options to open the Data Table Options dialog box.

2 Click Add row. The default is to add the row up. To add a row down,
select Insertion option and then click Add down. In addition, you can
select the Insertion option of Date to designate a specific date. (If a date
is not specified, the added row will contain a date that is chronologically in
order with respect to the initial row.)

When you add rows, the Data Table display is immediately updated.
To remove a row of data from the Data Table:

1 Select one or more rows in the Data Table display that you want to remove.
Click Additional options to open the Data Table Options dialog box.

2 Click Remove row(s). The default is to remove the selected rows. In
addition, to remove selected rows, select Removal options and then select
other options for row removal from the Remove rows list box. You can
specify a Start and End date or you can click the Non-uniform range
setting option to designate a range.

When you remove rows, the Data Table display is updated immediately.
Adding and Removing Columns

To add a column of data displayed in the Data Table:

1 Select a column from the Data Table display where you want to add a
column. Click Additional options to open the Data Table Options dialog
box.
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2 Click Add column. The default is to add the column to the left of the
selected column.

Note For time series objects, you cannot add a column to the left of the
Date/Times column; there is no restriction for double data.

To add a column to the right, select Insertion option and then click Add
right. In addition, you can use the Insertion option of New Column
Name to designate a specific column name. (If a New Column Name is
not specified, an added column will contain a column name of seriest,
series2, and so on.)

When you add columns, the Data Table display is updated immediately.
To remove a column of data displayed in the Data Table:

1 Select one or more columns in the Data Table display that you want to
remove. Click Additional options to open the Data Table Options dialog
box.

2 Click Remove column(s). The default is to remove the selected rows. In
addition, to remove selected columns, select Removal options and then
select columns for removal from the Remove columns list box.

When you remove columns, the Data Table display is updated
immediately.

Viewing and Modifying the Properties for a FINTS
Object
The FINTS Object Properties pane in FTSTool lets you modify financial

time series (fints) object properties. This area becomes active whenever the
Data Table displays a financial time series object.

To modify the properties for a fints object:
1 After you create a fints object, double-click the object name in the

MATLAB Workspace Variables list box to open the Data Table and
display the fints object properties.
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2 Click to modify the Description, Frequency, or Series Names fields.

The Frequency drop-down list supports the following conversion functions:

Function
toannual
todaily
tomonthy
toquarterly
tosemi

toweekly

New Frequency
Annual

Daily

Monthly
Quarterly
Semiannually
Weekly

3 Click Update properties to save the changes. This action also updates

the associated workspace variable.
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Using FTSTool with Other Time Series GUIs

FTSTool works with Datafeed Toolbox and Database Toolbox software to
load data. In addition, FTSTool interoperates with chartfts to display an
interactive plot and ftsgui to perform further time series data analysis.

The workflow for using FTSTool with chartfts is:

1 After loading data from either Datafeed Toolbox or Database Toolbox
software or an internal file, select a variable from the MATLAB
Workspace Variables list box.

2 Click the Plot tab, click Type, and then select Interactive Chart.

3 Click Plot. The interactive plot is displayed in chartfts. You can then use
chartfts menu items for further display options.

For more information on chartfts, select Help > Graphics Help.

The workflow for using FTSTool with the Financial Time Series GUI (ftsgui)
is:

1 After loading data from either Datafeed Toolbox or Database Toolbox
software or an internal file, select a variable from the MATLAB
Workspace Variables list box.

2 Select Tools > FTSGUI to open the Financial Time Series GUI window.

3 Select a variable from the MATLAB Workspace Variables list box. Click
the Plot tab and then select one of the following from the Type drop-down
list: Line Plot, High-Low Plot, or Candlestick Plot.

4 Click Plot. The plot is displayed in a MATLAB graphic window. In
addition, the Financial Time Series GUI window displays an entry for the
plotted fints object. You can then use the menu items in the Financial
Time Series GUI window to perform further analysis.

For more information on ftsgui, select Help > Help on Financial Time
Series GUI



Using FTSTool with Other Time Series GUIs

Note If the selected workspace variable that you are plotting is not a
fints object, a fints object is created when you click Plot. The new fints
object uses the name designated by the MATLAB workspace variable

box on the Create tab.
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Introduction

Use the financial time series graphical user interface (GUI) to analyze your
time series data and display the results graphically without resorting to the
command line. The GUI lets you visualize the data and the results at the
same time.

“Using the Financial Time Series GUI” on page 10-7 discusses how to use
this GUL.

Main Window
Start the financial time series GUI with the command

ftsgui

The Financial Time Series GUI window opens.

<) Financial Time Series GUI [ [T =]
File Data Analysis Graphs Window Help
Started: Main FTS GUI Window :I

The title bar acts as an active time series object indicator (indicates the
currently active financial time series object). For example, if you load the file
disney.mat and want to use the time series data in the file dis, the title bar
on the main GUI would read as shown.

<) Financial Time Series GUI. Active: Walt Disney Company (DIS)
File Data Analysis Graphs Window Help

Started: Main FTS GUI Windaw ;l
Loaded file: J:\dishey.mat

Dizplaying: ‘walt Disney Company [D15)

Dizplaying: TOQUARTERLY: 'walt Dishey Company [DIS]

Dizplaying: “walt Dizney Company [DIS]) - Mo VOLUME
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The menu bar consists of six menu items: File, Data, Analysis, Graphs,
Window, and Help. Under the menu bar is a status box that displays the
steps you are doing.

File Menu

<) Financial Time Series GUI [_ [T x]
Data Analysis  Graphs Window Help
Load o ;I
Sawve

Save As

Import
Export

Fage Setup
Frint Prewiew
Erint

Close FTS GLI
Exit MATLAB

The File menu contains the commands for input and output. You can read
and save (Load, Save, and Save As) MATLAB MAT-files, ASCII (text) data
files, as well as import (Import) Excel XLS files. MATLAB software does not
support the export of Excel XLS files at this time.

The File menu also contains the printing suite (Page Setup, Print Preview,

and Print). Lastly, from this menu you can close the GUI itself (Close FTS
GUI) and quit MATLAB (Exit MATLAB).
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Data Menu

<) Financial Time Series GUI, Active: Walt Disney Company (DIS)
Analysis  Graphs  Window Help

Fill Missing Data =]
Display  2mooth Data

Dizplay [DIS)
Display  Lag Data E

Lead Data

Filter Data
Box-Cox Transformation

Besample data
Conwvert Data Frequency To  »

The Data menu provides a collection of data manipulation functions and data
conversion functions.

Besample data

To Daily
ToWeekly

To Monthly

To Quarterly
To Semi-annual
To Annual

To use any of the functions here, make sure that the correct financial time
series object is displayed in the title bar of the main GUI window.

Analysis Menu

<) Financial Time Series GUI
File Data Graphs  Window Help

Started: Main FT Exp( ..} ;I
Log(..}
Logl0 ..}
Logz(..)

Basic Statistics

Difference
Eeriodic Average

Technical Analysis *




Introduction

The Analysis menu provides

® A set of exponentiation and logarithmic functions.

e Statistical tools (Basic Statistics), which calculate and display the
minimum, maximum, average (mean), standard deviation, and variance
of the current (active) time series object; these basic statistics numbers
are displayed in a dialog window.

® Data difference (Difference) and periodic average (Periodic Average)
calculations. Data difference generates a vector of data that is the
difference between the first data point and the second, the second and the
third, and so on. The periodic average function calculates the average per
defined length period, for example, averages of every five days.

e Technical analysis functions. See Chapter 12, “Technical Analysis” for a
list of the provided technical analysis functions.

As with the Data menu, to use any of the Analysis menu functions, make
sure that the correct financial time series object is displayed in the title bar of
the main GUI window.

Graphs Menu

<} Financial Time Series GUI, Active: Walt Disney Company (DIS)
Eile Data Analysis EEEhlgl Aindow Help

Started: Main FTS GUI Windar | ine Plot
Loaded file: J:\dizney. mat _

Digplaving: " alt Dizney Compe Eer Chart

Displaying: TOUUARTERLY: Y Harizontal Ear Chart

Digplaying: ' alt Dignew Comps 3D Bar Chart
Haorizontal 30 Bar Chart
candle Flot
High-Low Flot

Interactive Chart

The Graphs menu contains functions that graphically display the current
(active) financial time series object. You can also start up the interactive
charting function (chartfts) from this menu.
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Window Menu

<} Financial Time Series GUI, Active: Walt Disney Company (DIS)
Eile Data Analysis Graphs M Help

Started: Main FTS GUI Windaw 2 TOQUARTERLY: Walt Disney Company (DIS)
Loaded file: J:\dishey. mat .
Dizplaying: W alk Disney Cormpary [D15) 3'walt Disney Comparny (DIS)

Displaying: TOOUARTERLY: ‘walt Disnep [ 4 WWalt Disney Campany (DIS) - Mo WOLUME
Dizplaying: " alt Diznep Company [D15] - Me

1 Financial Time Series GUI, Active: Walt Disney Company (DIS)

0 MATLAE Command YWind e
|

The Window menu lists open windows under the current MATLAB session.

Help Menu

<} Financial Time Series GUI. Active: Walt Disney Company (DIS)
File Data Analysis Graphs  Window

Started: Main FT3 GUI Windaw Help on Financial Time Series GUI ‘I
Loaded file; J:\disney. mat . . . )
Displaying: 'walt Disney Company [DIS] Help on Financial Time Series Toollbox

Digplaing: TOQUARTERLY: “alt Digney Company (DIS
Displaying: W alt Disney Company [D15] - No YOLUME Help on MATLAB

MATLAB Demos =l

About Financial Time Series GUI
About MATLAB

The Help menu provides a standard set of Help menu links.
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Using the Financial Time Series GUI

In this section...
“Getting Started” on page 10-7

“Data Menu” on page 10-9
“Analysis Menu” on page 10-13
“Graphs Menu” on page 10-15

“Saving Time Series Data” on page 10-19

Getting Started

To use the Financial Time Series GUI, first start the financial time series GUI
with the command ftsgui. Then load (or import) the time series data.

For example, if your data is in a MATLAB MAT-file, select Load from the
File menu.

<) Financial Time Series GUI
Data Analysis  Graphs Window Help

I

Sawve
Save As

Import
Export

Fage Setup
Print Presdew
Erint

Close FTE Gl
Exit MATLAB
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Load a MAT-file or an ASCII data file HE
Look jn: |Eftsdata j gl IE

dizhey.mat
di30shart, mat

File name; Iftsdata. mat Open I
Files of type: IMAT-fiIes [* rnat) j Cancel |

For illustration purposes, choose the file ftsdata.mat from the dialog
presented.

If you don’t see the MAT-file, look in the directory
matlabroot\toolbox\finance\findemos, where matlabroot is the MATLAB
root directory (the directory where MATLAB is installed).

Note Data loaded through the Financial Time Series GUI is not available
in the MATLAB workspace. You can access this data only through the GUI
itself, not with any MATLAB command-line functions.

Each financial time series object inside the MAT-file is presented as a line
plot in a separate window. The status window is updated accordingly.
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! Finandial Time Series GUI, Active: International Bug ) Walt Disney Company (DIS) _|z ill
L |
Started: Main FTS GUI Window 2| Whiripool (VIR ;Iglil
Displaying: Walt Disney Company (DIS) = Ll ;IEI—I
Displaying: Intemnational Business Machines Corporation (IBM)  File Edit View Insert Tools Desktop Window Help =

Displaying: Whirlpool (WHR) R | s ‘ BN E | = ‘ 0 ’El =

200 ‘ - -
1 { [—— oPEN

—— HiGH

— Low

02-Jan-1995 024un1996 01-Nov-1997 (}24\[.}[ 1999

Whirlpool (WHR) is the last plot displayed, as indicated on the title bar
of the main window.

Data Menu

The Data menu provides functions that manipulate time series data.

2 Financial Time Series GUI

File Analysis  Graphs  Window Help

Startec  Fill Missing Data
Smooth Data

Lag Data
Lead Data

Filter Data
Box-Cox Transformation

Besample data
Convert Data Frequency To ¥

Here are some example tasks that illustrate the use of the functions on this
menu.
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Fill Missing Data

First, look at filling missing data. The Fill Missing Data item uses the
toolbox function fillts. With the data loaded from the file ftsdata, you have
three time series: IBM Corp. (IBM), Walt Disney Co. (DIS), and Whirlpool
(WHR). Click on the window that shows the time series data for Walt Disney
Co. (DIS).

) ¥alt Disney Company (DIS) _ - |EI|£|
File Edit Miew Insert Tools ‘Window Help

DEE& YA~/ PED

To view any missing data in this time series data set, zoom into the plot
using the Zoom tool (the magnifying glass icon with the plus sign) from the
toolbar and select a region.
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7} walt Disney Company (DIS) =1O] x|
Eile Edit WYiew Insert Tools indow Help

D=zda "A 2/ |po o

T

— YOLUME

e\

The gaps represent the missing data in the series. To fill these gaps, select
Data > Fill Missing Data. This selection automatically fills the gaps and
generates a new plot that displays the filled time series data.

-} Filled Walt Disney Company (DIS) 1ol x|

-} Filled Walt Disney Company (DIS) =1oi=|

File Edit Wew Insert Todls ‘Window Help File Edit ‘ew | Insert Tools Window Help
D& xA 2/ 20 D&/ NA 2/ [ppo

— VOLUME : — YOLUME
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You cannot see the filled gaps when you display the entire data set. However,
when you zoom into the plot, you see that the gaps have been eliminated.
Note that the title bar has changed; the title has been prefixed with the word
Filled to reflect the filled time series data.

Frequency Conversion
The Data menu also provides access to frequency conversion functions.

Besample data
i To Daily

ToWeekly

To Monthly

To Quarterly

To Semi-annual

To Annual

This example changes the DIS time series data frequency from daily to
monthly. Close the Filled Walt Disney Company (DIS) window, and click the
Walt Disney Company (DIS) window to make it active (current) again. Then,
from the Data menu, select Convert Data Frequency To and To Monthly.

A new figure window displays the result of this conversion.
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<) TOMONTHLY: Walt Disney Company (D

Eile Edit WYiew Insert Tools indow Help

=101 x]

lDzaa/rAar/peo

40

30

20

10

27-Mar-1996 29-Mar-1997

31-Mar-1998

0
02-Apr-1999

The title reflects that the data displayed had its frequency changed to monthly.

Analysis Menu

The Analysis menu provides functions that analyze time series data,
including the technical analysis functions. (See Chapter 12, “Technical
Analysis” for a complete list of the technical analysis functions and several

usage examples.)

For example, you can use the Analysis menu to calculate the natural
logarithm (log) of the data contained within the data set ftsdata.mat. This
data file provides time series data for IBM (IBM), Walt Disney (DIS), and
Whirlpool (WHR). Click the window displaying the data for IBM Corporation
(IBM) to make it active (current). Then select the Analysis menu, followed by

Log( ... ). The result appears in its own window.
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/) LOG of International Business Machines Corporationi

Eile Edit Yiew Insett Tools | wWindow Help

D=zda "A A/ | @oo

OPEM
HIGH
L
CLOSE
SWOLUME

Close the above window and click again on the IBM data window to make it
active (current).

Note Before proceeding with any time series analysis, make certain that the
title bar confirms that the active data series is the correct one.

From the Analysis menu on the main window, select Technical Analysis
and MACD. The result, again, is displayed in its own window.
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<) MACD: International Business Machint i [ 4|
File Edit VYiew Insert Tools Window Help
D=zda "A A/ | @oo
8 : T
: — MACDLine
= R S — MinePertiA ||

ﬂ_

-4 H H
02-Jan-1335 02-Jun-13996 01-Maw-1997 02-Apr-1999

Other analysis functions work similarly.

Graphs Menu

The Graphs menu displays time series data using the provided graphics
functions. Included in the Graphs menu are several types of bar charts (bar,
barh and bar3, bar3h), line plot (plot), candle plot (candle), and High-Low
plot (highlow). The Graphs menu also provides access to the interactive
charting function, chartfts.

Candle Plot

For example, you can display the candle plot of a set of time series data and
start up the interactive chart on the same data set.

Load the ftsdata.mat data set, and click the window that displays the
Whirlpool (WHR) time series data to make it active (current). From the main
window, select the Graphs menu and then Candle Plot.
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/) Financial Time Series GUI, Active: Whirlpool (WHR) | oy ] o3}
Fle Data analysis | Graphs Window Help
Displaying: Walt Disnes  Line Plot -]

Displaying: Whilpool (s par chart
tomorthly, Wal Disrey B
log: International Busin,  ELorizental Bar Chart

maed: Intemational Bus 30 Bar Chart |
e aveoll fzontal 30 Bar Chart B

Ipool (WHR|

Fle Edt Wew In

Ipzma xar/ e

Interactive Chart

The result is shown below.

Candle Plot: Whirlpool {\¢HR} - |EI|1|
File Edit Miew Insert Tools ‘Window Help

DeEa A A/ | @R

This does not look much like a candle plot because there are too many data
points in the data set. All the candles are too compressed for effective
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viewing. However, when you zoom into a region of this plot, the candles
become apparent.

2} Candle Plot: Whirlpool {WHR) S =]
File Edit VYiew Insert Tools Window Help

ID=zda "A 2/ |poe o

Interactive Chart

To create an interactive chart (chartfts) on the Whirlpool data, click the
window that displays the Whirlpool (WHR) data to make it active (current).
Then, go to the Graphs menu and select Interactive Chart.

10-17



1 0 Financial Time Series Graphical User Interface

7) Financial Time Series GUI. Active: Whirlpool (WHR)
Eile  Data  Analysis Mindow  Help

Started: Main FTS GUI Windoy  Line Plot

Loaded fils: J:\ftsdataiftsdata

Displaping: Intemalional Bugine  Ear Chart

B\sp:aym wﬁ!l‘Dlsr‘w i?qmné Horizontal Bar Chart
isplaying: Whirlpool [4HR) 90 Bar Chart

Horizontal 30 Bar Chart

Candle Plot
High-Low Plot

nal Business Machines Corporati... H=] E3
Yiew Inset  Taals ‘Window Help

Wiew Insert Tools Window Help
Whirlpool (WHR) =1o|
FEile Edit Wiew [nsert Tools Window Help

Ibczaa xA s 2o

The chart that results is shown below.
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<) Interactive Chart: Whirlpool (WHR) 10l =|

File Edit Yiew Insert Tools ‘Window Help Chart Tools

You can use this interactive chart as if you had invoked it with the chartfts
command from the MATLAB command line. For a tutorial on the use of
chartfts, see “Visualizing Financial Time Series Objects” on page 7-18.

Saving Time Series Data

The Save and Save As items on the main window File menu let you save
the time series data that results from your analyses and computations. These
items save all time series data that has been loaded or processed during the
current session, even if the window displaying the results of a computation
has previously been dismissed.

Note The Save and Save As items on the File menu of the individual plot
windows will not save the time series data, but will save the actual plot.

You can save your time series data in two ways:
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¢ Into the latest MAT-file loaded (Save)

® Into a MAT-file chosen (or named) from the window (Save As)

To illustrate this, start by loading the data file testftsdata.mat (located
in matlabroot/toolbox/finance/findemos). Then, convert the Disney
(DIS) data from daily (the original frequency) to monthly data. Next, run the
MACD analysis on the Whirlpool (WHR) data. You now have a set of five
open figure windows.

5/
File Data Analysis Graphs Window Help El
_oix] =]
_lolx
_lolx
o nermatonat busines Ndhines Corport _lo/x]

! TOMONTHLY: MACD: International Business Mad - =]
>

File Edit View Insert Tools Deskiop Window Help
OSds s [RL09 84 80O

8

—— MACDLine
NinePerMA

2 i
31-Jan-1995 01-Jul-1996 30-Nov-1997 01-May-1999

Saving into the Original File (Save)

To save the data back into the original file (testftsdata.mat), select Save
from the File menu.

A confirmation window appears. It confirms that the data has been saved in
the latest MAT-file loaded (testftsdata.mat in this example).
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<) Save: ALL time series data M= B

The time series data:

+» TOMOMTHLY: " alt Disney Company [D15)

+» MACD: Whirlpool f/HR)

+» Whirlpool f/HR)

+» Walt Digney Company [DIS)

+» |nternational Buginess Machines Corporation [|BR)

hazlve] beeh zaved inta file:

On:hamiorktestftedata mat

Ok |

Saving into a New File (Save As)
To save the data in a different file, choose Save As from the File menu.

The dialog box that appears lets you choose an existing MAT-file from a list or
type in the name of a new MAT-file you want to create.

Save As: ALL time series data
Save in: Ia wark j gl e

.1 ftproot
testftzdata.mat

File narme: Imyftstestdatel Save I
Save as lwpe: IMAT-fiIes [* mat) j Cancel |

After you click the Save button, another confirmation window appears.
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) Save As: ALL time series data

This confirmation window indicates that the data has been saved in a new file
named myftstestdata.mat.
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Trading Calendars Graphical User Interface

Use the createholidays function to open the Trading Calendars graphical
user interface.

.| Trading € - O] x|

Create holiday lists from FinancialCalendar. com data

1. Choose data file ... |

2. Choose codes file .. |

3. Choose info file . |

4. Choose directory for writing haoliday files .. |

¥ Include weekends
¥ Prompt for target directory

5. Create holiday files .. |

Close | Help |

The createholidays function supports http://www.FinancialCalendar.com
trading calendars. This function can be used from the command line or from
the Trading Calendars graphical user interface. For more information on
using the command line to programmatically generate the market specific
holidays.m files without displaying the interface, see createholidays.

To use the Trading Calendars graphical user interface:

1 From the command line, type the following command to open the Trading
Calendars graphical user interface.

createholidays
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Trading Calendars Graphical User Interface

2 Click Choose data file to select the data file.
3 Click Choose codes file to select the codes file.
4 Click Choose info file to select the info file.

5 Click Choose directory for writing holiday files to select the output
directory.

6 Select Include weekends to include weekends in the holiday list and
click Prompt for target directory to be prompted for the file location for
each holidays.m file that is created.

7 Click Create holiday files to convert FinancialCalendar.com financial
center holiday data into market-specific holidays.m files.

The market-specific holidays.m files can be used in place of the standard
holidays.m that ships with Financial Toolbox software.
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UlCalendar Graphical User Interface

In this section...

“Using UlCalendar in Standalone Mode” on page 11-4

“Using UlCalendar with an Application” on page 11-5

Using UlCalendar in Standalone Mode

You can use the UlCalendar graphical user interface in standalone mode to
look up any date. To use the standalone mode:

1 Type the following command to open the UICalendar GUI:

uicalendar

The UlCalendar interface is displayed:

1o x]
ol oy ] ]
Su Mo Tu [¥e Th Fr Sa
1 2 3 4 5
B 7 B 9 10 11 12
13 14 15 16 17 18 19
20 21 22 23 24 5 B
27 2% 29 30 3

Clear all 0K | Cancel'

2 Click the date and year controls to locate any date.
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Using UlCalendar with an Application

You can use the UlICalendar graphical user interface with an application
to look up any date. To use the UlCalendar graphical interface with an
application, use the following command:

uicalendar('PARAM1', VALUE1, 'PARAM2', VALUE2', ...)

For more information, see uicalendar.

Example of Using UlCalendar with an Application

The UlCalendar example creates a function that displays a graphical user
interface that lets you select a date from the UlCalendar graphical user
interface and fill in a text field with that date.

1 Create a figure.

function uicalendarGUIExample
f = figure('Name', 'uicalendarGUIExample');

2 Add a text control field.

dateTextHandle = uicontrol(f, 'Style', 'Text',
'String', 'Date:’,

'Horizontalalignment', 'left',

'"Position', [100 200 50 20]);

3 Add a uicontrol editable text field to display the selected date.

dateEditBoxHandle = uicontrol(f, 'Style', 'Edit',
'Position', [140 200 100 20],
'BackgroundColor', 'w');

4 Create a push button that startups the UlCalendar.

calendarButtonHandle = uicontrol(f, 'Style', 'PushButton’,
'String', 'Select a single date',

'Position', [275 200 200 20],

‘callback', @pushbutton_cb);

5 To startup UlCalendar, create a nested function (callback function) for
the push button.
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function pushbutton_cb(hcbo, eventStruct)

Create a UICALENDAR with the following properties:

1) Highlight weekend dates.

2) Only allow a single date to be selected at a time.
3) Send the selected date to the edit box uicontrol.
uicalendar('Weekend', [1 0 0 O 0O O 1],

'SelectionType', 1,

'DestinationUI', dateEditBoxHandle);

end

end

o® o° o°

o°

6 Run the function uicalendarGUIExample to display the application

interface:
} Figure 1: uicalendarGUIExample — |El|i|
File Edit View Insert Tools Desktop Window Help Ll

Diate: | Select a single date

7 Click Select a single date to display the UlCalendar graphical user
interface:
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UICalendar I_IEI_
N o |

8 Select a date and click OK to display the date in the text field:

Figure 1: uicalendarGUIExample

24-May-2007
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Introduction

Technical analysis (or charting) is used by some investment managers to
help manage portfolios. Technical analysis relies heavily on the availability
of historical data. Investment managers calculate different indicators from
available data and plot them as charts. Observations of price, direction,
and volume on the charts assist managers in making decisions on their

investment portfolios.

The technical analysis functions in this toolbox are tools to help analyze your
investments. The functions in themselves will not make any suggestions or
perform any qualitative analysis of your investment.

Technical Analysis: Oscillators

Function Type
adosc Accumulation/distribution oscillator
chaikosc Chaikin oscillator
macd Moving Average
Convergence/Divergence

stochosc Stochastic oscillator
tsaccel Acceleration
tsmom Momentum

Technical Analysis: Stochastics
Function Type
chaikvolat Chaikin volatility
fpctkd Fast stochastics
spctkd Slow stochastics
willpctr Williams %R




Introduction

Technical Analysis: Indexes

Function Type

negvolidx Negative volume index
posvolidx Positive volume index
rsindex Relative strength index

Technical Analysis: Indicators

Function Type

adline Accumulation/distribution line
bollinger Bollinger band

hhigh Highest high

llow Lowest low

medprice Median price

onbalvol On balance volume

prcroc Price rate of change

pvtrend Price-volume trend

typprice Typical price

volroc Volume rate of change

wclose Weighted close

willad Williams accumulation/distribution
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Examples

In this section...

“Overview” on page 12-4

“Moving Average Convergence/Divergence (MACD)” on page 12-4
“Williams %R” on page 12-6

“Relative Strength Index (RSI)” on page 12-7

“On-Balance Volume (OBV)” on page 12-8

Overview

To illustrate some the technical analysis functions, this section uses the IBM
stock price data contained in the supplied file ibm9599.dat. First create a
financial time series object from the data using ascii2fts:

ibm = ascii2fts('ibm9599.dat', 1, 3, 2);

The time series data contains the open, close, high, and low prices, as well
as the volume traded on each day. The time series dates start on January
3, 1995, and end on April 1, 1999, with some values missing for weekday
holidays; weekend dates are not included.

Moving Average Convergence/Divergence (MACD)

Moving Average Convergence/Divergence (MACD) is an oscillator function
used by technical analysts to spot overbought and oversold conditions. Look
at the portion of the time series covering the 3-month period between October
1, 1995 and December 31, 1995. At the same time fill any missing values due
to holidays within the time period specified:

part_ibm = fillts(ibm('10/01/95::12/31/95"));

Now calculate the MACD, which when plotted produces two lines; the first line
is the MACD line itself and the second is the nine-period moving average line:

macd_ibm = macd(part_ibm);
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Note When you call macd without giving it a second input argument to specify
a particular data series name, it searches for a closing price series named
Close (in all combinations of letter cases).

Plot the MACD lines and the High-Low plot of the IBM stock prices in two
separate plots in one window.

subplot(2, 1, 1);

plot(macd_ibm);

title('MACD of IBM Close Stock Prices, 10/01/95-12/31/95"');
datetick('x', 'mm/dd/yy');

subplot(2, 1, 2);

highlow(part_ibm);

title('IBM Stock Prices, 10/01/95-12/31/95"');

datetick('x', 'mm/dd/yy")

The following figure shows the result.

MACD of IBEM Close Stock Prices, 10/01/95-12/31/95

—— MACDLine
—— NinePerMA

-1
10/01/35 11/01/95 12/01/35 01/01/96

IBEM Stock Prices, 10/01/95-12/31/95

52

50

48

46

44

42
10/01/95 11/01/95 12/01/95 01/01/96
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Williams %R

Williams %R is an indicator that measures overbought and oversold levels.
The function willpctr is from the stochastics category. All the technical
analysis functions can accept a different name for a required data series. If,
for example, a function needs the high, low, and closing price series but your
time series object does not have the data series names exactly as High, Low,
and Close, you can specify the correct names as follows.

wpr = willpctr(tsobj, 14, 'HighName', 'Hi', 'LowName', 'Lo',...
'CloseName', 'Closing')

The function willpctr now assumes that your high price series is named Hi,
low price series is named Lo, and closing price series is named Closing.

Since the time series object part_ibm has its data series names identical to
the required names, name adjustments are not needed. The input argument
to the function is only the name of the time series object itself.

Calculate and plot the Williams %R indicator for IBM stock along with the
price range using these commands:

wpctr_ibm = willpctr(part_ibm);

subplot(2, 1, 1);

plot(wpctr_ibm);

title('Williams %R of IBM stock, 10/01/95-12/31/95');
datetick('x', 'mm/dd/yy');

hold on;

plot(wpctr_ibm.dates, -80*ones(1, length(wpctr_ibm)),...
‘color', [0.5 0 0], 'linewidth', 2)
plot(wpctr_ibm.dates, -20*ones(1, length(wpctr_ibm)),...
‘color', [0 0.5 0], 'linewidth', 2)

subplot(2, 1, 2);

highlow(part_ibm);

title('IBM Stock Prices, 10/01/95-12/31/95"');
datetick('x', 'mm/dd/yy');

The next figure shows the results. The top plot has the Williams %R line plus
two lines at -20% and -80%. The bottom plot is the High-Low plot of the IBM
stock price for the corresponding time period.
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Relative Strength Index (RSI)

The Relative Strength Index (RSI) is a momentum indicator that measures
an equity’s price relative to itself and its past performance. The function
name is rsindex.

The rsindex function needs a series that contains the closing price of a stock.
The default period length for the RSI calculation is 14 periods. This length
can be changed by providing a second input argument to the function. Similar
to the previous commands, if your closing price series is not named Close, you
can provide the correct name.

Calculate and plot the RSI for IBM stock along with the price range using
these commands:

rsi_ibm = rsindex(part_ibm);

subplot(2, 1, 1);

plot(rsi_ibm);

title('RSI of IBM stock, 10/01/95-12/31/95");
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datetick('x', 'mm/dd/yy');

hold on;

plot(rsi_ibm.dates, 30*ones(1, length(wpctr_ibm)),...
‘color', [0.5 0 O], 'linewidth', 2)
plot(rsi_ibm.dates, 70*ones(1, length(wpctr_ibm)),...
‘color',[0 0.5 0], 'linewidth', 2)

subplot(2, 1, 2);

highlow(part_ibm);

title('IBM Stock Prices, 10/01/95-12/31/95"');
datetick('x', 'mm/dd/yy');

The next figure shows the result.

REI of IBM Stoclk, 10/01/95-12/31/95
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On-Balance Volume (OBV)

On-Balance Volume (OBV) relates volume to price change. The function
onbalvol requires you to have the closing price (Close) series as well as
the volume traded (Volume) series.

Calculate and plot the OBV for IBM stock along with the price range using
these commands:
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obv_ibm = onbalvol(part_ibm);

subplot(2, 1, 1);

plot(obv_ibm);

title('On-Balance Volume of IBM Stock, 10/01/95-12/31/95');
datetick('x', 'mm/dd/yy');

subplot(2, 1, 2);

highlow(part_ibm);

title('IBM Stock Prices, 10/01/95-12/31/95"');

datetick('x', 'mm/dd/yy');

The next figure shows the result.

% ID? On-Balance Volume of IBM Stock, 10/01/95-12/31/95

— OnBalVol

! : :

-2 H H
10/01/95 11/01/95 12/01/95 01/01/96
IBM Stock Prices, 10/01/95-12/31/95

42 ' '
10/01/95 11/01/95 12/01/95 01/01/96
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Function Reference

Dates (p. 13-2)

Currency and Price (p. 13-6)
Financial Data Charts (p. 13-6)
Cash Flows (p. 13-7)
Fixed-Income Securities (p. 13-9)

Portfolios (p. 13-11)

Financial Statistics (p. 13-14)

Derivatives (p. 13-16)
GARCH Processes (p. 13-17)

Financial Time Series Object and
File Construction (p. 13-18)

Financial Time Series Arithmetic
(p. 13-18)

Financial Time Series Math
(p. 13-19)

Financial Time Series Descriptive
Statistics (p. 13-19)

Financial Time Series Utility
(p. 13-20)

Financial Time Series Data
Transformation (p. 13-21)

Work with dates

Work with currency and price data
Create charts

Work with cash flows

Work with fixed-income securities

Analyze and measure performance
for portfolios

Perform statistical analysis of
financial data

Price and analyze derivatives
Introduce GARCH analysis

Functions for creating financial time
series

Arithmetic in financial time series

Mathematical calculations in
financial time series

Statistics in financial time series

Utility work with financial time
series

Data transformations of financial
time series



13 Function Reference

Financial Time Series Indicator Work with indicators for financial

(p. 13-22) time series

Financial Time Series GUI (p. 13-23) Work with Financial Time Series
GUI

Financial Time Series Tool (p. 13-23) Work with Financial Time Series
Tool

Dates

Current Time and Date (p. 13-2) Work with current date and time

Date and Time Components (p. 13-2) Compute dates and times

Date Conversion (p. 13-3) Convert dates

Financial Dates (p. 13-4) Compute financial dates

Coupon Bond Dates (p. 13-5) Compute coupon bond dates

Current Time and Date

now Current date and time

today Current date

Date and Time Components

datefind Indices of date numbers in matrix
datevec Date components

day Day of month

eomdate Last date of month

eomday Last day of month

hour Hour of date or time
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Dates

lweekdate

minute
month

months
nweekdate

second
weekday
weeknum
year

yeardays

Date Conversion

date2time
datedisp
datenum
datestr
dec2thirtytwo

m2xdate

thirtytwo2dec
time2date
uicalendar

x2mdate

Date of last occurrence of weekday
in month

Minute of date or time
Month of date

Number of whole months between
dates

Date of specific occurrence of
weekday in month

Seconds of date or time
Day of week

Week in a year

Year of date

Number of days in year

Time and frequency from dates
Display date entries

Create date number

Create date string

Decimal to thirty-second quotation

MATLAB serial date number to
Excel serial date number

Thirty-second quotation to decimal
Dates from time and frequency
Graphical calendar

Excel serial date number to
MATLAB serial date number
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13 Function Reference

13-4

Financial Dates

busdate
busdays
createholidays
datemnth
datewrkdy
days360

days360e

days360isda

days360psa

days365
daysact
daysadd
daysdif

fbusdate
holidays
isbusday
lbusdate

thirdwednesday

Next or previous business day
Business days in serial date format
Create trading calendars

Date of day in future or past month
Date of future or past workday

Days between dates based on
360-day year

Days between dates based on
360-day year (European)

Days between dates based on
360-day year (International
Swap Dealer Association (ISDA)
compliant)

Days between dates based on
360-day year (Public Securities
Association (PSA) compliant)

Days between dates based on
365-day year

Actual number of days between
dates

Date away from starting date for any
day-count basis

Days between dates for any
day-count basis

First business date of month
Holidays and nontrading days

True for dates that are business days
Last business date of month

Find third Wednesday of month



Dates

wrkdydif

yearfrac

Coupon Bond Dates

accrfrac
cfamounts
cfdates

cfport

cftimes
cpncount
cpndaten
cpndatenq
cpndatep
cpndatepq

cpndaysn

cpndaysp

cpnpersz

Number of working days between

dates

Fraction of year between dates

Fraction of coupon period before

settlement

Cash flow and time mapping for

bond portfolio

Cash flow dates for fixed-income

security

Portfolio form of cash flow amounts

Time factors corresponding to bond

cash flow dates

Coupon payments remaining until

maturity

Next coupon date for fixed-income

security

Next quasi coupon date for fixed

Income security

Previous coupon date for
fixed-income security

Previous quasi coupon date for fixed

Income security

Number of days to next coupon date

Number of days since previous

coupon date

Number of days in coupon period
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Currency and Price

cur2frac

cur2str
dec2thirtytwo

frac2cur

thirtytwo2dec

Financial Data Charts

bar, barh
bar3, bar3h
bolling
candle
candle (fts)
chartfts

dateaxis

highlow
highlow (fts)
kagi
linebreak

movavg

plot
pointfig

Decimal currency values to fractional
values

Bank-formatted text
Decimal to thirty-second quotation

Fractional currency value to decimal
value

Thirty-second quotation to decimal

Bar chart

3-D bar chart
Bollinger band chart
Candlestick chart
Time series candle plot
Interactive display

Convert serial-date axis labels to
calendar-date axis labels

High, low, open, close chart
Time series High-Low plot
Kagi chart

Line break chart

Leading and lagging moving
averages chart

Plot data series

Point and figure chart



Cash Flows

Cash Flows

priceandvol
renko

volarea

Annuities (p. 13-7)

Amortization and Depreciation
(p. 13-7)

Present Value (p. 13-8)

Future Value (p. 13-8)

Payment Calculations (p. 13-8)
Rates of Return (p. 13-8)

Cash Flow Sensitivities (p. 13-9)

Annuities

annurate

annuterm

Price and volume chart
Renko chart

Price and volume chart

Work with annuities

Work with amortization and
depreciation

Work with present values

Work with future values

Work with payment calculations
Work with rates of return

Work with cash flow sensitivities

Periodic interest rate of annuity

Number of periods to obtain value

Amortization and Depreciation

amortize

depfixdb

depgendb

deprdv

Amortization schedule

Fixed declining-balance depreciation
schedule

General declining-balance
depreciation schedule

Remaining depreciable value
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depsoyd
depstln

Present Value

pvfix

pvvar

Future Value

fvdisc

fvfix

fvvar

Payment Calculations

payadv
payodd

payper

payuni

Rates of Return

effrr

elpm

13-8

Sum of years’ digits depreciation

Straight-line depreciation schedule

Present value with fixed periodic
payments

Present value of varying cash flow

Future value of discounted security

Future value with fixed periodic
payments

Future value of varying cash flow

Periodic payment given number of
advance payments

Payment of loan or annuity with odd
first period

Periodic payment of loan or annuity

Uniform payment equal to varying
cash flow

Effective rate of return

Compute expected lower partial
moments for normal asset returns



Fixed-Income Securities

irr
mirr
nomrr
taxedrr

xirr

Cash Flow Sensitivities

cfconv

cfdur

Fixed-Income Securities

Accrued Interest (p. 13-9)
Prices (p. 13-10)

Term Structure of Interest Rates
(p. 13-10)

Yields (p. 13-11)
Spreads (p. 13-11)
Interest Rate Sensitivities (p. 13-11)

Accrued Interest

acrubond

acrudisc

Internal rate of return
Modified internal rate of return
Nominal rate of return
After-tax rate of return

Internal rate of return for
nonperiodic cash flow

Cash flow convexity

Cash-flow duration and modified
duration

Work with accrued interest
Work with prices

Work with term structure of interest
rates

Work with yields
Work with spreads

Work with interest rate sensitivities

Accrued interest of security with
periodic interest payments

Accrued interest of discount security
paying at maturity
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Prices
bndprice
prdisc

prmat

prtbill

Price fixed income security from
yield to maturity

Price of discounted security
Price with interest at maturity

Price of Treasury bill

Term Structure of Interest Rates

disc2zero
fwd2zero

prbyzero

pyld2zero
tbl2bond

tr2bonds

zbtprice

zbtyield

zero2disc
zero2fwd

zero2pyld

13-10

Zero curve given discount curve
Zero curve given forward curve

Price bonds in portfolio by set of zero
curves

Zero curve given par yield curve

Treasury bond parameters given
Treasury bill parameters

Term-structure parameters given
Treasury bond parameters

Zero curve bootstrapping from
coupon bond data given price

Zero curve bootstrapping from
coupon bond data given yield

Discount curve given zero curve
Forward curve given zero curve

Par yield curve given zero curve



Portfolios

Portfolios

Yields

beytbill
bndyield
discrate

ylddisc
yldmat
yldtbill

Spreads

bndspread

Interest Rate Sensitivities

bndconvp
bndconvy
bnddurp
bnddury
bndkrdur

Portfolio Analysis (p. 13-12)
Performance Metrics (p. 13-13)

Bond equivalent yield for Treasury
bill

Yield to maturity for fixed income
security

Bank discount rate of money market
security

Yield of discounted security
Yield with interest at maturity

Yield of Treasury bill

Static spread over spot curve

Bond convexity given price
Bond convexity given yield
Bond duration given price
Bond duration given yield

Bond key rate duration given zero
curve

Perform portfolio analysis

Calculate performance metrics
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Porifolio Analysis

abs2active
active2abs
arith2geom
corr2cov
cov2corr
ewstats

frontcon
frontier

geom2arith

holdings2weights

pcalims

pcgcomp

pcglims

pcpval
periodicreturns
portalloc

portcons

Convert constraints from absolute to
active format

Convert constraints from active to
absolute format

Arithmetic to geometric moments of
asset returns

Convert standard deviation and
correlation to covariance

Convert covariance to standard
deviation and correlation coefficient

Expected return and covariance from
return time series

Mean-variance efficient frontier
Rolling efficient frontier

Geometric to arithmetic moments of
asset returns

Portfolio holdings into weights

Linear inequalities for individual
asset allocation

Linear inequalities for asset group
comparison constraints

Linear inequalities for asset group
minimum and maximum allocation

Linear inequalities for fixing total
portfolio value

Periodic total returns from total
return prices

Optimal capital allocation to efficient
frontier portfolios

Portfolio constraints



Portfolios

portopt

portrand

portror

portsim

portstats
portvar
portvrisk
ret2tick
ret2tick (fts)

selectreturn

targetreturn
tick2ret
tick2ret (fts)

totalreturnprice

weights2holdings

Performance Metrics

emaxdrawdown

inforatio

1pm

Portfolios on constrained efficient

frontier

Randomized portfolio risks, returns,

and weights

Portfolio expected rate of return

Monte Carlo simulation of correlated

asset returns

Portfolio expected return and risk
Variance for portfolio of assets
Portfolio value at risk (VaR)
Convert return series to price series

Convert return series to price series
for time series object

Portfolio configurations from 3-D

efficient frontier

Portfolio weight accuracy
Convert price series to return series

Convert price series to return series
for time series object

Total return price time series

Portfolio values and weights into

holdings

Compute expected maximum
drawdown for Brownian motion

Calculate information ratio for one

or more assets

Compute sample lower partial

moments of data
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maxdrawdown

portalpha

sharpe

Financial Statistics

13-14

Expectation Conditional
Maximization (p. 13-14)

Multivariate Normal Regression
(p. 13-15)

Expectation Conditional
Maximization — Multivariate
Normal Regression (p. 13-15)

Expectation Conditional
Maximization — Least-Squares
Regression (p. 13-16)

Seemingly Unrelated Regression
(p. 13-16)

Compute maximum drawdown for
one or more price series

Compute risk-adjusted alphas and
returns for one or more assets

Compute Sharpe ratio for one or
more assets

Work with expectation conditional
maximization

Work with multivariate normal
regression

Work with expectation conditional
maximization and multivariate
normal regression

Work with least-squares regression

Work with unrelated regression

Expectation Conditional Maximization

ecmnfish

ecmnhess

ecmninit

ecmnmle

Fisher information matrix

Hessian of negative log-likelihood
function

Initial mean and covariance

Mean and covariance of incomplete
multivariate normal data



Financial Statistics

ecmnobj

ecmnstd

Multivariate normal negative
log-likelihood function

Standard errors for mean and
covariance of incomplete data

Multivariate Normal Regression

mvnrfish

mvnrmle

mvnrobj

mvnrstd

Fisher information matrix for
multivariate normal or least-squares
regression

Multivariate normal regression
(ignore missing data)

Log-likelihood function for
multivariate normal regression
without missing data

Evaluate standard errors for
multivariate normal regression
model

Expectation Conditional Maximization - Multivariate

Normal Regression

ecmmvnrfish

ecmmvnrmle

ecmmvnrobj

ecmmvnrstd

Fisher information matrix for
multivariate normal regression
model

Multivariate normal regression with
missing data

Log-likelihood function for
multivariate normal regression
with missing data

Evaluate standard errors for
multivariate normal regression
model
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Expectation Conditional Maximization -
Least-Squares Regression

ecmlsrmle Least-squares regression with
missing data

ecmlsrobj Log-likelihood function for
least-squares regression with
missing data
Seemingly Unrelated Regression
convert2sur Convert multivariate normal

regression model to seemingly
unrelated regression (SUR) model

Derivatives

Option Valuation and Sensitivity Work with option valuation and
(p. 13-16) sensitivity

Option Valuation and Sensitivity

binprice Binomial put and call pricing

blkimpv Implied volatility for futures options
from Black’s model

blkprice Black’s model for pricing futures
options

blsdelta Black-Scholes sensitivity to

underlying price change

blsgamma Black-Scholes sensitivity to
underlying delta change
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GARCH Processes

blsimpv Black-Scholes implied volatility

blslambda Black-Scholes elasticity

blsprice Black-Scholes put and call option
pricing

blsrho Black-Scholes sensitivity to interest

rate change

blstheta Black-Scholes sensitivity to
time-until-maturity change

blsvega Black-Scholes sensitivity to
underlying price volatility

opprofit Option profit

GARCH Processes

Univariate GARCH Processes Work with univariate GARCH
(p. 13-17) processes

Univariate GARCH Processes

ugarch Univariate GARCH(P,Q) parameter
estimation with Gaussian
innovations

ugarchllf Log-likelihood objective function of

univariate GARCH(P,Q) processes
with Gaussian innovations

ugarchpred Forecast conditional variance of
univariate GARCH(P,Q) processes
ugarchsim Simulate univariate GARCH(P,Q)

process with Gaussian innovations
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Financial Time Series Object and File Construction

ascii2fts

fints

fts2ascii

fts2mat

merge

Financial Time Series Arithmetic

13-18

end

horzcat

length
minus
mrdivide

mtimes

plus
power
rdivide
size
subsasgn
subsref

times

Create financial time series object
from ASCII data file

Construct financial time series object

Write elements of time-series data
into ASCII file

Convert to matrix

Merge multiple financial time series
objects

Last date entry

Concatenate financial time series
objects horizontally

Get number of dates (rows)
Financial time series subtraction
Financial time series matrix division

Financial time series matrix
multiplication

Financial time series addition
Financial time series power
Financial time series division
Number of dates and data series
Content assignment
Subscripted reference

Financial time series multiplication



Financial Time Series Math

uminus
uplus

vertcat

Financial Time Series Math

cumsum
exp
hist
log
log10
log2
max
mean
min

std

Unary minus of financial time series
object

Unary plus of financial time series
object

Concatenate financial time series
objects vertically

Cumulative sum
Exponential values
Histogram

Natural logarithm
Common logarithm
Base 2 logarithm
Maximum value
Arithmetic average
Minimum value

Standard deviation

Financial Time Series Descriptive Statistics

corrcoef
cov

isempty

nancov

Correlation coefficients
Covariance matrix

True for empty financial time series
objects

Covariance ignoring NaNs
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Financial Time Series Utility

13-20

nanmax
nanmean
nanmedian
nanmin
nanstd
nansum
nanvar

var

chfield
eq (fts)

extfield
fetch

fieldnames

fregnum

freqgstr

ftsbound
ftsinfo

ftsuniq
getfield

getnameidx

Maximum ignoring NaNs

Mean ignoring NaNs

Median ignoring NaNs

Minimum ignoring NaNs
Standard deviation ignoring NaNs
Sum ignoring NaNs

Variance ignoring NaNs

Variance

Change data series name

Multiple financial times series object
equality

Data series extraction

Data from financial time series
object

Get names of fields

Convert string frequency indicator
to numeric frequency indicator

Convert numeric frequency indicator
to string representation

Start and end dates

Financial time series object
information

Determine uniqueness
Content of specific field

Find name in list



Financial Time Series Data Transformation

iscompatible Structural equality

isequal Multiple object equality

isfield Check whether string is field name
issorted Check whether dates and times are

monotonically increasing

rmfield Remove data series
setfield Set content of specific field
sortfts Sort financial time series

Financial Time Series Data Transformation

boxcox Box-Cox transformation

convert2sur Convert multivariate normal
regression model to seemingly
unrelated regression (SUR) model

convertto Convert to specified frequency
diff Differencing

fillts Fill missing values in time series
filter Linear filtering

lagts Lag time series object

leadts Lead time series object

peravg Periodic average of FINTS object
resamplets Downsample data

smoothts Smooth data

toannual Convert to annual

todaily Convert to daily

todecimal Fractional to decimal conversion
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tomonthly
toquarterly
toquoted
tosemi
toweekly

tsmovavg

Financial Time Series Indicator

13-22

adline
adosc
bollinger
chaikosc
chaikvolat
fpctkd
hhigh

llow

macd

medprice
negvolidx
onbalvol
posvolidx
prcroc
pvtrend
rsindex

spctkd

Convert to monthly

Convert to quarterly

Decimal to fractional conversion
Convert to semiannual

Convert to weekly

Moving average

Accumulation/Distribution line
Accumulation/Distribution oscillator
Time series Bollinger band

Chaikin oscillator

Chaikin volatility

Fast stochastics

Highest high

Lowest low

Moving Average
Convergence/Divergence (MACD)

Median price

Negative volume index
On-Balance Volume (OBV)
Positive volume index

Price rate of change

Price and Volume Trend (PVT)
Relative Strength Index (RSI)

Slow stochastics



Financial Time Series GUI

stochosc
tsaccel
tsmom
typprice
volroc
wclose
willad

willpctr

Financial Time Series GUI

ftsgui

Financial Time Series Tool

ftstool

Stochastic oscillator
Acceleration between periods
Momentum between periods
Typical price

Volume rate of change
Weighted close

Williams Accumulation/Distribution
line

Williams %R

Financial time series GUI

Financial time series tool
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abs2active

Purpose Convert constraints from absolute to active format
Syntax ActiveConSet = abs2active(AbsConSet, Index)
Arguments

AbsConSet Portfolio linear inequality constraint matrix

expressed in absolute weight format. AbsConSet is
formatted as [A b] such that A*w <= b, where Ais a
number of constraints (NCONSTRAINTS) by number of
assets (NASSETS) weight coefficient matrix, and b and
w are column vectors of length NASSETS. The value w
represents a vector of absolute asset weights whose
elements sum to the total portfolio value.

See the output ConSet from portcons for additional
details about constraint matrices.

Index NASSETS-by-1 vector of index portfolio weights.
The sum of the index weights must equal the
total portfolio value (for example, a standard
portfolio optimization imposes a sum-to-one budget
constraint).

Description ActiveConSet = abs2active(AbsConSet, Index) transforms a
constraint matrix to an equivalent matrix expressed in active weight
format (relative to the index). The transformation equation is

Awabsoftsre = Aiwactiue T Win GTE.E)E babsoftsre

Therefore

Aw —Aw.

acfiuei babsoft;fe index

=b

active
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abs2active

See Also

The initial constraint matrix consists of NCONSTRAINTS portfolio linear
inequality constraints expressed in absolute weight format. The index
portfolio vector contains NASSETS assets.

ActiveConSet is the transformed portfolio linear inequality constraint
matrix expressed in active weight format, also of the form [A b] such
that A*w <= b. The value w represents a vector of active asset weights
(relative to the index portfolio) whose elements sum to zero.

active2abs, pcalims, pcgcomp, pcglims, pcpval, portcons
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Purpose Fraction of coupon period before settlement

Syntax Fraction = accrfrac(Settle, Maturity, Period, Basis, EndMonthRule,
IssueDate, FirstCouponDate, LastCouponDate, StartDate)

Arguments

Settle Settlement date. A vector of serial date
numbers or date strings. Settle must be
earlier than or equal to Maturity.

Maturity Maturity date. A vector of serial date numbers
or date strings.

Period (Optional) Coupons per year of the bond. A
vector of integers. Allowed values are 0, 1, 2
(default), 3, 4, 6, and 12.

Basis (Optional) Day-count basis of the instrument.
A vector of integers.
® 0 = actual/actual (default)
e 1=30/360 (SIA)
® 2 = actual/360
® 3 = actual/365
* 4 =30/360 (PSA)
* 5=30/360 (ISDA)
® 6 = 30/360 (European)
e 7 = actual/365 (Japanese)
® 8 = actual/actual ISMA)
® 9 =actual/360 (ISMA)
® 10 = actual/365 (ISMA)
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EndMonthRule

IssueDate

FirstCouponDate

LastCouponDate

StartDate

e 11 = 30/360E (ISMA)
e 12 = actual/365 (ISDA)

(Optional) End-of-month rule. A vector.

This rule applies only when Maturity is an
end-of-month date for a month having 30 or
fewer days. 0 = ignore rule, meaning that a
bond’s coupon payment date is always the
same numerical day of the month. 1 = set rule
on (default), meaning that a bond’s coupon
payment date is always the last actual day of
the month.

(Optional) Date when a bond was issued.

(Optional) Date when a bond makes its first
coupon payment. When FirstCouponDate
and LastCouponDate are both specified,
FirstCouponDate takes precedence in
determining the coupon payment structure.

(Optional) Last coupon date of a bond before
the maturity date. In the absence of a specified
FirstCouponDate, a specified LastCouponDate
determines the coupon structure of the bond.
The coupon structure of a bond is truncated

at the LastCouponDate regardless of where it
falls and will be followed only by the bond’s
maturity cash flow date.

(Future implementation; optional) Date when
a bond actually starts (the date from which

a bond’s cash flows can be considered). To
make an instrument forward-starting, specify
this date as a future date. If StartDate is not
explicitly specified, the effective start date is
the settlement date.
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Description

Examples

See Also

14-6

Vector arguments must have consistent dimensions, or they must be
scalars.

Fraction = accrfrac(Settle, Maturity, Period, Basis,
EndMonthRule, IssueDate, FirstCouponDate, LastCouponDate,
StartDate) returns the fraction of the coupon period before settlement.
This function is used for computing accrued interest.

Given data for three bonds

Settle = '14-Mar-1997';

Maturity = ['30-Nov-2000'
'31-Dec-2000"
'31-dan-2001'];

Period = 2;

Basis = 0;

EndMonthRule = 1;

Execute the function.

Fraction = accrfrac(Settle, Maturity, Period, Basis,...
EndMonthRule)
Fraction =
0.5714
0.4033
0.2320

cfamounts, cfdates, cpncount, cpndaten, cpndatenq, cpndatep
cpndatepq, cpndaysn, cpndaysp, cpnpersz
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Purpose Accrued interest of security with periodic interest payments

Syntax Accrulnterest = acrubond(IssueDate, Settle, FirstCouponDate, Face,
CouponRate, Period, Basis)

Arguments
IssueDate Enter as serial date number or date string.
Settle Enter as serial date number or date string.
FirstCouponDate Enter as serial date number or date string.
Face Redemption (par, face) value.
CouponRate Enter as decimal fraction.
Period (Optional) Coupons per year of the bond. A

vector of integers. Allowed values are 0, 1, 2
(default), 3, 4, 6, and 12.

Basis (Optional) Day-count basis of the instrument.
A vector of integers.
e (0 = actual/actual (default)
e 1=30/360 (SIA)
® 2 = actual/360
® 3 = actual/365
* 4 =30/360 (PSA)
* 5=30/360 (ISDA)
® 6 = 30/360 (European)
e 7 = actual/365 (Japanese)
® 8 = actual/actual ISMA)
® 9 =actual/360 (ISMA)
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Description

Examples

See Also
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® 10 = actual/365 (ISMA)
e 11 = 30/360E (ISMA)
e 12 = actual/365 (ISDA)

Accrulnterest = acrubond(IssueDate, Settle,
FirstCouponDate, Face, CouponRate, Period, Basis)

returns the accrued interest for a security with periodic interest
payments. This function computes the accrued interest for securities
with standard, short, and long first coupon periods.

Note cfamounts or accrfrac is recommended when calculating
accrued interest beyond the first period.

Accrulnterest acrubond('31-jan-1983', '1-mar-1993',

'31-jul-1983', 100, 0.1, 2, 0)

Accrulnterest
0.8011

accrfrac, acrudisc, bndprice, bndyield, cfamounts, datenum
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Purpose Accrued interest of discount security paying at maturity
Syntax Accrulnterest = acrudisc(Settle, Maturity, Face, Discount, Period,
Basis)
Arguments
Settle Enter as serial date number or date string.
Settle must be earlier than or equal to Maturity.
Maturity Enter as serial date number or date string.
Face Redemption (par, face) value.
Discount Discount rate of the security. Enter as decimal
fraction.
Period (Optional) Coupons per year of the bond. A vector
of integers. Allowed values are 0, 1, 2 (default), 3,
4, 6, and 12.
Basis (Optional) Day-count basis of the instrument. A

vector of integers.

® 0 = actual/actual (default)
1 =30/360 (SIA)

2 = actual/360

3 = actual/365

4 = 30/360 (PSA)

5 = 30/360 (ISDA)

6 = 30/360 (KEuropean)

7 = actual/365 (Japanese)
8 = actual/actual (ISMA)
9 = actual/360 (ISMA)
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® 10 = actual/365 (ISMA)
e 11 = 30/360E (ISMA)
e 12 = actual/365 (ISDA)

Descripl‘ion Accrulnterest = acrudisc(Settle, Maturity, Face, Discount,
Period, Basis) returns the accrued interest of a discount security
paid at maturity.

Examples Accrulnterest = acrudisc('05/01/1992', '07/15/1992",
100, 0.1, 2, 0)

Accrulnterest
2.0604 (or $2.06)

References Mayle, Standard Securities Calculation Methods, Volumes I-1I, 3rd
edition. Formula D.

See Also acrubond, prdisc, prmat, ylddisc, yldmat
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Purpose Convert constraints from active to absolute format
Syntax AbsConSet = active2abs(ActiveConSet, Index)
Arguments

ActiveConSet Portfolio linear inequality constraint

matrix expressed in active weight format.
ActiveConSet is formatted as [A b] such that
A*w <= Db, where A is a number of constraints
(NCONSTRAINTS) by number of assets (NASSETS)
weight coefficient matrix, and b and w are
column vectors of length NASSETS. The value

w represents a vector of active asset weights
(relative to the index portfolio) whose elements
sum to 0.

See the output ConSet from portcons for
additional details about constraint matrices.

Index NASSETS-by-1 vector of index portfolio weights.
The sum of the index weights must equal the
total portfolio value (for example, a standard
portfolio optimization imposes a sum-to-one
budget constraint).

Description AbsConSet = active2abs(ActiveConSet, Index) transforms a
constraint matrix to an equivalent matrix expressed in absolute weight
format. The transformation equation is

Awactiue = A(wabsoft;te — Wiy de.’c}i bactiue

Therefore

Aw + Aw. =b

e s bacfiue index

absolut absolute
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The initial constraint matrix consists of NCONSTRAINTS portfolio linear
inequality constraints expressed in active weight format (relative to the
index portfolio). The index portfolio vector contains NASSETS assets.

AbsConSet is the transformed portfolio linear inequality constraint
matrix expressed in absolute weight format, also of the form [A b]
such that A*w <= b. The value w represents a vector of active asset
weights (relative to the index portfolio) whose elements sum to the total
portfolio value.

See Also abs2active, pcalims, pcgcomp, pcglims, pcpval, portcons
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Purpose

Syntax

Arguments

Description

Accumulation/Distribution line

adln = adline(highp, lowp, closep, tvolume)
adln = adline([highp lowp closep tvolume])

adlnts = adline(tsobj)
adlnts = adline(tsobj, ParameterName, ParameterValue, ...)
highp High price (vector)
lowp Low price (vector)
closep Closing price (vector)
tvolume Volume traded (vector)
tsobj Time series object

adln = adline(highp, lowp, closep, tvolume) computes the
Accumulation/Distribution line for a set of stock price and volume
traded data. The prices required for this function are the high (highp),
low (lowp), and closing (closep) prices.

adln = adline([highp lowp closep tvolume]) accepts a
four-column matrix as input. The first column contains the high prices,
the second contains the low prices, the third contains the closing prices,
and the fourth contains the volume traded.

adlnts = adline(tsobj) computes the Williams
Accumulation/Distribution line for a set of stock price data
contained in the financial time series object tsobj. The object must
contain the high, low, and closing prices plus the volume traded. The
function assumes that the series are named High, Low, Close, and
Volume. All are required. adlnts is a financial time series object with
the same dates as tsobj but with a single series named ADLine.
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adlnts = adline(tsobj, ParameterName, ParameterValue, ...)
accepts parameter name/parameter value pairs as input. These pairs
specify the name(s) for the required data series if it is different from the
expected default name(s). Valid parameter names are

e HighName: high prices series name

® | owName: low prices series name

® CloseName: closing prices series name

e VolumeName: volume traded series name

Parameter values are the strings that represent the valid parameter
names.

Examples Compute the Accumulation/Distribution line for Disney stock and plot
the results:

load disney.mat

dis_ADLine = adline(dis)

plot(dis_ADLine)

title('Accumulation/Distribution Line for Disney')
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<) Figure No. 1 10l =|
File Edit Yiew Insert Tools Window Help
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e .
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0.5 i '
28-Mar-1996 29-Mar-1997 30-Mar-1998 31-Mar-1999
References Achelis, Steven B., Technical Analysis from A to Z, Second Edition,

McGraw-Hill, 1995, pp. 56-58.

See Also adosc, willad, willpctr
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Purpose Accumulation/Distribution oscillator

Syntax ado = adosc(highp, lowp, openp, closep)
ado = adosc([highp lowp openp closep])
adots = adosc(tsobj)

adots = adosc(tsojb, ParameterName, ParameterValue, ...)

Arguments

highp High price (vector)

lowp Low price (vector)

openp Opening price (vector)

closep Closing price (vector)

tsobj Time series object
Description ado = adosc(highp, lowp, openp, closep) returns a vector, ado,

that represents the Accumulation/Distribution (A/D) oscillator. The A/D
oscillator is calculated based on the high, low, opening, and closing
prices of each period. Each period is treated individually.

ado = adosc([highp lowp openp closep]) accepts a four-column
matrix as input. The order of the columns must be high, low, opening,
and closing prices.

adots = adosc(tsobj) calculates the Accumulation/Distribution
(A/D) oscillator, adots, for the set of stock price data contained in the
financial time series object tsobj. The object must contain the high,
low, opening, and closing prices. The function assumes that the series
are named High, Low, Open, and Close. All are required. adots is a
financial time series object with similar dates to tsobj and only one
series named ADOsc.

adots = adosc(tsobj, ParameterName, ParameterValue, ...)
accepts parameter name-parameter value pairs as input. These pairs
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specify the name(s) for the required data series if it is different from the
expected default name(s). Valid parameter names are

e HighName: high prices series name

® | owName: low prices series name

® OpenName: opening prices series name

® CloseName: closing prices series name

Parameter values are the strings that represents the valid parameter
names.

Examples Compute the Accumulation/Distribution oscillator for Disney stock and
plot the results:

load disney.mat

dis_ADOsc = adosc(dis)
plot(dis_ADOsc)

title('A/D Oscillator for Disney')
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<} Figure No. 1 10l =|

File Edit Yiew Insert Tools Window Help
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See Also adline, willad
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Purpose

Syntax

Arguments

Description

Amortization schedule

[Principal, Interest, Balance, Payment] = amortize(Rate,
NumPeriods, PresentValue, FutureValue, Due)

Rate Interest rate per period, as a decimal fraction.
NumPeriods Number of payment periods.

PresentValue Present value of the loan.

FutureValue (Optional) Future value of the loan. Default = 0.
Due (Optional) When payments are due: 0 = end of

period (default), or 1 = beginning of period.

[Principal, Interest, Balance, Payment] = amortize(Rate,
NumPeriods, PresentValue, FutureValue, Due) returns the
principal and interest payments of a loan, the remaining balance of the
original loan amount, and the periodic payment.

Principal Principal paid in each period. A
1-by-NumPeriods vector.

Interest Interest paid in each period. A 1-by-NumPeriods
vector.

Balance Remaining balance of the loan in each payment

period. A 1-by-NumPeriods vector.

Payment Payment per period. A scalar.
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Examples Compute an amortization schedule for a conventional 30-year, fixed-rate
mortgage with fixed monthly payments. Assume a fixed rate of 12%
APR and an initial loan amount of $100,000.

Rate 0.12/12; % 12 percent APR = 1 percent per month
NumPeriods = 30*12; % 30 years = 360 months
PresentValue = 100000;

[Principal, Interest, Balance, Payment] = amortize(Rate, ...
NumPeriods, PresentValue);

The output argument Payment contains the fixed monthly payment.

format bank

Payment

Payment =
1028.61

Finally, summarize the amortization schedule graphically by plotting
the current outstanding loan balance, the cumulative principal, and the
interest payments over the life of the mortgage. In particular, note that
total interest paid over the life of the mortgage exceeds $270,000, far in
excess of the original loan amount.

plot(Balance,'b'), hold('on")
plot(cumsum(Principal),'--k")
plot(cumsum(Interest),':r'")

xlabel('Payment Month')

ylabel('Dollars')

grid('on')

title('Outstanding Balance, Cumulative Principal & Interest')
legend('Outstanding Balance', 'Cumulative Principal', ...
'Cumulative Interest')
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See Also

File Edit Wew Insert Tools Desktop ‘Window Help
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Payment Month

The solid blue line represents the declining principal over the 30-year
period. The dotted red line indicates the increasing cumulative interest
payments. Finally, the dashed black line represents the cumulative

principal payments, reaching $100,000 after 30 years.

annurate, annuterm, payadv, payodd, payper
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Purpose Periodic interest rate of annuity
Syntax Rate = annurate(NumPeriods, Payment, PresentValue, FutureValue,
Due)
Arguments
NumPeriods Number of payment periods.
Payment Payment per period.
PresentValue Present value of the loan or annuity.
FutureValue (Optional) Future value of the loan or annuity.
Default = 0.
Due (Optional) When payments are due: 0 = end of

period (default), or 1 = beginning of period.

Description Rate = annurate(NumPeriods, Payment, PresentValue,
FutureValue, Due) returns the periodic interest rate paid on a loan
or annuity.

Examples Find the periodic interest rate of a four-year, $5000 loan with a $130
monthly payment made at the end of each month.

Rate

annurate(4*12, 130, 5000, O, 0)

Rate

0.0094

(Rate multiplied by 12 gives an annual interest rate of 11.32% on the
loan.)

See Also amortize, annuterm, bndyield, irr
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Purpose

Syntax

Arguments

Description

Examples

See Also

Number of periods to obtain value

NumPeriods = annuterm(Rate, Payment, PresentValue, FutureValue,
Due)

Rate Interest rate per period, as a decimal fraction.
Payment Payment per period.

PresentValue Present value.

FutureValue (Optional) Future value. Default = 0.

Due (Optional) When payments are due: 0 = end of

period (default), or 1 = beginning of period.

NumPeriods = annuterm(Rate, Payment, PresentValue,
FutureValue, Due) calculates the number of periods needed to obtain
a future value. To calculate the number of periods needed to pay off a
loan, enter the payment or the present value as a negative value.

A savings account has a starting balance of $1500. $200 is added at
the end of each month and the account pays 9% interest, compounded
monthly. How many years will it take to save $5,000?

NumPeriods = annuterm(0.09/12, 200, 1500, 5000, 0)

NumPeriods =
15.68 months or 1.31 years.

annurate, amortize, fvfix, pvfix
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Purpose Arithmetic to geometric moments of asset returns
Syntax [mg, Cg] = arith2geom(ma, Ca);

[mg, Cg] = arith2geom(ma, Ca, t);
Arguments

ma Arithmetic mean of asset-return data (n-vector).

Ca Arithmetic covariance of asset-return data (n-by-n
symmetric, positive-semidefinite matrix.

t (Optional) Target period of geometric moments in
terms of periodicity of arithmetic moments with
default value 1 (scalar).

Description arith2geom transforms moments associated with a simple Brownian

motion into equivalent continuously-compounded moments associated
with a geometric Brownian motion with a possible change in periodicity.

[mg, Cg] = arith2geom(ma, Ca, t) returns mg,
continuously-compounded or "geometric" mean of asset

returns over the target period (n-vector), and Cg, which is a
continuously-compounded or "geometric" covariance of asset returns
over the target period (n-by-n matrix).

Arithmetic returns over period ¢, are modeled as multivariate normal
random variables

X~N(mA,CA)

with moments

E[X] =my

and

covX)=Cy
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Geometric returns over period ¢, are modeled as multivariate lognormal
random variables

Y ~ LN(1+mg,Cg)

with moments

E[Y] :1+mG

cov(Y)=Cg

Given t = ¢/ t,, the transformation from geometric to arithmetic
moments is

1
l1+mqy =exp(tm, +=tC
G, p(tm 4. 5 a,)

CGij =1+ mGi )1+ mGj )(exp(tCAij) -1)

For i,j =1,...,, n.

Note If ¢t =1, then Y = expX).

This function has no restriction on the input mean ma but requires the
input covariance Ca to be a symmetric positive-semidefinite matrix.

The functions arith2geom and geom2arith are complementary so that,
given m, C, and t, the sequence

[mg, Cg] = arith2geom(m, C, t);
[ma, Ca] geom2arith(mg, Cg, 1/t);

yields ma = m and Ca = C.
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Examples Example 1. Given arithmetic mean m and covariance C of monthly total
returns, obtain annual geometric mean mg and covariance Cg. In this
case, the output period (1 year) is 12 times the input period (1 month)
so that t = 12 with

[mg, Cg] = arith2geom(m, C, 12);

Example 2. Given annual arithmetic mean m and covariance C of asset
returns, obtain monthly geometric mean mg and covariance Cg. In this
case, the output period (1 month) is 1/12 times the input period (1 year)
so that t = 1/12 with

[mg, Cg] = arith2geom(m, C, 1/12);

Example 3. Given arithmetic means m and standard deviations

s of daily total returns (derived from 260 business days per year),
obtain annualized continuously-compounded mean mg and standard
deviations sg with

[mg, Cg] = arith2geom(m, diag(s ."2), 260);
sg = sqrt(diag(Cg));

Example 4. Given arithmetic mean m and covariance C of monthly total
returns, obtain quarterly continuously-compounded return moments.
In this case, the output is 3 of the input periods so that t = 3 with

[mg, Cg] = arith2geom(m, C, 3);

Example 5. Given arithmetic mean m and covariance C of 1254
observations of daily total returns over a 5-year period, obtain
annualized continuously-compounded return moments. Since the
periodicity of the arithmetic data is based on 1254 observations for a
5-year period, a 1-year period for geometric returns implies a target
period of t = 1254/5 so that

[mg, Cg] = arith2geom(m, C, 1254/5);
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See Also geom2arith
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Purpose

Syntax

Arguments

Description

14-28

Create financial time series object from ASCII data file

tsobj = ascii2fts(filename, descrow, colheadrow, skiprows)

tsobj = ascii2fts(filename, timedata, descrow, colheadrow,
skiprows)

filename ASCII data file

descrow (Optional) Row number in the data file that contains

the description to be used for the description field of
the financial time series object

colheadrow (Optional) Row number that has the column

headers/names

skiprows (Optional) Scalar or vector of row numbers to be
skipped in the data file

timedata Set to 'T' if time-of-day data is present in the ASCII

data file or to 'NT' if no time-of-day data is present.

tsobj = ascii2fts(filename, descrow, colheadrow, skiprows)
creates a financial time series object tsobj from the ASCII file named
filename. This form of the function can only read a data file without
time-of-day information and create a financial time series object without
time information. If time information is present in the ASCII file, an
error message appears.

The general format of the text data file is

¢ Can contain header text lines.

¢ (Can contain column header information. The column header
information must immediately precede the data series columns
unless skiprows is specified.
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Examples

¢ Leftmost column must be the date column.
® Dates must be in a valid date string format:
= 'ddmmmyy' or 'ddmmmyyyy'’
= 'mm/dd/yy' or 'mm/dd/yyyy'
= 'dd-mmm-yy' or 'dd-mmm-yyyy'
= 'mmm.dd,yy' or 'mmm.dd,yyyy’
e Each column must be separated either by spaces or a tab.
tsobj = ascii2fts(filename, timedata, descrow, colheadrow,
skiprows) creates a financial time series object containing time-of-day

data. Set timedata to 'T' to create a financial time series object
containing time-of-day data.

Example 1. If your data file contains no description or column header
rows,

1167900
1994700

1/3/95 36.75 36.9063 36.6563 36.875
1/4/95 37 37.2813 36.625 37.1563

you can create a financial time series object from it with the simplest
form of the ascii2fts function:

myinc = ascii2fts('my_inc.dat');

myinc

desc: my_inc.dat
freq: Unknown (0)

'dates: (2)' ‘'series1: (2)' ‘'series2: (2)' ‘series3: (2)'...
'03-Jan-1995"' [ 36.7500] [ 36.9063] [ 36.6563]
'04-Jan-1995"' [ 37] [ 37.2813] [ 36.6250]
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Example 2: If your data file contains description and column header
information with the data series immediately following the column
header row,

International Business Machines Corporation (IBM)
Daily prices (1/3/95 to 4/5/99)

DATE OPEN HIGH Low CLOSE VOLUME
1/3/95 36.75 36.9063 36.6563 36.875 1167900
1/4/95 37 37.2813 36.625 37.1563 1994700

you must specify the row numbers containing the description and
column headers:

ibm ascii2fts('ibm9599.dat', 1, 3);
ibm =

desc: International Business Machines Corporation (IBM)
freq: Unknown (0)

'‘dates: (2)' C'OPEN: (2)' 'HIGH: (2)° Low:  (2)' ...
'03-Jan-1995' [ 36.7500] [ 36.9063] [ 36.6563]
'04-Jan-1995' [ 37] [ 37.2813] [ 36.6250]

Example 3: If your data file contains rows between the column headers
and the data series, for example,

Staples, Inc. (SPLS)

Daily prices

DATE OPEN HIGH Low CLOSE VOLUME
Starting date: 04/08/1996

Ending date: 04/07/1999

4/8/96 19.50 19.75 19.25 19.375 548500
4/9/96 19.75 20.125 19.375 20 1135900

you need to indicate to ascii2fts the rows in the file that must be

skipped. Assume that you have called the data file containing the
Staples data above staples.dat. The command
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spls = ascii2fts('staples.dat', 1, 3, [4 5]);

indicates that the fourth and fifth rows in the file should be skipped in
creating the financial time series object:

spls =

desc: Staples, Inc. (SPLS)
freq: Unknown (0)

‘dates: (2)' 'OPEN: (2)' "HIGH: (2)' ‘Low: (2)'
'08-Apr-1996' | 19.5000] [ 19.7500] [19.2500]
'09-Apr-1996' | 19.7500] [ 20.1250] [19.3750]

Example 4: Create a financial time series object containing time-of-day
information.

First create a data file with time information:

dates = ['01-Jan-2001"';'01-Jan-2001'; '02-Jan-2001'; ...
'02-Jan-2001"'; '03-Jan-2001';'03-dan-2001"'];

times = ['11:00';'12:00';'11:00';'12:00';'11:00';'12:00'];
serial_dates_times = [datenum(dates), datenum(times)];

data = round(10*rand(6,2));

stat = fts2ascii('myfts_file2.txt',serial_dates_times,data, ...
{'dates';'times';'Datatl';'Data2'},'My FTS with Time');

Now read the data file back and create a financial time series object:

MyFts

ascii2fts('myfts_file2.txt','t',1,2,1)

MyFts

desc: My FTS with Time
freq: Unknown (0)

'dates: (6)' 'times: (6)' 'Datal: (6)' 'Data2: (6)'
'01-Jan-2001" '11:00' [ 9] [ 4]
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See Also
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'02-Jan-2001

'03-Jan-2001

fints, fts2ascii

'12:00'
'11:00'
'12:00'
'11:00'
'12:00'

71
2]
4]
9]
9]

9]
1]
4]
8]
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bar, barh

Purpose

Syntax

Arguments

Description

Examples

Bar chart
bar(tsobj)
bar(tsobj, width)
bar(..., 'style')
hbar = bar(...)
barh(...)

hbarh = barh(...)

tsobj Financial time series object.

width Width of the bars and separation of bars within a
group. (Default = 0.8.) If width is 1, the bars within
a group touch one another. Values > 1 produce
overlapping bars.

style ‘grouped’' (default) or 'stacked'.

bar, barh draw vertical and horizontal bar charts.

bar(tsobj) draws the columns of data series of the object tsobj. The
number of data series dictates the number of vertical bars per group.
Each group is the data for one particular date.

bar(tsobj, width) specifies the width of the bars.
bar(..., 'style') changes the style of the bar chart.
hbar = bar(...) returns a vector of bar handles.

Use the MATLAB command shading faceted to put edges on the bars.
Use shading flat to turn edges off.

Create bar charts for Disney stock showing high, low, opening, and
closing prices.
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lpceEa xa /|22

Bar Chart of Disney Prices
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load disney
bar(qg_dis)
title('Bar Chart of Disney Prices')
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Horizontal Bar Chart of Disney Prices
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load disney
bar(qg_dis)
title('Horizontal Bar Chart of Disney Prices')
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See Also bar3, bar3h, candle, highlow
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Purpose 3-D bar chart

Syntax bar3(tsobj)
bar3(tsobj, width)
bar3(..., 'style')

hbar3 = bar3(...)

bar3h(...)
hbar3h = bar3h(...)

Arguments

tsobj Financial time series object.

width Width of the bars and separation of bars within a
group. (Default = 0.8.) If width is 1, the bars within
a group touch one another. Values > 1 produce
overlapping bars.

style 'detached' (default), 'grouped’', or 'stacked'.

Desc ription bar3, bar3h draw three-dimensional vertical and horizontal bar charts.

bar3(tsobj) draws the columns of data series of the object tsobj. The
number of data series dictates the number of vertical bars per group.
Each group is the data for one particular date.

bar3(tsobj, width) specifies the width of the bars.
bar3(..., 'style') changes the style of the bar chart.
hbar3 = bar3(...) returns a vector of bar handles.

Use the MATLAB command shading faceted to put edges on the bars.
Use shading flat to turn edges off.

Examples Create three-dimensional bar charts for Disney stock showing high,
low, opening, and closing prices.
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load disney
bar3(q_dis, 'stacked')

title('Three-Dimensional Bar Chart of Disney Prices')
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Three-Dimensional Bar Chart of Disney Prices(Stacked)
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load disney
bar3(g_dis, 'stacked')

title('Three-Dimensional Bar Chart of Disney Prices (Stacked)')

See Also bar, barh, candle, highlow
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Purpose

Syntax

Arguments

Description

Examples

See Also

Bond equivalent yield for Treasury bill

Yield = beytbill(Settle, Maturity, Discount)

Settle Enter as serial date numbers or date strings.
Settle must be earlier than or equal to Maturity.

Maturity Enter as serial date numbers or date strings.

Discount Discount rate of the Treasury bill. Enter as decimal
fraction.

Yield = beytbill(Settle, Maturity, Discount) returns the bond
equivalent yield for a Treasury bill.

The settlement date of a Treasury bill is February 11, 2000, the
maturity date is August 7, 2000, and the discount rate is 5.77%. The
bond equivalent yield is

Yield = beytbill('2/11/2000', '8/7/2000', 0.0577)

Yield

0.0602

datenum, prtbill, yldtbill
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Purpose Binomial put and call pricing

Syntax [AssetPrice, OptionValue] = binprice(Price, Strike, Rate, Time,
Increment, Volatility, Flag, DividendRate, Dividend, ExDiv)

Arguments
Price Underlying asset price. A scalar.
Strike Option exercise price. A scalar.
Rate Risk-free interest rate. A scalar. Enter as a

decimal fraction.
Time Option’s time until maturity in years. A scalar.

Increment Time increment. A scalar. Increment is
adjusted so that the length of each interval is
consistent with the maturity time of the option.
(Increment is adjusted so that Time divided
by Increment equals an integer number of
increments.)

Volatility Asset’s volatility. A scalar.

Flag Specifies whether the option is a call (Flag =
1) or a put (Flag = 0). A scalar.

DividendRate (Optional) The dividend rate, as a decimal
fraction. A scalar. Default = 0. If you enter
a value for DividendRate, set Dividend
and ExDiv = 0 or do not enter them. If you
enter values for Dividend and ExDiv, set
DividendRate = 0.
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Description

Examples

Dividend (Optional) The dividend payment at an
ex-dividend date, ExDiv. A row vector. For
each dividend payment, there must be a
corresponding ex-dividend date. Default = 0. If
you enter values for Dividend and ExDiv, set
DividendRate = 0.

ExDiv (Optional) Ex-dividend date, specified in
number of periods. A row vector. Default = 0.

[AssetPrice, OptionValue] = binprice(Price, Strike, Rate,
Time, Increment, Volatility, Flag, DividendRate, Dividend,
ExDiv) prices an option using the Cox-Ross-Rubinstein binomial
pricing model.

For a put option, the asset price is $52, option exercise price is $50,
risk-free interest rate is 10%, option matures in 5 months, volatility is
40%, and there i1s one dividend payment of $2.06 in 3-1/2 months.

[Price, Option] = binprice(52, 50, 0.1, 5/12, 1/12, 0.4, 0, O,...
2.06, 3.5)

returns the asset price and option value at each node of the binary tree.
Price =

52.0000 58.1367 65.0226 72.7494 79.3515 89.0642
0 46.5642 52.0336 58.1706  62.9882 70.6980

0 0 41.7231 46.5981 49.9992 56.1192
0 0 0 37.4120 39.6887 44,5467
0 0 0 0 31.5044 35.3606
0 0 0 0 0 28.0688
Option =
4.4404 2.1627 0.6361 0

0 6.8611 3.7715 1.3018
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0 0 10.1591  6.3785  2.6645 0
0 0 0 14.2245 10.3113  5.4533
0 0 0 0 18.4956 14.6394
0 0 0 0 0 21.9312
References Cox, dJ., S. Ross, and M. Rubenstein, “Option Pricing: A Simplified

Approach”, Journal of Financial Economics 7, Sept. 1979, pp. 229-263.

Hull, John C., Options, Futures, and Other Derivative Securities, 2nd
edition, Chapter 14.

See Also blkprice, blsprice
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Purpose

Syntax

Arguments

Implied volatility for futures options from Black’s model

Volatility

blsimpv(Price, Strike, Rate, Time, Value, Limit,

Tolerance, Class)

Price

Strike

Rate

Time

Value

Limit

Tolerance

Class

Current price of the underlying asset (a futures
contract).

Exercise price of the futures option.

Annualized, continuously compounded risk-free rate
of return over the life of the option, expressed as a
positive decimal number.

Time to expiration of the option, expressed in years.

Price of a European futures option from which the
implied volatility of the underlying asset is derived.

(Optional) Positive scalar representing the upper

bound of the implied volatility search interval. If

Limit is empty or unspecified, the default = 10, or
1000% per annum.

(Optional) Implied volatility termination tolerance.
A positive scalar. Default = 1e-6.

(Optional) Option class (call or put) indicating the
option type from which the implied volatility is
derived. May be either a logical indicator or a cell
array of characters. To specify call options, set
Class = true or Class = {'call'}; to specify put
options, set Class = false or Class = {'put'}. If
Class is empty or unspecified, the default is a call
option.

14-43



blkimpv

Description Volatility = blkimpv(Price, Strike, Rate, Time, CallPrice,
MaxIterations, Tolerance) computes the implied volatility of a
futures price from the market value of European futures options using
Black’s model.

Volatility is the implied volatility of the underlying asset derived
from European futures option prices, expressed as a decimal number.
If no solution is found, blkimpv returns NaN.

Any input argument may be a scalar, vector, or matrix. When a value is
a scalar, that value is used to compute the implied volatility of all the
options. If more than one input is a vector or matrix, the dimensions of
all nonscalar inputs must be identical.

Rate and Time must be expressed in consistent units of time.

Examples Consider a European call futures option that expires in four months,
trading at $1.1166, with an exercise price of $20. Assume that the
current underlying futures price is also $20 and that the risk-free rate
is 9% per annum. Furthermore, assume that you are interested in
implied volatilities no greater than 0.5 (50% per annum). Under these
conditions, the following commands all return an implied volatility of
0.25, or 25% per annum:

Volatility = blkimpv(20, 20, 0.09, 4/12, 1.1166, 0.5)
Volatility = blkimpv(20, 20, 0.09, 4/12, 1.1166, 0.5, [],

{'call'})
Volatility = blkimpv(20, 20, 0.09, 4/12, 1.1166, 0.5, [], true)
References Hull, John C., Options, Futures, and Other Derivatives, Prentice Hall,

5th edition, 2003, pp. 287-288.

Black, Fischer, “The Pricing of Commodity Contracts,” Journal of
Financial Economics, March 3, 1976, pp. 167-79.

See Also blkprice, blsimpv, blsprice
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Purpose

Syntax

Arguments

Description

Examples

Black’s model for pricing futures options

[Call, Put] = blkprice(Price, Strike, Rate, Time, Volatility)

Price Current price of the underlying asset (a futures
contract).

Strike Strike or exercise price of the futures option.

Rate Annualized, continuously compounded, risk-free rate

of return over the life of the option, expressed as a
positive decimal number.

Time Time until expiration of the option, expressed in
years. Must be greater than 0.

Volatility Annualized futures price volatility, expressed as a
positive decimal number.

[Call, Put] = blkprice(ForwardPrice, Strike, Rate, Time,
Volatility) uses Black’s model to compute European put and call
futures option prices.

Any input argument may be a scalar, vector, or matrix. When a value is
a scalar, that value is used to compute the implied volatility from all
options. If more than one input is a vector or matrix, the dimensions of
all non-scalar inputs must be identical.

Rate, Time, and Volatility must be expressed in consistent units of
time.

Consider European futures options with exercise prices of $20 that
expire in four months. Assume that the current underlying futures
price is also $20 with a volatility of 25% per annum. The risk-free rate
1s 9% per annum. Using this data
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[Call, Put] = blkprice(20, 20, 0.09, 4/12, 0.25)
returns equal call and put prices of $1.1166.

References Hull, John C., Options, Futures, and Other Derivatives, Prentice Hall,
5th edition, 2003, pp. 287-288.

Black, Fischer, “The Pricing of Commodity Contracts,” Journal of
Financial Economics, March 3, 1976, pp. 167-179.

See Also binprice, blsprice
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Purpose

Syntax

Arguments

Description

Black-Scholes sensitivity to underlying price change

[CallDelta, PutDelta] = blsdelta(Price, Strike, Rate, Time,
Volatility, Yield)

Price
Strike
Rate

Time

Volatility

Yield

Current price of the underlying asset.
Exercise price of the option.

Annualized, continuously compounded risk-free rate
of return over the life of the option, expressed as a
positive decimal number.

Time to expiration of the option, expressed in years.

Annualized asset price volatility (annualized
standard deviation of the continuously compounded
asset return), expressed as a positive decimal
number.

(Optional) Annualized, continuously compounded
yield of the underlying asset over the life of the
option, expressed as a decimal number. (Default
= 0.) For example, for options written on stock
indices, Yield could represent the dividend yield.
For currency options, Yield could be the foreign
risk-free interest rate.

[CallDelta, PutDelta] = blsdelta(Price, Strike, Rate, Time,
Volatility, Yield) returns delta, the sensitivity in option value
to change in the underlying asset price. Delta is also known as the

hedge ratio.
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Note blsdelta can handle other types of underlies like Futures and
Currencies. When pricing Futures (Black model), enter the input
argument Yield as:

Yield = Rate

When pricing currencies (Garman-Kohlhagen model), enter the input
argument Yield as:

Yield = ForeignRate

where ForeignRate is the continuously compounded, annualized risk
free interest rate in the foreign country.

Examples [CallDelta, PutDelta] = blsdelta(50, 50, 0.1, 0.25, 0.3, 0)

CallDelta =
0.5955

PutDelta =
-0.4045

References Hull, John C., Options, Futures, and Other Derivatives, Prentice Hall,
5th edition, 2003.

See Also blsgamma, blslambda, blsprice, blsrho, blstheta, blsvega
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Purpose Black-Scholes sensitivity to underlying delta change
Syntax Gamma = blsgamma(Price, Strike, Rate, Time, Volatility, Yield)
Arguments

Price Current price of the underlying asset.

Strike Exercise price of the option.

Rate Annualized, continuously compounded risk-free rate
of return over the life of the option, expressed as a
positive decimal number.

Time Time to expiration of the option, expressed in years.

Volatility Annualized asset price volatility (annualized
standard deviation of the continuously compounded
asset return), expressed as a positive decimal
number.

Yield (Optional) Annualized, continuously compounded
yield of the underlying asset over the life of the
option, expressed as a decimal number. (Default
= 0.) For example, for options written on stock
indices, Yield could represent the dividend yield.
For currency options, Yield could be the foreign
risk-free interest rate.

Description Gamma = blsgamma(Price, Strike, Rate, Time, Volatility,

Yield) returns gamma, the sensitivity of delta to change in the
underlying asset price.

14-49



blsgamma

Examples

References

See Also

14-50

Note blsgamma can handle other types of underlies like Futures and
Currencies. When pricing Futures (Black model), enter the input
argument Yield as:

Yield = Rate

When pricing currencies (Garman-Kohlhagen model), enter the input
argument Yield as:

Yield = ForeignRate

where ForeignRate is the continuously compounded, annualized risk
free interest rate in the foreign country.

Gamma = blsgamma(50, 50, 0.12, 0.25, 0.3, 0)

Gamma =
0.0512

Hull, John C., Options, Futures, and Other Derivatives, Prentice Hall,
5th edition, 2003.

blsdelta, blslambda, blsprice, blsrho, blstheta, blsvega
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Purpose

Syntax

Arguments

Black-Scholes implied volatility

Volatility

blsimpv(Price, Strike, Rate, Time, Value, Limit,

Yield, Tolerance, Class)

Price
Strike
Rate

Time

Value

Limit

Yield

Current price of the underlying asset.
Exercise price of the option.

Annualized, continuously compounded risk-free rate
of return over the life of the option, expressed as a
positive decimal number.

Time to expiration of the option, expressed in years.

Price of a European option from which the implied
volatility of the underlying asset is derived.

(Optional) Positive scalar representing the upper

bound of the implied volatility search interval. If

Limit is empty or unspecified, the default = 10, or
1000% per annum.

(Optional) Annualized, continuously compounded
yield of the underlying asset over the life of the
option, expressed as a decimal number. (Default
=0.) For example, for options written on stock
indices, Yield could represent the dividend yield.
For currency options, Yield could be the foreign
risk-free interest rate.
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Description

Examples

14-52

Tolerance (Optional) Implied volatility termination tolerance.
A positive scalar. Default = 1e-6.

Class (Optional) Option class (call or put) indicating the
option type from which the implied volatility is
derived. May be either a logical indicator or a cell
array of characters. To specify call options, set
Class = true or Class = {'call'}; to specify put
options, set Class = false or Class = {'put'}. If
Class is empty or unspecified, the default is a call
option.

Volatility = blsimpv(Price, Strike, Rate, Time, Value,
Limit, Yield, Tolerance, Class) using a Black-Scholes model
computes the implied volatility of an underlying asset from the market
value of European call and put options.

Volatility is the implied volatility of the underlying asset derived
from European option prices, expressed as a decimal number. If no
solution is found, blsimpv returns NaN.

Any input argument may be a scalar, vector, or matrix. When a value
is a scalar, that value is used to price all the options. If more than one
input is a vector or matrix, the dimensions of all non-scalar inputs must
be identical.

Rate, Time, and Yield must be expressed in consistent units of time.

Consider a European call option trading at $10 with an exercise price
of $95 and three months until expiration. Assume that the underlying
stock pays no dividend and trades at $100. The risk-free rate is 7.5%
per annum. Furthermore, assume that you are interested in implied
volatilities no greater than 0.5 (50% per annum).

Under these conditions, the following statements all compute an
implied volatility of 0.3130, or 31.30% per annum.

Volatility = blsimpv(100, 95, 0.075, 0.25, 10, 0.5)
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Volatility = blsimpv(100, 95, 0.075, 0.25, 10, 0.5, 0, [], {'Call'})
Volatility = blsimpv (100, 95, 0.075, 0.25, 10, 0.5, 0, [], true)
References Hull, John C., Options, Futures, and Other Derivatives, Prentice Hall,

5th edition, 2003.

Luenberger, David G., Investment Science, Oxford University Press,
1998.

See Also blsdelta, blsgamma, blslambda, blsprice, blsrho, blstheta
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Purpose Black-Scholes elasticity
Syntax [CallEl, PutEl] = blslambda(Price, Strike, Rate, Time, Volatility,
Yield)
Arguments
Price Current price of the underlying asset.
Strike Exercise price of the option.
Rate Annualized, continuously compounded risk-free rate

of return over the life of the option, expressed as a
positive decimal number.

Time Time to expiration of the option, expressed in years.

Volatility Annualized asset price volatility (annualized
standard deviation of the continuously compounded
asset return), expressed as a positive decimal
number.

Yield (Optional) Annualized, continuously compounded
yield of the underlying asset over the life of the
option, expressed as a decimal number. (Default
= 0.) For example, for options written on stock
indices, Yield could represent the dividend yield.
For currency options, Yield could be the foreign
risk-free interest rate.

Description [CallEl, PutEl] = blslambda(Price, Strike, Rate, Time,
Volatility, yield) returns the elasticity of an option. CallEl
is the call option elasticity or leverage factor, and PutEl is the put
option elasticity or leverage factor. Elasticity (the leverage of an option
position) measures the percent change in an option price per one
percent change in the underlying asset price.
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Examples [CallEl, PutEl] = blslambda(50, 50, 0.12, 0.25, 0.3)
CallEl =
8.1274
PutEl =
-8.6466
References Daigler, Advanced Options Trading, Chapter 4.
See Also blsdelta, blsgamma, blsprice, blsrho, blstheta, blsvega
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Purpose Black-Scholes put and call option pricing
Syntax [Call, Put] = blsprice(Price, Strike, Rate, Time, Volatility, Yield)
Arguments

Price Current price of the underlying asset.

Strike Exercise price of the option.

Rate Annualized, continuously compounded risk-free rate

of return over the life of the option, expressed as a
positive decimal number.

Time Time to expiration of the option, expressed in years.

Volatility Annualized asset price volatility (annualized
standard deviation of the continuously compounded
asset return), expressed as a positive decimal
number.

Yield (Optional) Annualized, continuously compounded
yield of the underlying asset over the life of the
option, expressed as a decimal number. (Default
= 0.) For example, for options written on stock
indices, Yield could represent the dividend yield.
For currency options, Yield could be the foreign
risk-free interest rate.

Description [Call, Put] = blsprice(Price, Strike, Rate, Time,
Volatility, Yield) computes European put and call option prices
using a Black-Scholes model.

Any input argument may be a scalar, vector, or matrix. When a value
1s a scalar, that value 1s used to price all the options. If more than one
input is a vector or matrix, the dimensions of all non-scalar inputs must
be identical.
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Examples

References

See Also

Rate, Time, Volatility, and Yield must be expressed in consistent
units of time.

Note blsprice can handle other types of underlies like Futures and
Currencies. When pricing Futures (Black model), enter the input
argument Yield as:

Yield = Rate

When pricing currencies (Garman-Kohlhagen model), enter the input
argument Yield as:

Yield = ForeignRate

where ForeignRate is the continuously compounded, annualized risk
free interest rate in the foreign country.

Consider European stock options that expire in three months with
an exercise price of $95. Assume that the underlying stock pays no
dividend, trades at $100, and has a volatility of 50% per annum. The
risk-free rate is 10% per annum. Using this data

[Call, Put] = blsprice(100, 95, 0.1, 0.25, 0.5)
returns call and put prices of $13.70 and $6.35, respectively.

Hull, John C., Options, Futures, and Other Derivatives, Prentice Hall,
5th edition, 2003.

Luenberger, David G., Investment Science, Oxford University Press,
1998.

blkprice, blsdelta, blsgamma, blsimpv, blslambda, blsrho,
blstheta, blsvega

14-57



bilsrho
|

Purpose Black-Scholes sensitivity to interest rate change
Syntax [CallRho, PutRho]= blsrho(Price, Strike, Rate, Time, Volatility,
Yield)
Arguments
Price Current price of the underlying asset.
Strike Exercise price of the option.
Rate Annualized, continuously compounded risk-free rate

of return over the life of the option, expressed as a
positive decimal number.

Time Time to expiration of the option, expressed in years.

Volatility Annualized asset price volatility (annualized
standard deviation of the continuously compounded
asset return), expressed as a positive decimal
number.

Yield (Optional) Annualized, continuously compounded
yield of the underlying asset over the life of the
option, expressed as a decimal number. (Default
= 0.) For example, for options written on stock
indices, Yield could represent the dividend yield.
For currency options, Yield could be the foreign
risk-free interest rate.

Description [CallRho, PutRho]= blsrho(Price, Strike, Rate, Time,
Volatility, Yield) returns the call option rho CallRho, and the
put option rho PutRho. Rho is the rate of change in value of derivative
securities with respect to interest rates.

Examples [CallRho, PutRho] = blsrho(50, 50, 0.12, 0.25, 0.3, 0)
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CallRho =
6.6686

PutRho =
-5.4619

References Hull, John C., Options, Futures, and Other Derivatives, Prentice Hall,
5th edition, 2003.

See Also blsdelta, blsgamma, blslambda, blsprice, blstheta, blsvega
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Purpose

Syntax

Arguments

Description

14-60

Black-Scholes sensitivity to time-until-maturity change

[CallTheta, PutTheta] = blstheta(Price, Strike, Rate, Time,
Volatility, Yield)

Price
Strike
Rate

Time

Volatility

Yield

Current price of the underlying asset.
Exercise price of the option.

Annualized, continuously compounded risk-free rate
of return over the life of the option, expressed as a
positive decimal number.

Time to expiration of the option, expressed in years.

Annualized asset price volatility (annualized
standard deviation of the continuously compounded
asset return), expressed as a positive decimal
number.

(Optional) Annualized, continuously compounded
yield of the underlying asset over the life of the
option, expressed as a decimal number. (Default
=0.) For example, for options written on stock
indices, Yield could represent the dividend yield.
For currency options, Yield could be the foreign
risk-free interest rate.

[CallTheta, PutTheta] = blstheta(Price, Strike, Rate, Time,
Volatility, Yield) returns the call option theta CallTheta, and
the put option theta PutTheta. Theta is the sensitivity in option value
with respect to time.
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Examples

References

See Also

[CallTheta, PutTheta] = blstheta(50, 50, 0.12, 0.25, 0.3, 0)

CallTheta =
-8.9630

PutTheta =
-3.1404

Hull, John C., Options, Futures, and Other Derivatives, Prentice Hall,
5th edition, 2003.

blsdelta, blsgamma, blslambda, blsprice, blsrho, blsvega
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Purpose Black-Scholes sensitivity to underlying price volatility
Syntax Vega = blsvega(Price, Strike, Rate, Time, Volatility, Yield)
Arguments

Price Current price of the underlying asset.

Strike Exercise price of the option.

Rate Annualized, continuously compounded risk-free rate
of return over the life of the option, expressed as a
positive decimal number.

Time Time to expiration of the option, expressed in years.

Volatility Annualized asset price volatility (annualized
standard deviation of the continuously compounded
asset return), expressed as a positive decimal
number.

Yield (Optional) Annualized, continuously compounded
yield of the underlying asset over the life of the
option, expressed as a decimal number. (Default
= 0.) For example, for options written on stock
indices, Yield could represent the dividend yield.
For currency options, Yield could be the foreign
risk-free interest rate.

Description Vega = blsvega(Price, Strike, Rate, Time, Volatility,

Yield) returns vega, the rate of change of the option value with respect
to the volatility of the underlying asset.

Examples Vega = blsvega(50, 50, 0.12, 0.25, 0.3, 0)

Vega

9.6035
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References Hull, John C., Options, Futures, and Other Derivatives, Prentice Hall,
5th edition, 2003.

See Also blsdelta, blsgamma, blslambda, blsprice, blsrho, blstheta
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Purpose Bond convexity given price

Syntax [YearConvexity, PerConvexity] = bndconvp(Price, CouponRate, Settle,
Maturity, Period, Basis, EndMonthRule, IssueDate,
FirstCouponDate, LastCouponDate, StartDate, Face)

Arguments

Price Clean price (excludes accrued interest).

CouponRate Decimal number indicating the annual
percentage rate used to determine the coupons
payable on a bond.

Settle Settlement date. A vector of serial date
numbers or date strings. Settle must be
earlier than or equal to Maturity.

Maturity Maturity date. A vector of serial date numbers
or date strings.

Period (Optional) Coupons per year of the bond. A
vector of integers. Allowed values are 0, 1, 2
(default), 3, 4, 6, and 12.

Basis (Optional) Day-count basis of the instrument. A
vector of integers.
e (0 = actual/actual (default)

1 = 30/360 (SIA)

2 = actual/360

3 = actual/365

4 = 30/360 (PSA)

5 = 30/360 (ISDA)

6 = 30/360 (European)
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EndMonthRule

IssueDate

FirstCouponDate

LastCouponDate

® 7 = actual/365 (Japanese)
e 8 = actual/actual ISMA)
® 9 =actual/360 ISMA)

® 10 = actual/365 (ISMA)

e 11 = 30/360E (ISMA)

e 12 = actual/365 (ISDA)

(Optional) End-of-month rule. A vector.

This rule applies only when Maturity is an
end-of-month date for a month having 30 or
fewer days. 0 = ignore rule, meaning that

a bond’s coupon payment date is always the
same numerical day of the month. 1 = set rule
on (default), meaning that a bond’s coupon
payment date is always the last actual day of
the month.

(Optional) Date when a bond was issued.

(Optional) Date when a bond makes its first
coupon payment. When FirstCouponDate
and LastCouponDate are both specified,
FirstCouponDate takes precedence in
determining the coupon payment structure.

(Optional) Last coupon date of a bond before
the maturity date. In the absence of a specified
FirstCouponDate, a specified LastCouponDate
determines the coupon structure of the bond.
The coupon structure of a bond is truncated at
the LastCouponDate regardless of where it falls
and will be followed only by the bond’s maturity
cash flow date.
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Description

Examples
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StartDate (Future implementation; optional) Date when
a bond actually starts (the date from which
a bond’s cash flows can be considered). To
make an instrument forward-starting, specify
this date as a future date. If StartDate is not
explicitly specified, the effective start date is
the settlement date.

Face (Optional) Face or par value. Default = 100.

All specified arguments must be number of bonds (NUMBONDS)-by-1 or
1-by-NUMBONDS conforming vectors or scalar arguments. Use an empty
matrix ([ ]) as a placeholder for an optional argument. Fill unspecified
entries in input vectors with NaN. Dates can be serial date numbers
or date strings.

[YearConvexity, PerConvexity] = bndconvp(Price, CouponRate,
Settle, Maturity, Period, Basis, EndMonthRule, IssueDate,
FirstCouponDate, LastCouponDate, StartDate, Face) computes
the convexity of NUMBONDS fixed income securities given a clean price for
each bond. This function determines the convexity for a bond whether
or not the first or last coupon periods in the coupon structure are short
or long (that is, whether or not the coupon structure is synchronized to

maturity). This function also determines the convexity of a zero coupon
bond.

YearConvexity is the yearly (annualized) convexity; PerConvexity
is the periodic convexity reported on a semiannual bond basis (in
accordance with STA convention). Both outputs are NUMBONDS-by-1
vectors.

Find the convexity of three bonds given their prices.

Price = [106; 100; 981];
CouponRate = 0.055;
Settle = '02-Aug-1999';
Maturity = '15-Jun-2004"';
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See Also

Period = 2;
Basis = 0;

[YearConvexity, PerConvexity] = bndconvp(Price,...
CouponRate,Settle, Maturity, Period, Basis)

YearConvexity =
21.4447
21.0363
20.8951

PerConvexity =
85.7788

84.1454
83.5803

bndconvy, bnddurp, bnddury, cfconv, cfdur
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Purpose

Syntax

Arguments
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Bond convexity given yield

[YearConvexity, PerConvexity] = bndconvy(Yield, CouponRate, Settle,
Maturity, Period, Basis, EndMonthRule, IssueDate,
FirstCouponDate, LastCouponDate, StartDate, Face)

Yield Yield to maturity on a semiannual basis.

CouponRate Decimal number indicating the annual
percentage rate used to determine the coupons
payable on a bond.

Settle Settlement date. A vector of serial date
numbers or date strings. Settle must be
earlier than or equal to Maturity.

Maturity Maturity date. A vector of serial date numbers
or date strings.

Period (Optional) Coupons per year of the bond. A
vector of integers. Allowed values are 0, 1, 2
(default), 3, 4, 6, and 12.

Basis (Optional) Day-count basis of the instrument.
A vector of integers.
® 0 = actual/actual (default)
e 1=30/360 (SIA)
® 2 = actual/360
® 3 = actual/365
* 4 =30/360 (PSA)
* 5=30/360 (ISDA)
® 6 = 30/360 (European)
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EndMonthRule

IssueDate

FirstCouponDate

LastCouponDate

® 7 = actual/365 (Japanese)
e 8 = actual/actual ISMA)
® 9 = actual/360 (ISMA)

® 10 = actual/365 (ISMA)

e 11 = 30/360E (ISMA)

e 12 = actual/365 (ISDA)

(Optional) End-of-month rule. A vector.

This rule applies only when Maturity is an
end-of-month date for a month having 30 or
fewer days. 0 = ignore rule, meaning that a
bond’s coupon payment date is always the
same numerical day of the month. 1 = set rule
on (default), meaning that a bond’s coupon
payment date is always the last actual day of
the month.

(Optional) Date when a bond was issued.

(Optional) Date when a bond makes its first
coupon payment. When FirstCouponDate
and LastCouponDate are both specified,
FirstCouponDate takes precedence in
determining the coupon payment structure.

(Optional) Last coupon date of a bond before
the maturity date. In the absence of a specified
FirstCouponDate, a specified LastCouponDate
determines the coupon structure of the bond.
The coupon structure of a bond is truncated

at the LastCouponDate regardless of where it
falls and will be followed only by the bond’s
maturity cash flow date.
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Description

Examples
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StartDate (Future implementation; optional) Date when
a bond actually starts (the date from which
a bond’s cash flows can be considered). To
make an instrument forward-starting, specify
this date as a future date. If StartDate is not
explicitly specified, the effective start date is
the settlement date.

Face (Optional) Face or par value. Default = 100.

All specified arguments must be number of bonds (NUMBONDS)-by-1 or
1-by-NUMBONDS conforming vectors or scalar arguments. Use an empty
matrix ([ ]) as a placeholder for an optional argument. Fill unspecified
entries in input vectors with NaN. Dates can be serial date numbers
or date strings.

[YearConvexity, PerConvexity] = bndconvy(Yield, CouponRate,
Settle, Maturity, Period, Basis, EndMonthRule, IssueDate,
FirstCouponDate, LastCouponDate, StartDate, Face) computes
the convexity of NUMBONDS fixed income securities given the yield to
maturity for each bond. This function determines the convexity for

a bond whether or not the first or last coupon periods in the coupon
structure are short or long (that is, whether or not the coupon structure
is synchronized to maturity). This function also determines the
convexity of a zero coupon bond.

YearConvexity is the yearly (annualized) convexity; PerConvexity
is the periodic convexity reported on a semiannual bond basis (in
accordance with STA convention). Both outputs are NUMBONDS-by-1
vectors.

Find the convexity of a bond at three different yield values.

Yield = [0.04; 0.055; 0.06];
CouponRate = 0.055;

Settle = '02-Aug-1999';
Maturity = '15-Jun-2004"';
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See Also

Period = 2;
Basis = 0;

[YearConvexity, PerConvexity]=bndconvy(Yield, CouponRate,...

Settle, Maturity, Period, Basis)
YearConvexity =

21.4825

21.0358

20.8885
PerConvexity =

85.9298

84.1434
83.5541

bndconvp, bnddurp, bnddury, cfconv, cfdur
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Purpose Bond duration given price

Syntax [ModDuration, YearDuration, PerDuration] = bnddurp(Price,
CouponRate, Settle, Maturity, Period, Basis, EndMonthRule,
IssueDate, FirstCouponDate, LastCouponDate, StartDate, Face)

Arguments

Price Clean price (excludes accrued interest).

CouponRate Decimal number indicating the annual
percentage rate used to determine the coupons
payable on a bond.

Settle Settlement date. A vector of serial date
numbers or date strings. Settle must be
earlier than or equal to Maturity.

Maturity Maturity date. A vector of serial date numbers
or date strings.

Period (Optional) Coupons per year of the bond. A
vector of integers. Allowed values are 0, 1, 2
(default), 3, 4, 6, and 12.

Basis (Optional) Day-count basis of the instrument.
A vector of integers.
e (0 = actual/actual (default)

1 = 30/360 (SIA)

® 2 = actual/360

® 3 = actual/365

e 4 =30/360 (PSA)

e 5=230/360 (ISDA)

* 6 =30/360 (European)
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EndMonthRule

IssueDate

FirstCouponDate

LastCouponDate

® 7 = actual/365 (Japanese)
e 8 = actual/actual ISMA)
® 9 = actual/360 (ISMA)

® 10 = actual/365 (ISMA)

e 11 = 30/360E (ISMA)

e 12 = actual/365 (ISDA)

(Optional) End-of-month rule. A vector.

This rule applies only when Maturity is an
end-of-month date for a month having 30 or
fewer days. 0 = ignore rule, meaning that a
bond’s coupon payment date is always the
same numerical day of the month. 1 = set rule
on (default), meaning that a bond’s coupon
payment date is always the last actual day of
the month.

(Optional) Date when a bond was issued.

(Optional) Date when a bond makes its first
coupon payment. When FirstCouponDate
and LastCouponDate are both specified,
FirstCouponDate takes precedence in
determining the coupon payment structure.

(Optional) Last coupon date of a bond before
the maturity date. In the absence of a specified
FirstCouponDate, a specified LastCouponDate
determines the coupon structure of the bond.
The coupon structure of a bond is truncated

at the LastCouponDate regardless of where it
falls and will be followed only by the bond’s
maturity cash flow date.
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Description

Examples
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StartDate (Future implementation; optional) Date when
a bond actually starts (the date from which
a bond’s cash flows can be considered). To
make an instrument forward-starting, specify
this date as a future date. If StartDate is not
explicitly specified, the effective start date is
the settlement date.

Face (Optional) Face or par value. Default = 100.

All specified arguments must be number of bonds (NUMBONDS)-by-1 or
1-by-NUMBONDS conforming vectors or scalar arguments. Use an empty
matrix ([ ]) as a placeholder for an optional argument. Fill unspecified
entries in input vectors with NaN. Dates can be serial date numbers
or date strings.

[ModDuration, YearDuration, PerDuration] = bnddurp(Price,
CouponRate, Settle, Maturity, Period, Basis, EndMonthRule,
IssueDate, FirstCouponDate, LastCouponDate, StartDate,

Face) computes the duration of NUMBONDS fixed income securities given
a clean price for each bond. This function determines the Macaulay and
modified duration for a bond whether or not the first or last coupon
periods in the coupon structure are short or long (this is, whether or not
the coupon structure is synchronized to maturity). This function also
determines the Macaulay and modified duration for a zero coupon bond.

ModDuration is the modified duration in years, reported on a
semiannual bond basis (in accordance with SIA convention);
YearDuration is the Macaulay duration in years; PerDuration is the
periodic Macaulay duration reported on a semiannual bond basis (in
accordance with SIA convention). Outputs are NUMBONDS-by-1 vectors.

Find the duration of three bonds given their prices.

Price = [106; 100; 98];
CouponRate = 0.055;
Settle = '02-Aug-1999';
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|

Maturity = '15-Jun-2004';
Period = 2;

Basis = 0;

[ModDuration, YearDuration, PerDuration] = bnddurp(Price,...

CouponRate, Settle, Maturity, Period, Basis)
ModDuration =
4.2400
4.1925
4.1759
YearDuration =
4.3275
4.3077
4.3007
PerDuration =
8.6549
8.6154

8.6014

See Also bndconvp, bndconvy, bnddury, bndkrdur
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Purpose Bond duration given yield

Syntax [ModDuration, YearDuration, PerDuration] = bnddury(Yield,
CouponRate, Settle, Maturity, Period, Basis, EndMonthRule,
IssueDate, FirstCouponDate, LastCouponDate, StartDate, Face)

Arguments

Yield Yield to maturity on a semiannual basis.

CouponRate Decimal number indicating the annual
percentage rate used to determine the coupons
payable on a bond.

Settle Settlement date. A vector of serial date
numbers or date strings. Settle must be
earlier than or equal to Maturity.

Maturity Maturity date. A vector of serial date numbers
or date strings.
Period (Optional) Coupons per year of the bond. A

vector of integers. Allowed values are 0, 1, 2
(default), 3, 4, 6, and 12.

Basis (Optional) Day-count basis of the instrument.
A vector of integers.
® 0 = actual/actual (default)
e 1=30/360 (SIA)
® 2 = actual/360
® 3 = actual/365
* 4 =30/360 (PSA)
* 5=30/360 (ISDA)
® 6 = 30/360 (European)
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EndMonthRule

IssueDate

FirstCouponDate

LastCouponDate

® 7 = actual/365 (Japanese)
e 8 = actual/actual ISMA)
® 9 = actual/360 (ISMA)

® 10 = actual/365 (ISMA)

e 11 = 30/360E (ISMA)

e 12 = actual/365 (ISDA)

(Optional) End-of-month rule. A vector.

This rule applies only when Maturity is an
end-of-month date for a month having 30 or
fewer days. 0 = ignore rule, meaning that a
bond’s coupon payment date is always the
same numerical day of the month. 1 = set rule
on (default), meaning that a bond’s coupon
payment date is always the last actual day of
the month.

(Optional) Date when a bond was issued.

(Optional) Date when a bond makes its first
coupon payment. When FirstCouponDate
and LastCouponDate are both specified,
FirstCouponDate takes precedence in
determining the coupon payment structure.

(Optional) Last coupon date of a bond before
the maturity date. In the absence of a specified
FirstCouponDate, a specified LastCouponDate
determines the coupon structure of the bond.
The coupon structure of a bond is truncated

at the LastCouponDate regardless of where it
falls and will be followed only by the bond’s
maturity cash flow date.
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Description

Examples
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StartDate (Future implementation; optional) Date when
a bond actually starts (the date from which
a bond’s cash flows can be considered). To
make an instrument forward-starting, specify
this date as a future date. If StartDate is not
explicitly specified, the effective start date is
the settlement date.

Face (Optional) Face or par value. Default = 100.

All specified arguments must be number of bonds (NUMBONDS)-by-1 or
1-by-NUMBONDS conforming vectors or scalar arguments. Use an empty
matrix ([ ]) as a placeholder for an optional argument. Fill unspecified
entries in input vectors with NaN. Dates can be serial date numbers
or date strings.

[ModDuration, YearDuration, PerDuration] = bnddury(Yield,
CouponRate, Settle, Maturity, Period, Basis, EndMonthRule,
IssueDate, FirstCouponDate, LastCouponDate, StartDate,
Face) computes the Macaulay and modified duration of NUMBONDS
fixed income securities given yield to maturity for each bond. This
function determines the duration for a bond whether or not the first
or last coupon periods in the coupon structure are short or long (that
1s, whether or not the coupon structure is synchronized to maturity).
This function also determines the Macaulay and modified duration for
a zero coupon bond.

ModDuration is the modified duration in years, reported on a
semiannual bond basis (in accordance with SIA convention);
YearDuration is the Macaulay duration in years; PerDuration is the
periodic Macaulay duration reported on a semiannual bond basis (in
accordance with SIA convention). Outputs are NUMBONDS-by-1 vectors.

Find the duration of a bond at three different yield values.

Yield = [0.04; 0.055; 0.06];
CouponRate = 0.055;
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See Also

Settle = '02-Aug-1999';
Maturity = '15-Jun-2004"';
Period = 2;

Basis = 0;

[ModDuration,YearDuration,PerDuration]=bnddury(Yield,...
CouponRate, Settle, Maturity, Period, Basis)

ModDuration =
4.2444
4.1924
4.1751

YearDuration =
4.3292
4.3077
4.3004

PerDuration =
8.6585

8.6154
8.6007

bndconvp, bndconvy, bnddurp, bndkrdur
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Purpose

Syntax
Settle, Maturity)

Bond key rate duration given zero curve

KRDUR = bndkrdur(ZeroData, CouponRate,

KRDUR = bndkrdur(ZeroData, CouponRate, Settle,

Maturity,
Value2, ...)

Arguments

ZeroData

CouponRate

Settle

Maturity

Period

InterpMethod
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'Parameteri', Valuetl,

'Parameter2’,

Zero curve represented as a numRates-by-2
matrix where the first column i1s a MATLAB
date number and the second column 1is
accompanying zero rates.

numBonds-by-1 vector of coupon rates in decimal
form.

Scalar MATLAB date number for the
settlement date for all the bonds and the zero
data. Settle must be the same settlement date
for all the bonds and the zero curve.

numBonds-by-1 vector of maturity dates.

(Optional) Coupons per year of the bond. A
vector of integers. Acceptable values are 0, 1, 2
(default), 3, 4, 6, and 12.

(Optional) Interpolation method used to obtain
points from the zero curve. Acceptable values
are:

e ‘'linear' (default)

® ‘cubic’

® 'pchip'
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ShiftValue

KeyRates

CurveCompounding

CurveBasis

Basis

(Optional) Scalar value that zero curve is
shifted up and down to compute duration.
Default is .01 (100 basis points).

(Optional) Rates to perform the duration
calculation, specified as a time to maturity.
By default, KeyRates is set to each of the zero
dates.

(Optional) Compounding frequency of the
curve. Default is semiannual.

(Optional) Basis of the curve, where the choices
are identical to Basis below. Default is 0
(actual/actual).

(Optional) Day-count basis of the bond
instrument. A vector of integers:
® 0 = actual/actual (default)

e 1=30/360 (SIA)

® 2 = actual/360

® 3 = actual/365

* 4 =30/360 (PSA)

* 5=30/360 (ISDA)

e 6 =30/360 (European)

e 7 = actual/365 (Japanese)

® 8 = actual/actual ISMA)

® 9 = actual/360 (ISMA)

® 10 = actual/365 (ISMA)

e 11 = 30/360E (ISMA)

e 12 = actual/365 (ISDA)
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EndMonthRule

IssueDate

FirstCouponDate

LastCouponDate

StartDate

Face

(Optional) End-of-month rule. This rule applies
only when Maturity is an end-of-month date
for a month having 30 or fewer days. The
values are:

e 0 = ignore rule, meaning that a bond’s
coupon payment date is always the same
numerical day of the month.

® 1 = gset rule on (default), meaning that a
bond’s coupon payment date is always the
last actual day of the month.

(Optional) Date when a bond was issued.

(Optional) Date when a bond makes its first
coupon payment. When you specify both
FirstCouponDate and LastCouponDate
FirstCouponDate takes precedence in
determining the coupon payment structure.

(Optional) Last coupon date of a bond before
the maturity date. In the absence of a specified
FirstCouponDate, a specified LastCouponDate
determines the coupon structure of the bond.
The coupon structure of a bond is truncated

at the LastCouponDate regardless of where it
falls and will be followed only by the bond’s
maturity cash flow date.

(Future implementation; optional) Date when
a bond actually starts (the date from which

a bond’s cash flows can be considered). To
make an instrument forward-starting, specify
this date as a future date. If StartDate is not
explicitly specified, the effective start date is
the settlement date.

(Optional) Face or par value. Default = 100.
Face has no impact on key rate duration.
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Description

Examples

Note You must enter the optional arguments as parameter/value pairs.

KRDUR = bndkrdur(ZeroData, CouponRate, Settle, Maturity)
KRDUR = bndkrdur(ZeroData, CouponRate, Settle, Maturity,
"Parameteri', Valuel, 'Parameter2', Value2, ...)

The output argument KRDUR is a numBonds-by-numRates matrix of key
rate durations.

bndkrdur computes the key rate durations for one or more bonds given
a zero curve and a set of key rates. By default, the key rates are each
of the zero curve rates. For each key rate, the duration is computed by
shifting the zero curve up and down by a specified amount (ShiftValue)
at that particular key rate, computing the present value of the bond in
each case with the new zero curves, and then evaluating the following:

(PV_down - PV_up)
(PV x ShiftValue x 2)

krdur_ i =

Note The shift to the curve is computed by shifting the particular key
rate by the ShiftValue and then interpolating the values of the curve
in the interval between the previous and next key rates. For the first
key rate, any curve values before the date are equal to the ShiftValue;
likewise, for the last key rate, any curve values after the date are equal
to the ShiftValue.

Find the key rate duration of a bond for key rate times of 2, 5, 10, and
30 years.

ZeroRates = [0.0476 .0466 .0465 .0468 .0473 .0478 ...
.0493 .0539 .0572 .0553 .0530]';
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ZeroDates = daysadd('31-Dec-1998',[30 360 360*2 360*3 360*5 ...
360*7 360*10 360*15 360*20 360*25 360*30],1);

ZeroData = [ZeroDates ZeroRates];

krdur = bndkrdur(ZeroData,.0525,'12/31/1998',...
'11/15/2028"', 'KeyRates',[2 5 10 30])

krdur =

0.2986 0.8791 4.1354 9.5811

References Golub, B.W. and L.M. Tilman, Risk Management: Approaches for Fixed
Income Markets Wiley, 2000.

Tuckman, B. Fixed Income Securities: Tools for Today’s Markets Wiley,
2002.

See Also bndconvp, bndconvy, bnddurp, bnddury
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Purpose

Syntax

Arguments

Price fixed income security from yield to maturity

[Price, AccruedInt]
[Price, AccruedInt]

= bndprice(Yield, CouponRate, Settle, Maturity)

Period, Basis, EndMonthRule, IssueDate, FirstCouponDate,
LastCouponDate, StartDate, Face)

Required and optional inputs can be number of bonds (NUMBONDS)-by-1 or
1-by-NUMBONDS conforming vectors or scalar arguments. Optional inputs

can also be passed as empty matrices ([ ]) or omitted at the end of the
argument list. The value NaN in any optional input invokes the default
value for that entry. Dates can be serial date numbers or date strings.

Yield

CouponRate

Settle

Maturity

Period

Bond yield to maturity is on a semiannual basis
for basis values 0 through 7 and an annual
basis for basis values 8 through 12.

Decimal number indicating the annual
percentage rate used to determine the coupons
payable on a bond.

Settlement date. A vector of serial date
numbers or date strings. Settle must be
earlier than or equal to Maturity.

Maturity date. A vector of serial date numbers
or date strings.

(Optional) Coupons per year of the bond. A
vector of integers. Allowed values are 0, 1, 2
(default), 3, 4, 6, and 12.

bndprice(Yield, CouponRate, Settle, Maturity,
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Basis (Optional) Day-count basis of the instrument.
A vector of integers.
® 0 = actual/actual (default)
1 = 30/360 (SIA)
® 2 = actual/360
® 3 = actual/365
* 4 =30/360 (PSA)
* 5=30/360 (ISDA)
e 6 =30/360 (European)
e 7 = actual/365 (Japanese)
® 8 = actual/actual ISMA)
® 9 = actual/360 (ISMA)
® 10 = actual/365 (ISMA)
e 11 = 30/360E (ISMA)
e 12 = actual/365 (ISDA)

EndMonthRule (Optional) End-of-month rule. A vector.
This rule applies only when Maturity is an
end-of-month date for a month having 30 or
fewer days. 0 = ignore rule, meaning that a
bond’s coupon payment date is always the
same numerical day of the month. 1 = set rule
on (default), meaning that a bond’s coupon
payment date is always the last actual day of
the month.

IssueDate (Optional) Date when a bond was issued.
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Description

FirstCouponDate (Optional) Date when a bond makes its first
coupon payment. When FirstCouponDate
and LastCouponDate are both specified,
FirstCouponDate takes precedence in
determining the coupon payment structure.

LastCouponDate (Optional) Last coupon date of a bond before
the maturity date. In the absence of a specified
FirstCouponDate, a specified LastCouponDate
determines the coupon structure of the bond.
The coupon structure of a bond is truncated
at the LastCouponDate regardless of where it
falls and will be followed only by the bond’s
maturity cash flow date.

StartDate (Future implementation; optional) Date when
a bond actually starts (the date from which
a bond’s cash flows can be considered). To
make an instrument forward-starting, specify
this date as a future date. If StartDate is not
explicitly specified, the effective start date is
the settlement date.

Face (Optional) Face or par value. Default = 100.

[Price, AccruedInt] = bndprice(Yield, CouponRate,

Settle, Maturity, Period, Basis, EndMonthRule, IssueDate,
FirstCouponDate, LastCouponDate, StartDate, Face) given bonds
with STA date parameters and semiannual yields to maturity, returns
the clean prices and accrued interest due.

Price is the clean price of the bond (current price without accrued
interest).

AccruedInt is the accrued interest payable at settlement.

Price and Yield are related by the formula
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Price + Accrued_Interest = sum(Cash_Flow*(1+Yield/2)"(-Time))

where the sum is over the bonds’ cash flows and corresponding times in
units of semiannual coupon periods.

Examples Price a treasury bond at three different yield values.

Yield = [0.04; 0.05; 0.06];
CouponRate = 0.05;

Settle = '20-Jan-1997"';
Maturity = '15-Jun-2002"';
Period = 2;

Basis = 0;

[Price, AccruedInt] = bndprice(Yield, CouponRate, Settle,...
Maturity, Period, Basis)

Price =
104.8106
99.9951
95.4384

AccruedInt =
0.4945
0.4945

0.4945

See Also cfamounts, bndyield
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Purpose

Syntax

Arguments

Static spread over spot curve

Spread = bndspread(SpotInfo, Price, Coupon, Settle, Maturity,
Period, Basis, EndMonthRule, IssueDate, FirstCouponDate,

LastCouponDate)

SpotInfo

Price

CouponRate

Settle

Maturity

Period

Two-column matrix:
[SpotDates ZeroRates]

Zero rates correspond to maturities on the spot
dates, continuously compounded. You will
obtain the best results if you choose evenly
spaced rates close together, for example, by
using the three-month deposit rates.

Price for every $100 notional amount of bonds
whose spreads are computed.

Decimal number indicating the annual
percentage rate used to determine the coupons
payable on a bond.

Settlement date. A vector of serial date
numbers or date strings. Settle must be
earlier than or equal to Maturity.

Maturity date. A vector of serial date numbers
or date strings.

(Optional) Coupons per year of the bond. A
scalar or vector of integers. Allowed values are
0, 1, 2 (default), 3, 4, 6, and 12.
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Basis (Optional) Day-count basis of the instrument.
A vector of integers.
® 0 = actual/actual (default)
1 = 30/360 (SIA)
® 2 = actual/360
® 3 = actual/365
* 4 =30/360 (PSA)
* 5=30/360 (ISDA)
e 6 =30/360 (European)
e 7 = actual/365 (Japanese)
® 8 = actual/actual ISMA)
® 9 = actual/360 (ISMA)
® 10 = actual/365 (ISMA)
e 11 = 30/360E (ISMA)
e 12 = actual/365 (ISDA)

EndMonthRule (Optional) End-of-month rule. A vector.
This rule applies only when Maturity is an
end-of-month date for a month having 30 or
fewer days. 0 = ignore rule, meaning that a
bond’s coupon payment date is always the
same numerical day of the month. 1 = set rule
on (default), meaning that a bond’s coupon
payment date is always the last actual day of
the month.

IssueDate (Optional) Date when a bond was issued.
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FirstCouponDate

LastCouponDate

(Optional) Date when a bond makes its first
coupon payment. When FirstCouponDate
and LastCouponDate are both specified,
FirstCouponDate takes precedence in
determining the coupon payment structure.

(Optional) Last coupon date of a bond before
the maturity date. In the absence of a specified
FirstCouponDate, a specified LastCouponDate
determines the coupon structure of the bond.
The coupon structure of a bond is truncated

at the LastCouponDate regardless of where it
falls and will be followed only by the bond’s
maturity cash flow date.

Descripl’ion Spread = bndspread(SpotInfo, Price, Coupon, Settle,
Maturity, Period, Basis, EndMonthRule, IssueDate,
FirstCouponDate, LastCouponDate) computes the static spread to
benchmark in basis points.

Examples Compute a FNMA 4 3/8 spread over a Treasury spot-curve.

% Build spot curve.

RefMaturity = [datenum('02/27/2003');

datenum('05/29/2003");
datenum('10/31/2004");
datenum('11/15/2007"');
datenum('11/15/2012');
datenum('02/15/2031')1;
RefCpn = [0;
0;
2.125;
3;
4;
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5.375] / 100;

RefPrices = [99.6964;
99.3572;
100.3662;
99.4511;
99.4299;
106.5756] ;

RefBonds = [RefPrices, RefMaturity, RefCpn];

Settle = datenum('26-Nov-2002");

[ZeroRates, CurveDates] = zbtprice(RefBonds(:, 2:end),
RefPrices, Settle)

% FNMA 4 3/8 maturing 10/06 at 4.30 pm Tuesday, Nov 26, 2002
Price = 105.484;

Coupon = 0.04375;

Maturity = datenum('15-0ct-2006"');

% All optional inputs are supposed to be accounted by default,
% except the accrued interest under 30/360 (SIA), so:

2;

1;

SpotInfo = [CurveDates, ZeroRates];

Period

Basis

% Compute static spread over treasury curve, taking into account
% the shape of curve as derived by bootstrapping method embedded
% within bndspread.

SpreadInBP = bndspread(SpotInfo, Price, Coupon, Settle,
Maturity, Period, Basis)

plot(CurveDates, ZeroRates*100, 'b', CurveDates,
ZeroRates*100+SpreadInBP/100, 'r--')
legend({'Treasury'; 'FNMA 4 3/8'})

xlabel('Curve Dates')

ylabel('Spot Rate [%]')
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grid;
ZeroRates =

.0121
.0127
.0194
.0317
.0423
.0550

O O O o o o

CurveDates =

731639
731730
732251
733361
735188
741854

SpreadInBP =

18.7582
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Purpose

Syntax

Arguments

Yield to maturity for fixed income security

Yield = bndyield(Price, CouponRate, Settle, Maturity, Period, Basis,
EndMonthRule, IssueDate, FirstCouponDate, LastCouponDate,
StartDate, Face)

Required and optional inputs can be number of bonds (NUMBONDS)-by-1 or
1-by-NUMBONDS conforming vectors or scalar arguments. Optional inputs
can also be passed as empty matrices ([ ]) or omitted at the end of the
argument list. The value NaN in any optional input invokes the default
value for that entry. Dates can be serial date numbers or date strings.

Price Clean price of the bond (current price without
accrued interest).

CouponRate Decimal number indicating the annual
percentage rate used to determine the coupons
payable on a bond.

Settle Settlement date. A vector of serial date
numbers or date strings. Settle must be
earlier than or equal to Maturity.

Maturity Maturity date. A vector of serial date numbers
or date strings.

Period (Optional) Coupons per year of the bond. A
vector of integers. Allowed values are 0, 1, 2
(default), 3, 4, 6, and 12.
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Basis

EndMonthRule

IssueDate

(Optional) Day-count basis of the instrument.
A vector of integers.

® 0 = actual/actual (default)
1 = 30/360 (SIA)

® 2 = actual/360

® 3 = actual/365

* 4 =30/360 (PSA)

* 5=30/360 (ISDA)

e 6 =30/360 (European)

e 7 = actual/365 (Japanese)
® 8 = actual/actual ISMA)
® 9 = actual/360 (ISMA)

® 10 = actual/365 (ISMA)

e 11 = 30/360E (ISMA)

e 12 = actual/365 (ISDA)

(Optional) End-of-month rule. A vector.

This rule applies only when Maturity is an
end-of-month date for a month having 30 or
fewer days. 0 = ignore rule, meaning that a
bond’s coupon payment date is always the
same numerical day of the month. 1 = set rule
on (default), meaning that a bond’s coupon
payment date is always the last actual day of
the month.

(Optional) Date when a bond was issued.
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Description

FirstCouponDate (Optional) Date when a bond makes its first
coupon payment. When FirstCouponDate
and LastCouponDate are both specified,
FirstCouponDate takes precedence in
determining the coupon payment structure.

LastCouponDate (Optional) Last coupon date of a bond before
the maturity date. In the absence of a specified
FirstCouponDate, a specified LastCouponDate
determines the coupon structure of the bond.
The coupon structure of a bond is truncated
at the LastCouponDate regardless of where it
falls and will be followed only by the bond’s
maturity cash flow date.

StartDate (Future implementation; optional) Date when
a bond actually starts (the date from which
a bond’s cash flows can be considered). To
make an instrument forward-starting, specify
this date as a future date. If StartDate is not
explicitly specified, the effective start date is
the settlement date.

Face (Optional) Face or par value. Default = 100.

Yield = bndyield(Price, CouponRate, Settle, Maturity,
Period, Basis, EndMonthRule, IssueDate, FirstCouponDate,
LastCouponDate, StartDate, Face) given NUMBONDS bonds with SIA
date parameters and clean prices (excludes accrued interest), returns
the bond equivalent yields to maturity.

Yield is a NUMBONDS-by-1 vector of the bond equivalent yields to
maturity with semiannual compounding.

Price and Yield are related by the formula

Price + Accrued_Interest = sum(Cash_Flow*(1+Yield/2)"(-Time))
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where the sum is over the bonds’ cash flows and corresponding times in
units of semiannual coupon periods.

Examples Compute the yield of a treasury bond at three different price values.

Price = [95; 100; 1051];
CouponRate = 0.05;
Settle = '20-Jan-1997"';
Maturity = '15-Jun-2002"';
Period = 2;

Basis = 0;

Yield = bndyield(Price, CouponRate, Settle,...
Maturity, Period, Basis)

Yield =
0.0610
0.0500
0.0396

See Also bndprice, cfamounts
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Purpose

Syntax

Arguments

Description

Bollinger band chart

bolling(Asset, Samples, Alpha)
[Movavgv, UpperBand, LowerBand] = bolling(Asset, Samples, Alpha,
width)

Asset Vector of asset data.

Samples Number of samples to use in computing the moving
average.

Alpha (Optional) Exponent used to compute the element

weights of the moving average. Default = 0 (simple
moving average).

width (Optional) Number of standard deviations to include
in the envelope. A multiplicative factor specifying
how tight the bands should be around the simple
moving average. Default = 2.

bolling(Asset, Samples, Alpha, Width) plots Bollinger bands for
given Asset data. This form of the function does not return any data.

[Movavgv, UpperBand, LowerBand] = bolling(Asset, Samples,
Alpha, Width) returns Movavgv with the moving average of the Asset
data, UpperBand with the upper band data, and LowerBand with the
lower band data. This form of the function does not plot any data.

Note The standard deviations are normalized by N-1, where N = the
sequence length.
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Examples

See Also

14-100

If Asset i1s a column vector of closing stock prices
bolling(Asset, 20, 1)

plots linear 20-day moving average Bollinger bands based on the stock
prices.

[Movavgv, UpperBand, LowerBand] = bolling(Asset, 20, 1)

returns Movavgv, UpperBand, and LowerBand as vectors containing the
moving average, upper band, and lower band data, without plotting
the data.

candle, dateaxis, highlow, movavg, pointfig
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Purpose

Syntax

Arguments

Description

Time series Bollinger band

[mid, uppr, lowr] = bollinger(data, wsize, wts, nstd)
[midfts, upprfts, lowrfts] = bollinger(tsobj, wsize, wts, nstd)

data Data vector.

wsize (Optional) Window size. Default = 20.

wts (Optional) Weight factor. Determines the type of
moving average used. Default = 0 (box). 1 = linear.

nstd (Optional) Number of standard deviations for upper

and lower bands. Default = 2.

tsobj Financial time series object.

[mid, uppr, lowr] = bollinger(data, wsize, wts, nstd)

calculates the middle (mid), upper (uppr), and lower (lowr) bands that
make up the Bollinger bands from the vector data.

mid is the vector that represents the middle band, a simple moving
average with a window size of wsize. uppr and lowr are vectors that
represent the upper and lower bands. uppr is a vector representing the
upper band that is +nstd times. lowr is a vector representing the lower
band that is -nstd times.

[midfts, upprfts, lowrfts] = bollinger(tsobj, wsize, wts,
nstd) calculates the middle, upper, and lower bands that make up the
Bollinger bands from a financial time series object tsobj.

midfts is a financial time series object that represents the middle band
for all series in tsobj. Both upprfts and lowrfts are financial time
series objects that represent the upper and lower bands of all series,
which are +nstd times and -nstd times moving standard deviations
away from the middle band.
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Examples Compute the Bollinger bands for Disney stock closing prices and plot
the results:

load disney.mat

[dis_Mid,dis_Uppr,dis_Lowr]= bollinger(dis);
dis_CloseBolling = [dis_Mid.CLOSE, dis_Uppr.CLOSE,...
dis_Lowr.CLOSE];

plot(dis_CloseBolling)

title('Bollinger Bands for Disney Closing Prices')

<} Figure No. 1 10l =|

File Edit Yiew Insert Tools Window Help
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References Achelis, Steven B., Technical Analysis from A to Z, Second Edition,
McGraw-Hill, 1995, pp. 72-74.

See Also tsmovavg
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Purpose

Syntax

Arguments

Description

Box-Cox transformation

[transdat, lambda] = boxcox(data)
[transfts, lambdas] = boxcox(tsobj)
transdat = boxcox(lambda, data)
transfts = boxcox(lambda, tsobj)

data Data vector. Must be positive.

tsobj Financial time series object.

boxcox transforms nonnormally distributed data to a set of data that
has approximately normal distribution. The Box-Cox transformation is
a family of power transformations.

If A is not = 0, then

A
data(),) = M

If A is = 0, then
data(1) =log(data)

The logarithm is the natural logarithm (log base e). The algorithm calls
for finding the A value that maximizes the Log-Likelihood Function
(LLF). The search is conducted using fminsearch.

[transdat, lambda] = boxcox(data) transforms the data vector
data using the Box-Cox transformation method into transdat. It also
estimates the transformation parameter A.
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See Also

14-104

[transfts, lambda] = boxcox(tsojb) transforms the financial time
series object tsobj using the Box-Cox transformation method into
transfts. It also estimates the transformation parameter A.

If the input data is a vector, lambda is a scalar. If the input is a financial
time series object, lambda is a structure with fields similar to the
components of the object; for example, if the object contains series names
Open and Close, lambda has fields 1ambda.Open and lambda.Close.

transdat = boxcox(lambda, data) and transfts = boxcox(lambda,
tsobj) transform the data using a certain specified A for the Box-Cox
transformation. This syntax does not find the optimum A that
maximizes the LLF.

fminsearch
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Purpose

Syntax

Arguments

Description

Next or previous business day

Busday = busdate(Date, Direction, Holiday, Weekend)

Date Reference date. Enter scalar, vector, or matrix of
reference business dates as serial date numbers or
date strings.

Direction (Optional) Scalar, vector, or matrix of search
directions. 1 = next (default) or -1 = previous
business day.

Holiday (Optional) Vector of holidays and nontrading-day
dates. All dates in Holiday must be the same
format: either serial date numbers or date strings.
(Using serial date numbers improves performance.)
If Holiday is not specified, the non-trading day
default vector is determined by the routine holidays
function.

Weekend (Optional) Vector of length 7, containing 0 and 1, the
value 1 indicating weekend days. The first element
of this vector corresponds to Sunday. Thus, when
Saturday and Sunday form the weekend (default),
Weekend = [1 0 0 0 0 O 1].

Busday = busdate(Date, Direction, Holiday, Weekend) returns
the scalar, vector, or matrix of the next or previous business day(s),
depending on Holiday.

Use the function datestr to convert serial date numbers to formatted
date strings.
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Examples

See Also

14-106

Example 1.

Busday = busdate('3-Jul-2001', 1)
Busday

731037
datestr(Busday)
ans =
05-Jul-2001

Example 2. You can indicate that Saturday is a business day by
appropriately setting the Weekend argument.

Weekend = [1 0 0 0 0 0 0];

July 4, 2003 falls on a Friday. Use busdate to verify that Saturday,
July 5, is actually a business day.

Date = datestr(busdate('3-Jul-2003', 1, , Weekend))

holidays, isbusday
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Purpose

Syntax

Arguments

Description

Business days in serial date format

bdates
bdates

sdate
edate
bdmode

holvec

bdates

= busdays(sdate, edate, bdmode)
busdays(sdate, edate, bdmode, holvec)

Start date in string or serial date format.
End date in string or serial date format.

(Optional) Frequency of business days:

e DAILY, Daily, daily, D, d, 1 (default)

o WEEKLY, Weekly, weekly, W, w, 2

® MONTHLY, Monthly, monthly, M, m, 3

® QUARTERLY, Quarterly, quarterly, Q, q, 4

e SEMIANNUAL, Semiannual, semiannual, S, s, 5
o ANNUAL, Annual, annual, A, a, 6

Strings must be enclosed in single quotation marks.

(Optional) Holiday dates vector in string or serial
date format.

= busdays(sdate, edate, bdmode) generates a vector of

business days, bdates, in serial date format between the last business
date of the period that contains the start date, and the last business
date of period that contains the end date. If holvec is not supplied, the
dates are generated based on United States holidays. If you do not
supply bdmode, busdays generates a daily vector.

For example:
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vec
vec
05-Jan-2001
12-Jan-2001

datestr(busdays('1/2/01','1/9/01"', 'weekly'))

The end of the week is considered to be a Friday. Between 1/2/01
(Monday) and 1/9/01 (Tuesday) there is only one end-of-week day, 1/5/01
(Friday).

Because 1/9/01 is part of following week, the following Friday (1/12/01)
is also reported.

bdates = busdays(sdate, edate, bdmode, holvec) lets you supply
a vector of holidays, holvec, used to generate business days. holvec
can either be in serial date format or date string format. If you use this
syntax, you need to supply the frequency bdmode.

The output, bdates, is a column vector of business dates in serial date
format.

Setting holvec to '' (empty string) or [] (empty vector) results in
BUSDAYS using a default holiday schedule. The default holiday schedule
is the NYSE holiday schedule.
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Purpose

Syntax

Arguments

Description

Candlestick chart

candle(High, Low, Close, Open)
candle(High, Low, Close, Open, Color, Dates, Dateform)

High
Low
Close
Open

Color

Dates

Dateform

High prices for a security. A column vector.
Low prices for a security. A column vector.
Closing prices for a security. A column vector.
Opening prices for a security. A column vector.

(Optional) Candlestick color. A string. MATLAB
software supplies a default color if none is specified.
The default color differs depending on the background
color of the figure window. See ColorSpec in the
MATLAB documentation for color names.

(Optional) Column vector of dates for user specified
X-axis tick labels.

(Optional) Date string format used as the x-axis
tick labels. (See datetick in the MATLAB
documentation.) You can specify a dateform only
when tsobj does not contain time-of-day data.

If tsobj contains time-of-day data, dateform is
restricted to 'dd-mmm-yyyy HH:MM'.

candle(High, Low, Close, Open) plots a candlestick chart given
column vectors with the high, low, closing, and opening prices of a

security.

If the closing price is greater than the opening price, the body (the
region between the opening and closing price) is unfilled.

If the opening price is greater than the closing price, the body is filled.
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Examples

See Also
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candle(High, Low, Close, Open, Color, Dates, Dateform) plots
a candlestick chart given column vectors with the high, low, closing,
and opening prices of a security. In addition, the optional arguments
Color, Dates, and Dateform specify the color of the candle box and the
date string format used as the x-axis tick labels.

Given High, Low, Close, and Open as equal-size vectors of stock price
data

candle(High, Low, Close, Open, ‘'cyan')
plots a candlestick chart with cyan candles.

bolling, candle, dateaxis, highlow, movavg, pointfig
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Purpose

Syntax

Arguments

Description

Time series candle plot

candle(tsobj)

candle(tsobj, color)

candle(tsobj, color, dateform)

candle(tsobj, color, dateform, ParameterName, ParameterValue,
hcdl = candle(tsobj, color, dateform, ParameterName,
ParametervValue, ...)

tsobj Financial time series object

color (Optional) A three-element row vector representing
RGB or a color identifier. (See plot in the MATLAB
documentation.)

dateform (Optional) Date string format used as the x-axis
tick labels. (See datetick in the MATLAB
documentation.) You can specify a dateform only
when tsobj does not contain time-of-day data.
If tsobj contains time-of-day data, dateform is
restricted to 'dd-mmm-yyyy HH:MM'.

candle(tsobj) generates a candle plot of the data in the financial
time series object tsobj. tsobj must contain at least four data series
representing the high, low, open, and closing prices. These series must
have the names High, Low, Open, and Close (case-insensitive).

candle(tsobj, color) additionally specifies the color of the candle
box.

candle(tsobj, color, dateform) additionally specifies the date
string format used as the x-axis tick labels. See datestr for a list of
date string formats.
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candle(tsobj, color, dateform, ParameterName,
ParameterValue, ...) indicates the actual name(s) of the
required data series if the data series do not have the default names.
ParameterName can be

e HighName: high prices series name

® | owName: low prices series name

® OpenName: open prices series name

® CloseName: closing prices series name

hcdl = candle(tsobj, color, dateform, ParameterName,
ParameterValue, ...) returns the handle to the patch objects and
the line object that make up the candle plot. hdcl is a three-element

column vector representing the handles to the two patches and one line
that forms the candle plot.

Examples Create a candle plot for Disney stock for the dates March 31, 1998
through April 30, 1998:

load disney.mat

candle(dis('3/31/98::4/30/98"))
title('Disney 3/31/98 to 4/30/98")
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See Also candle, chartfts, highlow, plot
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Purpose

Syntax

Arguments

14-114

Cash flow and time mapping for bond portfolio

[CFlowAmounts, CFlowDates, TFactors, CFlowFlags] =
cfamounts(CouponRate, Settle, Maturity, Period, Basis,

EndMonthRule,

StartDate,

CouponRate

Settle

Maturity

Period

Basis

IssueDate, FirstCouponDate, LastCouponDate,

Decimal number indicating the annual
percentage rate used to determine the coupons
payable on a bond.

Settlement date. A vector of serial date
numbers or date strings. Settle must be
earlier than or equal to Maturity.

Maturity date. A vector of serial date numbers
or date strings.

(Optional) Coupons per year of the bond. A
vector of integers. Allowed values are 0, 1, 2
(default), 3, 4, 6, and 12.

(Optional) Day-count basis of the instrument.
A vector of integers.

e (0 = actual/actual (default)

e 1=30/360 (SIA)

® 2 = actual/360

® 3 = actual/365

* 4 =30/360 (PSA)

* 5=30/360 (ISDA)

® 6 = 30/360 (European)
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EndMonthRule

IssueDate

FirstCouponDate

LastCouponDate

® 7 = actual/365 (Japanese)
e 8 = actual/actual ISMA)
® 9 = actual/360 (ISMA)

® 10 = actual/365 (ISMA)

e 11 = 30/360E (ISMA)

e 12 = actual/365 (ISDA)

(Optional) End-of-month rule. A vector.

This rule applies only when Maturity is an
end-of-month date for a month having 30 or
fewer days. 0 = ignore rule, meaning that a
bond’s coupon payment date is always the
same numerical day of the month. 1 = set rule
on (default), meaning that a bond’s coupon
payment date is always the last actual day of
the month.

(Optional) Date when a bond was issued.

(Optional) Date when a bond makes its first
coupon payment. When FirstCouponDate
and LastCouponDate are both specified,
FirstCouponDate takes precedence in
determining the coupon payment structure.

(Optional) Last coupon date of a bond before
the maturity date. In the absence of a specified
FirstCouponDate, a specified LastCouponDate
determines the coupon structure of the bond.
The coupon structure of a bond is truncated

at the LastCouponDate regardless of where it
falls and will be followed only by the bond’s
maturity cash flow date.
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Description
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StartDate (Future implementation; optional) Date when
a bond actually starts (the date from which
a bond’s cash flows can be considered). To
make an instrument forward-starting, specify
this date as a future date. If StartDate is not
explicitly specified, the effective start date is
the settlement date.

Face (Optional) Face or par value. Default = 100.

Required arguments must be number of bonds (NUMBONDS) by 1 or
1-by-NUMBONDS conforming vectors or scalars. Optional arguments must
be either NUMBONDS-by-1 or 1-by-NUMBONDS conforming vectors, scalars,
or empty matrices.

[CFlowAmounts, CFlowDates, TFactors, CFlowFlags] =
cfamounts(CouponRate, Settle, Maturity, Period, Basis,
EndMonthRule, IssueDate, FirstCouponDate, LastCouponDate,
StartDate, Face) returns matrices of cash flow amounts, cash flow
dates, time factors, and cash flow flags for a portfolio of NUMBONDS fixed
income securities. The elements contained in the cash flow matrix, time
factor matrix, and cash flow flag matrix correspond to the cash flow
dates for each security. The first element of each row in the cash flow
matrix is the accrued interest payable on each bond. This is zero in the
case of all zero coupon bonds. This function determines all cash flows
and time mappings for a bond whether or not the coupon structure
contains odd first or last periods. All output matrices are padded with
NaNs as necessary to ensure that all rows have the same number of
elements.

CFlowAmounts is the cash flow matrix of a portfolio of bonds. Each row
represents the cash flow vector of a single bond. Each element in a
column represents a specific cash flow for that bond.

CFlowDates is the cash flow date matrix of a portfolio of bonds. Each
row represents a single bond in the portfolio. Each element in a column
represents a cash flow date of that bond.
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TFactors is the matrix of time factors for a portfolio of bonds. Each row
corresponds to the vector of time factors for each bond. Each element
in a column corresponds to the specific time factor associated with
each cash flow of a bond. Time factors are useful in determining the
present value of a stream of cash flows. The term time factor refers to
the exponent TF in the discounting equation

PV = CF/(1+2s2)'F

where:
PV = Present value of a cash flow.
CF = The cash flow amount.
z= The risk-adjusted annualized rate or yield corresponding
to given cash flow. The yield is quoted on a semiannual
basis.
TF = Time factor for a given cash flow. Time is measured in

semiannual periods from the settlement date to the
cash flow date. In computing time factors, you use SIA
actual/actual day count conventions for all time factor
calculations.

CFlowFlags is the matrix of cash flow flags for a portfolio of bonds.
Each row corresponds to the vector of cash flow flags for each bond.
Each element in a column corresponds to the specific flag associated
with each cash flow of a bond. Flags identify the type of each cash flow
(for example, nominal coupon cash flow, front or end partial or “stub”
coupon, maturity cash flow). Possible values are shown in the table.

Flag Cash Flow Type

0 Accrued interest due on a bond at settlement.
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Examples
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Flag Cash Flow Type

1 Initial cash flow amount smaller than normal due to
“stub” coupon period. A stub period is created when
the time from issue date to first coupon is shorter than

normal.

2 Larger than normal initial cash flow amount because
first coupon period is longer than normal.

3 Nominal coupon cash flow amount.

4 Normal maturity cash flow amount (face value plus the

nominal coupon amount).

5 End “stub” coupon amount (last coupon period
abnormally short and actual maturity cash flow is
smaller than normal).

6 Larger than normal maturity cash flow because last
coupon period longer than normal.

7 Maturity cash flow on a coupon bond when the bond has
less than one coupon period to maturity.

8 Smaller than normal maturity cash flow when bond has
less than one coupon period to maturity.

9 Larger than normal maturity cash flow when bond has
less than one coupon period to maturity.

10 Maturity cash flow on a zero coupon bond.

Consider a portfolio containing a corporate bond paying interest
quarterly and a treasury bond paying interest semiannually. Compute
the cash flow structure and the time factors for each bond.

Settle = '0O1-Nov-1993';

Maturity = ['15-Dec-1994';'15-dJun-1995'];
CouponRate= [0.06; 0.05];

Period = [4; 2];
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See Also

Basis = [1; 0];

[CFlowAmounts, CFlowDates, TFactors, CFlowFlags]

cfamounts(CouponRate,Settle, Maturity, Period, Basis)

CFlowAmounts

-0.7667 1.5000 1.5000
-1.8989 2.5000 2.5000

CFlowDates =

728234 728278 728368
728234 728278 728460
TFactors =

0 0.2404 0.7403 1.2404
0 0.2404 1.2404 2.2404

CFlowFlags =

4
NaN

1.5000 101.5000

102.5000 NaN
728552 728643
728825 NaN

2.2404

NaN

accrfrac, cfdates, cpncount, cpndaten, cpndatenq, cpndatep
cpndatepq, cpndaysn, cpndaysp, cpnpersz
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Purpose

Syntax

Arguments

Description

Examples

See Also
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Cash flow convexity

CFlowConvexity = cfconv(CashFlow, Yield)

CashFlow A vector of real numbers.

Yield Periodic yield. A scalar. Enter as a decimal fraction.

CFlowConvexity = cfconv(CashFlow, Yield) returns the convexity
of a cash flow in periods.

Given a cash flow of nine payments of $2.50 and a final payment
$102.50, with a periodic yield of 2.5%

CashFlow = [2.5 2.5 2.5 2.5 2.5 2.5 2.5 2.5 2.5 102.5];

Convex = cfconv(CashFlow, 0.025)

Convex =

90.4493 (periods)

bndconvp. bndconvy, bnddurp, bnddury, cfdur
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Purpose Cash flow dates for fixed-income security

Syntax CFlowDates = cfdates(Settle, Maturity, Period, Basis, EndMonthRule,
IssueDate, FirstCouponDate, LastCouponDate, StartDate)

Arguments

Settle Settlement date. A vector of serial date
numbers or date strings. Settle must be
earlier than or equal to Maturity.

Maturity Maturity date. A vector of serial date numbers
or date strings.

Period (Optional) Coupons per year of the bond. A
vector of integers. Allowed values are 0, 1, 2
(default), 3, 4, 6, and 12.

Basis (Optional) Day-count basis of the instrument.
A vector of integers.
® 0 = actual/actual (default)
e 1=30/360 (SIA)
® 2 = actual/360
* 3 = actual/365
* 4 =30/360 (PSA)
* 5=30/360 (ISDA)
® 6 = 30/360 (European)
e 7 = actual/365 (Japanese)
® 8 = actual/actual ISMA)
® 9 = actual/360 (ISMA)
® 10 = actual/365 (ISMA)
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EndMonthRule

IssueDate

FirstCouponDate

LastCouponDate

StartDate

14-122

e 11 = 30/360E (ISMA)
e 12 = actual/365 (ISDA)

(Optional) End-of-month rule. A vector.

This rule applies only when Maturity is an
end-of-month date for a month having 30 or
fewer days. 0 =ignore rule, meaning that a
bond’s coupon payment date is always the
same numerical day of the month. 1 = set rule
on (default), meaning that a bond’s coupon
payment date is always the last actual day of
the month.

(Optional) Date when a bond was issued.

(Optional) Date when a bond makes its first
coupon payment. When FirstCouponDate
and LastCouponDate are both specified,
FirstCouponDate takes precedence in
determining the coupon payment structure.

(Optional) Last coupon date of a bond before
the maturity date. In the absence of a specified
FirstCouponDate, a specified LastCouponDate
determines the coupon structure of the bond.
The coupon structure of a bond is truncated

at the LastCouponDate regardless of where it
falls and will be followed only by the bond’s
maturity cash flow date.

(Future implementation; optional) Date when
a bond actually starts (the date from which

a bond’s cash flows can be considered). To
make an instrument forward-starting, specify
this date as a future date. If StartDate is not
explicitly specified, the effective start date is
the settlement date.



cfdates

Description

Examples

Required arguments must be number of bonds (NUMBONDS)-by-1 or
1-by-NUMBONDS conforming vectors or scalars. Optional arguments must
be either NUMBONDS-by-1 or 1-by-NUMBONDS conforming vectors, scalars,
or empty matrices.

Any input can contain multiple values, but if so, all other inputs must
contain the same number of values or a single value that applies to all.
For example, if Maturity contains N dates, then Settle must contain
N dates or a single date.

CFlowDates = cfdates(Settle, Maturity, Period, Basis,
EndMonthRule, IssueDate, FirstCouponDate, LastCouponDate,
StartDate) returns a matrix of cash flow dates for a bond or set of
bonds. cfdates determines all cash flow dates for a bond whether or
not the coupon payment structure is normal or the first and/or last
coupon period is long or short.

CFlowDates is an N-row matrix of serial date numbers, padded with
NaNs as necessary to ensure that all rows have the same number of

elements. Use the function datestr to convert serial date numbers

to formatted date strings.

Note The cash flow flags for a portfolio of bonds were formerly available
as the cfdates second output argument, CFlowFlags. You can now use
cfamounts to get these flags. If you specify a CFlowFlags argument,
cfdates displays a message directing you to use cfamounts.

CFlowDates = cfdates('14 Mar 1997', '30 Nov 1998', 2, 0, 1)
CFlowDates =
729541 729724 729906 730089
datestr(CFlowDates)
ans =
31-May-1997
30-Nov-1997
31-May-1998
30-Nov-1998
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Given three securities with different maturity dates and the same
default arguments

Maturity = ['30-Sep-1997'; '31-0ct-1998'; '30-Nov-1998'];
CFlowDates = cfdates('14-Mar-1997', Maturity)
CFlowDates =

729480 729663 NaN NaN

729510 729694 729875 730059

729541 729724 729906 730089

Look at the cash-flow dates for the last security.

datestr(CFlowDates(3,:))
ans =

31-May-1997

30-Nov-1997

31-May-1998

30-Nov-1998

See Also accrfrac, cfamounts, cftimes, cpncount, cpndaten, cpndatenq,
cpndatep, cpndatepq, cpndaysn, cpndaysp, cpnpersz
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Purpose

Syntax

Arguments

Description

Examples

See Also

Cash-flow duration and modified duration

[Duration, ModDuration] = cfdur(CashFlow, Yield)

CashFlow A vector or matrix of real numbers. When using
a matrix, each column of the matrix is a separate
Yield Pashiddiowield. A scalar or vector. Enter as a decimal
fraction.

[Duration, ModDuration] = cfdur(CashFlow, Yield) calculates
the duration and modified duration of a cash flow in periods.

Given a cash flow of nine payments of $2.50 and a final payment
$102.50, with a periodic yield of 2.5%

CashFlow=[2.5 2.5 2.5 2.5 2.5 2.5 2.5 2.5 2.5 102.5];
[Duration, ModDuration] = cfdur(CashFlow, 0.025)

Duration =
8.9709 (periods)

ModDuration =
8.7521 (periods)

bndconvp, bndconvy, bnddurp, bnddury, cfconv
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Purpose Portfolio form of cash flow amounts

Syntax [CFBondDate, AllDates, AllTF, IndByBond] = cfport(CFlowAmounts,
CFlowDates, TFactors)

Arguments

CFlowAmounts Number of bonds (NUMBONDS) by number of cash
flows (NUMCFS) matrix with entries listing cash
flow amounts corresponding to each date in
CFlowDates.

CFlowDates NUMBONDS-by-NUMCFS matrix with rows listing
cash flow dates for each bond and padded with
NaNs.

TFactors (Optional) NUMBONDS-by-NUMCFS matrix with
entries listing the time between settlement and
the cash flow date measured in semiannual
coupon periods.

Description [CFBondDate, AllDates, AL1TF, IndByBond] =
cfport (CFlowAmounts, CFlowDates, TFactors) computes
a vector of all cash flow dates of a bond portfolio, and a matrix mapping
the cash flows of each bond to those dates. Use the matrix for pricing
the bonds against a curve of discount factors.

CFBondDate is a NUMBONDS by number of dates (NUMDATES) matrix of
cash flows indexed by bond and by date in Al1Dates. Each row contains
a bond’s cash flow values at the indices corresponding to entries in
AllDates. Other indices in the row contain zeros.

AllDates is a NUMDATES-by-1 list of all dates that have any cash flow
from the bond portfolio.

14-126



cfport

Examples

AL11TF is a NUMDATES-by-1 list of time factors corresponding to the dates
in AllDates. If TFactors is not entered, A11TF contains the number of
days from the first date in Al1lDates.

IndByBond is a NUMBONDS-by-NUMCFS matrix of indices. The ith row
contains a list of indices into Al1Dates where the ith bond has cash
flows. Since some bonds have more cash flows than others, the matrix
is padded with NaNs.

Use cfamounts to calculate the cash flow amounts, cash flow dates,
and time factors for each of two bonds. Then use cfplot to plot the
cash flow diagram.

Settle = '03-Aug-1999';

Maturity = ['15-Aug-2000';"'15-Dec-2000"'];
CouponRate= [0.06; 0.05];

Period = [3;2];

Basis = [1;0];

[CFlowAmounts, CFlowDates, TFactors] = cfamounts(CouponRate,...
Settle, Maturity, Period, Basis);
cfplot(CFlowDates,CFlowAmounts)
xlabel('Numeric Cash Flow Dates')
ylabel('Bonds"')

title('Cash Flow Diagram')
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Cash Flow Diagram

Bonds

1 1 1 1 1 ]
7303 730 7305 7308 7307 7308 7300
MNumeric Cash Flow Dates ¥ 10°

Finally, call cfport to map the cash flow amounts to the cash flow dates.

Each row in the resultant CFBondDate matrix represents a bond. Each
column represents a date on which one or more of the bonds has a cash
flow. A 0 means the bond did not have a cash flow on that date. The
dates associated with the columns are listed in Al1Dates. For example,
the first bond had a cash flow of 2.000 on 730347. The second bond had
no cash flow on this date.

For each bond, IndByBond indicates the columns of CFBondDate, or
dates in AllDates, for which a bond has a cash flow.

[CFBondDate, AllDates, AllTF, IndByBond] = ...
cfport(CFlowAmounts, CFlowDates, TFactors)

CFBondDate =

-1.8000 2.0000 2.0000 2.0000 0 102.0000 0
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-0.6694 0 2.5000 0 2.5000 0 102.5000
AllDates =

730335
730347
730469
730591
730652
730713
730835

ALLTF =

0
0.0663
0.7322
1.3989
1.7322
2.0663
2.7322

IndByBond =

See Also cfamounts
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Purpose Time factors corresponding to bond cash flow dates

Syntax TFactors = cftimes(Settle, Maturity, Period, Basis, EndMonthRule,
IssueDate, FirstCouponDate, LastCouponDate, StartDate)

Arguments

Settle Settlement date. A vector of serial date
numbers or date strings. Settle must be
earlier than or equal to Maturity.

Maturity Maturity date. A vector of serial date numbers
or date strings.

Period (Optional) Coupons per year of the bond. A
vector of integers. Allowed values are 0, 1, 2
(default), 3, 4, 6, and 12.

Basis (Optional) Day-count basis of the instrument.
A vector of integers.
® 0 = actual/actual (default)
e 1=30/360 (SIA)
® 2 = actual/360
® 3 = actual/365
* 4 =30/360 (PSA)
* 5=30/360 (ISDA)
® 6 = 30/360 (European)
e 7 = actual/365 (Japanese)
® 8 = actual/actual ISMA)
® 9 =actual/360 (ISMA)
® 10 = actual/365 (ISMA)

14-130



cftimes

EndMonthRule

IssueDate

FirstCouponDate

LastCouponDate

StartDate

e 11 = 30/360E (ISMA)
e 12 = actual/365 (ISDA)

(Optional) End-of-month rule. A vector.

This rule applies only when Maturity is an
end-of-month date for a month having 30 or
fewer days. 0 = ignore rule, meaning that a
bond’s coupon payment date is always the
same numerical day of the month. 1 = set rule
on (default), meaning that a bond’s coupon
payment date is always the last actual day of
the month.

(Optional) Date when a bond was issued.

(Optional) Date when a bond makes its first
coupon payment. When FirstCouponDate
and LastCouponDate are both specified,
FirstCouponDate takes precedence in
determining the coupon payment structure.

(Optional) Last coupon date of a bond before
the maturity date. In the absence of a specified
FirstCouponDate, a specified LastCouponDate
determines the coupon structure of the bond.
The coupon structure of a bond is truncated

at the LastCouponDate regardless of where it
falls and will be followed only by the bond’s
maturity cash flow date.

(Future implementation; optional) Date when
a bond actually starts (the date from which

a bond’s cash flows can be considered). To
make an instrument forward-starting, specify
this date as a future date. If StartDate is not
explicitly specified, the effective start date is
the settlement date.
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Description

Examples

See Also
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TFactors = cftimes(Settle, Maturity, Period, Basis,
EndMonthRule, IssueDate, FirstCouponDate, LastCouponDate,
StartDate) determines the time factors corresponding to the cash
flows of a bond or set of bonds. The time factor of a cash flow is the
difference between the settlement date and the cash flow date in units
of semiannual coupon periods. In computing time factors, you use SIA
actual/actual day count conventions for all time factor calculations.

Settle = '15-Mar-1997';

Maturity = '01-Sep-1999';

Period = 2;

TFactors = cftimes(Settle, Maturity, Period)
TFactors =

0.9239 1.9239 2.9239 3.9239 4.9239

accrfrac, cfdates, cfamounts, cpncount, cpndaten, cpndatenq,
cpndatep, cpndatepq, cpndaysn, cpndaysp, cpnpersz, date2time
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Purpose

Syntax

Arguments

Description

Chaikin oscillator

chosc = chaikosc(highp, lowp, closep, tvolume)

chosc = chaikosc([highp lowp closep tvolume])
choscts = chaikosc(tsobj)
choscts = chaikosc(tsobj, ParameterName, ParameterValue, ... )
highp High price (vector)
lowp Low price (vector)
closep Closing price (vector)
tvolume Volume traded (vector)
tsobj Financial time series object

The Chaikin oscillator is calculated by subtracting the 10-period
exponential moving average of the Accumulation/Distribution (A/D) line
from the three-period exponential moving average of the A/D line.

chosc = chaikosc(highp, lowp, closep, tvolume) calculates the
Chaikin oscillator (vector), chosc, for the set of stock price and volume
traded data (tvolume). The prices that must be included are the high

(highp), low (lowp), and closing (closep) prices.

chosc = chaikosc([highp lowp closep tvolume]) accepts a
four-column matrix as input.

choscts = chaikosc(tsobj) calculates the Chaikin Oscillator,
choscts, from the data contained in the financial time series object
tsobj. tsobj must at least contain data series with names High, Low,
Close, and Volume. These series must represent the high, low, and
closing prices, plus the volume traded. choscts is a financial time
series object with the same dates as tsobj but only one series named
ChaikOsc.
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Examples
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choscts = chaikosc(tsobj, ParameterName, ParameterValue,

.) accepts parameter name/parameter value pairs as input. These
pairs specify the name(s) for the required data series if it is different
from the expected default name(s). Valid parameter names are
e HighName: high prices series name
® | owName: low prices series name
® CloseName: closing prices series name
® VolumeName: volume traded series name

Parameter values are the strings that represent the valid parameter
names.

Compute the Chaikin oscillator for Disney stock and plot the results.

load disney.mat

dis_CHAIKosc = chaikosc(dis)
plot(dis_CHAIKosc)

title('Chaikin Oscillator for Disney')



chaikosc

=il

File Edit Yiew Insert Tools Window Help
Deda "A 2/ | @20

x 107 Chaikin Oscillator for Disney

2 T T

1.5 i |
29-Mar-1996 29-Mar-1997 29-Mar-1998 29-Mar-1999

References Achelis, Steven B., Technical Analysis from A to Z, Second printing,
McGraw-Hill, 1995, pp. 91-94.

See Also adline
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Purpose

Syntax

Arguments

Description
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Chaikin volatility

chvol = chaikvolat
chvol = chaikvolat
chvol = chaikvolat
chvol = chaikvolat
chvts = chaikvolat
chvts = chaikvolat

highp, lowp)

[highp lowp])

high, lowp, nperdiff, manper)

[high lowp], nperdiff, manper)

tsobj)

tsobj, nperdiff, manper, ParameterName,

P

ParametervValue, ...)
highp High price (vector).
lowp Low price (vector).
nperdiff Period difference (vector). Default = 10.
manper Length of exponential moving average in periods

(vector). Default = 10.

tsobj Financial time series object.

chvol = chaikvolat(highp, lowp) calculates the Chaikin volatility
from the series of stock prices, highp and lowp. The vector chvol
contains the Chaikin volatility values, calculated on a 10-period
exponential moving average and 10-period difference.

chvol = chaikvolat([highp lowp]) accepts a two-column matrix
as the input.

chvol = chaikvolat(high, lowp, nperdiff, manper) manually
sets the period difference nperdiff and the length of the exponential
moving average manper in periods.

chvol = chaikvolat([high lowp], nperdiff, manper) accepts a
two-column matrix as the first input.
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Examples

chvts = chaikvolat(tsobj) calculates the Chaikin volatility from the
financial time series object tsobj. The object must contain at least two
series named High and Low, representing the high and low prices per
period. chvts is a financial time series object containing the Chaikin
volatility values, based on a 10-period exponential moving average and
10-period difference. chvts has the same dates as tsobj and a series
called ChaikVol.

chvts = chaikvolat (tsobj,nperdiff, manper, ParameterName,
ParameterValue, ...) accepts parameter name/parameter value pairs
as input. These pairs specify the name(s) for the required data series
if 1t 1s different from the expected default name(s). Valid parameter
names are

e HighName: high prices series name

® | owName: low prices series name

Parameter values are the strings that represent the valid parameter
names.

nperdiff, the period difference, and manper, the length of the
exponential moving average in periods, can also be set with this form
of chaikvolat.

Compute the Chaikin volatility for Disney stock and plot the results:

load disney.mat

dis_CHAIKvol = chaikvolat(dis)
plot(dis_CHAIKvol)

title('Chaikin Volatility for Disney')
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References Achelis, Steven B., Technical Analysis from A to Z, Second Edition,

McGraw-Hill, 1995, pp. 304-305.

See Also chaikosc
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Purpose Interactive display
Syntax chartfts(tsobj)
Description chartfts(tsobj) produces a figure window that contains one or more

plots. You can use the mouse to observe the data at a particular time
point of the plot.

Examples Create a financial time series object from the supplied data file
ibm9599.dat:

ibmfts = ascii2fts('ibm9599.dat', 1, 3, 2);
Chart the financial time series object ibmfts:

chartfts(ibmfts)

With the Zoom feature set off, a mouse click on the indicator line
displays object data in a pop-up box.
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See Also

You can find a tutorial on using chartfts in “Visualizing Financial
Time Series Objects” on page 7-18. See “Zoom Tool” on page 7-21 for
details on performing the zoom. Also see “Combine Axes Tool” on page
7-24 for information about combining axes for specified plots.

candle, highlow, plot
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Purpose

Syntax

Arguments

Description

See Also
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Change data series name

newfts = chfield(oldfts, oldname, newname)

oldfts Name of an existing financial time series object.

oldname Name of the existing component in oldfts. A
MATLAB string or column cell array.

newname New name for the component in oldfts. A MATLAB
string or column cell array.

newfts = chfield(oldfts, oldname, newname) changes the name of
the financial time series object component from oldname to newname.

Set newfts = oldfts to change the name of an existing component
without changing the name of the financial time series object.

To change the names of several components at once, specify the series of
old and new component names in corresponding column cell arrays.

You cannot change the names of the object components desc, freq,
and dates.

fieldnames, isfield, rmfield
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Purpose

Syntax

Arguments

Convert multivariate normal regression model to seemingly unrelated
regression (SUR) model

DesignSUR

Design

Group

convert2sur(Design, Group)

A matrix or a cell array that depends on the number
of data series NUMSERIES.

e If NUMSERIES = 1, convert2sur returns the
Design matrix.

e [f NUMSERIES > 1, Design is a cell array with
NUMSAMPLES cells, where each cell contains a
NUMSERIES-by-NUMPARAMS matrix of known values.

Contains information about how data series are to be
grouped, with separate parameters for each group.
Specify groups either by series or by groups:

® To identify groups by series, construct an index
vector that has NUMSERIES elements. Element i
=1, ..., NUMSERIES in the vector, and has the
index j = 1, ..., NUMGROUPS of the group in
which series i is a member.

® To identify groups by groups, construct a cell array
with NUMGROUPS elements. Each cell contains a
vector with the indexes of the series that populate
a given group.

In either case, the number of series is NUMSERIES
and the number of groups is NUMGROUPS, with 1 <
NUMGROUPS < NUMSERIES.
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Description

Examples
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DesignSUR = convert2sur(Design, Group) converts a multivariate
normal regression model into a seemingly unrelated regression model
with a specified grouping of the data series. DesignSUR is either a
matrix or a cell array that depends on the value of NUMSERIES:

e [f NUMSERIES = 1, DesignSUR = Design, which is a
NUMSAMPLES-by-NUMPARAMS matrix.

e [f NUMSERIES > 1 and NUMGROUPS groups are to be formed, Design
is a cell array with NUMSAMPLES cells, where each cell contains a
NUMSERIES-by- (NUMGROUPS * NUMPARAMS) matrix of known values.

The original collection of parameters that are common to all series are
replicated to form collections of parameters for each group.

This example has ten series in three groups, and two model parameters.
Suppose

Group 1 has series 1, 3, 4, 8.
Group 2 has series 2, 6, 10.
Group 3 has series 5, 7, 9.
Either:
Group = [ 1, 2, 1, 1, 3, 2, 3, 1, 3, 2];
or

Group = cell(3,1);
Group{1} = [1, 3, 4, 8];
Group{2} = [2, 6, 10];
Group{3} = [5, 7, 91];

A regression with DesignSUR would have 3 x 2 = 6 model parameters.
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Purpose

Syntax

Arguments

Description

See Also

Convert to specified frequency

newfts = convertto(oldfts, newfreq)
newfts = convertto(oldfts, newfreq, 'parami','valuel', 'param2',
‘value2', ... )

oldfts Name of an existing financial time series object.
newfreq 1, DAILY, Daily, daily, D, d
2, WEEKLY, Weekly, weekly, W, w
3, MONTHLY, Monthly, monthly, M, m
4, QUARTERLY, Quarterly, quarterly, Q, q
5, SEMIANNUAL, Semiannual, semiannual, S, s
6, ANNUAL, Annual, annual, A, a

convertto converts a financial time series of any frequency to one of a
specified frequency.

newfts = convertto(oldfts, newfreq) converts the object oldfts
to the new time series object newfts with the frequency newfreq.

Refer to the documentation for each frequency conversion function to
determine the valid parameter/value pairs.

toannual, todaily, tomonthly, toquarterly, tosemi, toweekly
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Purpose

Syntax

Arguments

Description
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Correlation coefficients

corrcoef (X)
corrcoef (X,Y),

X Matrix where each row is an observation and each
column is a variable.

Y Matrix where each row is an observation and each
column is a variable.

corrcoef for financial time series objects is based on the MATLAB
corrcoef function. See corrcoef in the MATLAB documentation.

r=corrcoef (X) calculates a matrix r of correlation coefficients for
an array X, in which each row is an observation and each column is
a variable.

r=corrcoef (X,Y), where X and Y are column vectors, is the same
as r=corrcoef([X Y]). corrcoef converts X and Y to column
vectors if they are not; that is, r = corrcoef (X,Y) is equivalent to
r=corrcoef ([X(:) Y(:)]) in that case

If ¢ is the covariance matrix, c= cov(X), then corrcoef (X) is the
matrix whose (i, j) 'th element is ci, j/sqrt(ci,i*c(j, j)).

[r,pl=corrcoef(...) alsoreturns p, a matrix of p-values for testing
the hypothesis of no correlation. Each p-value is the probability of
getting a correlation as large as the observed value by random chance,
when the true correlation is zero. If p(i, j) is less than 0.05, then the
correlation r(i, j) is significant.

[r,p,rlo,rup]=corrcoef(...) also returns matrices rlo and rup,
of the same size as r, containing lower and upper bounds for a 95%
confidence interval for each coefficient.



corrcoef

Examples

See Also

[...]=corrcoef(..., PARAM1',VAL1, 'PARAM2',VAL2,...) specifies
additional parameters and their values. Valid parameters are:

e 'alpha' — A number between 0 and 1 to specify a confidence level of
100*(1-ALPHA)%. Default is 0.05 for 95% confidence intervals.

e 'rows' — Kither 'all' (default) to use all rows, 'complete' to use
rows with no NaN values, or 'pairwise’' to compute r(i, j) using rows
with no NaN values in column i or j.

The p-value is computed by transforming the correlation to create a
t-statistic having N — 2 degrees of freedom, where N is the number of
rows of X. The confidence bounds are based on an asymptotic normal
distribution of 0.5*log((1 + r)/(1 — r)), with an approximate variance
equal to 1/(N — 3). These bounds are accurate for large samples when
X has a multivariate normal distribution. The 'pairwise' option can
produce an r matrix that is not positive definite.

Generate random data having correlation between column 4 and the
other columns.

X = randn(30,4); % uncorrelated data

X(:,4) = sum(x,2); % introduce correlation

f = fints((today:today+29)', x); % create a fints object using x
[r,p] = corrcoef(x) % compute sample correlation and p-values
[1,j] = find(p<0.05); % find significant correlations

[1,7] % display their (row,col) indices

Note Class support for inputs X,Y: float: double and single.

cov, std, var
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Purpose

Syntax

Arguments

Description

Examples

See Also
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Convert standard deviation and correlation to covariance

ExpCovariance =

ExpSigma

corr2cov (ExpSigma, ExpCorrC)

Vector of length n with the standard deviations of

each process. n is the number of random processes.

ExpCorrC

(Optional) n-by-n correlation coefficient matrix. If

ExpCorrC is not specified, the processes are assumed
to be uncorrelated, and the identity matrix is used.

corr2cov converts standard deviation and correlation to covariance.

ExpCovariance is an n-by-n covariance matrix, where n is the number

of processes.

ExpCov(i,j) = ExpCorrC(i,j)*(ExpSigma(i)*ExpSigma(j)
ExpSigma = [0.5 2.0];
ExpCorrC = [1.0 -0.5

-0.5 1.01;
ExpCovariance = corr2cov(ExpSigma,

Expected results:

ExpCovariance

0.2500
-0.5000

-0.
4.

5000
0000

corrcoef, cov, cov2corr, ewstats, std

ExpCorrC)
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Purpose

Syntax

Arguments

Description

Covariance matrix

cov (X)
cov(X,Y)
Financial times series object.
Y Financial times series object.

cov for financial time series objects is based on the MATLAB cov
function. See cov in the MATLAB documentation.

If X is a financial time series object with one series, cov (X) returns the
variance. For a financial time series object containing multiple series,
where each row is an observation, and each series a variable, cov (X)
is the covariance matrix.

diag(cov (X)) is a vector of variances for each series and
sqrt(diag(cov(X))) is a vector of standard deviations.

cov(X, Y), where X and Y are financial time series objects with the
same number of elements, is equivalent to cov([X(:) Y(:)1).

cov(X) or cov(X, Y) normalizes by (N-1)if N> 1, where N is the number
of observations. This makes cov (X) the best unbiased estimate of the
covariance matrix if the observations are from a normal distribution.
For N = 1, cov normalizes by N.

cov(X, 1) orcov(X, Y, 1) normalizes by N and produces the second
moment matrix of the observations about their mean. cov(X, Y, 0)
is the same as cov(X, Y) and cov(X, 0) is the same as cov(X). The
mean is removed from each column before calculating the result.
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Examples To create a covariance matrix for the following dates:
dates = {'01-Jan-2007';'02-Jan-2007"';'03-Jan-2007"'};
A=[-112; -2313; 40 3]
f = fints(dates, A);
c = cov(f)
C =
10.3333 -4.1667 3.0000
-4.1667 2.3333 -1.5000
3.0000 -1.5000 1.0000
See Also corrcoef, mean, std, var
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Purpose

Syntax

Arguments

Description

Examples

Convert covariance to standard deviation and correlation coefficient

[ExpSigma, ExpCorrC] = cov2corr(ExpCovariance)
ExpCovariance n-by-n covariance matrix; for example, from
cov or ewstats. n is the number of random
processes.
[ExpSigma, ExpCorrC] = cov2corr(ExpCovariance) converts

covariance to standard deviations and correlation coefficients.
ExpSigma is a 1-by-n vector with the standard deviation of each process.

ExpCorrC is an n-by-n matrix of correlation coefficients.

ExpSigma(i) = sqrt(ExpCovariance(i,i))
ExpCorrC(i,j) = ExpCovariance(i,j)/(ExpSigma(i)*ExpSigma(j))
ExpCovariance = [0.25 .5

-0.5 0],

[ExpSigma, ExpCorrC] = cov2corr(ExpCovariance)

Expected results:

ExpSigma =
0.5000 2.0000
ExpCorrC =
1.0000 -0.5000
-0.5000 1.0000
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See Also corr2cov, corrcoef, cov, ewstats, std
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cpncount

Purpose

Syntax

Arguments

Coupon payments remaining until maturity

NumCouponsRemaining = cpncount(Settle, Maturity, Period, Basis,
EndMonthRule, IssueDate, FirstCouponDate, LastCouponDate,
StartDate)

Settle Settlement date. A vector of serial date
numbers or date strings. Settle must be
earlier than or equal to Maturity.

Maturity Maturity date. A vector of serial date numbers
or date strings.

Period (Optional) Coupons per year of the bond. A
vector of integers. Allowed values are 0, 1, 2
(default), 3, 4, 6, and 12.

Basis (Optional) Day-count basis of the instrument.
A vector of integers.
® 0 = actual/actual (default)
e 1=30/360 (SIA)
® 2 = actual/360
* 3 = actual/365
* 4 =30/360 (PSA)
* 5=30/360 (ISDA)
* 6 =30/360 (European)
e 7 = actual/365 (Japanese)
® 8 = actual/actual ISMA)
® 9 = actual/360 (ISMA)
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EndMonthRule

IssueDate

FirstCouponDate

LastCouponDate

StartDate

14-154

® 10 = actual/365 (ISMA)
e 11 = 30/360E (ISMA)
e 12 = actual/365 (ISDA)

(Optional) End-of-month rule. A vector.

This rule applies only when Maturity is an
end-of-month date for a month having 30 or
fewer days. 0 =ignore rule, meaning that a
bond’s coupon payment date is always the
same numerical day of the month. 1 = set rule
on (default), meaning that a bond’s coupon
payment date is always the last actual day of
the month.

(Optional) Date when a bond was issued.

(Optional) Date when a bond makes its first
coupon payment. When FirstCouponDate
and LastCouponDate are both specified,
FirstCouponDate takes precedence in
determining the coupon payment structure.

(Optional) Last coupon date of a bond before
the maturity date. In the absence of a specified
FirstCouponDate, a specified LastCouponDate
determines the coupon structure of the bond.
The coupon structure of a bond is truncated

at the LastCouponDate regardless of where it
falls and will be followed only by the bond’s
maturity cash flow date.

(Future implementation; optional) Date when
a bond actually starts (the date from which

a bond’s cash flows can be considered). To
make an instrument forward-starting, specify
this date as a future date. If StartDate is not
explicitly specified, the effective start date is
the settlement date.



cpncount

Description

Examples

See Also

Required arguments must be number of bonds (NUMBONDS)-by-1 or
1-by-NUMBONDS conforming vectors or scalars. Optional arguments must
be either NUMBONDS-by-1 or 1-by-NUMBONDS conforming vectors, scalars,
or empty matrices.

NumCouponsRemaining = cpncount(Settle, Maturity, Period,
Basis, EndMonthRule) returns the whole number of coupon payments
between the settlement and maturity dates for a coupon bond or set

of bonds.

NumCouponsRemaining = cpncount('14 Mar 1997', '30 Nov 2000',...
2, 0, 0)

8

Given three coupon bonds with different maturity dates and the same
default arguments

Maturity = ['30 Sep 2000'; '31 Oct 2001'; '30 Nov 2002'];

NumCouponsRemaining = cpncount('14 Sep 1997', Maturity)

NumCouponsRemaining
7

11

accrfrac, cfamounts, cfdates, cftimes, cpndaten, cpndatenq,
cpndatep, cpndatepq, cpndaysn, cpndaysp, cpnpersz
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Purpose Next coupon date for fixed-income security
Syntax NextCouponDate cpndaten(Settle, Maturity, Period, Basis,
EndMonthRule, IssueDate, FirstCouponDate, L